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About TOPS Pro 
Congratulations on purchasing TOPS Pro.  You're now the owner of the most 
advanced packaging software in the world.  TOPS Pro is extremely powerful and 
has proven to save millions of dollars for thousands of companies due to the 
efficiencies you'll realize in your business.  We're confident that TOPS Pro will 
provide the same benefit to your company, regardless of your product, package or 
volume. 

We've engineered TOPS Pro to meet the needs of the packaging professional.  
The software allows you to conduct a comprehensive range of analyses based on 
your product, package requirements, equipment and operations.  You'll be able to 
perform operations that were never before possible without a quality software 
system. 

Over the years, we've maintained a steady effort to simplify our software so that 
you, the end user, are able to conduct your packaging analysis quickly and 
efficiently.  Just in case you have a problem, we've written this User Guide to 
assist you with every possible issue or question you might have. 

If this User Guide does not answer your questions, or if you experience problems 
while using the TOPS Pro software, please call TOPS Technical Support or your 
TOPS sales representative at (972) 739-8677 or email us at tech@topseng.com. 
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How the User Guide is Organized 
This User Guide comes with your purchase of TOPS Pro software and its smaller 
modules, PackStak and LoadStak.  You will find some functionalities described 
here will not be available in your PackStak or LoadStak programs including 
MixPro Pallet, MixPro Tray, CASY and some stages in the Package Design 
Sequence. 

This User Guide is organized into 18 chapters and seven appendices, as follows: 

Chapter 1, Getting Started, discusses system requirements necessary to run 
TOPS Pro and instructions on how to install the TOPS Pro software. 

Chapter 2, The Basics, presents the basic features and functions of the TOPS Pro 
system, such as the Control Panel, performing a simple analysis, the Analysis 
View and printing an analysis. 

Chapter 3, Advanced Features, walks you through some of the more complex 
exercises, such as performing analyses with both fixed and newly designed 
containers, shipcase consolidation and performing a knockdown analysis. 

Chapter 4, Publishing an Analysis, explains how to convert an analysis to an 
HTML page and publish it to a web site or network location. 

Chapter 5, Package Pattern and Divider Editor, explains how to reconfigure 
cartons inside shipper, boxes on a pallet, or pallet inside a vehicle by moving 
individual items to different positions.  You can also remove or add items inside a 
shipper, on the pallet or inside vehicle. This chapter also shows you how to create 
a custom divider using a graphic editor. 

Chapter 6, MixPro Mixed Pallet Editor, discusses how to design a pallet for 
display with any number of different size boxes.  The MixPro Pallet system 
allows you to easily load and place all types of shipcases onto a pallet.  Use 
MixPro Pallet to create mixed pallets for display. 

Chapter 7, MixPro Mixed Tray Editor, discusses how to design a tray for 
display with any number of different size items.  The MixPro Tray system allows 
you to easily load and place all types of items onto a tray.  Use MixPro Tray to 
create mixed trays for display. 

Chapter 8, Create A Shape Yourself (CASY), explains how to design custom-
shaped bottles, cans, shipcases and trays for more realistic displays. 

Chapter 9, Stacking Strength, discusses how to calculate the stacking strength of 
your shipcases, how to analyze stacking strength results and the technical 
formulas TOPS Pro uses in its calculations. 



 

Preface xvii 

Chapter 10, Package Profile, explains how to create a package profile, which 
contains a number of products that use the same packaging; for example, several 
brands of cereal that use the same type of cereal box. 

Chapter 11, Reports and Printing, walks you through all of TOPS reports and 
the system's printing functions, including how to define print parameters, add text 
and graphics to a print preview, the Quick Print feature and the new Combined 
Report feature. 

Chapter 12, Designing Box Styles, presents the basic box drawing styles used in 
the TOPS Pro system and provides guidelines for designing box drawing styles 
tailored to your own needs. 

Chapter 13, Designing Divider Styles, presents the basic divider drawing styles 
used in the TOPS Pro system and provides guidelines for designing divider 
drawing styles tailored to your own needs. 

Chapter 14, TOPS Pro Config Program, discusses the functions provided by the 
TOPS Configuration program, which is a separate program that allows you to 
customize TOPS Pro to meet your needs in a number of ways.  For example, the 
TOPS Configuration program allows you to define a range of default settings – 
environment factors, box design factors, board combinations, paper, flutes, etc. – 
that TOPS Pro uses to perform everyday analyses. 

Chapter 15, Supervisor Functions, explains how a supervisor can add, delete and 
rename users in the system; approve or deny an analysis; and set up an analysis or 
Quick Print template. 

Chapter 16, RFID Analysis, gives a preview of the upcoming new feature, RFID 
Location Optimizer and explains how TOPS Pro can help determine placement of 
RFID tags for optimal readability on shipcases. 

Chapter 17, Eco Savings Report, explains how to configure cost data and create 
ESRs to compare data on corrugated use/wastage and carbon emissions across 
different solutions. 

Chapter 18, Send to MS Office, explains how to export TOPS analysis into MS 
Word and Excel.  It also illustrates how to create custom TOPS templates for 
these MS Office tools using bookmarks and field names. 

Appendix A, Frequently Asked Questions, outlines a comprehensive range of 
questions posed by TOPS Pro users. 

Appendix B, Dialog Boxes, presents all the dialog boxes used in both the TOPS 
Pro system and the TOPS Configuration program, including the function of the 
dialog box, a screen shot of the dialog box, how to access the dialog box, and 
field descriptions and instructions. 
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Appendix C, Menu Options, outlines the eight menus that comprise the TOPS 
Pro menu bar – File, Edit, View, Definitions, Tools, Export, Supervisor and Help 
– and describes the options included in each menu. 

Appendix D, Pallet Patterns, presents the 13 primary pallet patterns used in the 
TOPS Pro system. 

Appendix E, Box Styles, presents the available box styles defined in the TOPS 
Pro database. 

Appendix F, Divider Styles, presents the available divider styles defined in the 
TOPS Pro database. 

Appendix G, Tops Bookmarks, provides a list of all bookmarks and 
corresponding TOPS images and statistics which you can include in any Word 
documents. 

Appendix H, Importing to TOPS, provides the different format for importing 
shipcase and carton data into TOPS. 

Appendix I, Glossary, provides definitions for a range of terms used in the TOPS 
Pro system and the packaging industry. 
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New Features in TOPS Pro 6.50 
 Enhanced Truck Functions:  TOPS Pro 6.5 will allow partial layer inside a 

vehicle in order to meet weight limitation set by the user. Unitloads exceeding 
the weight limit will be removed automatically. Users can also manually edit 
the load inside the truck. 

 Quick Strength: With Quick strength, stacking strength results come in the 
form of ECT values given the safety factor, number of loads high and amount 
of product support. 

 Improved Knockdown to handle non-RSC Boxes: The improved 
knockdown feature can now be used for boxes other than an RSC box by 
allowing the user to type in a formula for getting the knockdown dimensions 
of the box. 

 Custom Dividers: Users have the ability to control the height and width as 
well as the alignment of the divider within a carton or shipper. The new 
defined divider can be saved to the database for future use. 

 Unit of Measure and Dimension Display: New option to display both the 
inside and outside dimension as well as showing them in both English and 
metric values. 

 Incorporate MixTray and MixPro results into TOPS Analysis: Ability to 
bring the mixed trays and mixed pallets created with MixPro into the TOPS 
design sequence and use them as shipcase or unitload. 

 Advanced Layer Parameters: The flexibility to control over layers and layer 
accessories including defining new slipsheets, trays, pads, caps and more. 

 New Pallet Report with Wal-Mart Scores: New shipcase and pallet 
summary reports with War-Mart Efficiency scores. 

 Add Product Dimensions and Weight for Primary Pack: Users employing 
the Pallet report to generate unit load details can enter dimensions, volume, 
and weight for products going into the primary pack. This feature is used to 
calculate Wal-Mart efficiency values which will reflect in the Pallet report 
statistics. 

 Integration with Artios CAD: The new integration allows users to launch 
TOPS directly from Artios CAD and bring pallet configuration from TOPS 
back to the CAD program. 

 Solution Windows Shown in Tabs:  Solution windows are now presented in 
a tabbed format, allowing the user to navigate through the solutions with a 
quick click of the mouse. 

 Octagonal Box Style and Inverted Bags and Bottles. 
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 Report with Packaging Instructions: Package instructions, including the 
type and quantity of straps, corner posts, and/or shrink wrap used for shipcase 
and Unitload can be added to the analysis report and be displayed with the 3D 
graphics or at the bottom of the report. 

 Set Application Background: Add something fun to your TOPS Pro 
software by selecting any JPEG graphics to be used as the wallpaper for the 
control panel. 

 Define Compression/Bulge for Unitloads: Users can set these values as 
positive or negative percentage to represent compression and bugle for 
unitloads respectively. 

 Easier File Manipulation: The Open/save dialog box has a convenient right 
click menu as well as supporting drag-and-drop function to move analyses 
among folders. 

 Auto File Recovery and Program Maintenance: The Auto Recovery 
function helps prevent data loss in case of unexpected power outage by setting 
automatic backup. The Maintenance Control Feature lets users on a network 
know how long they have until a scheduled maintenance will occur. This will 
give users time to work on an analysis and save it before the programs shuts 
down. 

 New Report Views:  New views include Inverted Unitload 3D and Current 
View: More display options are now available for reports.  

 Opening and Saving Analyses in XML Format. 
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Chronology of Features in TOPS Pro 
This section outlines the various releases of the TOPS Pro software, along with 
the features included in each release. 

Version 6.0 (Major Release) 
 Eco Savings Report to compare the effects different case sizes and load 

solutions have on the environment, in terms of carbon emission, corrugated 
and packing material waste/usage. 

 Tabbed Solution Views. 

 Modify Pattern for Interpack/Shipcase Stage. 

 Comparison Reports to include up to five solutions. 

 Inverted Nesting for Tubs in both directions. 

 New Packaging Options: edge protector or a pallet on top of a unitload. 

 New Box Styles including display case, display case, tear out box, HSC with 
top cover and common footprint standard boxes for produce. 

 New Pallet Types and Parameters including new pallets from Chep, Litco, 
OptiLedge and options to specify color and align offset for stringers. 

 New C.A.S.Y. shape options including top and side handles; new C.A.S.Y. 
tray supports cover and mirror function. 

 Expanded Unitload Label Option for size and placement. 

 Enhanced Edit Options to add arrows or lines to reports. 

 Analysis Archive Function. 

 Import/Export Analyses in XML Format. 

 

Version 5.60 (Major Release) 
 MixPro Auto Load Generator to create optimal club store display pallets.  

 New MixPro functions to support slip sheets, corner posts, set shipcase 
display face directions and more. 

 Load shipcases directly into the void spaces to the side, top or end of the 
unitloads inside vehicles to maximize cube utilization. 

 Add unitload labels and control their placements.  

 Inverted nesting for blister packs, tubs and buckets.   

 Supports blister packs, in straight or nested inverted arrangements. 
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 More standard shapes including stand-up pouches, custom trays and boxes 
with lid. 

 Create reports with side-by-side comparison between any two solutions as 
well as between two analyses at any state of an analysis (shipcase, pallet load 
or container). 

 Define new flute parameters in the TOPS Configuration program. 

 Support slave pallet and pallets with false bottom or raised platform. 

 New file interface with quick find and sort capabilities. 

 Enhanced Reporting with up to 6 panels for more package illustrations and 
statistics. 

 The database function is added to support Intermediate packs. 

 Support shipcase costing in per box or per square area unit to give a quick 
glimpse of the total corrugated costs. 

 Direct PDF Output. 

 Automatically exports analysis data from TOPS to be used with other systems 
like SAP or other ERP systems. 

 Creates details for each analysis with custom defined fields and enter tare 
weight for shipcases and pallets. 

 Drag and Drop Analysis Import. 

 

Version 5.02 (Major Release) 
 Create New Template allows you to save the analysis as a template and add it 

to the Template Toolbar 

 Publish Analysis to Web or to a local network 

 Creates folders for organizing and storing analyses 

 Shipcase Parameters allows you to choose All or Multiple shipcases from the 
database 

 Unitload Parameters allows you to specify the maximum number of layers on 
a pallet 

 Send to Word uses a Word template to convert an analysis directly to a 
Microsoft Word file 

 Email Stacking Strength Board Combo List directly from TOPS 

 New Print Preview includes Unitload Dual Plan preview of a unitload with the 
rotation of each layer 

 Updated Windows Toolbar including Stacking Strength button and the All 
Stages Enhanced View button added 
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 Define Stacking Strength Factor for a Non-RSC Box 

 New Divider Styles include 2-Way Air Cell and U Simple 

 Supports Pop-Up Help Tips 

 New flyBar for easy access to routine function buttons in Analysis View 

 Optional arrows indicating pads and slipsheets on unitload 

 More Print Parameters including additional notes for information such as 
Label Format, Test Weight and Package Quantity 

 Define default thickness for a slipsheet; maximum length, width and height 
increments for Intermediate Pack Sizing or Shipcase Sizing in TOPS Pro 
Configuration program 

 Save to Shipcase Database at the same time you save the analysis   

 
Version 5.X (Major Release) 

 One-click design sequence template in Control Panel 
 Organized analysis into projects or folders 
 Selectable shipcase list for database analysis 
 Supported maximum number of layers for unitload 
 Exported analysis to MS Word custom templates 
 Directly email stacking strength board combo list 
 New Dual Pane print option showed rotated layers for unitloads 
 New CASY shapes (trigger top and rounded rectangles) and shape (match top, 

match bottom, match both, pinch top or pinch bottom) 
 Right-click menu at Graphic View pane to access frequently used functions 
 Supported stacking strength factor for non-RSC boxes 
 New divider styles of U simple and 2-way air cell 
 Floating toolbar for graphic screen to access common functions 
 Optional quad view with all stages 
 Enhanced graphics view with marker for pads and slipsheets 
 Included additional information fields for print reports 
 Additional default settings on thickness for slipsheets, maximum size for 

intermediate pack, maximum and minimum size for shipcase 
 Saved analysis-generated shipcase to database 
 Added bundle with straps as new shipcase style 
 Traditional and Simplified Chinese language support 
 XML Export 
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Release 2 (Major Release) 

 Added MixPro Tray Design Editor 
 Added ePAC™ Publisher 
 New, realistic wrap-around box style 
 Accounting for overlapping of bags 
 Define columns for the stacking strength report 
 Direct email from MixPro Pallet and MixPro Tray 
 Thumbnail images of pallet patterns 
 Interlocking of products in a shipcase 
 Added PNG and WMF to available graphic file formats 
 Display shrinkwrapped and strapped pallets 
 Use multiple pallets in a calculation 

 
Version 4.xx (Major Release) 

 Automatic layer calculation for MixPro 
 Automatic Knockdown Calculations based on RSC cartons 
 Added MixPro Pallet Design Editor 
 Analysis templates easier to define and use 
 Custom shape generator for trays and extruded 
 Direct email of reports using MAPI clients 
 Improved supervisor access control features 
 Layer adjustments above 14 layers 
 One-click access to stage parameters via the Windows Toolbar 
 Email support for Lotus Notes 

 
Version 3.5x (Major Release) 

 Packed case weight calculations now use RSC Board Area instead of Surface 
Area 

 Program now pays attention to "max along" limits 
 Changed simple and none printing STR adjustments 
 Four-digit dates for year 2000 compliance 
 Added support for additional bundling stage 
 Packer now allowed to be a fixed size 
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 Now reports Pallet Dimensions in Unitload Parameters dialog box 
 Bulk Product icon can now be turned off 
 Added time stamp to printout 
 Standardized graphics file output (BMP, JPEG) 
 Added paste-on graphics to Box drawings 
 Added (manual) pallet pattern editing capabilities 
 "Show Contents" state now saved with the analysis 
 Combined reports for KnockDown/Erected Boxes 
 Added support for Robotic Palletizer 
 Added five most recently used analyses to File menu 
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Chapter 1: Getting Started 

Introduction 
This chapter covers the following topics to get you up and running with 
the TOPS Pro system: 

 System requirements/specifications necessary to run TOPS Pro 
 Instructions on how to install stand-alone and network versions of 

TOPS Pro software 
 Instructions on how to setup the TOPS license 
 Contact information if you need assistance 

 

System Requirements/Specifications 
To install and run the TOPS Pro software, your system needs to meet the 
following requirements: 

 Platform:  All versions of Windows (95, 98, 2000, NT, XP, 2003, 
Vista, Windows7) 

 Network:  Any network is compatible.  TOPS Pro is not network-
protocol dependent; it only needs a file server 

 Processor Required:  Any processor capable of running the installed 
platform.  A Pentium processor of 400 MHz or better is recommended 

 Hard Disk Space Required:  100 MB 

 RAM Required:  256MB minimum – 512MB or more recommended 
for “Save to Clipboard” function 

 Video Required:  800 x 600 at 16-bit color or higher is recommended 

 Terminal/Citrix Server:  TOPS can be deployed on terminal or Citrix 
server 

Network Information:  TOPS Pro is installed from a client machine to 
the file server.  After the install, all work is done on the client(s).  TOPS 
Pro and DirectX usually do not take more than 100 MB of space on the 
file server, depending on the database size.  DirectX is copied to the file 
server for install on client(s) that do not have a working copy of DirectX.  
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The TOPS Pro software uses 32-bit code.  For import/export of data, 
TOPS Pro uses ASCII comma delimited text files compatible with most 
document management systems, spreadsheets, databases and mainframes, 
including Excel, Access, Paradox, AS400 and UNIX platforms. 

 

Installing TOPS Pro 
For the most updated procedures to install your TOPS Pro license, please 
refer to the Installation Instructions inside your software CD packet. 

Before your begin installation, please make sure: 

 If you are installing a network license, please start the process from 
the client machine. 

 Make sure you have administrative rights (including read, write, 
modify and execute) to install to your computer and the network. 

 You MUST contact TOPS via phone or email to complete the 
electronic license setup. 

To start installation, follow these instructions: 

1. Close all other programs. 

2. Insert the installation CD into the CD-ROM drive.  The TOPS Pro 
installation program launches automatically.  Click on Install TOP 
Pro. 
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Note:  If the installation does not automatically start, use the Start/Run 
D:\setup command, where D: is your CD-ROM drive. 

3. Installation will start with the TOPS Pro software welcome screen and 
a reminder to close all Windows programs. Continue installation by 
clicking on the Next button.  
 

 
 

4. At the Installation dialog box as shown below, select: 
 

 
 Install to Local PC (Standalone Version Only) to install the 

stand-alone TOPS Pro license you purchased (as marked on the 
CD cover). There can only be one single install for each stand-
alone license. 

 Install to Server (Network Version Only) if your license is of 
network configuration (as indicated on the CD cover info). Note 
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that you should start installation from a client machine. If you are 
not, click the Cancel button and abort the setup process.  Restart 
installation from a client machine that is connected to a server 
where TOPS is to be hosted. 
 

5. Specify if you are installing a new license or upgrading an earlier 
version of TOPS.  If you are upgrade from an older version, you will 
be prompted whether export existing data to the upgraded version. 

 
6. Based on the Purchase License Information on the CD cover, select 

the TOPS software module you’ve purchased for installation and click 
on Next button to continue. 
 

 
7. At the “Choose Default Software Settings” screen as shown below, 

clik on the Next button to use the default selections.  You can easily 
change the language and unit of measure later in the application. 
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8. At the “Choose Common Component Location” screen as shown 

below, specify the folder where the software will be installed and click 
on the Next button. 
 

 
 

 Stand-alone License:  Use the default folder of C:\Program 
Files\TOPSAPPS\ or click the Browse button to specify another 
folder on your computer. It is recommended to use the default 
folder so future upgrade will be more straight forward. 

 Network License:  Click the Browse button to select the mapped 
drive of the server from the client machine.  
Note: After installation and successful license setup, run 
NETSETUP or WAN_SETUP on each client machine to copy the 
necessary files to start TOPS Pro. 
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9. TOPS will confirm with the installation path. Click on Next to start 

installation. 

 
 

10. From this point on, you will see a series of dialog boxes indicating the 
progress of installation. When the process is complete, you will see the 
screen with the message “TOPS for Windows has been successfully 
installed”.  At this time click Finish to return back to the Software 
Install Selection screen.  Click on Exit to close the application. 
 

 
 
Note: If you are installing an upgrade, you will see a message whether 
to export existing data.  Please refer to the section Upgrading TOPS 
Pro for more details. 
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Starting & Setting Up TOPS Pro 
After successful installation of TOPS, there will be a 
shortcut added to your windows desktop.  Click the desktop 
shortcut to access the Set TOPS License dialog box. 

You can also start TOPS Pro via Windows Start menu.  
Go to the TOPS for Windows Apps and select TOPS Pro. 
 

 
 

To setup the license, have the following information ready and call TOPS 
at 972-739-8677 and ask for “New License Setup”: 

 Company Name: The name you’d like to appear in all TOPS reports 
 Serial Number:  The serial number on the CD cover or the front face 

of your CD, NOT the serial number shown in this dialog box.  
 The Key from the Set TOPS License dialog box. 
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Enter the (1) Company Name, (2) Serial Number and (3) Verification 
Code EXACTLY as provided and click on the Apply button. If all 
information is entered correctly, you should see a message saying 
“License successfully set” and the License Information section will reflect 
the TOPS license module and format. 

Congratulations!  At this point, the installation is complete.  Now you're 
ready to go to work with TOPS Pro. 

To run TOPS Pro, go to Start | All Programs | TOPS for Windows Apps | 
TOPS Pro or click the TOPS Pro shortcut on the desktop. 
 

Upgrading TOPS Pro 
If you are upgrading an existing installation, please install it in the same 
folder as the earlier version. You will be asked whether to export existing 
data to the new version.   

 

Click “Export Existing Data” to export data to the current version of 
TOPS.  Else, click the “Don’t Export Existing Data” button. You will then 
have to email the data folder to TOPS in order to convert the data to be 
compatible with the current version. 

You might run into messages asking whether to replace existing records, 
click on the Skip or Replace button accordingly as desired.  You can also 
check the “Apply to all” option so all duplicate records will be handled in 
the same manner.
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For Network Setup 

All users should have full read / write / modify / execute access to a level 
up from the TOPSAPPS directory on the network. 

1. Make sure you have full administrative rights to the workstation you 
wish to set up TOPS Pro 

2. Permanently map a network drive to the location on the server, where 
you installed TOPS Pro.  

3. Browse across the mapped network drive to the TOPSAPPS directory. 
4. Run the NETSETUP.EXE file for a LAN (Local Area Network) install 

and WAN_SETUP.EXE file for a WAN (Wide Area Network) install, 
respectively.   
 
Note: Wansetup copies over all EXE, DLL files, and as much of the 
software as possible to the WAN user’s PC.  This can be done to as 
many machines as needed; the license limits users’ access by 
concurrency. 

 
NETSETUP / WAN_SETUP will verify that there is a valid version of 
DirectX installed on the local PC, create a local TOPSPRO.ini file and 
place it in Windows or Win32 directory.  It will then create the required 
shortcuts for the software and place those on the desktop and under Start | 
Programs | TOPS for Windows Apps Menu 
 
Note: If during the installation an error message occurs, please make note 
of the error and continue with the installation until it is finished.  Then, 
call the TOPS Technical support 
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TOPS Pro Program Group 
The TOPS Pro program group includes a number of icons.  The four 
primary programs are: 

 TOPS Pro Config:  Launches the utility program for TOPS 
Pro, which allows you to change global defaults, perform bulk 
exporting, and even define and adjust your own board grades, 
papers and flutes.  We’ll refer to this icon as the Config icon. 

 TOP Pro:  Launches the main program.  We’ll refer to this 
icon as the TOPS Pro icon. 

 TOPS Pro Move License Manager:  Allows you to move 
the authorization of the program between the key disk and the 
copy residing on your system.  We’ll refer to this icon as the 
Move icon. 
 
This icon also gives you easy access to the Reset function, in the event 
that you require a reset of your floppy license.  You will also run this 
program to setup the electronic license of TOPS Pro, should your 
computer does not have a floppy drive. 
 

 TOPS Pro Viewer:  Available only in the network version of 
TOPS, the Viewer allows you to view solutions that have 
already been generated in the TOPS Pro system.  This is a 
view/print-only feature and does not allow any changes made to the 
existing analyses. 
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Uninstall and Move TOPS Pro 
The TOPS Pro software is designed with an authorization scheme that 
enforces the TOPS Pro licensing agreement – each stand-alone license or 
network license can only have one single installation.  

Circumstances may arise when you need to reinstall the software. For 
instance, you are getting a new computer/hard disk or upgrading the 
version of Windows you're using. In such a case, please contact TOPS for 
assistance to move your TOPS license.  Please note that you will have to 
delete/remove the old installation once the move has been completed. 

 

Contact Information 
If you need to contact TOPS Technical Support for any reason, use the 
information below: 

TOPS Software Corporation 
275 West Campbell Road, Suite 600 
Richardson, Texas  75080 USA 
Phone 972.739.8677 
Fax 972.739.9478 
 
Email for technical support: tech@topseng.com 
Email for sales information:  info@topseng.com 

Web page: www.topseng.com 
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Chapter 2: The Basics 

Introduction 
This chapter walks you through the basic features and functions of the 
TOPS Pro System.  It's important to understand and master the basics 
first, so we'll work through each of these stages one at a time.  This 
chapter introduces the basic stages in the sequence they are normally 
used in the system, as follows: 

 Control Panel:  Introduces the primary panel in the system, which 
allows you to select the type of analysis you want to perform, the 
stages to be used in the analysis, and the dimensions of each stage. 

 Perform a Simple Analysis:  Walks you through the steps to 
perform a simple shipcase-to-pallet analysis. 

 Analysis View:  Displays the different solutions generated for your 
analysis.  Allows you to select the solution that best meets your 
packing needs. 

 Layer Parameters:  Explains how to apply a number of different 
stages – rotations, pads, trays, slipsheets, caps, secondary patterns – 
to your unitload layers. 

 Print the Analysis:  Explains how to design the layout of the 
printout, including what type of information to include and how to 
present that information (different graphic views, text and numbers, 
etc.) and how to use your company logo in the reports 

 Copy an Image to the Clipboard:  Explains how to select an image 
in TOPS Pro and copy it to the Windows clipboard.  Explains how to 
copy the image into Microsoft Word or Power Point and how to use 
the Paste Special feature. 

 Save the Analysis:  Explains how to save your analysis to the 
database. 

 Direct Email From TOPS Pro:  Allows you to email a standard 
printout directly to another person who may or may not have TOPS 
Pro. 

 Direct Export to PDF file:  Allows you to create TOPS analysis 
reports directly to a pdf file without using Adobe Acrobat or other 
third party PDF writer. 
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Control Panel 
When you login to the system, the Control Panel appears, as pictured 
below.  The Control Panel contains all the primary features of the system:  
Menu Bar, Windows Toolbar, Template Toolbar, Package Design 
Sequence Area, Button-Style Menus and Shortcut Buttons. 

 

 

 
 
 
 
 
 

The Control Panel is the primary panel in the system.  It is the working 
area from which you will select the type of analysis you want to perform, 
select the stages to be used in the analysis and define the dimensions of 
each stage. 

Menu Bar Package Design Sequence Area 

Button-Style Menus 
Shortcut Buttons 

Windows Toolbar 

Template Button 
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Menu Bar 
The Menu Bar, pictured below, provides a number of drop-down menus.  
These menus provide options that allow you to perform common tasks, 
many of which are duplicated on the Button Bar and Shortcut Buttons. 

 

The list below gives a brief description of the eight menus on the Menu 
Bar: 

 File Menu:  Allows you to create new records, open existing records, 
save records and set up print parameters.  You can also access this 
menu to publish and archive existing analyses. 

 Edit Menu:  Allows you to copy text and images to the Windows 
clipboard, as well as work with secondary pallet patterns. 

 View Menu:  Allows you to view graphic images in a number of 
formats:  3-D, front, side, split screen, quad screen and others. 

 Define Menu:  Allows you to define parameters for new products, 
cartons, shipcases, pallets, vehicles, etc. as well as access to the 
C.A.S.Y functions. 

 Tools Menu:  Allows you to revise your TOPS Pro configuration, the 
language used in TOPS Pro, stacking strength parameters, color 
selections, Eco Savings Reports (ESR) and MixPro functions. 

 Import Menu:  Allows you to import TOPS analyses. 

 Export Menu:  Allows you to export different types of graphic files 
(.bmp, .tiff, .jpeg), analyses, product reports, etc. 

 Supervisor Menu:  Allows you to perform supervisor functions such 
as login/logout tasks, access approval and denial, template setup, etc. 

 Help Menu:  Allows you to display Help information for all features 
and functions in the system. 

Note:  For detailed information about all the menus and menu options 
included on the Menu Bar, please refer to Appendix C, Menu Options. 



 

2-4 TOPS Pro (Version 6.50) User Guide  

Windows Toolbar 
The Windows Toolbar, as pictured below, contains a number of icons 
that allow you to perform standard, routine functions.  It also provides 
direct links to parameter dialog boxes for primary packages, intermediate 
packers, shipcase, unitloads and vehicles so you can modify those 
parameters without losing your place in the analysis. 

 

The following table outlines the icons found in the Toolbar and its 
corresponding purpose. 

Icon Function 

 
New Analysis:  Select from the menu to start a new analysis 
from scratch or start a new analysis via a predefined analysis 
template. 

 
Open Analysis:  Select from the menu to open an analysis in 
standard format or in XML format. This will lead to the 
respective dialog box for further action. 

 
Save Analysis:  Select from the menu to save the analysis as a 
new analysis, as a template or as an XML file. 

 
Print:  Select from the menu whether to prints the current 
analysis, pallet report, package profile, container diagram, 
combined  report or compare solutions. 

 Previous:  Takes you to the previous step in the Package 
Design Sequence for an analysis. 

 
Next:  Takes you to the next step in the Package Design 
Sequence for an analysis.  If there is no next step, this icon 
takes you back to the Package Design Sequence. 

 
Cancel to Package Design Sequence:  Cancels out of the 
active analysis and takes you back to the Package Design 
Sequence area, where you can start over. 

 
Design CASY Shape or Tray:  Select from the menu to open 
the CASY Primary Package Style or CASY Tray Style 
function editor. 
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Icon Function 

 
MixPro / MixTray Editor:  Select from the menu to open 
the MixPro Mixed Pallet Editor or the MixTray Mixed Tray 
Editor. 

 
Modify Parameters:  Select from the menu to quickly access 
the parameter dialog box for the different design sequence: 
primary pack, interpack, shipcase, unitload or vehicle. 

 
Show CASY:  Serves as a toggle switch to turn on or off the 
CASY graphics display. 

 
Stacking Strength:  Opens the Stacking Strength dialog box. 

 
Send to Office:  Select from the menu to send current 
analysis to Microsoft Word or Excel. 

 
Information:  Click to export current analysis data to Artios 
CAD or open the Load Plan function to determine the load 
requirements for a specified quantity of primary product 
when the current package sequence is used. 

 
Export: Select from the menu the different export options. 
For graphics, export options include BMP, JPEG, PNG and 
PDF files. Users can also export analysis in text or XML 
format or export data to Artios CAD. 

 
Create PDF: Allows you to create PDF report for analysis, 
pallet report or package profile. 
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Template Toolbar 
The Template Toolbar will be displayed upon clicking Template button.  
 

 

The Toolbar, pictured below, gives you easy access to analysis templates 
set up in the system.   

Notice the first button in the toolbar to the left.  
This template button shows four stages of an 
analysis:  Can/Cylinder-Shipcase-Pallet-Vehicle. 

If you click on this button, TOPS Pro 
automatically inserts the corresponding icons in 
the Package Design Sequence Area. 

As you set up the stages that make up an 
analysis, TOPS Pro allows you to save the 
analysis as a template and add it to the Template 
Toolbar.  For more information, please refer to 
the section “Perform a Simple Analysis.” 

 
 

Button-Style Menus 
The Button-Style Menus, pictured below, allow you to set up a Package 
Design Sequence, in which you select the various stages to be used in an 
analysis. 

 

There are six Button-Style Menus, each represents a stage of an analysis. 

Each button-style menu contains a list of items that allows you to define 
the stages of an analysis with any combination of items you need.  To 
select an item, click on the graphic representation of the item in the list, 
then click on the text button at the top of the list.  As you select each 
stage, the corresponding icon will appear in the Package Design 
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Sequence Area of the Control Panel.  To remove an icon from that area, 
simply click on the text button again. 

Note:  Be aware that there are a few duplications in the button-style 
menus that should be clarified. 

 Carton Icons:  There are two Carton icons.  The Box Carton icon 
(green) displays the Carton Parameters dialog box.  The Intermediate 
Pack Carton icon (blue) displays the Intermediate Pack Parameters 
dialog box. 

 Tray Icons:  There are two Tray icons.  The Intermediate Pack Tray 
icon (blue) displays the Intermediate Pack Parameters dialog box.  
The Shipper Tray icon (yellow) displays the Shipcase Parameters 
dialog box. 

 Bag Icons:  There are two Bag icons.  The Film Bag icon (green) and 
the Shipper Bag icon (yellow) both display the Bag Parameters dialog 
box.  However, you'll use the first Film Bag icon to design a bag that 
contains a product.  You'll use the Shipper Bag icon to put a bag onto 
a pallet. 

 Bottle Icons:  There are two Bottle icons.  The Bottle icon (green) 
and the Shipper Bottle icon (yellow) both display the Bottle 
Parameters dialog box.  However, you'll use the first Bottle icon to 
design a bottle that goes into a shipcase.  You'll use the Shipper 
Bottle icon to design a bottle that goes onto a pallet. 

 

Right Click Menu 
The Right Click Menu, pictured below, allows you to 
set up a Package Design Sequence, as well as to replace 
the wall paper used for the background of TOPS Control 
Panel.       

To access, place the mouse cursor at any blank area of 
the Control Panel and click the right mouse button. 

Click the corresponding design step to be added to the 
Design Sequence; a check mark will indicate the 
presence of the step. 
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Set Background 
Click the Set Background option in the Right Click menu to open the Set 
Background Image dialog box, as pictured here. 

 

 Custom: Click this radio button to use a new graphics for the Control 
Panel. 

 Graphic: Click the Browse button to open a folder and specify the 
graphics image to be used. 

 Position: Click Center to center the image on the Control Panel at its 
native resolution and Stretch to fill the entire Control Panel with the 
new graphic. 
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Package Design Sequence 
The Package Design Sequence Area is the area on your screen in which 
you define a series of stages for an analysis.  For example, let's say you 
selected six stages from the Button-Style Menus:  bulk, bag, carton, 
shipper, pallet and truck.  The corresponding icons will appear in the 
Package Design Sequence Area, as pictured below. 

 

The icons you see in this figure are often referred to, respectively, as the 
Bulk Parameters icon, the Bag Parameters icon, the Carton Parameters 
icon, the Shipper Parameters icon, the Unitload Parameters icon and the 
Transit Vehicle Parameters icon. 

This represents a Package Design Sequence in which you'll find the best 
solution for this analysis:  bulk product into a bag, into a carton, into a 
shipcase, onto a pallet and into a truck. 

Next, when you click on any of these icons, a dialog box will appear and 
allow you to define the parameters of that particular stage in the 
sequence.  For example, when you click on the Bottle icon, the Bottle 
Parameters dialog box appears, and you'll tell the system precisely how 
your bottles are designed in terms of dimensions, weight, shape, etc. 

You can also click the Calc button on the lower right hand corner to start 
defining parameters for each stage. 
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Shortcut Buttons 
The Shortcut Buttons, pictured below, allow you to view and calculate 
solutions for an analysis. 

 

 View Button:  Allows you to display and view the solution panels 
(Analysis View) for a selected analysis.  This function becomes 
active only after an analysis has been completed. 

 Calc Button:  Allows you to calculate solutions for an analysis.  
After you've selected all the stages for the analysis and defined 
parameters for each stage, the Calc button tells the system to generate 
all possible solutions for the analysis, given the data you entered. 

If you click on the Calc button and your analysis is incomplete – you 
forgot to enter a necessary detail – TOPS Pro automatically displays the 
appropriate dialog box and prompts you to enter the missing data.  If 
you've simply made changes to the analysis, the system allows you to 
look over the changes you made before you continue. 
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Perform a Simple Analysis 
To follow through with the basics of the TOPS Pro software, this section 
walks you through a simple analysis and leads to the Analysis View, 
which is presented in the next section.   

This analysis – shipcase onto a pallet – is very common and considered 
simple because it involves only two stages. We are stacking shipcases of 
dimension 17x13x11 (inch), weighing 10 pounds onto a pallet with no 
overhang. 

Define the Package Design Sequence 
To perform this analysis, start from the Control Panel and click on the 
Shipper and Pallet icons. 

 

Save the Package Design Sequence as a Template 
The shipcase-to-pallet sequence is a routine analysis that you’ll perform 
frequently.  TOPS Pro allows you to save this analysis as a template and 
add it to the Template Toolbar. 

To save the Package Design Sequence as a template, follow these 
instructions: 

1. Go to the Menu Bar and open the File Menu. 

2. From the File Menu, click on the Save As Template option.  The 
Analysis Save As dialog box, as pictured on the next page, appears. 
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3. In the Description field, enter the name of the new template (e.g., 
Shipcase -> Pallet) and click on OK. 

TOPS Pro saves the new template to the database and adds it to the 
Template Toolbar.  The next time you want to perform this analysis, 
simply go to the Template Toolbar and click on the “Shipcase -> Pallet” 
template button to start the analysis. 

Note:  To display the Template Toolbar on the Control Panel, go to the 
Configuration dialog box and select the Display Template Buttons option. 
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Define Shipcase and Pallet Parameters 
To define parameters for the shipcase and pallet, follow these steps: 

1. Click on the Shipper icon in the Package Design Sequence area. 

 

2. Enter data to define your shipcase parameters as shown in the dialog 
and click on OK.   
 
TOPS stores your parameters to memory and closes the Shipcase 
Parameters dialog box. 



 

2-14 TOPS Pro (Version 6.50) User Guide  

3. Click on the Pallet icon in the Package Design Sequence area and the 
UnitLoad Parameters dialog box, as shown below, appears. 

 

4. Change the Maximum Overhang to 0 for both Length and Width 
dimension and click on OK. 
 
TOPS stores your parameters to memory and closes the UnitLoad 
Parameters dialog box. 

5. Click on the Calc button to generate solutions for the analysis. 

TOPS Pro uses the defined parameters – shipcase and unitload – and 
generates all possible solutions for the analysis.  When the calculation is 
complete, the Analysis View appears.  The next section discusses the 
Analysis View in detail. 
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Revise Parameters for an Analysis (if necessary) 
To revise any parameters for an analysis that has not yet been generated 
(you've not yet clicked on the Calc button), follow these instructions: 

1. Click on the appropriate icon. 

2. Use the dialog box to make the necessary changes. 

To revise any parameters for an analysis that has already been generated, 
follow these instructions: 

3. Click on the Modify icon in the Windows Toolbar and select the 
desired parameter to be modified.  For example, to revise shipcase 
parameters, click on the Modify button and then select Modify 
Shipcase Parameters in the drop down list. 

 

4. Enter the necessary changes in the Shipcase Parameters dialog box. 

5. Click on the OK button. 

TOPS Pro uses your changes to generate a new set of solutions. 
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Analysis View 
When TOPS Pro generates solutions for an analysis, it displays the 
Analysis View, as pictured below.  You'll use the Analysis View to study 
the different solutions and select the one that best meets your packing 
needs. 

 

The Analysis View is normally divided into three panes, which work in 
conjunction with one another.  Let's talk about these three panes one at a 
time. 

 Solution View Pane:  This pane, in the top left portion of the screen, 
displays a graphic of what the selected unitload solution looks like – 
i.e., how the shipcases have been loaded onto the pallet. 

 Statistics View Pane:  This pane, in the top, right portion of the 
screen, displays detailed statistics for the selected solution. 

 Solution List Pane:  This pane, at the bottom of the screen, displays 
a list of the best 50 (if there are 50) solutions generated for the 
analysis, along with a variety of basic information for each solution. 
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Solution View Pane 
The Solution View pane displays a 3-D graphic of what the selected 
solution looks like; this pane is linked to the Solution List pane at the 
bottom.  For example, if you select Solution 1 in the Solution List, the 
Solution View displays a graphic that corresponds to Solution 1.  If you 
select Solution 5 in the Solution List, the Solution View displays a 
graphic for Solution 5, and so on. 

In this analysis, the UnitLoad Solution View pane, pictured below, shows 
a graphic view for Solution 1. 

 

Notice the following features on this pane: 

 Type of Solution:  The title bar of the pane reads "UnitLoad View 1 
of 19."  If this were a Carton solution, the title bar would read "Carton 
View ..." 

 Solutions Counter:  The title bar of the pane shows a counter (for 
example, 1 of 19).  This tells you that this is the first of 19 solutions 
generated by the system. 

   Alternate Pallet Patterns:  For a given solution, there might be 
a number of alternate ways you can configure the unitload on the 
pallet.  For each possible configuration, TOPS Pro displays a button 
on the left side of the pallet.  In the figure on the previous page, two 
buttons correspond to two possible configurations for Solution 1.  If 
there were six possible configurations, the pane would display six 
different buttons. 

If you click on a button, the pane redraws to show the selected 
configuration.  If there were a large number of buttons, the scroll bar 
would allow you to access all the available buttons. 
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Note:  Keep in mind that these buttons do not represent different 
solutions, but different configurations for a single solution. 

    Rotation Buttons:  For any solution, click on these buttons 
to rotate the 3-D graphic along the horizontal and vertical axes 
respectively. 

  Copy to Clipboard Button: Click this button to copy the 3-D 
unitload graphics to the system clipboard. Once on the clipboard, the 
graphics can be pasted onto other applications like MS Word, Excel 
or more. 

  Show CASY On/Off Button: Click this button to toggle on/off 
the CASY display on the 3-D unitload diagram. This button serves 
the same functions as the CASY button ( ) on the Windows toolbar. 

  Layer Parameters Button: Click this button to open the Layer 
Parameters dialog box where you can rotate and add different layer 
accessories to selected layers of the unitload. 

  Show Dims On/Off Button: Click this button to toggle on/off 
the dimension display on the unitload diagram.  

If the dimensions shown here are not the dimensions you'd like to see, 
try turning on or off the UL Size as Pallet Size switch on the 
Configuration dialog box.  For more information on the Configuration 
dialog box, please refer to Appendix B, Dialog Boxes. 

  Package Instruction Button: Click this button to open the 
Package Instruction dialog box to add package instruction for the 
current stage of the package sequence. 

 Scroll Bar:  The scroll bar on the right side of the pane allows you to 
display each successive solution in the list.   

For example, if you click on the down button on the scroll bar, the 
pane displays the next solution in the list.  If you click on the up 
button, the pane displays the previous solution in the list.  If you 
scroll all the way down, the pane displays the final solution in the list; 
all the way up displays the first solution. 

 RFID Button:  Click this button to select from Sort by RFID or 
RFID function.  The RFID function displays the RFID analysis screen 
which allows you to optimally place RFID tags on the face of the 
shipcase to provide maximum readability. 



 

Chapter 2:  The Basics 2-19 

The Sort by RFID function will sort the solutions in the Solution List 
Pane in the order of RFID Blockage, which is added as the last 
column in the solution list. To remove the RFID Blockage data from 
the solution, select the Sort by RFID function again. 

For more information on RFID, please refer to Chapter 16. 

 Print Button:  Allows users to print the current image or open the 
Quick Print dialog box, which allows you to define print parameters 
and print the graphic in the pane. 

Note:  For more information on the Quick Print dialog box, please 
refer to Chapter 11, Printing, or Appendix B, Dialog Boxes. 

 Strength Button:  Allows users to select either QStrength or regular 
Stacking Strength analysis for the pallet load.  For more information 
on stacking strength, please refer to Chapter 9, Stacking Strength. 

 Modify Button:  Displays the Pallet Pattern Editor, which allows you 
to add, remove and reposition shipcases on a pallet. 

 

Solution View Menu 
As you’re working with an analysis, the Solution View features a menu 
with a number of useful functions.  With the Solution View active, right-
click inside the Solution View pane and a small menu appears, as 
pictured below on the right 

The Solution View Menu provides the following options: 

 Next:  Displays the next stage of the analysis in 
Solution View. 

 Previous:  Displays the previous stage of the analysis 
in Solution View. 

 Cancel:  Closes the Analysis View and returns you to 
the Control Panel. 

 Show:  Leads to a submenu to select items to be 
displayed in the solutions: dimensions, contents, 
bitmaps, CASY style, shrinkwrapped, strapped and markers. 

 View:  Allows you to view the image in a variety of formats:  3-
dimensional, plan, front, side, as text (statistics), single stack, pop top, 
double stack, assembly and exploded. 
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 Divider 3D:  If the shipcase includes dividers, this option displays 
the image in 3-dimensional format, including the dividers. 

 Divider Plan:  If the shipcase includes dividers, this option displays 
the image in plan format, including the dividers. 

 Save Image:  Provides a number of options for saving the Solution 
view image – as a bitmap file, JPEG file, PDF file, etc. 

 Print:  Allows you to print the Solution View image. 

 Pop Corner:  For a unitload image, this option displays one corner of 
the load exposed so you can see the contents.  A pop corner view of a 
unitload is pictured below.  

 Clear Case:  For a unitload image, this option displays the shipcases 
as clear cases so you can see the contents.  A clear case view of a 
unitload is pictured below. 

     
Pop-corner            Clear Case 
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Statistics View Pane 
The Statistics View pane displays detailed statistics for a selected 
solution; this pane is linked to the Solution List pane.  For example, if 
you select Solution 1 in the Solution List, the Statistics View displays 
data for Solution 1.  If you select Solution 5 in the Solution List, the 
Statistics View displays data for Solution 5, and so on. 

In this analysis the UnitLoad View pane, pictured below, shows statistics 
for Solution 1.  The Text View pane automatically sizes the information 
displayed to the window size.  You can add and remove rows and 
columns of statistics by running the TOPS Pro Configuration program.  
For more information about changing the Statistics, please refer to 
Appendix B, Dialog Boxes, see section Configuration, Statistics Tab. 

  

Notice the following features on this pane: 

 Type of Solution:  The title bar of the pane reads "UnitLoad View 1 
of 19."   

 Solutions Counter:  The title bar of the pane shows a counter (for 
example, 1 of 19).  This tells you that this is the first of 19 solutions 
generated by the system. 

 Detailed Statistics:  The pane presents detailed statistics for the 
selected solution – most of the same information you see in the List 
pane. 

 Scroll Bar:  The scroll bar on the right side of the pane allows you to 
move up and down the display area of the pane. 
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Solution List Pane 
The Solution List pane displays a list of all solutions generated for the 
analysis.  In the figure below, the Solution List pane includes 19 
solutions for the analysis (only seven are visible).  A scroll bar allows 
you to move up and down the list.  For each solution, this pane displays 
different items of basic information, which appears in columns across the 
pane, depending on the type of analysis performed. 

The bold italics column headings (on the right side of the pane) indicate 
the solutions can be sorted based on that data.  Just click on the bold text 
to sort. 

Important Note:  In order to see all displayed columns of information in 
the Solution List pane, be sure to maximize the Analysis View.  If you 
still can't see all columns, try increasing your video resolution. 

Also, units of measurement (English or Metric) used in the Solution List 
pane are set up in Configuration. 

 

 

Depending on the analysis performed, the Solution List pane displays 
some/all of the following items of information: 

 Select: Highlight with a check mark if the solution has been selection 
for comparison. 

 Sol: Identifies the solution (Solution 1, 2, 3, etc.). 

 Case Wgt:  The gross weight of the shipcase. 

 Vol (ID):  The volume of the shipcase, based on inside dimensions. 

 Slack (Len, Wid & Hgt): The amount of unused space along the 
Length, Width and Height of the shipcase. 

 Ptrn Type: The stacking pattern used to configure the shipcase. 

 Note:  For detailed information about pallet patterns, please refer to 
Appendix D, Pallet Patterns. 
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 Cubic Eff (Shipcase):  The percentage of cubic area that is used. 
TOPS Pro calculates this value based on how much space is being 
used versus the space you're trying to fill in the shipcase.. 

 Dim Vert: The dimension – length, width or height – specified as the 
vertical dimension of the shipcase relative to the ground. 

 Unitload Width:  The width of the unitload. 

 Height:  The height of the unitload, including the pallet. 

 Unitload Weight:  The weight of the unitload, including the pallet. 

 Cases/Layer:  The number of shipcases configured in each layer of 
the unitload. 

 Layers/Unitload:  The number of layers of shipcases configured in 
the unitload. 

 Cases/Unitload:  The number of shipcases configured in the unitload. 

 Area Efficiency:  The percentage of the pallet area that is used in the 
configuration.  TOPS Pro calculates this value based on how much 
pallet area is covered by shipcases. 

 Cubic Efficiency:  The percentage of cubic area that is used in the 
configuration.  TOPS Pro calculates this value based on how much 
space is being used versus the space you are trying to fill. 

The exact statistics listed depend on the stage of design sequence you are 
looking at. 

Solution List - Tab View 
When there are multiple stages in the design sequence, the solutions at 
each stage will be displayed in tabs displayed at the top of the Solution 
List pane. 

 

Clicking each tab in the Solution List will also bring the program focus to 
the corresponding graphics pane. 
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When multiple pallets or vehicles are selected for an analysis, the 
solutions will be grouped in tabs displayed at the bottom of the Solution 
List as shown earlier. 

For multiple pallets, you have the choice of keeping all solutions in one 
big list under the UnitLoad tab or grouped them in tabs under the pallet 
type as pictured below. 

 
Solution list “Optimize for all Pallets” 

 
Solution list “Optimize for each Pallet” 
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UnitLoad Layer Parameters 
Once you've decided on a solution, you can work with the individual 
layers in the unitload.  The Layer Parameters feature allows you to apply 
a number of different stages to your unitload layers, including the 
following: 

 Rotate selected layers. 

 Use the secondary pattern set up for selected layers. 

 Add caps, pads, slipsheets and trays to selected layers. 
 

This feature allows you to select whichever layers you want – one, 
multiple, all or none – then apply a function to those selected layers.  You 
have the flexibility to define layer parameters any way you want. 

To define layer parameters, open the Layer Parameters dialog box by 
clicking on the Layer Parameter button (  ) in the Unitload View pane 
or go to the menu bar, open the Edit menu and select Layer Parameters. 
The Layer Parameters dialog box appears, as pictured below. 

The Basic tab contains check boxes and function buttons to allow you to 
easily apply different accessories to specific layers: 
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 Unitload (UL) Drawing Options:  Allow you to select individual 
layers for which you want to perform a function – rotate, insert a pad, 
remove a slipsheet, etc. 

 Function Buttons:  Allow you to perform global functions on the 
unitload layers – Rotate All, Pad All, Clear Caps, Clear Second 
Pattern, etc.  This is useful if you want to apply a function to a 
number of layers, not just one or two individual layers. 

 Options Button: Allow you specify these options: 

 Rotate:  Specify how layers will be rotated – Length flip, width 
flip, length and width flip or rotate 90 degrees. 

 Spread:  Specify how the layers will be spread – pack tightly, 
spread to edge of layer or spread to pallet edge. 

 Filler:  Specify how filler (if any) will be used with the layers – at 
middle or at end.  
 

The Advanced tab provides more “advanced” way to specify accessories. 

 

 Layer: Specify which layers the specific function or accessory will 
be applied: none, alternate, custom or basic.  

 Custom Layer Setup:  Select the layers to apply the function; enter 
1,2,5,7,9 in the Custom Desc field to rotate layers 1, 2, 5, 7 and 9.  
You can also specify to apply the function for every x layers. 
Note:  Use this custom function to specify layers beyond 28. 

 New:  You can also define new slipsheet, pad, tray or cap via this 
dialog box. Click on Pre-defined and then select an existing accessory 
or define a new one by clicking on the New button. 



 

Chapter 2:  The Basics 2-27 

TOPS Pro stores the layer parameters to memory and returns you to the 
Analysis View.  The Graphic View pane displays the unitload with your 
defined layer parameters. 

Unitload Drawing Options 
The Unitload Drawing Options portion of the dialog box is organized into 
seven columns, as follows: 

Note:  These options are adornments.  They do not change the size of the 
unitload. 

 Layer:  Displays a column of layers that correspond to a unitload 
solution.  Each layer represents a specific layer of cases in the 
unitload.  If there are more than 28 layers in the unitload, click the 
Advanced tab and use the Custom Layer Setup to specify layers 
beyond 28. 

 Rotate:  Check the box to rotate a specific layer in the unitload. 

 Pad Under:  Check the box to insert a pad under a specific layer in 
the unitload. 

 Slipsheet:  Check the box to insert a slipsheet under a specific layer 
in the unitload. 

 Tray:  Check the box to insert a tray in the unitload. 

 Cap:  Check the box to insert a cap over a specific layer in the 
unitload. 

 2nd Pat:  Check the box to use a secondary pattern for a specific 
layer in the unitload. 

Function Buttons 
The Layer Parameters dialog box includes 14 function buttons, as 
follows: 

 Rotate All Button:  Rotates all layers in the unitload.  When you 
click on this button, TOPS Pro automatically checks all the active 
boxes in the Rotate column. 

 Rotate Top 2 Button:  Rotates the top two layers in the unitload. 

 Clear Rotate Button:  Clears all the Rotate commands already set up 
for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Rotate column. 
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 Pad All Button:  Inserts pads between each layer in the unitload.  
When you click on this button, TOPS Pro automatically checks all the 
active boxes in the Pad Under column. 

 Pad Even Button:  Inserts pads under only the even-numbered layers 
in the unitload.  When you click on this button, TOPS Pro 
automatically checks all the active boxes in the Pad Under column for 
even-numbered layers. 

 Clear Pads Button:  Clears all the Pad commands already set up for 
the unitload.  When you click on this button, TOPS Pro automatically 
un-checks all the active boxes in the Pad Under column. 

 Slips for All Button:  Inserts slipsheets between each layer in the 
unitload.  When you click on this button, TOPS Pro automatically 
checks all the active boxes in the Slipsheet column. 

 Clear Slips Button:  Clears all the Slipsheet commands already set 
up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Slipsheet column. 

 Trays for All Button:  Places every layer in the unitload on a tray.  
When you click on this button, TOPS Pro automatically checks all the 
active boxes in the Tray column. 

 Clear Trays Button:  Clears all the Tray commands already set up 
for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Tray column. 

 Caps for All Button:  Places a cap on every layer in the unitload.  
When you click on this button, TOPS Pro automatically checks all the 
active boxes in the Cap column. 

 Clear Caps Button:  Clears all the Cap commands already set up for 
the unitload.  When you click on this button, TOPS Pro automatically 
un-checks all the active boxes in the Cap column. 

 2nd Pat for All Button:  Replaces all the current layers in the 
unitload with the selected secondary pattern.  When you click on this 
button, TOPS Pro automatically checks all the active boxes in the 2nd 
Pat column. 

 Clear 2nd Pat Button:  Clears all the Tray commands already set up 
for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Tray column. 
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Filler 
Filler serves primarily to fill empty space between layers, which prevents 
load shifting.  The Filler function allows you to specify how filler will be 
used, as follows: 

 None:  No filler is inserted between layers. 

 Middle Filler:  Inserts filler in the middle of the layers. 

 End Filler:  Inserts filler at the ends of the layers. 

Spread 
The Spread function allows you to specify how the layers will be spread 
on the pallet, as follows. 

 Pack Tightly:  Shipcases in each layer are packed tightly toward the 
center, with minimum spread in between. 

 Spread to Layer Edge:  Shipcases in each layer are spread to the 
edge of the unitload.  This option "squares up" the unitload. 

 Spread to Pallet Edge:  Shipcases in each layer are spread to the 
edge of the pallet. 

Rotate 
The Rotate function allows you to specify how the layers will be rotated, 
as follows: 

 Length Flip:  Flips the layer pattern along its length. 

 Width Flip:  Flips the layer pattern along its width. 

 Length and Width Flip:  Rotates the layer along both its length and 
width. 

 Rotate 90 Degrees:  Rotates the layer 90 degrees. 
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Print the Analysis 
TOPS Pro provides a lot of flexibility in the way you design and print 
analysis output.  After you've decided on a solution, you're ready to print 
a hard copy that shows the information that went into the analysis. 

You'll design the layout of the printout, then decide what type of 
information will be included and how that information will be presented 
(different graphical views, text and numbers, etc.). 

In this example, we'll design the output to have the following 
characteristics: 

 The output will have a 3-Way Top page layout. 

 The heading will read "Shipcase-to-Pallet Analysis." 

 The three areas of the printout will show the UnitLoad 3D View, the 
UnitLoad Plan View and the UnitLoad Statistics. 

 The bottom of the printout will show sample text. 

Define Print Parameters 
To print the output from an analysis, start from the Control Panel and 
follow these instructions: 

1. Go to the Menu Bar and open the File menu. 

2. Select Print Preview, then select Analysis. 

Notice that the Print Parameters dialog box is organized into the 
following sections: 

 Page Layout:  Allows you to select one of eleven possible page 
layouts: 

 The Full Page layout allows you to select only one area of the 
analysis to print. 

 The Horizontal Split and Vertical Split layouts allow you to 
select two areas of the analysis to print. 

 The 3 Way Bottom, 3 Way Top, 3 Way Left and 3 Way Right 
layouts allow you to select three areas of the analysis to print. 

 The Quad Split layout allows you to select four areas of the 
analysis to print. 

 The 5 Way and 5 Way Down layout allows you to select five 
areas of the analysis to print. 
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 The 6 Way Fixed, 6 Way Scaled and 6 Way Down layouts has 
all six areas of the analysis to print. 

 Heading:  Allows you to enter the text of the heading that will appear 
at the top of the printout. 

 Areas 1 through 6:  Allow you to select the area(s) of the analysis 
from which you want to print information. 

Note:  Be aware that the number of areas available to select from 
depends on the page layout you selected.  For example, if you 
selected the Horizontal Split layout, which contains two sections, 
you'll be able to select from only two areas. 

 Notes:  Allows you to enter the text of any notes that will appear at 
the bottom of the printout. 

Tip:  To force the text to wrap to the next line, type a left apostrophe 
(`) at the end of the line of text.  In a normal word processor 
application, you'd use the Enter or Return key to do this. 

 Show Additional Notes:   Allows you to enter information about 
such as Label Format, Test Weight and Package Quantity. 

 Printer:  Allows you to select either Black and White (B+W) or 
Color printing. 

 Double Stack Unitload:  Allows you to print output as a double-
stacked unitload. 

 Print Analysis Name:  Allows you to print the analysis name on the 
printout. 

 Show Graphics/C.A.S.Y.:  Allows you to show graphics or CASY 
design in the printout. 

Note:  If the analysis includes both graphics and a CASY design, the 
system will display the CASY design, not both. 
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 Font: Here you can select the font on the preview screen. The text 
can be displayed in the following 3 sizes. 

 Regular:   Helvetica  10 pt 
 Small:   Helvetica    8 pt  
 Very Small:  Helvetica    6 pt 

 
 Package Instruction: For any package instruction (e.g. corner post, 

plastic wrap) entered under the Edit > Package Instruction function, 
you can specify where in the report these instructions will appear.  

 With 3D graphic – at the top right hand corner of the 3D 
unitload graphic. 

 Below Layout – in a new packaging section after the graphics 
and statistics. 

 
3. Enter and select the print parameters for the analysis as illustrated 

below.  Use the Tab key to move from field to field.   
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4. After completing the print parameters, click on OK.  The Print 

Preview panel appears, as pictured below. 

  

Notice the following things about the Print Preview panel: 
 

 The heading reads "Shipcase-to-Pallet Analysis" and includes today's 
date.  The heading also includes a title, if you specified a title for the 
analysis. 

 Area 1 displays a graphic of the UnitLoad 3D View. 

 Area 2 displays a graphic of the UnitLoad Plan View. 

 Area 3 displays the UnitLoad Statistics. 

 At the bottom of the printout, the Notes section will display any text 
you have entered. 

 The Close button will close the preview and return you to the 
solution screen. 

 The Zoom button allows you to magnify the panel and get a closer, 
more detailed look at the output. 

 The Print button sends the output to the printer. 
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 The Email button allows you to email this report as a JPG 
attachment to another user. 

 The PDF button allows you to export the current report to a PDF file 
in a specified location on your computer. 

 The Add/Edit text button allows you to add text and line/arrows 
anywhere on the printout. 

5. To print the output, click on the Print button. 

Add Text, Lines or Images to Printed Output 
After you've designed and generated your analysis output, the system 
allows you to add text or graphic images to the output before you print it.  
This is a very easy process that allows you to customize and enhance the 
output's presentation. 

To add text and images to the output, start from the Print Preview panel 
and follow these instructions: 

1. Click on the Add/Edit Text button.  TOPS Pro magnifies the Print 
Preview panel. 

2. Click on the area of the output where you want to enter text.  TOPS 
Pro displays a four-cornered entry field ( ) with the cursor 
positioned inside the field.  Notice that you can "drag" the entry field 
to any position on the screen by placing the mouse cursor near the 
field and the mouse cursor changes to a ( ). 

3. Enter the text that you want to appear in the selected area. 

In this exercise, enter "UnitLoad 3D View" in Area 1 (top left) and 
"UnitLoad Plan View" in Area 2 (top right).  

4. To add lines or arrows to the printout, right click the mouse button 
and highlight Line at the pop-up menu.  Select "--------". 

When the pop-up menu closes, place the mouse at any location, click 
the left mouse button and drag the mouse to create a line on the 
screen.  Move the line to under the text "UnitLoad 3D View".  Repeat 
the same procedure to add a line under text "UnitLoad Plan View".  
The result will be similar to the screen below. 
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5. To add an image to the printout, go to the Menu Bar and open the 
Edit Menu. Select Paste Pict From File and then a file from the Select 
File dialog box as pictured below. 
 

 
 

6. Select any sample graphics and click on Open to use.  You can also 
browse to any location to use any graphics.  The Print Preview panel 
redisplays with the selected bitmap file inserted into the output. 

7. Drag the image to the area where you want it to appear and size it as 
desired by dragging any one of the four corner boxes ( ) around the 
graphics. 
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8. After completing the text and graphics, click on the Print button.   
TOPS Pro sends the analysis output to the printer. 

9. Click on the Close button.  TOPS Pro asks if you want to save your 
changes. 

10. Click on Yes.  TOPS Pro prompts you to enter a filename to be saved. 

11. Enter the name of this file and click on OK. 

12. TOPS Pro returns you to the Control Panel. 
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Change the Company Logo in Printed Output 
The company logo used in printed outputs within TOPS is referenced in 
the TOPSPRO.INI file saved in the ...\TOPSAPPS\TOPSPRO\ folder.  
When opened with a text editor like Windows Notepad, you will see 
something similar to the screen below. 

 

To use your company’s logo, you can either: 

1. Rename your company logo (if in BMP format) to tops.BMP as 
referenced above and make sure it is saved in the same 
...\TOPSAPPS\TOPSPRO\BMP\ folder.  This option does not require 
any change to the TOPSPRO.INI file. 

2. Change the logo path to point to the folder where your company logo 
resides.  For example, you can change the highlighted entry in the 
screen above to: 
            LogoPath=C:\Images\ComLogo.bmp 
if your company logo is saved in the referenced folder. 

 

Change the Printer Pen Width 
The printer pen width refers to the thickness of the lines in a graphic or 
text when you print an analysis.  The default for printer pen width is zero, 
which is a hairline width. 

To change the printer pen width, follow these instructions: 

1. From the menu bar, open the Tools menu. 

2. Select Configuration and click on the Reports tab when the 
Configuration dialog box appears. 
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3. In the Printer Pen Width field, enter a value to specify the line 
thickness with which you want to print. If you're satisfied with the 
printer, click on OK. 

TOPS Pro saves the updated configuration to the database and returns 
you to the previous screen. 

Note:  Printer pen width has no effect when CASY graphics are turned 
on. 

 

Copy TOPS Graphics to Other 
Programs 
For TOPS Pro users, it is common practice to copy graphic images from 
the system into other applications.  This section addresses the following 
routines and features: 

 Copy a single graphic 
 Copy the entire Print Preview 
 Copy a graphic to Microsoft Word 
 Copy a graphic to Microsoft Power Point 
 Paste Special 

 

Copy a Single Graphic 
To copy a single graphic to the clipboard, follow these instructions: 

1. Click on a graphic to select it.  The title bar of the selected window 
should be highlighted. 

Note:  You may want to resize the window to the size of the desired 
image before copying.  For better printing, make the image twice as 
large. 

2. Go to the menu bar and open the Edit menu. To copy the graphic in 
color, select Copy to Clipboard Color. To copy the graphic in black 
and white, select Copy to Clipboard B+W.  You can also use the right 
click menu and select Save Image, then select Clipboard or just click 

the copy to Clipboard button .  

TOPS Pro copies the selected graphic to the clipboard, from which it can 
be pasted into any other Windows program. 
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Copy the Entire Print Preview 
To copy the Print Preview to the clipboard, start from Print Preview 
mode and follow these instructions: 

1. Click on the Zoom button and TOPS Pro redisplays the Print Preview 
in zoom mode. 

Note:  If you don't zoom in, you'll capture an exact image of the 
zoom-out state, including the wide margins. 

2. Go to the menu bar and open the Edit menu. 

3. To copy the Print Preview in color, select Copy to Clipboard Color. 
To copy the Print Preview in black and white, select Copy to 
Clipboard B+W. 

TOPS Pro copies the Print Preview to the clipboard. 

Copy a Graphic to Microsoft Word 
To copy a graphic to Microsoft Word, follow these instructions: 

1. Copy a graphic to the clipboard as described in earlier sections. 

2. Open the Microsoft Word application. 

3. Paste the graphic in the Word document. 

4. Depending on the version of Word you are using, you can go to the 
menu bar and open the Format menu or double click on the graphic to 
access the Format menu. 

Note:  For detailed information about defining Picture parameters, 
please refer to your Microsoft Word documentation. 

Copy a Graphic to Microsoft Power Point 
To copy a graphic to Microsoft Power Point, follow these instructions: 

1. Copy a graphic to the clipboard. 

2. Open the Microsoft Power Point application. 

3. Paste the graphic in the Power Point presentation. 

4. Use the Power Point edit function to edit the graphic in the Power 
Point presentation. 
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Note:  For detailed information about the Power Point edit function, 
please refer to your Microsoft Power Point documentation. 

 

Paste Special 
Paste Special is a Microsoft Word feature that allows you to define the 
format for a graphic pasted into a Word document.  The formats available 
depend on the version of Word you have.  The Paste Special dialog box 
below gives you four format options including Picture (Windows or 
Enhanced Metafile), Bitmap and Device Independent Bitmap. 

To use the Paste Special feature, follow these instructions: 

1. Copy a graphic to the clipboard as described in previous sections. 

2. Open the Microsoft Word application. 

3. Go to the Word menu bar and open the Edit menu. 

4. Select Paste Special to open the Paste Special dialog box, as pictured 
below. 

 

In Word 2007, access the Paste Special function under the Home tab. 
Click on Paste and then select Paste Special… 
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5. Select the format for your graphic. 

 The Picture format looks best when you're not resizing an image 
with lots of text.  This format presents the image in the smallest 
file size and provides the most control for editing. 

 The Bitmap and Device Independent Bitmap formats present 
the image in the largest file size, but provides more accurate text 
and numbers when resizing an image smaller than the original. 

 The Picture (Enhanced Metafile) format will paste the graphics 
as a vector or line art file which enables you to resize to any 
dimension without losing quality. 
This is recommended for single graphics only and not for Print 
Preview reports. 

Note:  For detailed information about the Paste Special feature, 
please refer to your Microsoft Word documentation. 
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Save the Analysis 
After you've completed the analysis and are satisfied that all parameters 
are as you want them, you're ready to save the analysis to the database. 

Important Note:  Be aware that this save function works differently 
from the normal save function in the Windows environment.  TOPS Pro 
does not save an analysis as a file on your hard drive.  Rather, it saves the 
analysis as a record to the database – an important difference to 
remember when you need to open or search for an analysis. 

To save the analysis, follow these instructions: 

1. Click on the Save icon which opens the Analysis Save As dialog box 
appears, as pictured below. 

 

2. Enter the title for the analysis at the top field of the dialog box. 

Note:  You can use any characters up to a maximum length of 31 
characters.  If you enter a name of an unapproved analysis that has 
already been used, TOPS Pro will prompt you to overwrite the 
duplicate name. 

If the duplicate analysis is being used at the time, the system will 
reject the name and prompt you to enter another one.  There may be 
approved and unapproved (working) analyses with the same names. 

3. The analysis will be saved in the specified title in the Main Folder as 
highlighted above. 
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The other functions of the Analysis Save As dialog box are described 
below: 

 The Sort function will sort the analyses by Name, User or Date. 
Users will select the sort option in the drop down list box. 
 
Note: Analyses created with earlier versions of TOPS Pro will not 
have the user and date information. 

 The Folders section provides a tree view of all existing folders.  You 
can save the analysis into any of these folders; Main Folder is the 
default.  The area to the right of the Folders section displays a list of 
analyses that have been saved to a selected folder. 

 The Show option allows you to filter the analyses to be displayed 
based on their approval status, Approved, Working or All. Click the 
corresponding button to select the list. 

 The New Folder button allows you to create a new folder and add it 
to the current database.  
To create a new folder, click on the New Folder button. 

For more information about the Analysis Save As dialog box, please refer 
to Appendix B, Dialog Boxes. 

 

Direct Email From TOPS Pro 
TOPS Pro has an internal email feature that allows you to email an 
analysis and a Stacking Strength Board Combo List to another person 
who may or may not have TOPS Pro. 

Email Analyses as Graphics Reports 
This email function will attach a print preview report of the selected 
analysis as a JPEG graphics to your email client. This is the best way to 
share reports with everyone including those who do not own a copy of 
TOPS Pro.   

To email a print preview report: 

 Go to the File menu and select the Open option.  At the Open 
Analysis dialog box, highlight the analysis report to be emailed and 
click on the Email button. 
Note: You can select multiple analyses by clicking the analysis name 
while holding down the [Shift] key on the keyboard. 
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 With the analysis open, go to the File menu and select Print Preview.  
Select Analysis and select print parameters as described in earlier 
sections.  When preview opens, click on the Email button. 
 

Email Analyses as Text Files 
Analyses in text format can only be imported and viewed by another 
TOPS Pro user.  To email an opened analysis as text:  

 Go to the File menu and select the Email Analysis option 
 Go to Help menu and select the Email Problem Definition option  

 
The TXT file will be attached to a new message of your email client.  
TOPS users receiving these TXT files can open the analysis using the 
import function under the Import menu, Import TOPS Data option. 

Email Stacking Strength Results 
To email the Stacking Strength Board Combo List, start from the 
Stacking Strength Results Screen, go to the Tools menu and select the 
Email Stacking Strength option.  The result will be attached as an .HTM 
file to a new message of your email program.  Enter the recipient and 
email the message just like a regular email. 

 

Direct Export to PDF 
TOPS Pro has a built-in PDF writer which allows you to create PDF 
reports directly without the use of Acrobat or other third party PDF 
programs.  Once you have created the analysis as described above, use 
one of these methods to create the PDF file: 

 Go to the Export men and select the PDF option 
 If you are in the Print Preview screen, go to the Export menu and 

select PDF option 
 
The Get Export File Name dialog will appear, select the folder where the 
PDF file will be saved, enter the filename or use the default tops.pdf 
filename then click on Save to create the file. 
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Chapter 3: Advanced Features 

Introduction 
This chapter walks you through some of the more advanced, complex 
analyses that you'll use in your day-to-day packaging routines.  The first 
four analyses take the form of four exercises, as outlined below: 

 Exercise #1:  Fixed Carton-New Shipcase-Pallet 

In this scenario, you have a fixed-size carton (6x2x4) that you use to 
package brown sugar.  Your objective is to design a shipcase that 
allows you to put the maximum number of cartons onto a pallet. 

 Exercise #2:  New Carton-New Shipcase-Pallet 

In this scenario, you've decided you can improve on the solution that 
resulted from Exercise #1.  If you revise the dimensions of the carton – 
change length, width and height 1/4 inch in either direction – TOPS 
Pro will have some flexibility to generate a broader range of solutions.  
Again, your objective is to design a shipcase that allows you to put the 
maximum number of cartons onto a pallet. 

 Exercise #3:  Shipcase Consolidation 

In this scenario, you want to find an existing shipcase that will allow 
you to load the most cartons of brown sugar on a pallet.  Instead of 
designing a new shipcase, you'll search the TOPS Pro database to find 
the shipcase that best meets your needs.  Again, your objective is to 
design a shipcase that allows you to put the maximum number of 
cartons onto a pallet. 

 Exercise #4:  Knockdown Analysis:  A situation where a box has 
been collapsed flat.  In a knockdown analysis, you'll usually take a 
bundle of collapsed boxes and load them onto a pallet. 
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This chapter also introduces the following TOPS Pro features: 

 Paste-On Graphics:  Allows you to dress up your cartons, shipcases, 
trays and other box-like containers with graphics, such as a corporate 
logo. 

 Export:  Allows you to select a graphic, product report, case, carton, 
analysis or pallet pattern, then export it to another applications outside 
the TOPS Pro system. 

You can also use the Export function to send pallet pattern information 
to a robotic palletizer. 

 Artios Integration:  Allows you to automatically import Length, 
Width, Height and Box Style information from the Artios CAD 
software into TOPS Pro and drop it into a template. 

 Quick Print Template System:  Allows you to print multiple pages 
of information in a single batch.  This feature also allows you to 
design reusable report styles for standardized specifications. 

 Combined Report:  Combines information from two analyses or two 
solutions of the same analysis onto one printout.  This feature is 
especially useful to include both the knocked-down and erected 
palletizations of a shipcase in a single report. 

 Control of Displayed Statistics:  Allows you to add or remove 
selected statistics from your printouts.  In essence, this feature allows 
you to turn on and off any column of information the software can 
display in a statistics pane. 

 Shipcase Database Option:  Tells TOPS Pro to consider all shipcases 
in the database when it calculates solutions.  The Multiple option 
allows you to select the shipcases to be used when TOPS Pro 
calculates solutions. 
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Exercise #1:  Fixed Carton-New Shipcase-
Pallet Analysis 

In this scenario, you're packaging cartons of brown sugar into shipcases 
and onto a pallet.  Your brown sugar carton is a fixed-size carton.  The 
shipcases in your inventory don't very well meet your needs for this 
particular carton; there's too much wasted space and you don't load as 
many cartons onto the pallet as you'd like.   

You need a new shipcase that packs the cartons more efficiently.  Your 
objective is to design a new shipcase that packs as many brown sugar 
cartons as possible onto a pallet.  You know the following facts going into 
the analysis: 

 The carton is a fixed size with inside dimension of 6 inches long, 2 
inches wide and 4 inches high. 

 Your marketing people like a shipcase to have a quantity of 10, 12 or 
24 cartons. 

 Your shipping people use standard pallets and like to load pallets in a 
1-block or 2-block pattern arrangement. 

In this analysis, you'll work through these primary steps: 

 On the Carton Parameters dialog box, you'll set up the fixed brown 
sugar carton. 

 On the Shipcase Parameters dialog box, you'll set up the parameters 
TOPS Pro needs to design your new shipcase. 

 On the UnitLoad Options dialog box, you'll set up the analysis to 
consider only 1-block and 2-block pallet patterns. 
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Start from the Control Panel and follow these instructions: 

1. Set up a Carton-Shipper-Pallet packaging sequence. (Use the green 
carton icon.) 
 

 

2. Click on the green Carton icon.  The Carton Parameters dialog box 
will appear.  Enter the dimension of the dimension of the carton as 
pictured below. 
 

 

3. Click on OK.  TOPS Pro stores your carton parameters to memory and 
returns you to the Control Panel. 

4. Click on the Shipper icon.  The Shipcase Parameters dialog box 
appears. Set the following parameters as illustrated in the dialog box. 

 Case:  Select New.  You want TOPS Pro to design a new, 
optimum shipcase and note that the dimensions are grayed out. 

 Dimensions:  Select Inside.  You want TOPS Pro set up the 
shipcase using the inside dimensions. 

 Round to nearest 1/16":  Check the box to tell TOPS Pro to 
round its calculations to the nearest 1/16".  This measure is the 
industry standard for packaging construction. 

 Sizing:  Enter 10, 12 and 24 in the first three fields.  This tells 
TOPS Pro to design shipcases that contain only 10, 12 or 24 of the 
fixed-size cartons. 
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5. Click on OK.  TOPS Pro stores your shipcase parameters to memory 
and returns you to the Control Panel. 

6. Click on the Pallet icon, the UnitLoad Parameters dialog box appears. 
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7. Click on the Options button.  The UnitLoad Options dialog box 
appears, as pictured below. 
 

 

8. Because the shipping people like to load pallets in the 1-block and 2-
block arrangements, select only 1-block and 2-block, and make sure 
any other Pattern Styles are not selected or checked. 

9. Click on OK.  TOPS Pro stores your selected pattern styles to memory 
and returns you to the UnitLoad Parameters dialog box. 

10. Because your company uses a standard GMA Notched pallet, you 
don't need to change any parameters on the UnitLoad Parameters 
dialog box.  Click on OK. 

TOPS Pro stores the default unitload parameters to memory and 
returns you to the Control Panel. 

11. With all parameters defined, click on the Calc button.  TOPS Pro 
calculates solutions for the given parameters and displays the Analysis 
View, as pictured here. 
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As you can see, TOPS Pro has generated 50 solutions – 50 different 
shipcases designed to hold either 10, 12 or 24 cartons.  In the Solution 
List pane at the bottom, if you look at the Cart/UL (cartons per 
unitload) column, you'll see that the best solutions are listed first.  
 
At this point, you can look at the various solutions and see how the 
unitload is arranged for each solution.  In this exercise, we'll go with 
the sixth solution, which packs 10 cartons into a shipcase. 
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12. Click on the sixth solution in the list to select it.  The Analysis View 
redisplays with graphics for the selected solution. 

• Click on the Next button ( ) on the toolbar.  The Analysis View 
redisplays with statistics for the selected solution, as pictured below. 
 

 
 
Notice that the solutions are listed with the most Cartons/UL on top, 
totaling 1,600 cartons onto a unitload.   

13. Click on the Next button ( ) on the toolbar.  TOPS Pro returns you 
to the Control Panel. 

14. Print and save your work. 
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Exercise #2:  New Carton-New 
Shipcase-Pallet 
In the previous exercise, you were working with a fixed-size carton and 
designed a new shipcase to pack as many cartons as possible onto a pallet, 
given a preferred pallet pattern.  In this exercise, we believe we can fit 
more cartons onto a pallet if we revise the size of the carton.  We'll enter a 
range of dimensions for the carton, which allows TOPS Pro to generate a 
broader range of solutions.  We know the following facts going into the 
analysis: 

 We'll design a new carton and tell TOPS Pro to account for a 1/4-inch 
range in each direction for each dimension.  For example, the fixed 
carton had a length of 6 inches.  In this exercise, we'll tell TOPS Pro to 
calculate a minimum length of 5.75 inches and a maximum length of 
6.25 inches and a similar range for width and height.  Also, you know 
that the volume of the carton, regardless of the specific dimensions, is 
48 cubic inches. 

 You've persuaded your marketing people that the optimal shipcase 
holds a quantity of 10 cartons. 

 Your shipping people use standard pallets and like to load pallets in a 
1-block or 2-block pattern arrangement. 

In this analysis, you'll work through these primary steps: 

 On the Carton Parameters dialog box, you'll set up the new carton. 

 On the Shipcase Parameters dialog box, you'll set up the parameters 
TOPS Pro needs to design your new shipcase to hold 10 cartons. 

 On the UnitLoad Options dialog box, you'll set up the analysis to 
consider only 1-block and 2-block pallet patterns. 
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Start from the Control Panel and follow these instructions: 

1. Set up a Carton-Shipper-Pallet packaging sequence.  (Use the green 
Carton icon.)  If the packaging sequence from the previous exercise is 
still there, you can use it. 
 

 

2. Click on the Carton icon.  The Carton Parameters dialog box appears.  
Enter the following parameters as illustrated: a dimension range for 
each of length, width and height at 0.25 inch increments and a fixed 
volume of 48 cubic inches. 
 

 

3. Click on OK.  TOPS Pro stores your carton parameters to memory and 
returns you to the Control Panel. 

4. Click on the Shipper icon.  At the Shipcase Parameters dialog box, 
select New Case, Inside Dimension and enter 10 as the only Value 
under Sizing as in the following illustration. 
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5. Click on OK.  TOPS Pro stores your shipcase parameters to memory 
and returns you to the Control Panel. 

6. Click on the Pallet icon.  The UnitLoad Parameters dialog box 
appears.   

7. As in the previous exercise, click on the Options button and select 
only 1-block and 2-block arrangements. 

8. Click on OK.  TOPS Pro stores your selected pattern styles to memory 
and returns you to the UnitLoad Parameters dialog box. 

9. Because your company uses a standard GMA Notched pallet, you 
don't need to change any parameters on the UnitLoad Parameters 
dialog box.  Click on OK. 
 
TOPS Pro stores the default unitload parameters to memory and 
returns you to the Control Panel. 

10. Click on the Calc button. TOPS Pro calculates solutions for the given 
parameters and displays the Analysis View, as pictured on the next 
page. 
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As you can see, this screen shows a list of carton solutions and their 
corresponding carton arrangements.  At this point, you can look at the 
different carton arrangements and decide on one if you like.  However, 
we'll select all the arrangements to give TOPS Pro more options to 
work with as the system generates solutions. 

11. Click on the Select All button.  TOPS Pro automatically checks all the 
carton arrangements as selected as indicated by the check marks added 
under the Select column. 

12. Click on OK.  The Analysis View redisplays, as pictured below. 
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As you can see, TOPS Pro has generated 20 solutions – 20 different 
shipcases designed to hold 10 cartons, with the first four unitload 
solutions carrying more than 1,600 cartons already.   
In the List Pane at the bottom, if you look at the Cart/UL (cartons per 
unitload) column, you'll see that the best solutions are listed first. 
 
At this point, you can look at the various solutions and see how the 
cartons and unitload are arranged for each solution.  In this exercise, 
we'll go with the first solution.  This solution allows you to load 1,680 
cartons per pallet, and the carton arrangement and pallet pattern are 
well-designed. 
 
Remember that in the previous exercise, the analysis with the fixed 
carton gave us a maximum of 1,600 cartons per unitload.  With this 
solution, by revising the dimensions of the carton, we can add another 
80 cartons onto the pallet.  This calls for changing the outside 
dimension of the fixed carton to 6.29 inch x 2.04 inch x 3.93 inch 
while keeping the same volume of 48 cubic inches. 

13. Click on the Next button ( ) on the toolbar.  The Analysis View 
redisplays with the statistics. 
 

 

At this point, you can look at the different solutions and see if there's a 
unitload arrangement that you like more than the others. 

14. Select the solution you want to use for your new carton and shipcase. 
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15. Click on the Next button.  TOPS Pro saves the solution parameters to 
memory and returns you to the Control Panel. 

16. Print and save your work. 
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Exercise #3:  Shipcase Consolidation 
Analysis (Database Function) 
In this scenario, you need a shipcase to load your cartons of brown sugar, 
but you don't want to have to design a new shipcase.  Time and cost issues 
make it necessary to go with a shipcase that's already set up in the 
database.  Now your objective is to search the TOPS Pro database for an 
existing shipcase that will load the most cartons of brown sugar on a 
pallet. 

You know the following facts going into the analysis: 

 The carton is a fixed size – 6 inches long, 2 inches wide and 4 inches 
high. 

 The quantity of cartons that will go into the shipcase is not an issue 
here. 

 Your shipping people use standard pallets and like to load pallets in a 
1-block or 2-block pattern arrangement. 

In this analysis, you'll work through these primary steps: 

 On the Carton Parameters dialog box, you'll set up the fixed brown 
sugar carton. 

 On the Shipcase Parameters dialog box, you'll set up the parameters 
TOPS Pro needs to search the database for the right shipcase. 

 On the UnitLoad Options dialog box, you'll set up the analysis to 
consider only 1-block and 2-block pallet patterns. 
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Start from the Control Panel and follow these instructions: 

1. Set up a Carton-Shipper-Pallet packaging sequence.  (Use the green 
Carton icon.) 
 

 

2. Click on the Carton icon.  The Carton Parameters dialog box appears.  
Enter the fixed dimension of 6x2x4 inches for the carton as pictured 
below. 
 

 

3. Click on OK.  TOPS Pro stores your carton parameters to memory and 
returns you to the Control Panel. 

4. Click on the Shipper icon.  The Shipcase Parameters dialog box 
appears.  Use these guidelines to enter shipcase parameters as 
illustrated on the following page. 

 Case:  Select Database.  You want TOPS Pro to search the 
database for the optimum shipcase.   
 
TOPS Pro comes with some sample shipcases.  To add your own, 
go to the Define menu and select Shipping Case.  Refer to 
Appendix B for more details. 

 DataBase:  Select All.  You want TOPS Pro to go through all 
shipping cases in the database.  

 Dimensions:  Select Inside.  You want TOPS Pro set up the 
shipcase using the inside dimensions. 
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Note:  In this exercise, you want TOPS Pro to search the complete 
range of shipcases in the database.  Therefore, instead of entering 
specific sizing values, you'll enter a range.  Because you want TOPS 
Pro to look at every shipcase in the database, we'll make the range a 
big one (1-1000). 

 Sizing:  Select Range and enter Min Count of 1 and Max Count of 
1000. 

 
 

5. Click on OK.  TOPS Pro stores your shipcase parameters to memory 
and returns you to the Control Panel. 

6. Click on the Pallet icon.  The UnitLoad Parameters dialog box 
appears.  Click on the Options button to select only 1-Block and 2-
Block pattern styles. 

7. Click on OK.  TOPS Pro stores your selected pattern styles to memory 
and returns you to the UnitLoad Parameters dialog box. 

8. Because your company uses a standard GMA Notched pallet, you 
don't need to change any parameters on the UnitLoad Parameters 
dialog box. Click on OK and TOPS Pro stores the default unitload 
parameters to memory and returns you to the Control Panel. 
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9. Click on the Calc button.  TOPS Pro calculates solutions for the given 
parameters and displays the Analysis View, as pictured here. 
 

 

 
As you can see, TOPS Pro has generated 50 solutions – 50 different 
shipcase and arrangement that can accommodate your brown sugar 
cartons.  In the List Pane at the bottom, if you look at the Cart/UL 
(cartons per unitload) column, you'll see that the best solutions are 
listed first.   

10. At this point, you can work through the Analysis Views and look at 
the various criteria that go into your decision-making:  carton 
arrangement, pallet pattern, underhang, overhang or cubic efficiency. 

11. When you've decided on a solution, click on the Next button ( ) on 
the toolbar to view the statistics for the unitload.   

12. Click on the Next button again, TOPS Pro stores the solution 
parameters to memory and returns you to the Control Panel. 

13. Print and save your work. 
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Exercise #4:  Knockdown Analysis 
One frequently used analysis is the knockdown (KD) analysis, which 
refers to a situation where a box has been collapsed flat.  In a knockdown 
analysis, you'll usually take a bundle of collapsed boxes and load them 
onto a pallet.  The dimensions of the box have obviously changed. 

TOPS Pro allows you to account for the knockdown by entering the 
dimensions of a box after it has been collapsed flat. You can also enter 
dimension of the erected box and TOPS Pro will calculate the dimension 
of the knockdown box for calculation.  TOPS Pro allows you to find the 
optimal solution for loading bundles of collapsed boxes onto a pallet after 
one or more boxes have been collapsed. 

Note:  The Knockdown button, located on the Carton Parameters dialog 
box, will automatically calculate these dimensions for you.  

Objective:  Find the optimal solution for loading bundles of collapsed 
boxes onto a pallet after one or more boxes have been collapsed. 

In this analysis, the various stages have these general characteristics: 

 Each carton (box) measures 6 inches long, 2 inches wide and 4 inches 
high.  

 Each bundle is configured as a shipcase that contains 20, 25 or 30 
collapsed boxes. 
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To perform this analysis, start from the Control Panel and follow these 
instructions:  

1. Set up a Carton-Shipper-Pallet packaging sequence.  (Use the green 
Carton icon.)  
 

 
2. Click on the Carton icon.  The Carton Parameters dialog box appears. 

Select KnockDown under Carton and enter the dimension and caliper 
of the erected carton (6x2x4) as pictured below.  Use the Tab key to 
move from field to field. 
 

  
3. Place a check mark “ ” under for Width under Vert column, this 

allows the knock down flats to lay flat inside the shipper. 

4. Click the KnockDown button to enter your Knockdown Options.  For 
this example, leave the settings as is and click OK. 
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5. Upon returning to the Carton Parameters dialog box, the KnockDown 
column next to the Carton dimension will be populated with the knock 
down dimension of the carton. 
 

 
6. Click on OK to store your carton parameters to memory and redisplays 

the Control Panel. 

7. Click on the Shipper icon to open the Shipcase Parameters dialog box.  
Specify the parameters described below as illustrated in the dialog 
box. 
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 Case:  Use the default (New). 
 Style:  Select Bundle (Invisible). 
 Dimensions:  Use the default (Outside). 
 Vert:  Use the default (Height), this governs the orientation of the 

shipcase when loaded onto the pallet. 
 Sizing:  Select Values. 
 Values:  Enter 20, 25 and 30. 

8. Click on the Options button to specify the sizing for the shipcase 
(represented in this example as a bundle of collapsed boxes).  The 
Shipcase Options dialog box appears, as pictured next. 

 
9. Use the following fields to define the sizing of the shipcase.  This 

instructs TOPS Pro to stack the KD boxes as single bundle only but 
can be as many as 100 boxes high (depth). 

 Max Cartons along Length/Cartons:  Enter 1. 
 Max Cartons along Width/Cartons:  Enter 1. 
 Max Cartons along Height/Cartons:  Enter 100. 

10. After completing the sizing parameters, click on OK.  TOPS Pro stores 
your sizing parameters to memory and redisplays the Shipcase 
Parameters dialog box. 

11. After completing the shipcase parameters, click on OK.  TOPS Pro 
stores your shipcase parameters to memory and redisplays the Control 
Panel. 

12. Click on the Pallet icon.  The UnitLoad Parameters dialog box 
appears. We don’t want any overhang so change those values to 0. 
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 Maximum Overhang Length:  Enter 0 
 Maximum Overhang Width:  Enter 0. 

 
 

13. At this point, let's say you want all the knockdowns oriented the same 
way on the pallet – a one-block pattern.  (In a two-block pattern, the 
knockdowns are oriented in two ways, and so on.)  Because you want 
to see only a one-block solution, you need to tell TOPS Pro to 
eliminate all other possibilities. 

14. Click on the Options button.  The UnitLoad Options dialog box 
appears, as pictured on the next page. 
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Notice a couple of things about the UnitLoad Options dialog box: 

 The Pattern Styles section provides a list of all types of patterns 
you might want to see.  To select a pattern style, you click on the 
box next to that style, and an " " marks that style as selected.  To 
de-select a pattern style, click on the box again, and the box is 
cleared. 

 When you select a pattern style, the g.o.d. window in the bottom, 
right corner of the screen displays a visual of what the selected 
pattern style looks like. 

15. You want to see only a one-block pattern, so select 1 Block.  If you see 
any options marked with a " " as selected, and be sure to de-select 
those options. 

16. Click on OK.  TOPS Pro stores your unitload options to memory and 
redisplays the UnitLoad Parameters dialog box. 

17. After completing the unitload parameters, click on OK.  TOPS Pro 
stores your unitload parameters to memory and redisplays the Control 
Panel. 

18. Click on the Calc button. TOPS Pro uses the defined parameters – 
carton, shipcase and unitload – and generates all possible solutions for 
the analysis. TOPS Pro displays the Analysis View with three different 
panes, as picture here. 
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Let's look at these three panes one at a time: 

 Shipcase Solution View:  This pane, in the top, left portion of the 
screen, displays a graphic of what a selected shipcase solution 
looks like – i.e., how the collapsed boxes are bundled.  If you 
select another solution from the Shipcase Solution List, this 
graphic will change accordingly. 

 UnitLoad Solution View:  This pane, in the top, right portion of 
the screen, displays a graphic of the unitload that corresponds to 
the selected shipcase solution.  It shows how the bundles are 
configured on the pallet.  The UnitLoad Solution View is driven by 
the selected shipcase solution and changes in conjunction with the 
Shipcase Solution View. 

For example, if you select Solution 2 from the Shipcase Solution 
List, the Shipcase Solution View will redisplay to reflect the 
Solution 2 values.  At the same time, the UnitLoad Solution View 
will redisplay to reflect Solution 2. 

 Shipcase Solution List:  This pane, at the bottom of the screen, 
displays a list of all shipcase solutions generated for the analysis.  
In this example, TOPS Pro has generated three shipcase solutions. 

19. Select a shipcase solution. 

20. Click on the Next button in the Toolbar.  TOPS Pro redisplays the 
Analysis View with three new panes, as pictured on the next page. 
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Notice that TOPS Pro has proceeded to the next step in the analysis.  
We've completed the shipcase stage of the analysis; now we're ready 
to work with the unitload solutions, which will complete the analysis. 
 
All three panes work in conjunction with one another.  Let's briefly 
outline these three panes: 

 UnitLoad Solution View:  This pane displays a graphic of what a 
selected unitload solution looks like – i.e., how the knockdowns 
are loaded onto the pallet. 

 UnitLoad Statistics View:  This pane displays detailed statistics 
for a selected solution. 

 UnitLoad Solution List:  This pane displays a list of all the 
solutions generated for the analysis.  For this analysis, TOPS Pro 
has generated two solutions for the given shipcase and unitload 
parameters. 

For each solution, this pane displays 15 items of basic information – 
case weight, volume, vertical dimension, etc. – which appear in 15 
columns across the pane. 

21. Select a unitload solution. 

22. Click on OK in the UnitLoad View pane.  TOPS Pro redisplays the 
Control Panel. 

23. Click on the Save button to save the analysis record. 
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Paste-On Graphics 
The Paste-On Graphics feature allows you to dress up your cartons, 
shipcases, trays and other box-like containers with graphics, such as a 
corporate logo.  This is a fairly limited feature that's accessed with a 
Graphics button on the following dialog boxes: 

 Define Carton 
 Define Shipping Case 
 Intermediate Pack Parameters  
 Milk Carton Parameters 
 ShipCase Parameters 
 Can Parameters 

 
Before getting into the step-by-step instructions, be aware of these tips and 
guidelines regarding Paste-On Graphics: 

 In order for the Paste-On Graphics feature to work, you must turn on 
the Show Graphics switch.  To turn on Show Graphics, start from the 
Control Panel, open the View menu and select Show 
Graphics/C.A.S.Y. 

 For speed purposes, before using a graphic, TOPS Pro shrinks the 
graphic to no larger than 64 pixels by 64 pixels.  TOPS Pro then places 
the reduced graphic on the shipcase, carton, etc.  Therefore, if you're 
designing graphics to be used in TOPS Pro, you'll get best results with 
graphics that are no bigger than 64 x 64 pixels. 

 The Paste-On Graphics feature does not work for monochrome 
bitmaps.  If you want to use a monochrome bitmap, open it in 
Microsoft Paintbrush and re-save it as a 16-color bitmap. 

 
To demonstrate how the Paste-On Graphics feature works, we'll start by 
defining parameters for a shipcase, then add graphics to the front and side 
of the shipcase.  Start from the Control Panel and follow these 
instructions: 

1. From the Menu Bar, open the View menu and select Show 
Graphics/C.A.S.Y. 

Note:  The Paste-On Graphics feature will not be available unless you 
first turn on the Show Graphics feature. 

2. From the button-style menus, click on the Shipper icon.  The Shipper 
icon appears. 

 Drum Parameters 
 Tub Parameters 
 Bucket Parameters 
 Bottle Parameters 
 Bag Parameters 
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3. Click on the Shipper icon on the design sequence.  The Shipcase 
Parameters dialog box appears.  Enter 10 x 7.5 x 5 for the shipcase. 
 

 
 

4. Click on the Graphic button.  The Assign Graphics dialog box appears, 
as pictured below. 
 

 
Notice three things about this dialog box: 

 This dialog box works in conjunction with the Graphic Online 
Display (g.o.d.) feature, which appears in the bottom portion of 
the screen.  As you assign graphics to the shipcase, the g.o.d. 
feature will redisplay to show the selected graphic pasted on the 
shipcase. 
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 The Top, Front, Back, Right and Left fields allow you to browse 
a list of graphic files and select a graphic for the top, front and side 
of the shipcase. 

 The Rotate buttons allow you to turn the graphic on the shipcase 
face.  The left Rotate button turns the graphic counter-clockwise 
by 90 degrees each time you press the button.  Likewise, the right 
Rotate button turns the graphic clockwise by 90 degrees each time 
you press the button. 

5. To paste a graphic on the front of the shipcase, go to the Front field 
and click on the Browse button.  The File Open dialog box appears, as 
pictured below. 
 

 

5. Scroll down the list of file names until you find the graphic you want. 

Note:  In the figure above, the list of files represents a few of the 
bitmaps that are shipped with the TOPS Pro software. 

6. Select the graphic and click on OK.  In this exercise, we'll select the 
tops.bmp file.   
The Graphic Online Display (g.o.d.) redisplays, as pictured below, 
with the selected graphic on the front of the shipcase. 
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Note:  Whatever color is in the lower, right-hand corner of the bitmap 
is assumed to be the background color.  All parts of the bitmap that 
match that color are displayed transparently as the color of the 
underlying box.  If you don't want a transparent background, change 
the color of the lower, left-hand pixel to a color that is not currently 
used in the bitmap. 

7. To paste a graphic on the right side of the shipcase, go to the Right 
field and click on the Browse button.  The Get Graphics File Name 
dialog box appears. 

8. Scroll down the list of file names until you find the graphic you want. 

9. Select the graphic and click on OK.  Again, we'll select the tops.bmp 
file.  The Graphic Online Display (g.o.d.) redisplays, as pictured 
below, with the selected graphic on the front and side of the shipcase. 
 

 
10. 11. To rotate the shipcase in the graphic display, use the right and left 

Rotate buttons.  TOPS Pro rotates the shipcase in the g.o.d. feature by 
90 degrees left (counter-clockwise) or right (clockwise). 
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Export 
The Export feature allows you to select a graphic, product report, case, 
carton, analysis or robotic palletizer, then export it to another application 
outside the TOPS Pro system. 

Export a Graphic 
To export a graphic from the TOPS Pro system, follow these instructions: 

1. Select the graphic you want to export.  To select a graphic window for 
export, click on that window to make it active. 

2. From the Menu Bar, open the Export menu and select the format you 
want to use to export the graphic: 

 BMP (Color) 
 BMP (B+W) 
 EPS 
 TIFF 
 PCX 

 
In this example, we'll select BMP (Color). 

Note:  When you select a graphic for export, TOPS Pro creates a file 
that is the same size as the graphic you see on your screen.  The color 
depth will match your current Windows display setting. 

The Save File As dialog box appears, as pictured here. 
 

 

 JPEG 
 HTML 
 PNG 
 PDF 
 WMF 



 

3-32 TOPS Pro (Version 6.50) User Guide 

Notice that the Save File As dialog box displays a list of bitmap files.  
If you select a JPEG format, the dialog box will display a list of .jpeg 
files, and so on. 

3. In the File Name field, enter the name of the file. 

4. Select the drive and directory path to which you want to save the file. 

5. If everything is correct, click on OK. 

TOPS Pro saves the graphic file to the selected drive and directory 
path. 
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Export a Product Report 
The product report exports information to an ASCII comma delimited text 
file in a form suitable for import into Microsoft Access, Excel or other 
applications.  The report includes information on every product attached 
to an approved package profile. 

To export a product report from the TOPS Pro system, follow these 
instructions: 

1. From the Menu Bar, open the Export menu and select Product Report. 

The Product Export dialog box appears, as pictured below.  Notice that 
TOPS Pro has automatically inserted the directory path of the product 
file, along with "topsexport.csv" as the file name. 
 

 
 
Note:  For more information on the Product Export dialog box, please 
refer to Appendix B, Dialog Boxes. 

2. In the Export File Name field, replace " topsexport.csv " with the 
name of the product file. 

3. If everything is correct, click on Export.  TOPS Pro issues a message 
indicating that the export is complete. 
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Export a Case 
TOPS Pro allows you to export the shipcase in the current analysis from 
the TOPS Pro system to an ASCII comma delimited test file for use by 
third-party products, such as Design Axis' Package for DOS product. 

To export a shipcase from the TOPS Pro system, follow these instructions: 

1. From the Menu Bar, open the Export menu and select Case. 

The Export to ASCII dialog box appears, as pictured below.  Notice 
that TOPS Pro has automatically inserted (1) the directory path of the 
product file, along with "tops.txt" as the file name, and (2) the shipcase 
style (RSC). 
 

 

Note:  For more information on the Export to ASCII dialog box, 
please refer to Appendix B, Dialog Boxes. 

2. In the Export File field, replace " tops.txt " with the name of the 
product file.  As an option, you can use the Browse button to display 
the Get Export File Name dialog box and select the file to be exported. 

3. In the Export Style field, enter another shipcase style, if necessary. 

4. If everything is correct, click on Export.  TOPS Pro issues a message 
indicating that the export is complete. 
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Export a Carton 
TOPS Pro allows you to export the carton in the current analysis from the 
TOPS Pro system to an ASCII comma delimited test file for use by third-
party products, such as Design Axis' Package for DOS product. 

To export a carton from the TOPS Pro system, follow these instructions: 

1. From the Menu Bar, open the Export menu and select Carton. 

System Response:  The Export to ASCII dialog box appears, as 
pictured below.  Notice that TOPS Pro has automatically inserted (1) 
the directory path of the product file, along with "tops.txt" as the file 
name, and (2) the carton style (Tuck). 

Note:  For more information on the Export to ASCII dialog box, 
please refer to Appendix B, Dialog Boxes. 
 

 

2. In the Export File field, replace " tops.txt " with the name of the 
product file.  As an option, you can use the Browse button to display 
the Get Export File Name dialog box and select the file to be exported. 

3. In the Export Style field, enter another carton style, if necessary. 

4. If everything is correct, click on Export.  TOPS Pro issues a message 
indicating that the export is complete. 
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Export an Analysis 
TOPS Pro allows you to export an analysis to an ASCII comma delimited 
text file or an XML file.  You can use this file to transfer analyses to other 
copies of TOPS Pro (same release or higher) or to back up your work. 

To export an analysis from the TOPS Pro system, follow these 
instructions: 

1. From the Menu Bar, open the Export menu and select Analysis. 

The Export Analysis dialog box appears, as pictured below.  Notice 
that TOPS Pro has automatically inserted the directory path of the 
product file, along with "tops.txt" as the file name. 
 

 

2. In the Export File Name field, replace "tops_data.txt" with the name of 
the product file.  As an option, you can use the Browse button to 
display the Get Export File Name dialog box and select the file to be 
exported. 

3. To export all analysis files, click on the All button.  All analyses, 
including both pending and approved ones, will be highlighted. 
Note:  To select only specific analyses for export, press the [Ctrl] key 
on your keyboard while clicking the name of the analysis with the left 
mouse button. 

4. If everything is correct, click on Export.  TOPS Pro issues a message 
indicating that the export is complete. 

The Export Analysis dialog box allows you to search for a file to export.  
If you click on the Search button, the Analysis Search dialog box appears.  
For more information about this dialog box, please refer to Appendix B, 
Dialog Boxes. 
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Export to a Robotic Palletizer 
TOPS Pro allows you to export the arrangement of a pallet pattern layer to 
an ASCII text file, which can be used by robotic palletizing machines to 
determine how to arrange a unitload. 

To export a robotic palletizer from the TOPS Pro system, follow these 
instructions: 

1. Select the pallet pattern you want to export, which means you have to 
highlight a unitload solution. 
Note:  You will not see any response if your current selection is on a 
shipcase solution. 

2. From the Menu Bar, open the Export menu and select Robotic 
Palletizer. The Export Robotic Palletizer dialog box appears, as 
pictured below. 
 

 
3. Click the Browse button to select drive and directory path for the 

exported file and specify the output filename to be used. 

4. Select the co-ordinate preference for the pallet and shipcase. 

5. Specify the delimiter to be used among comma, semicolon or tab to 
separate each field in the record. 

6. Select the unit of measure. 

7. Add pallet, shipcase and layer information to the output as desired. 

8. Click on Export.  TOPS Pro will create the text file as specified to the 
selected drive and directory path. 
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Below is an example of a text file output for a Robotic Palletizer including 
pallet and shipcase information for one layer (of 30 shipcases). 
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Artios Integration 
The Artios CAD program can send Length, Width, Height and Box Style 
information to TOPS Pro to be automatically imported and dropped into a 
template for palletization.  You can also use this feature to add 
information to the Shipcase and Carton databases.  Please note that the 
graphics in Artios cannot be transferred into TOPS Pro. 

To use TOPS with Artios CAD, please review the following section. 

From Artios to TOPS: Box Data for Palletization 

Setting Defaults in Artios CAD 
To initiate the integration of TOPS Pro from Artios, the defaults should be 
set in Artios so that it points to the correct install of TOPS Pro. Below are 
the steps involved. 

Note: The menus and screenshots might be slightly different from what is 
shown here with different versions of Artios 

1. Choose Options menu in Artios and select Defaults under it. This 
should open up the default selection dialog. 

2. Under Shared defaults, go to the section Outputs, select Artios, 
Palletization and then TOPS as shown below. 
 

 
3. Double click on the TOPS icon to set the details.  



 

3-40 TOPS Pro (Version 6.50) User Guide 

 
4. At the Properties dialog box, click on the Advanced tab. The “WITH 

OUTCM.OUTPUT” field under Output through command file should 
have the current install of TOPS Pro with full path and INI 
information within single quotes.  
Example: '"C:\ProgramFiles\TOPSAPPS\6.01\TOPSPRO\topspro.exe" 
-ini=C:\PROGRA~1\TOPSAPPS\6.01\TOPSPRO\topspro.ini' 
 

 
5. Select the Directories tab and make sure that the Plot File section has 

the option Fixed Filename checked.  The Filename and Directory can 
have the default values. 
 

 
6. Click OK and save the defaults. 
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Launching TOPS Pro 
1. From Artios CAD, select the Export to TOPS menu option.  This will 

launch TOPS Pro. 

2. Login TOPS Pro under any user name. 

3. A message box appears asking if you would like pass the current 
carton design from Artios CAD into TOPS Pro as an erected box or as 
knockdown.  Select Box for a shipper to pallet analysis or 
KnockDown for a knockdown carton analysis. 
 
The dimension will be imported accordingly based on this selection. 

 

 
4. Next, a dialog will prompt for an Analysis name to use for the 

imported carton in an analysis, you may use any name here and hit Ok 
button.  
 

 
5. At the Set Up Box Parameters dialog box, you can select the following 

options regarding the carton data from Artios CAD: 

 To import the carton as a Primary (green carton) or Shipcase 
(yellow shipper).  

 Specify the box style for the imported carton at the TOPS Style 
drop list.  The style is normally preselected if it’s included in the 
Artios output data. 

 Enable the “Add to Database” checkbox to add this carton to the 
database. 

 Specify a design template to use for the analysis using the existing 
carton. 
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Templates: 
 Standard Bundled Templates – KnockDowns will be bundled 
 Standard Bundled Templates – KnockDowns will be placed in 

shipcase 
 Custom Template – Open “Open Analysis” dialog box to select a 

pre-defined analysis template 
 New Analysis – placed KnockDown in Bundles, pallet and then 

into a truck 
 

NOTE:  The analysis is setup using a predefined template / default values. 
Contact TOPS Software if you would like to know how to change this 
template / default values. 

             Box Import: 

                                       

KnockDown Import: 
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6. TOPS Pro will then perform an analysis using the Artios data. 

7. Once the analysis is calculated you may then perform a KD (knock 
down) analysis for this box by clicking on the “KD” button on the tool 
bar. 

8. Then TOPS will perform and KD analysis.  

9. Use the “Combine Report” to get single page printout with both the 
KD and Box/erected analysis on it. 

Note:  To enable Artios import, you'll need to login to the TOPS 
Configuration program as a supervisor, go to the Global Configuration 
dialog box and turn on the Artios-Laserpoint IQ switch. 

From TOPS to Artios: Box and Pallet information 
To initiate the Artios box design from TOPS Pro, go to the Windows 
Toolbar and click on the Integration button ( ) to open the Send to Artios 
dialog box. 

 

Select the information (box data only or box and pallet data) to be 
exported to Artios and click on the Export button. This will launch Artios 
CAD with the box dimension already imported.  If you select Box and 
Pallet to export, a 3D image of the unitload will also be available along 
with  the box dimension. 

Note: If the Integration button ( ) opens the Load Plan dialog box 
instead, please open TOPSPRO.INI and change the  section under 
[Integration] from Type=LoadPlan to Type=XML. 

 

For further assistance, please contact TOPS technical support. 
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Quick Print Template System 
TOPS Pro has a Quick Print feature that allows you to print multiple pages 
of information in a single batch.  This feature also allows you to design 
reusable report styles for standardized specifications.  The Quick Print 
feature is good if you need a standard printout that has four graphics on 
the first page and statistics on the second page.  For more information, 
please refer to Chapter 11, Printing. 

Combined Report 
The Combined Report feature combines information from two analyses or 
up to five solutions of the same analysis onto one printout.  This feature is 
particularly useful to include both the knocked-down and erected 
palletizations of a shipcase in a single report.  For more information, 
please refer to Chapter 11, Printing. 

Control of Displayed Statistics 
This feature allows you to add or remove selected statistics from your 
printouts.  For example, you can remove information regarding slack or 
RSC Area from the printed statistics.  You could also specify whether to 
add Bulge information to the report.  In essence, this feature allows you to 
turn on and off any column of information the software can display in a 
statistics pane.  For more information, please refer to Configuration - 
Statistics Tab in Appendix B, Dialog Boxes. 

Shipcase Database Option 
As you work through analyses and create various types of shipcases, 
TOPS Pro allows you to save those shipcases to a shipcase database.  
Rather than enter shipcase parameters with each new analysis, this feature 
allows you to use shipcases already defined in the system. 

Notice two things on the Shipcase Parameters dialog box: 

The Case feature includes a Database option, which activates the 
Database feature just below. 

The Database feature tells TOPS Pro to automatically use shipcases 
already set up and stored in the shipcase database.  The Database feature 
has two options: 
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 All:  Tells TOPS Pro to consider all shipcases saved to the database 
when it calculates solutions. 

 Multiple:  Opens the Select Items dialog box and allows you to select 
specific shipcases to be used in calculating solutions. 

To use the Multiple option, follow these instructions: 

1. Click the Multiple button, the Select Items dialog box appears, as 
pictured below.  
 

 
Notice two things about this dialog box: 

 The window on the left shows a list of shipcases available to be 
used in the calculation. 

 The window on the right shows a list of shipcases that have been 
selected to be used in the calculation. 
 

2. Select a shipcase to be used in the analysis. 

3. Click on the Add button. 

4. Repeat steps 2 and 3 for each shipcase to be used in the analysis. 
 
Note:  To use all shipcases, click on the Add All button.  To remove a 
shipcase from the right-hand window, select the shipcase and click on 
the Remove button. 
To remove all shipcases from the right-hand window, click on the 
Remove All button. 

5. After selecting the shipcases, click on the OK button.  TOPS Pro 
stores the selected shipcases to memory and redisplays the Shipcase 
Parameters dialog box. 
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Chapter 4: Publishing an Analysis 

Introduction 
TOPS Pro allows you to publish the results of an analysis to the Web or to 
a local network, thus allowing other people to view the analysis.  With the 
Publish Analysis feature, analyses are collected into albums, which are 
created by the user to logically organize one or more analyses. 

To publish an analysis to the Web or network, start from the Control Panel 
and follow these instructions: 

1. Go to the Menu Bar and open the File Menu. 

2. Select the Publish Analysis option then select either the To Web or To 
Network option.   
 
The Publisher dialog box appears in one of two forms, as pictured 
here. 
 

 
Publisher to Web/Internet Option 
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Publisher to Local Network Option 

The Publisher dialog box is organized into the following sections: 

 Publish Profile:  A profile contains information regarding the 
destination (web or local network) where analyses will be 
published.  Creating a profile enables you to quickly recall the 
details of the published site. 

 Profile Name:  Enter the name for a new profile (details of the 
profile will be entered under the Site section) or select an 
existing profile from the drop-down list. 

 New Profile:  Click to create a new profile. 
 Save Profile:  Click to save the Site information into the 

specified profile. 
 Remove Profile:  Delete the selected profile from the database. 
 Web/Internet or Local Network:  Specify whether the new 

profile is a web or local network location. 
 

 Site:  Specifies or displays the details of the publish location for 
the new or selected profile. 
 
With the Web/Internet option selected, the Site section prompts 
you for the followings: 

 Address:  IP address or URL of the destination web site 
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 Remote Path:  Name of the folder on the remote site where the 
analyses will be saved, if applicable 

 User Name and Password:  Authenticate your right to access 
the remote site 

With the Local Network option selected, the Site section prompts 
you to enter a destination Path.  Enter the directory path or click 
on the Browse button to specify a location on your local network. 
 
Note:  For specific Site information, please contact your IT 
Department. 
 Connect/Disconnect:  Click to connect to or disconnect 

from the selected remote location. 
 

 Album:  Published analyses are organized into albums.  This 
section allows you to create a new album, select an existing album 
to which the selected analysis will be stored or remove an existing 
album. 

 Analysis:  Allows you to select and add one or more analyses to be 
published as part of an album. 

 File Transfer Status:  Displays a list of FTP transactions (when 
publishing a profile to the Web). 

3. In the Profile Name field, use the drop-down list to select an existing 
profile that will be used to publish the analysis. In this case, previously 
saved Site information for the selected profile will be recalled. 
 
Note:  To create a new profile, click on the New Profile button and 
enter the name of the new profile in the Profile Name field. 

4. In the Site section, enter information for one of two options for a new 
profile:  If you’re publishing to the Web, enter the Address, Remote 
Path, User Name and Password.  If you’re publishing to a local 
network, browse for and select the path.  

5. After entering Site information, click on the Connect button.  TOPS 
Pro establishes a connection to the specified site, then populates the 
Album section with a list of existing albums stored on the site. 

6. In the Album section, you can select an existing album from the drop-
down list to add new analyses or to create a new album. 
 
To create a new album, click on the New Album button and enter the 
name at the pop-up dialog box. 
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7. In the Analysis section, go to the “Available for Publishing” list, select 
the analysis you want to publish, then click on the Add button.  Repeat 
this step for each analysis you want to add to the album. 
 
To remove a selected analysis from the album, highlight the analysis in 
the “Existing Analysis is Selected” list and click on the Remove 
button. 
 
TOPS Pro retrieves images from the selected analysis, converts the 
images to XML and HTML files, and sends the files to the specified 
location in the profile. 
 
Note:  When publishing to the Web, TOPS Pro displays a log of FTP 
transactions in the File Transfer Status window.  If there is an error 
publishing to the Web, this log provides information that might 
identify the problem. 
 

Viewing the Published Analyses 
To view the analyses published to the web, enter the following at the web 
browser address field - http://URL/FolderName/AlbumName.html where 

 URL is the web address or IP address for the site as specified in the 
Site information section of the Publisher dialog box 

 FolderName is the optional Remote Path specified under Site 
Information 

 AlbumName is the name of the Album containing the analyses as 
specified under the Album section of the Publisher dialog box 
 

The browser will be updated to open the specified html file as illustrated 
on the next page.  To view any analysis, just click on the Name to open the 
report. 
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Published Analysis list on the web 

To view the analyses published to the local network, open the Windows 
Explorer and browse to the folder as specified in the Publish dialog box. 

Tip:  Create a shortcut to the Analysis.html file so you can access the 
published album with just one simple click. 

 
Published Analysis list on the web 
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Chapter 5: Package Pattern and 
Divider Editor 

Introduction 
This chapter discusses the following editing functions in TOPS Pro: 

 Pallet Pattern Editor 
 Vehicle Load Editor 
 Interactive Shipcase Sizing Editor 
 Custom Divider Editor 

 
The Pallet Pattern Editor allows you to reconfigure boxes on a pallet by 
moving individual boxes to different positions, removing boxes from the 
pallet and adding boxes to the pallet.  The Editor allows you to manipulate 
the configuration in a way that cannot be accomplished with the standard 
dialog boxes and parameters. 

Note:  This feature allows you to edit pallet patterns.  It works with one- 
to four-block patterns, diagonals and previously edited patterns.  Because 
TOPS Pro allows you to edit columns of shipcases, not the whole pallet, 
any edits will be replicated for every layer. 

The Vehicle Load Editor is similar to the Pallet Pattern Editor and allows 
you to re-layout the contents inside the transit vehicle. 

The Interactive Shipcase Sizing Editor allows you to reconfigure the 
arrangement inside an intermediate pack or shipcase by removing or 
adding items inside the box.  If the new arrangement calls for a bigger 
shipcase, its Auto Size function will automatically adjust the shipcase size 
to accommodate the additional items. 

The new Divider Editor provides a graphical interface where you can 
easily create custom divider for any interpack or shipcase. 

Using the Pallet Pattern Editor 
The Pallet Pattern Editor has a number of useful features, which we'll 
discuss one at a time.  First, let's perform a simple analysis that will result 
in a standard shipcases-on-a-pallet configuration.  Follow these 
instructions: 
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1. Define the Package Design Sequence by clicking on the Shipper and 
Pallet icons. The Shipper and Pallet icons appear in the Package 
Design Sequence area of the Control Panel. 

2. Click on the Shipper icon to open the Shipcase Parameters dialog box. 
Enter the dimension of the shipcase as pictured below. 
 

 
3. After entering shipcase parameters, click on OK.  TOPS Pro stores 

your parameters to memory and closes the dialog box. 

4. Click on the Pallet icon to open the UnitLoad Parameters dialog box. 
Use the default setting as pictured below and click on OK. 
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5. Click on the Calc button to generate solutions for the analysis. 

TOPS Pro uses the defined parameters and generates all possible 
solutions for the analysis.  When the calculation is complete, the 
Analysis View appears with three panes, as pictured below. 
 

 
 
Notice that each of the UnitLoad View panes has a Modify button, 
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which displays the Editing Screen and allows you to make changes to 
the pallet configuration. 

6. Click on the Modify button and the editing screen appears. 

 
 

 

 

 

Notice the following elements on the screen: 

 Add-a-Box Feature:  Allows you to add an individual box to the 
pallet.  This feature works in conjunction with the horizontal/vertical 
option. 

 Horizontal/Vertical Option:  When you add a box to the pallet, these 
buttons allow you to position the box horizontally or vertically. 

   Flush Up/Down/Left/Right Buttons:  Allow you to select a box 
and position it flush – in the direction you choose – against the nearest 
box.  This feature also allows you to use two directions; for example, 
you can position a box flush down and to the right simultaneously. 

 Color Drop-Down List:  Allows you to select a box or multiple boxes 
and paint them a different color. 

 Rotate Buttons:  Rotates the highlighted shipcase 90 or 180 degrees. 

Add-a-Box Flush 
ButtonsColor 

List 
Rotate 
Button 

Align 
Buttons 

Spread/Center 
Buttons 

3D View 
Pane 

Horizontal/ 
Vertical  
Option 

Top View Pane 

Pallet View Pane 

Snap to 
Overhang

Button
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 Restore Button:  Erases any edits you've made and restores the 
Editing Screen with the original parameters. 

 Cancel Button:  Erases any edits you've made, closes the Editing 
Screen and returns you to the Analysis View. 

 OK Button:  Saves any edits you've made, closes the Editing Screen 
and returns you to the Analysis View. 

 Shrink Fit Button / Auto Size Button:  Not applicable. 

 Snap to Overhang Button:  Check this box to make sure the cartons 
will align with the allowable overhang setup in the Unitload 
Parameters dialog box. This function requires the Flush Buttons to be 
enabled also. 

   Align Left Button:  Allows you to select multiple boxes, select 
one as the anchor box and align the boxes with the anchor box in the 
direction you choose.  The first box you select will serve as the anchor 
box. 

   Align Right Button:  Allows you to select multiple boxes, select 
one as the anchor box and align the boxes with the anchor box in the 
direction you choose.  The first box you select will serve as the anchor 
box. 

   Align Up Button:  Allows you to select multiple boxes, select 
one as the anchor box and align the boxes with the anchor box in the 
direction you choose.  The first box you select will serve as the anchor 
box. 

   Align Down Button:  Allows you to select multiple boxes, select 
one as the anchor box and align the boxes with the anchor box in the 
direction you choose.  The first box you select will serve as the anchor 
box. 

   Spread Horizontal Button:  Allows you to select multiple boxes 
and spread them horizontally on the pallet, with equal spacing between 
the selected boxes. 

   Spread Vertical Button:  Allows you to select multiple boxes 
and spread them vertically on the pallet, with equal spacing between 
the selected boxes. 

   Center Horizontal Button:  Allows you to center all the boxes 
horizontally on the pallet. 
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   Center Vertical Button: Allows you to center all the boxes 
vertically on the pallet. 

   Center All Button:  Allows you to center all the boxes in the 
middle of the pallet. 

 Layer Button:  Specify which layer the modifications will be applied 
to.  Select from the drop list to change individual layer or to all layers.  
To modify only layers 3 and 4 out of 8 layers, select from the drop list 
Layer 3, make the changes; then select Layer 4 and make any change 
desired. 

 Top View Pane:  Displays the pallet and boxes from directly above.  
This pane allows you to manipulate the pallet configuration by 
working with individual boxes.  Using your mouse, you'll add, remove 
or reposition a box; align boxes; spread boxes; and center boxes from 
this pane. 

 3-D View Pane:  Displays the pallet and boxes from a different angle, 
and gives you a graphic illustration of what the whole configuration 
looks like as you make changes in the Top View pane. 
 
You can rotate the 3D graphics for a different view by pressing the 
arrow buttons while holding down the [Shift] key. 

 Pallet View Pane:  Displays the boxes transparently so you can see 
how they're positioned on the deck boards of the pallet.  This feature 
allows you to line up the boxes precisely as you want in relation to the 
deck boards of the pallet. 

To demonstrate how to use these editing features to manipulate your pallet 
configuration, we'll walk through three basic routines: 

 Move boxes on the pattern. 
 Remove boxes from the pattern. 
 Add new boxes to the pattern. 
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Move Boxes on the Pattern 
To move boxes on the pattern, you'll use these editing features: 

 Select multiple boxes 
 Rubber-banding 
 Align Left/Right/Up/Down buttons 
 Spread Horizontal/Vertical buttons 
 Center Horizontal/Vertical buttons 
 Flush Up/Down/Left/Right buttons 

Select Multiple Boxes 
To select multiple boxes to be moved, follow these instructions: 

1. Left-click on the first box.  (TOPS Pro highlights the box.) 

2. Press the Shift key, hold it down and, one at a time, and click on the 
other boxes you want to move.  (TOPS Pro highlights all the selected 
boxes.) 

3. Move the boxes as necessary. 

Rubber-Banding 
You can also select multiple boxes for moving by using the rubber-
banding feature.  To select boxes with the rubber-banding method, follow 
these instructions: 

1. Left-click on the white area outside the unitload. 

2. Drag the mouse to form a "rubberband box" on the pane.  Enlarge the 
box to include all the boxes on the pallet you want to move. 

3. Let go of the left mouse button. 

4. All boxes that are completely inside the "rubberband box" will be 
highlighted (selected).  Any boxes that are only partially inside the 
"rubberband box" will not be highlighted. 

5. Move the boxes as necessary. 
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Align Left/Right/Up/Down Buttons 
The Align Left/Right/Up/Down feature allows you to select multiple 
boxes, select one as the anchor box and align the boxes with the anchor 
box in the direction you choose. 

In the figure on the right, you'll see that three boxes 
on the left side of the pattern are positioned just off 
the pallet.  Suppose we want to position these three 
boxes just off the pallet, but we want the three to 
align together with the bottom-most box (the 
anchor). 

In this case, we'll use the Align Left button to align the three boxes to the 
left relative to the bottom-most box.  Follow these instructions: 

1. Left-click on the first box, then press the Shift 
key and click on the other two boxes that are out 
of line.  Be sure to click on the bottom-most box 
first.  (Don't release the Shift key until all three 
boxes are selected.) 

After you've selected the three boxes, the Top View pane will look 
like the one on the right. 

2. Click on the Align Left button . 

TOPS Pro aligns the three selected boxes, with 
the bottom-most box as the anchor – the one you 
clicked on first – as pictured on the right. 

 
Note that when you aligned the boxes to the left, the 3-D View and 
Pallet View panes redisplay to reflect the boxes' new position on the 
pallet. 
 
Note:  The Align Right, Align Up and Align Down buttons work 
according to the same principles. 
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Spread Horizontal/Vertical Buttons 
The Spread Horizontal feature allows you to select 
multiple boxes and spread them horizontally on the 
pallet, with equal spacing between the selected 
boxes. 

In the figure on the right, you'll see that one of the 
boxes has been removed from the top row on the pallet. 

In this exercise, we want to space the five boxes on the top row 
horizontally, so that there's equal spacing between those five boxes.  
Follow these instructions: 

1. Press the Shift key and click on the five boxes on 
the top row of the pallet.  (In this case, it doesn't 
matter which box you select first.) 

After you've selected the five boxes, the Top 
View pane will look like the one on the right. 

2. Click on the Spread Horizontal button . 

TOPS Pro spreads the five selected boxes 
horizontally, creating equal space between them, 
as pictured on the right. 

 
Note that when you spread the selected boxes horizontally, the 3-D 
View and Pallet View panes redisplay to reflect the boxes' new 
position on the pallet. 
 
Note:  The Spread Vertical button works according to the same 
principles.   
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Center Horizontal/Vertical Buttons 
The Center Horizontal feature allows you to center 
all the boxes horizontally on the pallet.  In the figure 
on the right, you'll see that one box on the left side is 
positioned a few inches off the pallet; consequently, 
the boxes are not centered on the pallet. 

 
In this exercise, we'll center all the boxes on the pallet horizontally.  
Follow this instruction: 

1. Click on the Center Horizontal button . 

TOPS Pro automatically centers all the boxes 
horizontally on the pallet, as pictured on the 
right. 
 
Note that when you center the selected boxes horizontally, the 3-D 
View and Pallet View panes redisplay to reflect the boxes' new 
position on the pallet. 
 
Note:  The Center Vertical button works according to the same 
principles. 

 

Flush Up/Down/Left/Right Buttons 
The Flush Up/Down/Left/Right buttons allow you to select a box and 
position it flush – in the direction you choose – against the nearest box.  
This feature also allows you to use two directions; for example, you can 
position a box flush down and to the right simultaneously. 

In the figure on the right, you see that one box is 
positioned out of line, separated from the other 
boxes on the pallet. 

You'll use the Flush directional arrows to move the 
box back into position.  In this exercise, we'll use the 
Up and Left arrows separately, then together.  Follow these instructions: 
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1. Click on the box to select it. 

2. Click on the Flush Up arrow. 

Note:  When you click on this arrow, it will 
depress and show a red outline. 

3. Drag the box slightly in any direction, then let go.  
TOPS Pro snaps the box flush up against the 
nearest box, as pictured on the right. 
 
Note that when you moved the box flush up, the 3-D View and Pallet 
View panes redisplay to reflect the box's new position on the pallet. 

Now you want to move the box flush left. 

1. Click on the box to select it. 

2. Click on the Flush Left arrow. 

Note:  When you click on this arrow, it will 
depress and show a red outline. 

3. Drag the box slightly in any direction, then let go.  
TOPS Pro snaps the box flush left against the 
nearest box, as pictured on the right. 
 
Again, note that when you moved the box flush left, the 3-D View and 
Pallet View panes redisplay to reflect the box's new position on the 
pallet. 
 
This feature allows you to move a box in two 
directions at once with only one movement.  Again, 
we'll start with the box moved out of line, as 
pictured on the right. 
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To move the box flush up and left simultaneously, follow these 
instructions: 

1. Click on the box to select it. 

2. Click on the Flush Up and Flush Left arrows. 

Note:  When you click on these arrows, they will 
depress and show a red outline. 

3. Drag the box slightly in any direction, then let go.  TOPS Pro snaps 
the box flush up and left against the nearest box, as pictured above. 
 
Again, note that when you moved the box flush up and left, the 3-D 
View and Pallet View panes redisplay to reflect the box's new position 
on the pallet. 

Remove Boxes from the Pattern 
Removing boxes from the pattern is easy.  Using your mouse, follow these 
two simple instructions: 

1. Click on the box you want to remove. 

2. Drag the box off the pallet pane; that is, anywhere outside the area that 
bounds the Top View Pane.  TOPS Pro removes the box from the 
pallet, leaving an empty space where the box used to be. 

Add New Boxes to the Pattern 
To add new boxes to the pallet, you'll use these editing features: 

 Add-a-Box 
 Horizontal/Vertical option 
 Flush Up/Down/Left/Right buttons 
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Add a Box Using the Horizontal/Vertical Option 
The Add-a-Box feature allows you to add an individual box to the pallet.  
This feature works in conjunction with the horizontal/ vertical option.  But 
first, before you can add a box to the pallet, there must be ample empty 
space on the pallet.  After you've removed one or more boxes on the 
pallet, follow these instructions: 

1. Click on the box in the corner of the screen. 

2. Select either the horizontal or vertical option, depending on how you 
want the box to lie on the pallet by clicking on the radio button. 

3. Drag the box from the Add-a Box window to an empty space in the 
Top View Pane. 

TOPS Pro adds the box to the pallet and positions the box horizontally 
or vertically, based on your input when you release the mouse button 
as pictured below. 
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Using the Vehicle Pattern Editor 
The Vehicle Pattern Editor works exactly the same way as the Pallet 
Pattern Editor. To access the editor, click the Modify button in the Vehicle 
View pane. 

 

In the example, we will change the orientation of some pallets on the top 
layer inside the vehicle.  For other details, please refer to the previous 
section for more instructions. 

1. In the Editing screen, select Layer 2 from Layer option at the top right 
hand corner.  This will only apply modifications to the top layer inside 
the vehicle. 

2. Select the four pallets on the right inside the vehicle as shown below. 
You can use the rubber banding method or the standard mouse click 
while holding down the [Shift] button as described on page 5-7. 

 
3. With the pallets highlighted, drag them outside the top view pane to 

remove them from the vehicle. 
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4. Go to the Add-A-Box section and drag the pallet inside the vehicle. 
You can enable the flush button to make sure the pallets are aligned. 

 
5. Repeat step 4 to bring more pallets inside the vehicle. 

 
6. To accept the modifications, click on the OK button. 
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Using the Interactive Shipcase Sizing 
Editor 
The Interactive Shipcase Sizing Editor allows you to reconfigure the 
arrangement inside an intermediate pack or shipcase by removing or 
adding items inside the box.  If the new arrangement calls for a bigger 
shipcase, its Auto Size function will automatically adjust the shipcase size 
to accommodate the additional items. 

To illustrate its function, let's perform a simple analysis that places cartons 
inside a shipcase.  Follow these instructions: 

1. Define the Package Design Sequence by clicking on the Carton 
(green) and Shipper icons. The Carton and Shipper icons appear in the 
Package Design Sequence area of the Control Panel. 

2. Click on the Carton icon to open the Carton Parameters dialog box. 
Enter the dimension of the shipcase as pictured below. 
 

  
3. After entering carton parameters, click on OK.  TOPS Pro stores your 

parameters to memory and closes the dialog box. 

4. Click on the Shipcase icon to open the Shipcase Parameters dialog 
box. Specify a New case and use a Sizing Value of 12 as pictured on 
the next page and click on OK. 
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5. Click on the Calc button to generate solutions for the analysis. 

TOPS Pro uses the defined parameters and generates all possible 
solutions for the analysis.  When the calculation is complete, the 
Analysis View appears with three panes, as pictured below. 
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Notice that each of the Shipcase View panes has a Modify button, 
which displays the Editing Screen and allows you to make changes to 
the shipcase configuration. 

6. Scroll down to solution referenced and click on the Modify button to 
open the Editing screen. 
 
 
 

 
 
Note that the screen is very similar to the Pallet Pattern Editor as 
described on page 5-3 except for the Sizing Option. 

 Auto Size:  When checked, this allows TOPS Pro to automatically 
resize the shipcase to accommodate any changes made by moving, 
adding or removing items. 
 

 Shrink Fit:  Allows the shipcase to shrink so all items will fit 
tightly inside the shipcase. 
 

Please refer to page 5-4 and 5-5 for descriptions for the rest of the 
elements on the Editor screen. 
 

To demonstrate how to use the auto sizing and other features, we'll walk 
through these basic routines.  For selection, alignment and spread/center 
functions, please refer to the similar section on Pallet Pattern Editor. 

 Move cartons inside the shipcase 
 Add new cartons the shipcase 
 Rotate cartons inside the shipcase 

Add-a-Box Flush 
Buttons

Color 
List 

Rotate 
Button 

Align 
Buttons 

Spread/Center 
Buttons 

Sizing 
Option 

Horizontal/ 
Vertical  
Option 

Top View Pane 

3D View Pane 
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Move Cartons Inside the Shipcase 
To move a carton in the shipcase, follow these instructions: 

1. Make sure the Auto Size option is checked. 

2. Left-click on the carton you want to move.  (TOPS Pro 
highlights the carton with a darker outside.) 

3. While holding down the left mouse button, move the 
carton to a new location as pictured on the right.  

4. Release the mouse button when done. 

5. Note that the shipcase is resized as well as the 3D View Pane being 
updated automatically with the new carton arrangement. 

Rotate the Cartons 
We will rotate the two cartons on the left 90 degrees and 
add a new carton.  To select the two cartons to be rotated, 
follow these instructions: 

1. Left-click on the first carton marked (1) on as pictured 
on the right. 

2. Press and hold the Shift key, now click on the carton 
marked (2).  

3. With both cartons highlighted, click Rotate90deg 
button. 

4. Note the two cartons are now rotated 90 degrees. 

Add a New Carton 
We will now add a new carton to the shipcase so there will be 7 cartons 
per layer inside the shipcase.  Follow these 
instructions: 

1. Click on the Add-a-Box icon in the corner of the 
Editor screen.  

2. Select the horizontal option. 

3. Drag the box from the Add-a Box window to the 
empty space between the two cartons as pictured on 
the right.  

4. Note that a new carton will be added when you release the mouse 
button. 



 

5-20 TOPS Pro (Version 6.50) User Guide 

Resize the Shipcase 
We will resize the shipcase so all cartons will be centered.  Follow these 
instructions: 

1. Click the Center All items button  to bring all 
cartons to the center as pictured on the right.  
Note that all cartons are now cluttered in the 
middle but not using the space efficiently. 

2. Enable the Flush Bottom button by clicking on 

the down arrow . 

3. Use the rubber banding method (page 5-6) to 
select all three cartons on the left. 

4. With all three cartons selected, drag and drop the 
group towards the lower part of the shipcase as 
pictured on the right. 

5. When the mouse button is released, all cartons are now repacked 
tightly inside the shipcase. 

6. To use this new shipcase arrangement, click on the OK button. 

Click Yes on the message “Box size was changed, continue?” to 
accept the change and return to the Analysis View. 
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7. To rotate the layers inside the shipcase, go to the Edit menu, select 
Layer Parameters and check the layer you’d like to rotate. 

8. Click on OK to return to the Analysis View which now shows rotated 
top layer inside the shipcase. 
 

 
 

9. The Shipcase Sizing Editor is also available at the Intermediate 
Package level and for different primary package types like cans, mike 
cartons, etc. 
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Defining Custom Dividers 
Custom Divider can be easily defined inside TOPS Pro using the graphical 
divider editor. Users have the ability to control the size, including the 
height, width and alignment of each partition within a carton or shipper. 
After the divider has been defined, it can be saved to the database and can 
be used again in future analyses. 

To define custom dividers, follow these instructions: 

1. Define the Package Design Sequence by clicking on the Can/Cylinder 
(green) and Shipper (yellow) icons. The Can and Shipper icons appear 
in the Package Design Sequence area of the Control Panel. 

2. Click on the Can icon to open the Can Parameters dialog box. Enter 
the dimension of the shipcase as pictured below. 
 

 
3. After entering shipcase parameters, click on OK.  TOPS Pro stores 

your parameters to memory and closes the dialog box. 

4. Click on the Shipper icon to open the Shipcase Parameters dialog box. 
We will place 12 cans inside a new shipcase as pictured below and 
click on OK. 
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5. Click on the Calc button to generate solutions for the analysis. 

TOPS Pro uses the defined parameters and generates all possible 
solutions for the analysis.  When the calculation is complete, the 
Analysis View appears with three panes, as pictured below. 
 

 

6. Click on the Divider button to access the divider editing screen. 
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7. You will be prompted whether to have “Divider in the edger?” In this 
example, we are not using divider along the edges and click on NO to 
proceed to the divider editor as shown here. 
 

 
 

Notice the following elements on the screen: 

 Draw/Select Mode:  Click to select which edit mode will be used. 
Select Mode allows you to highlight (in red) different partitions of 
the divider upon the mouse click, followed by action items via the 
right click menu.  
When in Draw Mode, each mouse click will add or remove the 
selected divider partition. You can access the right click menu to 
change the size and alignment of the selected cell partition. 
 

 Add All/Remove All/Select All Button:  These buttons provide 
the functions exactly as described. 

 
 OK Button: Click this button to open the Define Dividers dialog 

box to save the custom divider into TOPS database for future use. 
 

 Cancel Button: To cancel any changes and return back to the 
Solution View of the analysis. 

 
 3-D View Pane:  Displays the pop top view of the shipcase. You 

can rotate the 3D graphics for a different view by pressing the 
arrow buttons while holding down the [Shift] key. 

 
 Top View Pane:  Displays the shipcase and its contents from 

directly above.  
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8. We will create a custom divider for the 12 cans as 

illustrated on the right.  The divider will have the 
same height as the shipcase except the central 
single partition between the 2 six-pack will be 
80% the height of the shipcase. 

9. To start, click on the Add All button to place 
partitions around every divider cell.  

10. Place the mouse at the location of the cursor as 
shown on the right and click the right mouse 
button. At the pop-up dialog box, select Size. 

11. The following dialog box will open. Change the 
Width to 70% of Box Width as shown below. 
 

  
12. The partition now is only 70% of the width of the 

cell.  

13. With the mouse cursor placed on the same 
partition (now smaller), click the right mouse 
button and select Alignment, then click on Right.  

14. Repeat steps 10 through 13 on the three partitions 
circled on the right. 

15. We will now repeat steps 10 through 14 to bring 
the other four partitions to 70% of cell width and 
align left to create the 2 dividers for the 6 cans on 
each side.  

16. To set the height for the center divider, change to 
Select Mode (in order to select across partitions) 
and then click the center divider.  
The partition will highlight in red. Click the right 
mouse button, select Size and enter 80% of Box 
Height at the dialog box. 

17. To save the new divider, click on the OK button 
to open the Define Dividers dialog box as shown. 
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18. Enter a name for this new divider in the Description field so it can be 
used in the future, click on the Save button. 

19. Click the Close button to exit the divider editor and return to the 
Solution View which shows the new divider inside the shipcase. 
 

 
Note: This custom divider is for product arrangement of 4x3 only. If 
you apply this divider to a shipcase with other than a possible 4x3 
arrangement, you will receive an error message as followed. 
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Chapter 6: MixPro Mixed Pallet 
Editor 

Introduction 
This chapter discusses MixPro Pallet Editor, a TOPS Pro module that 
allows you to design a mixed-product pallet for display with different size 
boxes.  These mixed pallet are extremely common in warehouse stores. 

For example, the mixed pallet load can include several shipcases of snack 
foods – chocolate bars, peanut bars and corn chips, all of which have 
different shipcase dimensions.  The MixPro Pallet system allows you to 
easily load and place all types of shipcases onto a pallet. 

 

MixPro Pallet Editor   
To access the MixPro Pallet module, go to the Toolbar and click on the 
MixPro Pallet Editor icon and select MixPro Mixed Pallet Editor. You can 
also open the MixPro Pallet Editor by going to the Tools Menu and then 
select MixPro. 
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Notice the following features on the MixPro Pallet Editor: 

 Calc Wizard:  Clicks the button to open MixPro auto load generator, 
an automatic calculation engine to place mixed size shipcases onto a 
pallet. 

 Pallet Button:  Allows you to select a pallet from the database for 
loading shipcases. 

 Filter Button:  Allows you to filter the types of shipcase to be 
displayed in the Shipcase List.  Select “All” to display all available 
cases and trays supported by MixPro. 

 Shipcase List:  Displays a list of shipcases that you can add to the 
pick list for loading onto the pallet. 

 Pick List:  Displays a list of shipcases you’ve selected from the 
shipcase list.  These shipcases can be loaded onto the pallet.  The pick 
list also tracks the following information for each type of shipcase:  
number of cases, length, width and height. 

 Layer Button:  Allows you to add layers of shipcases onto the mixed 
pallet, provided space is available to add the layers. 

 Pallet Display Window:  Displays an image of the pallet and allows 
you to drag shipcases onto the pallet. 

 Snap Toolbar:  Allows you to move the unitload flush to any corner 
or side of the pallet. 
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Create a Mixed Pallet Manually 
In this exercise, we’ll manually create a mixed pallet load that consists of 
the following: 

 15 cases of chocolate bars 
 32 cases of peanut bars 
 30 cases of corn chips 

To load this mixed pallet, follow these instructions: 

1. Click on the Pallet button.  The Pallet Parameters dialog box appears.  

2. Use the default pallet but change the overhang and load height as 
pictured below. 
 

 
3. Look at the shipcase list and decide which items you want to load onto 

the pallet.  In this exercise, we want the mixed pallet load to include 
chocolate bars, peanut bars and corn chips. 
 
Notice that the initial shipcase list does not include any of these items.  
In this case, MixPro allows you to create new shipcases for these 
items.   

4. To create a new shipcase, click Define on the Menu bar and select 
Shipping Case.  The Define Shipcase dialog box appears. 

5. Enter the shipcase name, dimension, color and label (if desired) as 
pictured here for Chocolate Bars and click on Save when done.  The 
new shipcase information will be saved. 
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6. Click on New to define a new shipcase for Peanut Bars.  Click on Save 

when all parameters are entered. 
 

 
7. Click on New to define a new shipcase for Corn Chips.  Click on Save 

when all parameters are entered. 

 
 
Note:  You can paste a graphic image onto a shipcase.  To use paste-
on graphics, click on the Graphic button.  Further, you can add CASY 
trays to the shipcase.  To add trays, click on the Contents button. 

Note:  The Contents button is only available for newly defined 
shipcase and will be available upon clicking on the New button in the 
Define Shipcase dialog box. 

The MixPro Pallet Editor redisplays with the name of the new shipcase 
included in the shipcase list.  When you’ve created these three new 
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shipcases, the shipcase list will include chocolate bars, peanut bars and 
corn chips. 

8. In order to load an item onto the pallet, you have to move it from the 
shipcase list to the pick list.  To move an item to the pick list, double 
click the shipcase from the shipcase list.  The system inserts the 
selected item into the pick list. 

Repeat this step for each item you want to select to the pick list.  In 
this exercise, we’re loading three items – chocolate bars, peanut bars 
and corn chips. 

9. From the pick list, select an item to be loaded onto the pallet.  In this 
exercise, we’ll select the chocolate bars first. 

A graphic of the selected shipcase appears in the g.o.d. (graphic online 
display) window, located in upper left corner of the data display 
window, as pictured below. 

 

You can change the orientation of the case by clicking on the Rotation 
button.  Select the dimension to be loaded vertically and then the face 
direction.  The current orientation is highlighted with a (√ ) mark. 

Note:  You can also change the case orientation by clicking on 
different faces.  For example, position it on its side or on its end – 
click on the face of the shipcase you want to face the floor.  Click on 
the top of the case to rotate 90 degrees. 
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         Click on the face with the arrow            Click on the top face to rotate shipcase 90 degrees 

Note:  To remove/hide the selected shipcase in the g.o.d. window, 
click the [Esc] key on the keyboard. 

10. To load the item onto the pallet, click on the image of the shipcase and 
drag it onto the pallet. 

The system copies an image of the shipcase to the pallet area, as 
pictured here. 

 

In the figure above, the shipcase automatically flushes against the top 
left corner of the pallet because of the default Snap feature. 
 
Note:  If needed, click on the green √ which turns to a red X, to 
disable the Snap feature. In this way, you can place the shipcase 
anywhere on the pallet, without being aligned to any side or corner of 
the pallet. 

11. Continue to load cases until you’ve loaded 15 cases of chocolate bars 
to the pallet, forming a wall along the backside of the pallet.  Your 
unitload will look similar to the one pictured on the next page. 
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12. To begin adding the next item onto the pallet (the peanut bars), select 

it from the pick list.  The case pictured in the g.o.d. window changes to 
the newly selected case.   

Complete the mixed pallet load until the unitload contains the 
following items: 

 15 cases of chocolate bars 
 32 cases of peanut bars 
 30 cases of corn chips 

When you’ve finished loading the three different shipcases, the 
unitload will look similar to the unitload pictured on the next page. 
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13. Now that all the shipcases are loaded onto the pallet, you can now 
align the unitload on the pallet as you like – to the top, bottom, left, 
right, etc.  You can also display the labels on the various shipcases.   

Note:  The MixPro alignment feature works a little differently than in 
TOPS Pro.  In MixPro, the alignment moves the entire load; you 
cannot select individual cases to align. 

Notice the following buttons in the MixPro Pallet Editor Screen button 
bar: 

   Align Top:  Aligns the load to the top edge of the pallet. 

   Align Bottom:  Aligns the load to the bottom edge of the 
pallet. 

   Align Left:  Aligns the load to the left edge of the pallet. 

   Align Right:  Aligns the load to the right edge of the pallet. 

   Align Vertical:  Compacts the spacing to align the load in the 
center of the pallet vertically. 

   Align Horizontal:  Compacts the spacing to align the load in 
the center of the pallet horizontally. 
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   Label:  Displays the labels on the shipcases.  This is an on/off 
toggle feature. 

  Edit Texture: Adds graphics to the different faces of the 
shipcase. 

   Show Contents:  Clicks to show contents of any CASY trays. 

   Show Front Face:  Clicks to show the display face of the 
shipcases. 

   Add Corner Posts:  Adds corner posts to the unitload.  You 
will define the width and thickness of the corner posts in the pop 
up dialog box. 

  Snap Tool: Clicks to enable or disable the Snap buttons for the 
MixPro Pallet editor. 
 

14. When your load is aligned the way you want it, you’re ready to work 
with the Print Preview feature, tailor the report and then print it. 

15. Before closing MixPro, be sure to give this mixed pallet a name and 
save the file. 
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Create a Mixed Pallet Using Layers 
MixPro allows you to configure layers of shipcases on a pallet.  To work 
with layer configurations, start from the MixPro Pallet Editor and follow 
these instructions. 

1. Add your item to the PickList.  In this example, we will start again 
with Chocolate Bars by double clicking the item in the shipcase list. 

2. With the Chocolate Bars shipcase displayed in the g.o.d. window, 
click on the Layers button.  The Layer Generation Screen appears, as 
pictured on the next page. 
 

 
 
Notice the following about the Layer Generation Screen: 

 A list of layer configurations is displayed in the lower portion of 
the screen.  For each configuration, the screen displays pattern 
type, count (number of cases in a layer), area percentage, length, 
width and height. 

 The layer configuration display shows an illustration of the 
selected configuration in the upper portion of the screen.  This 
display also provides dimensions for length, width and height. 

 The Number of Layer box allows you to specify the number of 
layers in the configuration. 
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Note:  TOPS will limit the number of layers for each item based 
on the remaining space available on the pallet. 

3. Select the layer configuration you want for the mixed pallet load.  
Here we will select the first BiBlock configuration as illustrated 
above. 

4. Select the number of layers in the configuration to two (2). 

5. Click on OK.  The mixed pallet with two layers of chocolate bars will 
be displayed, as shown on the next page. 
 

 

6. Repeat steps 1-5 to add one layer of Peanut Bars and two layers of 
Corn chips to the pallet, with the final results as shown below. 
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Layer Manipulations 
By right clicking the mouse while pointing to the different layers within 
the mixed pallet, you will see a menu with these functions: 

 Properties:  Provide statistics (shipcase name, length, width, height 
and weight) on the layer of item you are pointing to. 

 Rotate 90 degrees:  Where space permits, turn the referenced block 
90 degrees as illustrated by the top two layers of the pallet below. 
 

                   

 Rotate 180 degrees:  Turn the referenced block 180 degrees as 
illustrated on the top five rows of top layer below.   
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Note: Use this function to turn the front face of the shipcase to the 
outside of the mixed pallet to create pallet for display in club stores. 
 

        
                  Original top layer                       Five rows turned             Last column broken apart with 
                                                                       180 degrees              front shipcase turned 180 degrees 

 Break:  Break the placement of shipcases into individual shipcases. 
In the top layer of the illustration above, the top five rows are 
considered one placement and the last column another.   
We will break apart the last column placement and turn the front 
shipcase 180 degrees, with the result illustrated above. 

 Add Slipsheet:  Add a slip sheet on top of the up-most shipcase layer 
of the pallet. 
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MixPro Auto Load Generator 
Mixpro auto load generator is an automatic calculation engine to place 
mixed size shipcases onto a pallet which is optimized for aisle display in 
club stores. Users can specify arrangement preference in layer or column. 

To use the Auto Load Generator, follow these steps: 

1. At the menu, select Tools | Mixpro. 

2. At the Mixpro screen, click on the Calc Wizard button to open the 
auto load generator. 

3. The Calculate MixPal dialog, similar to the one shown below, will 
open. The shipcase list on the left lists all pre-defined shipcases in 
your database. 
 

 

4. To add shipcases to the load generator, highlight the items on the list 
and click the Add button or simply double-click on the shipcase name.  
 
Note: Shipcases added to the list on the right will have a minimum 
quantity of 1 and maximum quantity of 99. To adjust these quantities, 
click on the number and type in a new value. 

5. Specify the calculation option by clicking on either: 

 Calc by layer:  Generate the mixed load by optimizing by layer 
 Calc by column: Generate the mixed load by optimizing by 

column 
6. Specify the pallet to be used for the mixed load by clicking on the 

Pallet button. 
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7. At the Pallet Parameters dialog as shown below, specify any allowable 
overhangs and height restrictions. Click OK to close the dialog. 
 

 

8. Set the Speed-Space slide bar to a desired setting or keep it at the 
default value. This controls if MixPro optimizes calculation for speed 
or for space efficiency. 

9. When ready, click on the Calc button. 

10. MixPro will return a mixed pallet optimized by layer or column as 
specified by the users. 

 
Mixed pallet optimized by layer 
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Mixed pallet optimized by column 

11. You can scroll through the different solutions and pick the pattern that 
works best for you.  Click OK and the selected mixed pallet will be 
displayed in the MixPro dialog as shown below. 
 

 

Once in the MixPro Pallet Editor, you can perform functions on each layer 
and/or shipcase as described on page 6-12. 
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Direct Email From MixPro Pallet 
MixPro Pallet has an internal email feature that allows you to email a 
standard printout directly to another person who may or may not have 
TOPS Pro.  When you email a report or analysis to someone, TOPS Pro 
automatically attaches the appropriate reports as JPEG files to a new email 
message using your default email application.  To use the direct email 
feature, follow these instructions: 

1. Work through the analysis to create the mixed pallet. 

2. At the Menu Bar, go to the File Menu and select Print Preview. 

3. You have a choice of the following report types: 

 Load:  Picture of mixed pallet with unitload and pallet dimensions 
as well as contents of the load. 

 Load (front/back):  Similar to the Load report but with the 
additional view of the back side of the unitload. 

 By placement:  Report giving step by step illustrations on how the 
mixed pallet is created with each placement of shipcases.  

 By Layer:  Report with step by step illustrations on how the mixed 
pallet is created by layer placement. 

 By Edge:  Report with step by step illustrations on how the mixed 
pallet is created from the side of the pallet. 
 

4. At the report preview screen, click on the Email button.  
 
The system launches your default email application and prompts you 
to enter an address for the recipient, subject, etc., as you would for any 
normal email message.  TOPS Pro attaches the appropriate analysis 
files to the email message, then sends the message to the recipient. 

5. On the receiving end, the recipient must select all the attached files 
and save them to a common folder.  From there, the recipient can view 
the report or analysis through most any Web browser or Microsoft 
Word. 
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Tips for Working with Cases on a 
Pallet 

 To add a second case to the pallet, hold down the Shift key and click 
on the first shipcase.  To place the second case on top of the first case, 
Shift and click on top of the first case.  To place the second case to the 
side of the first case, Shift and click on the side of the first case. 

 If you’ve loaded a column, row or layer of cases on the pallet, you can 
add another column, row or layer with one click.  For example, to add 
a layer of cases, hold down the Shift key and click on the top of the 
first layer.  The system adds another layer on top of the first layer.  To 
remove a layer of cases, hold down the Alt and Shift keys 
simultaneously and click on the layer. 

 To remove (or delete) one or more cases from the pallet, click on the 
case(s) and drag it off the backside of the pallet (to the left).  The 
case(s) completely disappear from the display.   

To temporarily remove one or more cases from the pallet – you want 
to load it back later – click on the case(s) and drag it off the frontside 
of the pallet (to the right).  The case(s) remain in view on the display. 

 Use the Layer button to have MixPro calculate optional patterns for 
the selected shipcase. 
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Loading MixPro Pallets into Trucks 
Users can now load the mixed pallets created with MixPro Pallet Editor 
into any transit vehicles in the Design Sequence. 

 

When you click on the pallet icon to define Unitload parameters, you will 
open the UnitLoad dialog box as shown here. 

 

Click the drop down button for the Mix Pallet option to select any MixPro 
Pallets previously defined and place them inside trucks or containers. 
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Chapter 7: MixPro Mixed Tray 
Editor 

Introduction 
This chapter discusses MixPro Tray, a TOPS Pro module that allows you 
to design a mixed-product tray for display with different size packages in 
the tray.  For example, suppose you’re loading trays to be displayed in a 
grocery store, where the tray will be displayed directly on a busy aisle. 

This mixed tray includes several different items of nutrition supplements – 
cans of protein powder, bottles of Gatorade and energy bars, all of which 
have different product dimensions.  MixPro Tray allows you to easily load 
and place all types of packages into a tray.  These trays can then be saved 
and used in MixPro Pallet to create a mixed pallet for display. 

MixPro Tray Editor  
To access the MixPro Tray module, go to the Toolbar and click on the 
MixPro Pallet icon, select MixTray Mixed Tray Editor from the drop list. 
You can also access the MixPro Tray Editor via the Tools > MixedTray 
Menu in the tool bar. 
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Notice the following features on the MixPro Tray Editor: 

 Shipcase Button:  Allows you to select a tray template. 

 Package List:  Displays a list of packages (or objects) that you can 
add to the pick list for loading into the tray. 

 Add Button:  Moves a selected item from the package list to the pick 
list. 

 Delete Button:  Deletes a selected item from the package list. 

 New Button:  Opens the Define Package Info dialog box and allows 
you to create a new package/object.  Use this function if the package 
list does not include the package you need. 

 Remove Button:  Removes a selected package from the pick list. 

 Modify Button:  Opens the Define Package Info dialog box, which 
allows you to modify a newly created package/object. 

Note:  The Modify function applies only to packages created in 
MixPro Tray.  You cannot modify packages created in TOPS Pro.  
Also, you cannot modify a package that’s already placed into the tray. 

 Pick List:  Displays a list of packages you’ve selected from the 
package list.  These packages can be loaded into the tray.  The pick list 
also tracks the following information for each type of package:  
number of packages, length, width and height. 

 Tray Display Window:  Displays an image of the tray and allows you 
to drag packages into the tray. 

 Snap Toolbar:  Allows you to move the assortment of packages flush 
to any corner or side of the tray. 

 
In this exercise, we’ll create a mixed tray that consists of the followings: 

 6 Bottled Water  
 6 Bottled Soda 

The first step in this process is to create a new tray designed to hold these 
products.  We’ll design the tray based on a template designed in CASY.  
From the MixPro Tray Editor, follow these instructions: 
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Create a New Shipcase/Tray 
1. Click on the Shipcase button.  The Select ShipCase dialog box 

appears, as pictured below.  It displays the first shipcase style on the 
list as the default. 
 

 
2. From the Select Shipcase dialog box, click on the New button and the 

Define Shipcase dialog box appears, as pictured below. 
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3. To define a new shipcase, enter the dimensions as displayed in the 
picture below. 
 

 
 
Note:  The style Simple.tsc is created using the CASY Tray function 
covered in Chapter 8.  You can select any style found in the drop list 
for this exercise but keep the dimension at 16x12x15. 

4. After completing the new shipcase parameters, click on OK.  The 
Define Shipcase dialog box closes.  The Select Shipcase dialog box re-
appears with the parameters for the new tray. 

5. From the Select Shipcase dialog box, click on OK. 

MixPro saves the new tray to the database.  (MixPro saves the tray as 
a shipcase.)  The MixPro Tray Editor re-appears, as pictured below, 
with the new tray name (Tray 16x12x15) displayed next to the 
Shipcase button. 
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6. Look at the package list and decide which items you want to place into 
the tray.  To select an existing package from the list, double click on 
the package name or highlight the name and then click on Add button.  
The package will be added to the PickList. 
 
In this exercise, we want the mixed tray to include some bottled drinks 
which are not on the package list.  In this case, MixPro allows you to 
create new packages for these items, just like what we did earlier with 
the shipcase. 

Create A New Package  
From the MixPro Tray Editor as pictured above, click on the New 
button.  The Define Package Info dialog box appears, as pictured on 
the next page. 
 
In the Define Package Info dialog, you will select a package Style 
from the drop list (these styles are created using the C.A.S.Y. Primary 
Package described in Chapter 8) to be applied to this new package, 
provide a name and dimensions.  

7. Use the following fields to define Bottled Water.  If you want, you can 
also define a label for each package.   
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8. After completing the package dimensions, click on Save.  MixPro 
saves the new package to the database and refreshed the dialog for a 
second package input. 

9. Create a second package named Bottled Soda as pictured below: 
 

 
10. After completing the package dimensions, click on OK to save and 

leave the Define Package Info dialog.  MixPro saves the new package 
to the database and the MixPro Tray Editor reappears. 
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Add Packages to the Shipcase/Tray 
11. In order to place a package into the tray, you have to move it from the 

package list to the PickList.  To add Bottle Water and Bottle Soda to 
the list, highlight the selection in the package list and click on the Add 
button or double click on the package. 

12. The system inserts the selected items into the pick list.  A graphic of 
the selected package appears in the g.o.d. (graphic online display) 
window, located in upper left corner of the data display window, as 
pictured below. 
 

 
 
Note:  To change the orientation of the package, for example, position 
it on its side or on its end, click on the rotation button and select the 
new orientation from the pop-up menu. 

13. To load the item into the tray, click on the image of the item and drag 
it into the tray.  The system copies an image of the item to the tray 
area. 

Repeat this step until the tray contains six Bottle Water.  When you’ve 
done this, the screen will look similar to the one pictured on the next 
page. Note that the quantity is now 6 for Bottled Water in the PickList. 

Note:  For tips on placing packages into a tray, use the guidelines 
outlined at the end of this chapter. 
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14. Repeat the previous steps to place 6 Bottled Soda into the tray.  When 
you’re done, your tray will look similar to the tray pictured below. 
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Save the Mixed Tray 
15. If this tray is the way you want it, open the File menu and select the 

Save As option.  The Save As dialog box appears, as pictured below. 
 

 
16. Select a location where the file will be saved.  The default folder is 

under \TOPSAPPS\TOPSPRO\STYLE\.   In the File name field, enter 
the name of the mixed tray (Mixed Bottled Drinks). 

17. Click on the Save button.  MixPro saves the tray to the database. 

18. Exit MixPro Tray.  The Control Panel appears.  
 
The mixed tray created can now be used in the MixPro Pallet to create 
a display pallet. 

Use the Mixed Tray in Mixed Pallet 
19. From the Toolbar at the top of the Control Panel, click on the MixPro 

Mixed Pallet Editor icon and select MixPro Mixed Pallet Editor. 
 
Note that the new Mixed Bottled Drinks tray is already added to the 
list in addition to the Chocolate Bars, Peanut Bars and Corn Chips we 
defined earlier.  Note also the different icons next to the name of the 
shipcase. 
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20. To add the mixed tray (shipcase) to the pallet, select the Mixed Bottled 
Drinks shipcase and click on the Add button or double click on the 
package name. 

MixPro adds the tray (shipcase) to the PickList and displays a graphic 
of the tray (shipcase), as pictured below. 
 

 



 

Chapter 7:  MixPro Mixed Tray Editor 7-11 

21. Drag and drop the shipcases onto the pallet until the unitload is 
complete. 

Note:  For instructions on how to load shipcases onto a pallet, please 
refer to Chapter 6, MixPro Pallet. 

22. To display the contents of the shipcases, go to the Toolbar at the top of 
the MixPro Pallet Editor and click on the Show Contents icon . 

The MixPro Pallet Editor re-appears to show the contents of the 
package, as pictured below. 
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Direct Email From MixPro Tray 
MixPro Tray has an internal email feature that allows you to email a 
standard printout directly to another person who may or may not have 
TOPS Pro.  When you email a report or analysis to someone, TOPS Pro 
automatically attaches the appropriate files to a new email message using 
your default email application.  To use the direct email feature, follow 
these instructions: 

1. Work through the analysis to complete the Mixed Pallet as desired. 

2. Go to the File menu and select Load or other reports. 

3. Select if you’d like the report to be in color, black and white or just 
color outline.  Click on OK. 

4. When the report appears, click on the Email button. 

The system launches your default email application and prompts you 
to enter an address for the recipient, subject, etc., as you would for any 
normal email message.  TOPS Pro attaches the appropriate analysis 
files to the email message, then sends the message to the recipient. 

5. On the receiving end, the recipient must select all the attached files 
and save them to a common folder.  From there, the recipient can view 
the report or analysis through most any Web browser or Microsoft 
Word. 
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Tips for Working with Packages on a 
Tray 

 To add a second package to the tray, hold down the Shift key and click 
on the first package.  To place the second package on top of the first, 
Shift and click on top of the first package.  To place the second 
package to the side of the first, Shift and click on the side of the first 
package. 

 If you’ve loaded a column, row or layer of packages on the tray, you 
can add another column, row or layer with one click.  For example, to 
add a layer of packages, hold down the Shift key and click on the top 
of the first layer.  The system adds another layer on top of the first 
layer.  To remove a layer of packages, hold down the Alt and Shift 
keys simultaneously and click on the layer. 

 To remove (or delete) one or more packages from the tray, click on the 
package(s) and drag it off the backside of the tray (to the left).  The 
package(s) completely disappear from the display.   

To temporarily remove one or more packages from the tray – you want 
to load it back later – click on the package(s) and drag it off the 
frontside of the tray (to the right).  The package(s) remain in view on 
the display. 

 Right-click to display a small menu that allows you to position a 
package on the tray in a number of directions.  The first menu provides 
the following functions: 

 Hgt Vertical 
 Len Vertical 
 Wid Vertical 

 
For the height, length and width vertical functions, you have four 
additional functions: 

 Face Forward 
 Face Left 
 Face Back 
 Face Right 

 
Using these guidelines, continue to load packages until you’ve loaded 
as many spray bottles as you want into the tray. 
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Using MixPro Tray in the Design 
Sequence 
Users can now incorporate any MixTray into a Design Sequence which 
starts with the yellow Shipcase stage. 

 

When you click the yellow icon to define shipcase parameters, you will 
see the Mix Tray option in the dialog box. Clip the drop down button to 
specify any Mix Tray previously defined and place them onto pallets as in 
the MixPro Mixed Pallet Editor described earlier. 
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Chapter 8: Create A Shape 
Yourself (CASY) 

Introduction 
This chapter discusses the Create A Shape Yourself (CASY) system, 
which allows you to design custom-shaped bottles, cans, shipcases, trays, 
etc. not included in the standard TOPS Pro database.  This chapter 
discusses the CASY system in two sections:  CASY Primary Style and 
CASY Tray Style. 

CASY Primary Package  
The Create A Shape Yourself (CASY) system allows you to design a 
primary package (bottle, can, cup, etc.) that has a custom, non-standard 
shape.  You can use the CASY system to create a more realistic model of 
your product. 

Note:  The CASY system is designed for display purposes only.  You 
won’t use CASY to define dimensions for a new bottle, can, cup, etc.  The 
CASY system simply allows you to create a unique shape for a cylinder 
and see how it looks when packaged on a tray or shipper, etc. 

After you’ve designed a cylinder with CASY, you can give that unit a 
name and save it to the database.  As you work with an analysis in TOPS 
Pro – for example, a tray of soda cans – all your CASY-designed units are 
available in a drop-down list.  If you want to see your tray packaged with 
the custom-shaped cans, you can select the CASY-designed can from the 
list. 

To design a custom-shaped cylinder, click the CASY tool icon and 
select CASY Primary Style. You’ll work with the CASY Primary Package 
Screen, as pictured on the next page. 
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Notice that the CASY Primary Package Screen is divided into two primary 
sections: 

 Edit View Work Area:  This section, on the left side of the screen, 
allows you to start with a generic cylinder and create a distinctly 
shaped unit (bottle, can, cup, etc.). 

 Edit View Display Area:  This section, on the right side of the screen, 
displays the unit in adjustable 3-D as you manipulate its shape in the 
Edit View Work Area. 

In the Edit View Work area, notice the following features: 

 Work Unit:  This cylinder-shaped unit allows you to mark off 
sections in the unit.  (By default, the unit displays as a cylinder.  You 
can change its shape to an oval, rectangle or some other transitioned 
shape.)  For each section, you'll drag the marker toward or away from 
the center axis and thus begin to define the shape of the unit.  You'll 
use this click and drag technique to define all the various sections of 
the work unit. 

 Center Axis:  A dotted vertical line that runs from top to bottom 
through the center of the work unit.  The center axis allows you to 
offset a selected section of the work unit. 
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 Cell Size:  Defines the relative dimension, not the actual size, of the 
new shape being created. When this CASY shape is applied to a new 
package later on, it will be scaled to the exact size as defined by the 
user. 

 XLocation:  For a selected point on the left edge of the work unit, this 
represents the relative distance to the center axis. 

 YLocation:  For a selected point on the left edge of the work unit, this 
represents the relative distance to the bottom edge of the work unit. 

Note:  The X and YLocation measures are relative measures.  They don’t 
represent inches, millimeters, etc.  Rather, they represent relative distances 
between two points, the total of which is set on the right side of the screen 
(length, width and height). 

In the Edit View Display Area, notice the following features: 

 Display Unit:  This image evolves into a specific shape as you define 
the work unit.  The CASY system allows you to rotate the display unit 
backward, forward, left and right to view it from a number of angles. 

 Length:  The relative length of the display unit. 

 Width:  The relative width of the display unit. 

 Height:  The relative height of the display unit. 

Note:  The Length, Width and Height measures are relative measures.  
They don’t represent inches, millimeters, etc.  Rather, they represent 
relative length, width and height of the work unit – the hypothetical space 
you’re using to build this cylinder. 

Suppose you want to design a custom oil can that’s comprised of four 
sections:  a spout at the top of the can, the neck of the can, the body of the 
can and a wide base at the bottom of the can.  In addition, the spout will be 
positioned off-center, to one side of the can.  To design this oil can, start 
from the CASY Primary Package Screen and follow these instructions: 

1. In the work area, select the points on the left edge of the work unit by 
clicking on the edge.  This marks the four sections of the oil can. 

 The section from the first marker (top left corner of the work unit) 
to the second marker will represent the spout of the oil can. 

 The section from the second marker to the third marker will 
represent the neck of the oil can. 

 The section from the third marker to the fourth marker will 
represent the body of the oil can. 
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 The section from the fourth marker to the fifth marker (bottom left 
corner of the work unit) will represent the base of the oil can. 

When you’ve marked off the four sections, the work unit will look 
similar to the one pictured below. 

 

Notice that the display unit shows four clearly defined sections.  Also, 
notice that if you select one of the markers on the left edge of the work 
unit, the x- and y-Locations change accordingly to show you the 
relative distance of that point from the center and bottom axes. 

2. First, we’ll design the spout section of the oil can.  Click on the first 
marker, positioned on the top left corner of the work unit.   

Note:  Notice that the arrow converts to a crosshair symbol (+).  When 
the crosshair symbol appears, you can drag that marker to another 
position on the work unit. 

Drag the marker straight across the top edge of the unit to a position 
near the center axis.  In this exercise, we’ll drag the first marker to an 
x-Location of 0.4818; or type in this value for the x-Location.  This 
marks the top of the spout section.  This marker is flush to the top of 
the image, so the y-Location is 15.0. 

Next, click on the second marker, which marks the bottom of the spout 
section, and drag it straight across to a position near the center axis.  In 
this exercise, we’ll make the bottom of the spout slightly wider than 
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the top of the spout; the x-Location will be 0.9315; or type in this 
value for the x-Location.  The y-Location is 10.2141. 

3. Next, we’ll design the neck section of the oil can.  The second marker, 
which marks the bottom of the spout section, also marks the top part of 
the neck section.  The position of this marker will not change. 

Click on the third marker, which marks the bottom of the neck section, 
and drag it slightly to the right.  In this exercise, we’ll drag this marker 
to an x-Location of 3.6296.  The y-Location is 8.2227. 

4. Next, we’ll design the body section of the oil can.  The third marker, 
which marks the bottom of the neck section, also marks the top part of 
the body section.  The position of this marker will not change. 

Click on the fourth marker, which represents the bottom of the body 
section, and drag it slightly to the right, even with the third marker – 
an x-Location of 3.5690.  (There should be a perfectly straight, vertical 
line from the third marker to the fourth marker.)  The y-Location is 
0.5172. 

The bottom section of the unit, the base section of the oil can, is 
already set; it’s defined by the fourth and fifth markers.  (The fifth 
marker sits on the bottom left corner). 

When you’ve defined the five sections of the oil can, the work unit 
should look similar to the one pictured below. 
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5. Next, we’ll fine-tune the shapes of each section of the oil can.  The 
CASY system allows you to assign a specific shape – round, oval or 
rectangular – to an individual section.  In this exercise, we’ll go with 
the default shape (Round) for each section of the oil can. 

To assign a shape to the spout section, right-click on 
that section in the work unit.  A small menu appears, 
as pictured on the right. 
 
Select the Primary Shape option.  A submenu 
appears, as pictured below. 
 

 

Select the Round option. 

Repeat these steps for each section of the oil can.  When you’ve 
assigned the appropriate shapes to the four sections of the oil can, the 
can should look like the one pictured below. 
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6. Next, we'll position the spout off-center, flush to the right side of the 
oil can.  In the above figure, notice that each section of the work unit 
has a marker that sits on the center axis line.   

To move a section off-center, click on the center marker for that 
section and drag it off-center.  In this exercise, we’ll click on the 
center marker for the spout section and drag it to the right, as pictured 
below. 
 

 

7. Notice that in previous figure, there’s a disjointed space where the 
spout section meets the neck section of the can; it needs a smoother 
transition.  CASY provides a feature that allows you to smoothly 
transition from one section to another when one section is off-center. 

Right-click in the neck (second) section on the work unit and the small 
menu appears. 

Select the Primary Shape option.  At the submenu which appears, 
select the TransTop option. 
 
The work unit redisplays with the spout and neck sections of the can 
joined seamlessly together, as pictured on the next page. 
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Note:  The TransTop option transitions the top of the selected section 
to conform to the bottom of the adjoining section.  Likewise, the 
TransBottom option transitions the bottom of a section to conform to 
the top of the adjoining section.  The TransTop and TransBottom 
options are active only when you’re working with an off-center 
section. 

CASY provides two other transition features that you should be aware 
of.  The TransRect option gives the selected section a round bottom 
that transitions to a rectangular top.  Likewise, the TransRound option 
gives the selected section a rectangular bottom that transitions to a 
round top. 

8. Next, we’ll assign colors to the five sections of the oil can.  In this 
exercise, we’ll make the spout gray, the neck and body sections red, 
and the base black.   

Right-click in the spout section of the work unit, 
the small menu appears.  Select the Color option. 
A color palette appears, as pictured on the right, 
and prompts you to select a color. 

Select gray and click on OK.  The color palette 
closes and the display unit on the screen 
redisplays with the spout colored gray.  Repeat 
these steps and assign a color to each section of 
the work unit.   
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9. CASY also allows you to select and insert a bitmap onto individual 
sections of the primary package.  To insert a bitmap onto a section, 
right-click on that section. 

The small menu appears, select the Insert Bitmap option.  A dialog box 
appears with a list of bitmap files, as pictured below. 

 
 
Select the bitmap file you want to insert and click on the Open button. 

The system inserts the bitmap onto the selected section of the oil can.  
You can resize the bitmap as you like and drag it any position on the 
selected section. 

10. When you’re satisfied with all the elements of the custom-shaped 
primary package, save the new shape by going to the File menu and 
select Save As. 
 

 

The new shape will now be available in the C.A.S.Y. Style drop list of 
primary packages.  Note that this is a shape function only, the actual look 
of the can depends on the dimension of the primary package as defined in 
the Parameters dialog box.  Make sure also the Show CASY function  
is enabled in order to view the applied shape. 
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Other Primary Package Shape Functions 
In addition to applying bitmapped graphics, color and primary shape 
functions, the C.A.S.Y. functions also include the following: 

 Handle:  Select from Round or Rectangular handle as well as 
locations of left, right or vertical as pictured below. 
 

 Horizontal Right (mug) 
 

 Rectangular Left (pitcher) 
 

 Rectangular Vertical (canister) 

 Shape Function:  Select from pinch top, pinch bottom. 
 

   Pinch bottom (toothpaste) 
 

 Pinch top (lotion) 
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CASY Shipcase/Tray 
The Create A Shape Yourself (CASY) system allows you to design and 
build a shipcase or tray that has a custom, non-standard shape.  You can 
use CASY Shipcase/Tray to create more realistic trays and boxes. 

Note:  The CASY system is designed for display purposes only.  You 
won’t use CASY to define the dimensions of a shipcase or tray.  The 
CASY system simply allows you to create a unique shape for a shipcase or 
tray and see how it looks when loaded onto a pallet, etc. 

After you’ve designed a shipcase or tray with CASY, you can give that 
unit a name and save it to the database.  As you work with an analysis in 
TOPS Pro – for example, a tray of soda cans – all your CASY-designed 
units are available in a drop-down list.  If you want to see a pallet loaded 
with the custom-shaped shipcases, you can select the CASY-designed 
shipcase from the list. 

To design a custom-shaped shipcase or tray, you’ll work with the CASY 
Shipcase/Tray Screen, as pictured below. 

 

Notice that the CASY Shipcase/Tray Screen is divided into two primary 
sections: 

 Edit View Work Area:  This section, on the left side of the screen, 
allows you to start with a generic box and create a distinctly shaped 
unit (shipcase or tray). 
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 Edit View Display Area:  This section, on the right side of the screen, 
displays the unit as you manipulate its shape in the Edit View Work 
Area. 

In the Edit View Work area, notice the following features: 

 Work Unit:  This box-shaped unit allows you to click on any point on 
the top edge of the unit, drag it downward and form openings that give 
the unit its shape. 

 Cell Size:  Defines the relative dimension, not the actual size, of the 
new shipcase or tray being created. When this CASY shape is applied 
to a new shipper later on, it will be scaled to the exact size as defined 
by the user. 

 XLocation:  For a selected point on the top edge of the work unit, this 
represents the relative distance to the right edge or the unit. 

 YLocation:  For a selected point on the top edge of the work unit, this 
represents the relative distance to the bottom edge of the work unit. 

Note:  The X and YLocation measures are relative measures.  They don’t 
represent inches, millimeters, etc.  Rather, they represent relative distances 
between two points. 

In the Edit View Display Area, notice the following features: 

 Display Unit:  This image evolves into a specific shape as you define 
the shape with the work unit.  The CASY system allows you to rotate 
the display unit backward, forward, left and right to view it from a 
number of angles. 

 Length:  The relative length of the display unit. 

 Width:  The relative width of the display unit. 

 Height:  The relative height of the display unit. 

Note:  The Length, Width and Height measures are relative measures.  
They don’t represent inches, millimeters, etc.  Rather, they represent 
relative length, width and height of the work unit – the hypothetical space 
you’re using to build this shape. 

Also, notice the six large icons at the top of the screen, just below the 
button bar.  The Front, Back, Left and Right icons allow you to work 
with the corresponding areas of the work unit.  For example, you can 
choose to work with the front side of the tray, back side, left side or right 
side. 

Note:  The Top and Bottom icons are not currently active. 
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In this exercise, we’ll design a shipcase for bleach bottles.  We want the 
bleach brand label to be clearly visible as the bottles sit in the case, so 
we’ll design the case with a large display window in the front and back 
sides.  Also, the shipcase needs handles (holes) in the left and right sides 
of the case. 

To design a shipcase that meets these specifications, follow these 
instructions: 

1. When the CASY Shipcase/Tray Screen opens, the front side of the unit 
is active by default, so we’ll work with that side first.  The front needs 
six markers along its top edge, which we’ll use to design the display 
window.  The top left and top right corners serve as two of the 
markers.   

Click on the top edge of the shipcase to insert the other four markers.  
Position these four markers as follows:   

 Marker 2:  XLocation = 1.0538 
 Marker 3:  XLocation = 2.2094 
 Marker 4:  XLocation = 7.7500 
 Marker 5:  XLocation = 8.9222 

Note:  These markers are for relative positioning only and there is no 
need to be exact. 

The work unit, with six markers across the top edge, should look like 
the one pictured below. 

 



 

8-14 TOPS Pro (Version 6.50) User Guide 

2. For markers 3 and 4, drag the markers downward to a YLocation of 
1.9371.  When you’ve moved these markers into the right positions, 
the work unit should look like the one pictured below. 
 

 

3. Now that the display window on the front side of the 
shipcase is complete. 

4. To create a similar cut out on the back side, right-click 
inside the work unit.  A small menu appears, as pictured 
on the right.   

5. Select Mirror to duplicate the same cut out on the back 
side of the box. 

6. On the left and right sides of the case, we want to create 
holes to serve as handles for the shipcase.  To create a 
hole in the left side of the shipcase, click on the Left 
icon on the Toolbar.  The CASY Shipcase/Tray Screen 
redisplays with work unit representing the left side of 
the case. 

7. Right-click inside the work unit and select the Insert Hole option.  The 
system inserts a box, which represents the hole, on the face of the 
work unit.  This box has markers that allow you to expand the box to 
the right, left, up and down.  You can also drag the box to any position 
on the work unit you want. 
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Resize the box (hole) to the appropriate size and move it near the top 
edge of the work unit.  The left side of the shipcase should look similar 
to the one pictured below. 
 

 

8. Now that the hole on the left side of the shipcase is complete, repeat 
the same process to design a hole for the right side or use the Mirror 
function to make sure the hole is created at the identical location on 
the opposite side. 

9. CASY allows you to select and insert a bitmap onto any side of the 
shipcase.  To insert a bitmap, select a side (front, back, left or right) to 
make it active. 

Right-click inside the work unit and select the Insert Bitmap option.  A 
dialog box appears with a list of bitmap files, as pictured below. 
 

 

Select the bitmap file you want to insert and click on the Open button. 
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The system inserts the selected bitmap onto the active side of the 
shipcase.  You can resize the bitmap as you like and drag it to any 
position on the active side.  

In this exercise, we’ll insert a TOPS bitmap on the left and right sides 
of the shipcase.  After all the design elements are complete, the 
shipcase should look similar to the one pictured below. 
 

 

10. To save this new shipcase/tray, go to the File menu and select Save 
As.  A dialog appears, enter a name for the tray, for example, Tops 
Display Tote as pictured below and click on Save. 
 

 

TOPS will save this new tray in the database.  To use this tray as a 
shipcase, select “Tops Display Tote” in the drop list from the C.A.S.Y. 
Style field.  Make sure the Show CASY function  is enabled. 
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Chapter 9: Stacking Strength 

Introduction 
As a packaging professional, you'll routinely need to calculate the stacking 
strength of your shipping cases.  The TOPS Pro software uses the McKee 
formula to calculate the stacking strength of a regular slotted container 
(RSC).  This chapter covers the stacking strength function, including the 
following topics: 

 The McKee formula 
 Edge crush test (ECT) 
 Ring crush test (RCT) 
 Calculate stacking strength 
 Stacking strength results 
 Email board combo list 
 Configuration default settings 

 

The McKee Formula 
The McKee formula uses two laboratory tests performed on board 
components – the edge crush test (ECT) and/or the ring crush test (RCT) – 
to derive a box compression strength value.  TOPS Pro adjusts this 
compression strength value (lab compression) with a variety of 
environmental and structural factors to calculate a box performance value. 

 
Important Note 

 

 Even though the McKee formula is a generally 
accepted design formula, the packaging engineer is 
ultimately responsible to evaluate the degree to which 
this formula might apply and perform the physical 
tests to assure safety. 
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The McKee formula is defined as follows:   

(FC) × (ECT) × (BP).4924 × (Caliper).5076 

Lab Compression = [(FC) × (ECT) × (BP).4924 × (Caliper).5076] × (Shape 
Factor) × (Length-to-Width Ratio Factor) × (Horizontal Flute Factor) × 
(Printing Factor) 

Box Performance = (Lab Compression) × (Flap Gap Factor) × (Humidity 
Factor) × (Storage Time Factor) × (Pallet Spacing Factor) × (Interlock 
Factor) × (Overhang Factor) + (Product Support) 

The abbreviated components in the formula are outlined below: 

 FC = Flute Constant (5.87) 

 ECT = Edge Crush Test 

 BP = Box Perimeter 

 Overhang Factor = 1 – [minimum of (square root of overhang) x 
32.25 ÷ 100, 1] 

Note:  The next three values – Horizontal Flute Factor, Shape Factor and 
Printing Factor – are defined and adjusted in the TOPS Configuration 
program.  For more information, please refer to Chapter 14, Configuration. 

 Horizontal Flute Factor (HFF) = 1, unless non-vertical flute is 
selected.  If non-vertical flute is selected, TOPS Pro looks at HFF for 
the specific board grade.  However, there is no generally accepted 
industry standard for how much a non-vertical flute's compression will 
degrade.  TOPS Pro currently ships with a HFF of 0.9 for a 10 percent 
reduction. 

Note:  To adjust HFF, open the Definitions menu and select Board 
Combinations. 

 Shape Factor = Table lookup based on the proportions of the box – 
relative to box depth – and dimension vertical.  To adjust the shape 
factor, open the Definitions menu and select Box Design Factors. 

 Printing Factor = Table lookup based on printing type and quantity.  
To adjust the printing factor, open the Definitions menu and select Box 
Design Factors. 

 Product Support = Additional support to the overall stacking strength 
provided by the products inside the shipcase. 
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For all other factors, TOPS Pro looks up the value in the table of 
environmental factors, in the Configuration program.  Other factors, which 
the McKee formula does not account for, include rough handling, 
transportation conditions, workers sitting on the box, die cuts, adhesive 
additives, etc. 

Edge Crush Test 
Box compression strength is a matter of structural mechanics.  
Engineering formulas have been developed using various relationships to 
predict compression strength.  The general formula used here predicts Box 
Compression Test (BCT) value as related to Edge Crush Test (ECT), 
Flexural Rigidity and box perimeter. 

Edge Crush Test, also known as Short Column Test, is measured as the 
pounds of force per inch needed to crush a portion of the sidewall of 
combined corrugated board.  Although not the sole criterion for box 
performance, ECT values are an excellent indicator of Box Compression 
Test values and box performance in most of today's applications. 

Ring Crush Test 
The Ring Crush Test (RCT) measures paper strength – specifically 
stiffness.  RCT has been widely used and has a history of more than 20 
years of data correlated to combined board strength (ECT). 

In the RCT, a strip of paper is placed into a jig that curls it into a short, 
tubular ring.  Pressure is then applied perpendicular to the exposed edge.  
Ring Crush is measured as the pounds of force required to crush this 
specimen.  This value has a direct relationship to predicting Edge Crush 
values of the combined board and, ultimately, box compression strength. 

Due to industry-wide improvements in the paper-making process, industry 
average RCT values have gradually increased for a given Basis Weight 
over the years.  However, across the industry, there is substantial variation 
in Ring Crush for a given Basis Weight – from different paper mills, even 
from different paper machines within the same mill. 

"High Ring Crush" or "High Performance" linerboard and medium are 
well above the industry average, at the upper end of the industry 
variability range for a given Basis Weight.  Generally, these papers are 
more tightly pressed – thinner/denser/less porous – than those at the 
average or lower end of the range, which gives paper greater strength per 
pound. 
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Calculate Stacking Strength 
In this exercise, you'll perform a shipcase-to-pallet analysis first, then 
calculate the stacking strength.  To calculate stacking strength, start from 
the Control Panel and follow these instructions: 

1. Perform a shipcase-to-pallet analysis and calculate solutions. 

2. At the Analysis View, click on the Strength button on one of the 
panels.  As an option, you can open the Tools menu and select 
Stacking Strength. 

The Stacking Strength dialog box appears, as pictured below. 

 

 
Notice that the dialog box is complete with pre-defined shipcase and 
pallet parameters, which are grayed out (you can't change them). 
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3. At this point, you'll need to make decisions regarding the following 
parameters: 

Note:  Some of these parameters are pulled from the Environment 
Factors dialog box in the TOPS Configuration program.  This dialog 
box is pictured on page 9.7 for easy reference. 

 Storage Time:  Select the target storage time for the unitloads – 
the period of time you expect the unitloads to be stored in a 
warehouse; for example, three months. 

 Humidity:  Enter the humidity percentage that exists in the 
warehouse.  The default is 50 percent; a typical humidity factor is 
85 percent. 

 # of Loads High:  Enter the target number of pallets high the 
unitload can be stacked in the warehouse. 

 Rotation:  Select the rotation to be used for the unitloads.  Use 
these guidelines: 

If the unitloads are columnar (non-interlocked), select None.  This 
rotation yields no degradation in stacking strength. 

If the unitloads are fully interlocked, select All.  This rotation 
yields a 30 percent degradation in stacking strength. 

If the unitloads are partially interlocked – for example, only the top 
two layers – select Some.  This rotation yields a 15 percent 
degradation in stacking strength. 

 Footprint Factor:  If you have multiple unitloads and not all 
shipcases help support the unitload above, specify how many 
shipcases do help support.  Lowering this number reduces the 
number of bottom-most cases that help support the above unitload. 

 Amount of Printing:  Select the amount of printing on the 
shipcases – usually Simple. 

 Type of Printing:  Select the type of printing on the shipcases – 
usually Flexo. 

 High Light:  Select either Color or None to specify whether you 
want the next screen and printouts to appear in color.  If you only 
want to print, select None.   

Note:  This has no bearing on stacking strength. 
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 Calculation Method:  Select the method used to calculate 
stacking strength.  Use these guidelines: 

The Ring Crush method looks up the ring crush values of the 
board combination's liners and mediums, then calculates the edge 
crush test (ECT) value from those values. 

The Edge Crush method uses the exact ECT value typed in for 
each board combination. 

The Kellicut method is an internationally recognized way to 
calculate stacking strength. 

 Dividers:  The Dividers button displays the Dividers dialog box, 
which displays information entered from the ShipCase Parameters 
dialog box.  Use the Dividers dialog box to change the dividers 
parameters. 

Dividers provide a significant increase in stacking strength of your 
shipcases.  For example, a 12-cell divider – if it's made of the same 
cardboard as the shipcase –increases stacking strength by 108 
percent. 

 Options:  The Options button displays the Stacking Strength 
Options dialog box, which allows you to specify which columns of 
information will appear on the Stacking Strength Results report by 
selecting from a listing of board grades. 

For detailed information about the Stacking Strength Options 
dialog box, please refer to Appendix B, Dialog Boxes. 

4. After completing the stacking strength parameters, click on OK.  The 
Stacking Strength Results Screen appears, as pictured on page 9.8. 

5. If you want to print the list of stacking strength options, open the File 
menu, select Print, then select Stack Strength List.  TOPS Pro sends 
the list of stacking strength options to the printer. 

6. If you want to print all the board combinations in the software, open 
the File menu, select Print Database, then select Stacking Strength.  
TOPS Pro sends the list of board combinations to the printer. 
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Environment Factors Dialog Box 
The Environment Factors dialog box, pictured below, allows you to assign 
numeric safety factors to a range of environmental factors.  TOPS Pro uses 
environmental factors to calculate stacking strength. 

Note:  The Environment Factors dialog box is accessed from the TOPS 
Pro Configuration program.   

 

For detailed information about the Environment Factors dialog box, please 
refer to Appendix B, Dialog Boxes. 
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Stacking Strength Results 
Once you've calculated a stacking strength analysis, TOPS Pro displays 
the Stacking Strength Results Screen, as pictured below.  This screen is 
divided into two panes: 

 Stacking Strength Statistics Pane:  This information includes any 
added data related to the stacking strength option and your package 
design. 

 Stacking Strength List Pane:  This pane, the lower section of the 
screen, displays a number of columns that represent the board grades 
selected from the Stacking Strength Options dialog box.  The default 
set of columns is represented in the figure below. 
 

 
 

                         A       B                   C   D   E    F    G   H     I   J    K 
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The Stacking Strength Results Screen provides the following stacking 
strength information: 

 (A) At 2 Loads High, bottom case must support 84.33 lbs:  Amount 
of weight that must be supported by a box on the bottom layer of the 
bottom pallet. 

 (B) Board Spacing:  Also known as pallet spacing.  Use these 
guidelines: 

 If this value is less than 0.1 inch, you have tight pallet spacing. 

 If this value is greater than 0.1 inch and less than 3 inches, you 
have normal pallet spacing. 

 If this value is greater than or equal to 3 inches, you have wide 
pallet spacing. 

Note:  The stacking strength factors associated with pallet spacing are 
defined on the Environment Factors dialog box, pictured on page 9.7. 

 (C) Lab Div:  Lab Compression of the divider.  This column appears 
only if you've specified a divider.  To define new dividers, open the 
Definitions menu and select Dividers.  Each divider has a support 
factor that determines the amount of additional support added by the 
divider.  (A support factor of one (1) = no change.) 

 (D) Lab Box:  Lab Compression of the box without the divider.  This 
column appears only if you've specified a divider. 

 (E) Total Lab:  Total Lab Compression.  If you've defined a divider, 
this value is the sum of the divider compression and box lab 
compression; i.e., Total Lab Compression = Lab Compression of the 
divider + Lab Compression of the box without the divider. 

 (F) Box Perf:  Box Performance.  The resulting compression strength, 
which takes into account the environmental conditions you've 
specified. 

 (G) Safety Factor:  Total Lab divided by the weight that must be 
supported by the bottom case. 

 (H) Safety Margin:  The percentage that the box performance exceeds 
the weight that must be supported by the bottom case; i.e., G = (F – A) 
÷ A.  Boards with Safety Margins that are greater than zero are 
highlighted in blue. 
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 (I) Loads High:  How many unit loads it takes to reach the limit (box 
performance) of a bottom-most case. 

 (J) ECT lbs/in:  The ECT of the board.  If the calculation method is 
Edge Crush, this value is the empirical value entered for each board in 
the TOPS Configuration program.  If the calculation is Ring Crush, 
TOPS will calculate the ECT from the Ring Crush Factor (RCF) of 
each board's papers. 

 (K) Cost/1000ft2:  The cost per 1000 square feet as entered into the 
board grade database. 

Now that you've calculated stacking strength options for your analysis, 
you're ready to narrow down the list of options and select the one that best 
meets your needs.  Follow these instructions: 

1. Analyze the list of options and decide how you want to narrow the list.  
For example, you might want to narrow the list to show all options that 
have a safety factor of 4-7 and a compression strength of 550-665. 

2. Click on the Filter button.  The Stacking Strength Filter dialog box 
appears.  Enter the limiting values for Compression Strength and 
Safety Factor as pictured below. 
 

 
Note:  Compression is the recommended filter method because it's the 
most fine-tuned.  For more information about the Safety Strength 
Filter dialog box, please refer to Appendix B, Dialog Boxes. 

3. After completing the filter criteria, click on OK. 

TOPS Pro identifies all options that match your filter criteria, then 
redisplays the Stacking Strength Results Screen, as pictured below.  
The options that match your criteria are displayed in blue; the options 
that do not match are displayed in black. 
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Notice that TOPS Pro has filtered the list of solutions from 421 down 
to five. 

4. To sort the options by a specific criteria, open the Sort menu and select 
a sort option:  Name, Lab Compression, ECT, Cost or Reverse Order. 

TOPS Pro redisplays the Stacking Strength Results Screen with the 
options sorted according to the selected sort option. 

5. After you've selected a solution, print the output. 

Note:  At this time, there is no way to limit the number of columns 
printed or displayed. 
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Stacking Strength Results – Menu 
Options 
The Stacking Strength Results Screen features a menu bar with the 
following menus: 

 File Menu 
 Sort Menu 
 Tools Menu 
 Supervisor Menu 
 Help Menu 

The File, Supervisor and Help menus are identical to the File, Supervisor 
and Help menus that appear on the Control Panel’s menu bar.  For more 
information on these menus, please refer to Appendix C, Menu Options. 

Sort Menu 
The Sort menu provides the following options: 

 Name 
 Lab Compression 
 ECT 
 Cost 
 Reverse Order 

 
The Sort menu allows you to sort stacking strength results by name, lab 
compression, ECT, cost and reverse order. 

To use the Sort function, start from the Stacking Strength Results Screen 
and select a Sort option (for example, ECT).  The Stacking Strength List 
Pane redisplays with the stacking strength results sorted based on the 
selected option. 
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Tools Menu 
The Tools menu provides the following options: 

 Email Stacking Strength 
 Select As Primary Boardgrade 

Note:  The Select As Primary Boardgrade option is not currently active. 

The Email Stacking Strength option allows you to email the Stacking 
Strength Board Combo List to other users.  This function is discussed in 
the next section. 

Email Stacking Strength Combo Board List 
After you’ve calculated stacking strength results, TOPS Pro allows you to 
email the Stacking Strength Board Combo List to other users.  To use this 
feature, start from the Stacking Strength Results Screen and follow these 
instructions: 

1. Go to the Windows Toolbar and open the Tools Menu. 

2. Select the Email Stacking Strength option.  TOPS Pro automatically 
launches your email application, converts the Stacking Strength Board 
Combo List to an HTML file as pictured below and attaches it to the 
email. 
 

 

3. Send the email to the appropriate users.  TOPS Pro closes the email 
application and returns you to the Stacking Strength Results Screen. 
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Define Stacking Strength Factor for a 
Non-RSC Box 
When defining parameters for a new, non-RSC box, TOPS Pro includes a 
feature that defines stacking strength in relation to an RSC box.  For 
example, you can define stacking strength for the non-RSC box as 80 
percent or 120 percent of the stacking strength of an RSC box.  To use this 
feature, follow these instructions: 

1. Go to the Menu Bar and open the Define Menu. 

2. From the Define Menu, select the Box Styles option.  The Case Styles 
dialog box appears, as pictured below. 
 

 

 
3. In the Strength Factor field, enter a stacking strength factor as a 

percentage.  For example, if stacking strength for this box is 90 percent 
compared to that of an RSC box, enter 90.00. 

4. Complete the remaining fields to define the new box. 

5. After defining the new box parameters, click on the OK button. 

TOPS Pro saves the new box, including stacking strength factor, to the 
database. 
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Configuration Default Settings 
The TOPS Configuration program allows you to define defaults for the 
various stacking strength variables used in the system, including the 
following: 

 Board Combinations:  Adjusts board grades, including changing, 
deleting or marking them unavailable.  Use this option to adjust a 
board's ECT or cost per 1,000 square feet. 

 Flutes:  Adjusts base flutes, such as the default thickness or flute 
constant. 

 Environmental Factors:  Adjusts humidity, storage time, interlock 
and pallet spacing lookup values. 

 Paper:  Adjusts paper ring crush values. 

 Dividers:  Adjusts divider definitions, which reside in the primary 
TOPSWIN program. 

For more information about defining stacking strength default values, 
please refer to Chapter 14, Configuration. 
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QStrength: Quick Strength Reports 
The QStrength function allows users to determine the ECT value and 
minimal strength requirements for a shipcase’s board combination, 
without needing to know the actual papers or board combination 
possibilities. 

TOPS will calculate the weight to be supported and users can provide their 
desired Safety Factor range. Based on this information, TOPS can now 
provide the minimal requirements for the shipcase in total pounds that 
must be supported, and a range of acceptable ECT values. With this 
information, a corrugate provider can then look at what board 
combinations in their stock meet these requirements. 

To access the QStrength report, please follow these steps:  

1. Create a design sequence of  

2. Enter the dimension of the shipcase at the Shipcase Parameters dialog 
box and make sure it has a defined gross weight. 

3. Select the pallet to be used in the Unitload Parameters dialog box and 
specify any height and overhang requirements. 

4. Click Calc to view the solutions. 
 

 
5. In the UnitLoad view, click on the Strength button and select 

QStrength. 
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QStrength Report 

  
QStrength report showing required support / shipcase 

 
QStrength report showing ECT value for each board  
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 # of Loads High:  Enter the target number of pallets high the unitload 
can be stacked in the warehouse. 

 Prod Sup:  Additional support to the overall stacking strength 
provided by the products inside the shipcase. If present, the required 
support from each shipcase will be less. 

 Safety Factor:  Enter the desired range for safety factor. This is the 
Total Lab divided by the weight that must be supported by the bottom 
case.  

 Req. Support/Case:  Based on the safety factor range provided, these 
fields show the minimal weights the shipcase must be able to support. 

 ECT:  Based on the safety factor range provided, these fields show the 
minimal ECT values that will be required from the corrugate 
provider’s board combinations.  

 Y-Axis: The graph can be toggled to report required pounds per 
shipcase, or required ECT value per shipcase. 

For more information about defining stacking strength default values, 
please refer to Chapter 14, Configuration. 
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Chapter 10: Package Profile 

Introduction 
This chapter discusses the package profile, which allows you to create a 
profile for a complete package analysis, sometimes called a cube 
specification.  The package profile is designed for situations where many 
products use the same packaging.  For example, if you package cereal, you 
can use the same box for several different brands of cereal. 

Create a Package Profile 
In this example, we will create a packaging solution for 8 oz bags of 
potato chips. The same package information will be used for 3 different 
variations: original, cheddar cheese and BBQ flavor.  To create a package 
profile, follow these instructions: 

1. Complete an 8 oz chip package analysis and save it to the database.   
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2. Open the File menu and select Package Profile.  The Package Profile 
dialog box appears.  Create a new Package Profile called Potato Chips 
8oz Bag as pictured below.  
 

 
 
The Package Profile dialog box allows you to add individual products 
to the package profile.  Each product will appear on the profile by 
name, UPC, product code, declared weight and calculated gross 
unitload weight. 

 Pallet Spec:  Enter the specification number for the pallet style.  
By default, TOPS Pro suggests a unique spec ID. 

 Description:  Enter a description of the package profile being 
created. 

 Date:  Enter the current date to specify when the package profile 
was created. 

 Customer Name: Enter the name for the customer if desired. 

 Product Name:  Select a product name associated with the 
package profile or type in the first few letters of the product. 

Note:  The drop-down list displays products that have been added 
to this profile.  You'll use this field to edit or delete a product. 

 Master Number:  Enter the master number associated with the 
package profile. 

Note:  You can use this field for any numeric value.  To rename 
the field, use the Text Modification dialog box.  For more 
information, please refer to Appendix B, Dialog Boxes. 

 Retail Display Base:  This is a reserved key. 

 Clamp Direction:  Select the clamp direction associated with the 
package profile, if applicable. 



 

Chapter 10:  Package Profile 10-3 

Note:  The printout will show clampability arrows on the unitload 
according to your input here.  Unlike the clampable option on the 
UnitLoad Options dialog box, the clamp direction does not affect 
the calculations. 

 Warehouse Stack Hgt:  Enter the maximum stacking height for 
your warehouse. 

Note:  Like the Master Number field, you can use this field for any 
numeric value by renaming it via the Tools/Language function. 

 Comments:  Enter the text of any comments that are relevant to 
the package profile. 

3. After completing the package profile parameters, click on OK and 
TOPS Pro returns you to the Control Panel. 

4. Open the File menu, select Print Preview, then Package Profile.  The 
Package Profile Specification Screen appears, as pictured below. 
 

 
5. Click on the Zoom button.  TOPS Pro magnifies the Package Profile 

Specification Screen in Zoom mode. 
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6. Study the screen to make sure everything is as you want it.  Make 
annotations and add graphics as necessary. 

7. After completing any annotations or graphics, click on the Close 
button.  TOPS Pro takes you out of the Print Preview mode and back 
to the preceding screen. 

8. Save your work to the database. 

 

Add a Product to the Package Profile 
To add a product to the package profile, start from the Package Profile 
dialog box and follow these instructions: 

1. Go to the File menu and select Package Profile. 

2. The Package Profile dialog with the description Potato Chips created 
earlier appears. 
 

 
 

3. Click on the Add Product button.  The Specification Products dialog 
box appears, as pictured on the next page. 
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The Specification Products dialog box allows you to (1) add a product 
to the package profile or (2) define parameters for a new product to be 
added to the Product Name drop-down list. 

Note:  For detailed information about the Specification Products 
dialog box, please refer to Appendix B, Dialog Boxes. 

4. If the product you want to add is not on the list, you can add it to the 
database by clicking on the New Product button.  The Define Product 
dialog box appears. 

5. Add a new Product Chips Original as pictured below. 
 

 
Note:  For detailed information about the Define Product dialog box, 
please refer to Appendix B, Dialog Boxes. 

6. After completing the Define Product dialog box, click on Save. TOPS 
Pro saves your new product parameters to the database. 

7. Add Chips Cheddar and Chips BBQ in the Define Product dialog box 
as pictured on the next page and click on Save to save the new 
products to the database. 
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8. After defining all new products, click on Close to return to the 

Specification Products dialog box. 

9. The last product added, Chips BBQ will appear in the Specifications 
Products dialog, click on OK to add this to the Package Profile as 
pictured below. 
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10. To add the other two chips to the Package Profile, click on the Add 
Product button to open the Specification Products dialog box.  Click 
the drop-down list to select Chips Cheddar as pictured below and click 
on OK to add the product to the profile. 
 

 
 

11. Repeat step 9 to add Chips Original to the profile.  

12. When you are back at the Package Profile, click on the Product Name 
as pictured below and you’ll see all three chip variations are added to 
the profile. 
 

 
13. Click OK to close the Package Profile dialog box.  TOPS Pro saves the 

new package profile to the database. 
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Edit a Product in the Package Profile 
This feature allows you to select and edit a product in the package profile.  
To edit a product, start from the Package Profile dialog box and follow 
these instructions: 

1. The current Package Profile “Potato Chips 8oz Bad” will be opened 
with 3 chips variations already added.  

2. To edit Chip BBQ, select it under the Product Name drop-down list 
and click on the Edit button. 

3. Enter more details or make necessary changes for the Chips BBQ as 
pictured below and click on OK to save. 
 

 
4. TOPS Pro saves your changes to the database and redisplays the 

Package Profile dialog box. Click OK to close the Package Profile 
dialog box. 

5. Go to the Print menu and select Print Preview and then Package 
Profile. 

6. The new report will now include the 3 chip variations together with 
the declared and case weights for Chip BBQ updated as pictured on 
the next page.  
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Remove a Product from the Package 
Profile 
This feature allows you to select and remove a product from the pallet 
specification in the package profile.  To remove a product, start from the 
Package Profile dialog box and follow these instructions: 

1. Use the Product Name drop-down list to select the product you want to 
remove. 

2. Click on the Remove Product button.  TOPS Pro asks this question:  
"Remove product "XXX" from Pallet Specification?" 

3. To remove the product from the package profile, click on OK.  TOPS 
Pro removes the product from the package profile and updates the 
database. 
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Chapter 11: Reports and Printing 

Introduction 
TOPS Pro provides a lot of flexibility in the way you design and print 
analysis output.  When you've completed an analysis and decided on a 
solution, TOPS Pro allows you to print a hard copy of the information that 
went into the analysis.  For a package profile and pallet report, TOPS Pro 
allows you to print a pre-defined report. 

You can use the Print function under the File menu to send the report 
directly to the printer.  It is recommended to use the Print Preview 
function under the File menu to design the layout and preview the output 
before sending it to the printer or other formats like JJEG or PDF. 

This chapter walks you through the following print features and functions: 

 Print Preview for an analysis, including how to define print parameters 
 Print Preview for a package profile 
 Add text to Print Preview 
 Add a graphic image to Print Preview 
 Edit a graphic image in Print Preview 
 The Quick Print feature 
 The Pallet Report feature 
 The Combined Report feature 
 Printer width 

Print Preview – Analysis 
After you’ve selected a solution for an analysis, you're ready to print the 
output of that analysis.  This section explains how to design the layout of 
the printout, then define the type of information to be included and how 
present that information (different graphical views, text and numbers, 
etc.). 

In this example, we'll open an existing sample analysis from the TOPS Pro 
software and design the printed output to have the following 
characteristics: 

 The output will have a 5-Way Down page layout. 

 The heading will read "Print Example". 
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 The five areas of the printout will show graphics of the primary 
package, intermediate package 3D view, shipcase 3D view, unitload 
3D view plus the statistics for the unitload. 

 The bottom of the printout will show text “Shrink-wrapped 6-pack 
bottle water”. 

To start, follow these steps: 

1. Go to the Menu Bar and open the File menu, select Open and highlight 
“Water Bottles” at the bottom of the Analyses in Main Folder and 
click on Open. 

2. The analysis with a previously saved solution will be opened and 
displayed in the analysis view as pictured below. 
 

 
 
Note: If your screen layout is different from what is displayed here, 
please change it by going to the toolbar, select View Menu and then 
Split screen. 

3. To preview a report, go to the File menu, select Print Preview, then 
select Analysis. The Print Parameters dialog box appears. 
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Define Print Parameters 
The Print Parameters dialog allows you to design the layout of the output, 
what type of information will be included, etc. 
 
Enter the print parameters as described earlier and click on OK to generate 
the preview of the color report as pictured on page 11-5. 
 

 

The Print Parameters dialog box is organized into the following sections: 

 Page Layout:  Allows you to select one of 13 possible page layouts as 
illustrated. 

 Heading:  Allows you to enter the text of the heading that will appear 
at the top of the printout. 

 Areas 1 through 6:  Allow you to select what graphics or statistics to 
go to each of these areas in the report. The graphic views and data 
available from the drop list depend on your current design sequence. 
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Note:  Be aware that the number of areas available to select from 
depends on the page layout you selected.  For example, if you selected 
the Horizontal Split layout, which contains two sections, you'll be able 
to select from only two areas.  

 Notes:  Allows you to enter the text of any notes that will appear at the 
bottom of the printout. 

Tip:  To force the text to wrap to the next line, type a left apostrophe 
(`) at the end of the line of text.  In a normal word processor 
application, you'd use the Enter or Return key to do this. 

 Show Additional Notes:   Allows you to enter information about such 
as Label Format, Test Weight and Package Quantity. 

 Printer:  Allows you to select either Black and White (B+W) or Color 
printing. 

 Double Stack Unitload:  Allows you to print output as a double-
stacked unitload. 

 Print Analysis Name:  Allows you to print the analysis name on the 
printout.  This will appear at the top center of the report. 

 Show Graphics/C.A.S.Y.:  Allows you to show graphics or CASY 
design in the printout. 
 
Note:  If the analysis includes both graphics and a CASY design, the 
system will display the CASY design, not both. 

 Font: Here you can select the font on the preview screen. The text can 
be displayed in the following 3 sizes. 

 Regular:  Helvetica  10 pt. 
 Small:   Helvetica    8 pt.  
 Very Small:  Helvetica    6 pt. 

 

 Package Instruction: Here you can select whether to include 
previously defined package instruction in the printout for each stage of 
the design sequence. When included, specify whether to show them 
with the 3D graphics or in the packaging section after the different 
print areas. 
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Notice the following things about the Print Preview panel: 

 This zoom-out state is a rough approximation of the actual printout.  
For a more accurate view, zoom in. 

 The analysis name appears in the top, center of the printout and reads 
"Water Bottles." 

 The heading appears in the top, left of the printout and reads "Print 
Example". 

 The date appears in the top, right of the printout.  TOPS Pro 
automatically inserts both the date printed and the date modified. 

Note:  At this time, there is no way to exclude the date, user name or 
page number from the printout. 

 Area 1 displays a graphic of the Primary Pack 
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 Area 2 displays a graphic of the Intermediate Pack 3D View together 
with the package instruction. 

 Area 3 displays a graphic of the Case 3D view and package 
instruction. 

 Area 4 displays a graphic of the UnitLoad 3D view and package 
instruction. 

 Area 5 displays statistics of the Unitload. 

 The Close button allows you to return to the analysis view. 

 The Zoom button allows you to magnify the panel and get a closer, 
more detailed look at the output.  Zoom also allows you to annotate 
your printout.  

 The Print button sends the output to the selected printer. 

 The Email button opens your mail application and attaches a standard 
printout as a (.jpg) to be emailed directly to another person. 

Note:  For more information, please refer to Chapter 2, The Basics. 

 The PDF button allows you to save the current report into a PDF file. 

 The Add/Edit text button allows you add/edit annotation and/or 
simple lines and arrows to the output. 

Note:  To change the logo in the report, please refer to page 2-37. 
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Print Preview – Package Profile 
For a package profile, TOPS Pro allows you to print a pre-defined report.  
To display the Print Preview for a package profile, start from the Control 
Panel and follow these instructions: 

1. Go to the Menu Bar and open the File menu. 

2. Select Print Preview, then select Package Profile.  The Package Profile 
dialog box appears, as pictured below. 
 

 
 
We are using the Water Bottles analysis in the previous example to 
create a package profile. 

3. Use the following fields to enter package profile parameters.  Use the 
Tab key to move from field to field.  For the purpose of this example, 
we'll enter the following parameters: 

 Pallet Spec:  Enter the specification number for the pallet style.  
By default, TOPS Pro suggests a unique spec ID. 

 Description:  Enter a description of the package profile being 
created. 

 Date:  Enter the current date to specify when the package profile 
was created. 

 Customer Name:  Enter a customer name for this product package 
profile if desired. 

 Product Name:  Use the drop-down list to select a product name 
associated with the package profile or type in the first few letters of 
the product. 

Note:  The drop-down list displays products that have been added 
to this profile.  You'll use this field to edit or delete a product. 
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 Master Number:  Enter the master number associated with the 
package profile. 

Note:  You can use this field for any numeric value.  To rename 
the field, use the Text Modification dialog box.  Please refer to 
Appendix B, Dialog Boxes. 

 Retail Display Base: Not implemented. 

 Clamp Direction:  Use the drop-down list to select the clamp 
direction associated with the package profile. 

Note:  The printout will show clampability arrows on the unitload 
according to your input here.  Unlike the clampable option on the 
UnitLoad Options dialog box, the clamp direction does not affect 
the calculations. 

 Warehouse Stack Hgt:  Enter the maximum stacking height for 
your warehouse. 

Note:  Like the Master Number field, you can use this field for any 
numeric value. 

 Comments:  Enter the text of any comments that are relevant to 
the package profile. 

4. After completing the package profile parameters, click on OK.  The 
Print Preview panel appears, as pictured below. 
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Notice the following things about the Print Preview panel: 

 The pallet specification number, description, date created and 
master number appear in the top of the printout.  These items 
match the information you entered on the Package Profile dialog 
box. 

 A series of pallet statistics appears in the top, left of the printout. 

 The Products section displays a variety of information about the 
products included in the package profile. 

 A number of graphic views appear in the bottom and left portions 
of the panel. 

 The Comments area displays any comments you entered on the 
Package Profile dialog box. 

 The Zoom button allows you to magnify the panel and get a 
closer, more detailed look at the output. 

 The Print button sends the output to the printer. 
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 The Email button saves the report as a JPEG and attaches it to 
your email client. 

 The PDF button allows you to save the report to a PDF file in a 
specified directory. 

 The Add/Edit text button allows you add/edit annotation and/or 
simple lines and arrows to the output. 

5. To print the output, click on the Print button.  The system sends the 
print preview output to the printer. 

 

Annotate a Printout with Text 
After you've designed and generated your analysis output or the package 
profile, the system allows you to annotate a printout with text before you 
print it.  This allows you to customize and enhance the output's 
presentation. 

To add text to the analysis output, start from the Print Preview panel and 
follow these instructions: 

1. Click on the Add/Edit text button. The system magnifies the Print 
Preview panel. 

2. Click on the area of the output where you want to enter text.  The 
system displays a four-cornered entry field ( ) with the cursor 
positioned inside the field.  Notice that you can "drag" the entry field 
to any position on the screen. 
 
Note:  To make copies, hold down the Control key (Ctrl) while 
dragging. 

3. Enter the text that you want to appear in the selected area.  In this 
exercise (with the Water Bottles analysis), enter text as follows: 

 In Area 1 (primary pack), click above the graphic and enter this 
text:  "12oz Bottled Water." 

 In Area 2 (top right), click above the graphic and enter this text:  
"Shrink Warp 6-pack". 

 In Area 3 (bottom right), click above the graphic and enter this 
text:  "Four 6-packs on Tray". 
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Note: In this print Preview, the package instructions are included 
in a section below the layout.  

4. To change the font and/or font size, highlight the text, open the Text 
menu on the menu bar and select Font.  The Font dialog box appears, 
as pictured below. 
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5. Use the Font dialog box to select the font, font style and/or size and 
click on OK.  TOPS Pro returns you to the Print Preview panel. 
 
If no text has been selected, this new font will apply to all new texts to 
be added. 

6. Drag the text fields so they're positioned where you want them. 

7. After adding the text, click on the Print button. The system sends the 
analysis output to the printer. 

 

Insert Arrows or Lines on a Printout 
To add lines or arrows on the printout, use the right-click menu while in 
the Edit screen.  Follow these steps to add arrows pointing the annotated 
texts added to the graphics in each area. 

1. Click the right mouse button while in the zoom in or edit mode. 

2. A small menu pops up, select Line and then Arrow – Turn Horizontal 
as pictured below. 
 

 
3. Bring the mouse cursor starting from the annotated text towards the 

bottle as shown below.   
 

 
4. Release the mouse button to add the turned arrow. 
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Use the same method to insert straight arrows or lines in the printout. 

Another way to add small arrows is to use a symbol font.  This involves 
using the Alt key and the numeric keypad to insert keystrokes that are not 
usually available.  This method offers an advantage over using bitmaps – 
these arrows have transparent backgrounds and won't obliterate the area 
on the printout where they're placed. 

Most fonts have more symbols than the normal 26 letters, 10 numbers and 
punctuation symbols.  A font often includes arrows, trademark symbols, 
accented characters, etc.  In Microsoft Word, if you open the Insert menu 
and select Symbol, the Symbol dialog box appears, as pictured below.  
You can also use the Windows Character Map feature, located in the 
Accessories folder. 
 

 

If you highlight a symbol – such as the right arrow (→) – a number 
appears on the status bar; for example, 174.  This number represents the 
ASCII code for the selected symbol and the selected font. 

The following steps allow you to insert these characters into most 
programs, even if they don't have an Insert Symbol feature.  To insert 
characters into a TOPS Pro printout, follow these instructions: 

1. Go to the Print Preview Screen and zoom in. 

2. Click on the screen to insert text. 

3. Make sure the keyboard's Num Lock light is on. 

4. Open the Text menu and select Font to display the Font dialog box. 

5. Select the font you want to use.  
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Note:  To insert arrows onto the printout, use the Symbol or 
Wingdings font.  To simply bold or italicize the text, use the active 
font should be sufficient. 

6. Hold down the Alt key on your keyboard. 

7. While holding down the Alt key, type the ASCII number for the 
symbol you want to insert with a zero (0) in front; for example, type 
0172.  Use the table below as a guide. 

8. Release the Alt key.  TOPS Pro inserts the selected symbol onto the 
printout.  You may need to adjust the font size to make it more legible. 

 

Common ASCII Codes for Symbols 

Symbol Font Wingdings Font 

0171   ↔ 0219   ⇔ 0223    0231    0239    

0172   ← 0220   ⇐ 0224    0232    0240    

0173   ↑ 0221   ⇑ 0225    0233    0241    

0174   → 0222   ⇒ 0226    0234    0242    

0175   ↓ 0223   ⇓ 0227    0235    0245    

1076   ° 0226   ® 0228    0236    0246    

 0227   © 0229    0237    0247    

 0228   ™ 0230    0238    0248    
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Annotate a Printout with Graphics 
After you've designed and generated your analysis output, the system 
allows you to add text to the output before you print it.  This allows you to 
customize and enhance the output's presentation. 

To add a graphic image to the output, start from the Print Preview panel 
and follow these instructions: 

1. Go to the Menu Bar and open the Edit Menu. 

2. Select Paste Pict From File.  The Select File dialog box appears, as 
pictured below. 
 

 
 
Notice that this dialog box displays a list of bitmap files. 

3. Select the tops.bmp file and click on OK.  The Print Preview panel 
redisplays with the selected TOPS Pro bitmap file inserted into the 
output. 

4. Drag the image to the area where you want it to appear. 

5. Open the Edit menu and select Paste. 

6. System Response:  Windows copies the image from the clipboard and 
pastes it to the output. 

7. After adding the graphic, click on the Print button.  The system sends 
the analysis output to the printer. 
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Tips for Working with Graphics 
When you're using graphics to annotate a printout, keep these tips in mind: 

 Graphics are resizable.  To resize a graphic image, press the Control 
key and use the corner tabs to drag and resize the graphic.  The 
Control key allows you to resize the graphic – wider, thinner, shorter, 
taller – without distorting the image proportions. 

 To make copies of a graphic image, hold down the Ctrl key and move 
the image from one point to another. 

 To restore a graphic image to its original size, follow these 
instructions: 

1. Click on the image. 

2. Open the Picture menu and select Restore Size. 

 To edit bitmap images, follow these instructions: 

1. Double-click on the image.  The Windows Paintbrush application 
opens with the selected image ready to be edited. 

2. Use Paintbrush to make any necessary edits to the graphic image. 

3. Save your work in Paintbrush and close the Paintbrush application.  
TOPS Pro returns you to the Print Preview panel in Zoom mode.  
The edited graphic has been inserted in its original area of the 
panel.  The graphic has a tab on each corner that allows you to 
resize the image, if necessary. 

4. Open the Edit menu and select Refresh. 

5. If the edited graphic is correct, click on the Print button. 
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Edit a Graphic Image in Print Preview 
You might decide to edit the graphic image in the print area before you 
print the output.  To edit a graphic image in Print Preview, start from the 
Print Preview panel and follow these instructions: 

1. Click on the Zoom button. 

2. Right-click on the graphic image in the print area you want to edit.  
Select Convert to Bitmap in the pop-up dialog box. 

3. Click on Yes to confirm converting the graphic in the selected print 
area (pane) to a bitmap. 

4. The Save File As dialog box appears, as pictured below, and prompts 
you to enter a file name for the graphic. 
 

 
 

5. Enter a file name for the graphic and click on OK. 

6. Edit and resize the graphic image using the instructions outlined on 
page 11-15 in the previous section, Tips for Working with Graphics.  
Save the image when editing is done. 

7. When you re-open the Print Preview for the analysis, the edited 
graphic will appear. 

8. It this is the way you want it, click on the Print button to send the 
report to the selected printer. 
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Quick Print 
The Quick Print feature allows you to create and use a standardized 
printing template and print output for an analysis, based on the selected 
template.  This feature allows you to print output for an analysis without 
manually defining parameters on the Print Parameters dialog box. 

To print output using the Quick Print feature, start from the Analysis View 
and follow these instructions: 

1. Go to the UnitLoad View and make sure it is the currently active pane 
with a highlighted title bar. 

2. Click on the Print button and select QPrint.  The Quick Print dialog 
box appears, as pictured below. 
 

 
 

3. Select the template you want to use to print the analysis. 
 
Note:  The window contains a list of standardized printing templates.  
Each template has a standard print output coded for it.  This feature 
allows you to print output for an analysis without manually defining 
parameters on the Print Parameters dialog box.  For information about 
creating Quick Print templates, please refer to Chapter 15, Supervisor 
Functions. 

4. Use the following fields to enter Quick Print parameters.  Use the Tab 
key to move from field to field.   

 Send To:  Select an option – PDF, Printer or Both – to specify a 
print destination. 
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 Include:  Select one or more options – Analysis, Pallet Spec, 
Statistics, Problem Def – to specify what will be included in the 
printout. 

 Heading:  Enter the text of the heading that will appear at the top 
of the printout. 

 Notes:  Enter the text of any notes that will appear at the bottom of 
the printout. 

 PDF:  If you select PDF or Both in the Send To field, use the 
Browse button to select a PDF file to print to. 

Note:  This option is integrated with and requires the Adobe 
Acrobat software product.  Without Acrobat, the PDF option will 
not work. 

5. After completing the Quick Print parameters, click on OK. 

 

On how to create a Quick Print template, please refer to Chapter 15, 
Supervisor Functions. 
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Pallet Report 
The Pallet Report has a predefined format and provides summary and 
efficiency data on the shipcase and pallet level of the analysis. In the 
Extended View, it includes the Wal-Mart efficiency factors for selling unit 
and pallet unit cube utilization. 
 
To generate a Pallet Report, follow these steps.  
 
1. With the analysis open, go to the File menu on the menu bar 

2. Select Print Preview and then Pallet Report. The following dialog box 
will open. 
 

 

 Spec ID: Enter a code to identify the specification, if desired. 
 Customer:  Enter the customer name for the product, if applicable. 

This will be placed as the title for the report. 
 Output: Select between Smart View and Extended View for the 

report. 
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Pallet Report - Smart View 
The Smart View is a single page report providing summary data on the 
shipcase and pallet in both English and metric unit plus a 3D illustration of 
the pallet load. 
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Pallet Report - Enhanced View 
The Enhanced View provides a more comprehensive summary of the data 
together with efficiency data regarding shipcase and pallet utilization. 
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Combined Report: Compare Solution 
The combined report function for solutions allows you to select up to five 
(5) solutions within the same stage of the analysis and place them side-by-
side for comparison.   
 
Using the same analysis Water Bottles as our example, we will create two 
combined reports, one at the shipcase stage and one at the unitload stage. 
 
1. Go to the File menu, select Open option. 

2. Highlight Water Bottles at the bottom of the Approved list and click 
on OK to open. 

3. Click on the Cancel ( ) button on the tool bar to go access the 
Control Panel. 

4. Click on Calc button to re-generate the solutions for the analysis. 

5. Select the 6-pack (3x2x1) solution for the intermediate package and 
click on the Next ( ) button on the tool bar to go to the shipcase 
stage of the analysis.  There are four shipcase solutions. 

6. We will select all four solutions to create a combined report. To select, 
double click on each analysis in the Solution List Pane until a check 
mark appears against each solution under the Select column on the far 
left as shown on the next page. 
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7. With the four solutions selected, go to the File menu, select Print 
Preview, then Compare Solutions.  

8. The combined report, showing all four shipcase solutions, together 
with the comparison statistics for the shipcase, will be generated as 
shown on the next page. 
 
Note:  You can also create the same report using the right click menu.  
With the mouse in the solution list pane as shown above, click the 
right mouse button to access a pop-up menu, then select Preview 
Multiple Solution. 
 

  

9. At the Print Preview screen, you can print, email or edit as desired. 

10. Click Close to return to the analysis view. 

11. Let’s select shipcase solution 4 and click the Next ( ) button to move 
on to the unitload analysis. 

12. At the unitload view screen, double click solutions 1, 2 and 4 as shown 
on the next page. 
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13. To create the combined report, go to the File menu, select print 
Preview, then Compare Solutions or use the right click menu as 
described in Step 8 to create the combined report pictured below. 
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Combined Report: Compare Analysis 
The combined report function places any two analyses side-by-side for 
comparison. Users can specify which sequence of the analysis 
(intermediate pack, shipcase or unitload) to appear in the report. To create 
a combined report to compare across analyses, follow these instructions. 
 
1. Go to the File menu, select Open the first analysis.  In this example, 

highlight Water Bottles analysis from the list. 

2. Go to File menu again, select Print Preview, then Combined Report. 

3. The Combined Report Parameters dialog box, as pictured on the next 
page, will open. 
 

     

 Analysis:  Click the Browse button to select a second analysis to 
compare. 

 Sequence:  Select from the drop down list box the sequence to 
appear in the report. 

4. Click the Browse button to select a second analysis for comparison.  
Here, select the Cola Bottles analysis from the list. 

5. For the sequence for comparison, click on the drop-down list to select 
Shipcase. 
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6. Click on OK and the combined report will appear in the preview 
screen as pictured on the next page. 

7. You can choose to edit, zoom, print or email from the comparison 
report preview. 
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Combined Report for Knocked-Down and Erected 
Boxes 
Users can use the combined report to include both knocked-down and 
erected palletizations of a shipcase.   

To use the Combined Report feature for this purpose, both analyses must 
have the same name – with one exception.  At the end of the erected 
analyses name, put "{Box}" and at the end of the knocked-down analyses 
name, put "{KD}"; for example, Sample{Box} and Sample{KD}.   

Note:  If the analysis has been saved with one of those two tags in the 

name, a button ( ) appears on the Windows Tool bar to facilitate 
switching between the two analyses.  (Note that this feature is not 
available to Loadstack licensees.) 

To access this special Combined Report feature, follow these instructions: 

1. Correctly name the analyses, using the guidelines above. 

2. Use one of two options: 

 Open the File menu, select Print, then select Combined Report. 
 Open the File menu, select Print Preview, then select Combined 

Report. 
The Combined Report Print Preview panel appears. 

3. Annotate or add graphics as necessary. 

4. After completing the annotations or graphics, click on Print.  TOPS 
Pro sends the Combined Report to the printer. 

If you need assistance, contact TOPS Technical Support. 
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Printer Width 
The printer width refers to the thickness of the lines in a graphic or text 
when you print an analysis.  The default for printer width is zero, which is 
a hairline width.  You might want to make the printed lines thicker; for 
example, to improve fax documents.  If so, TOPS Pro allows you to 
change the printer width in Configuration. 

Note:  If the Show Graphics feature is turned on, the printer width will 
have no effect. 

To change the printer width, follow these instructions: 

1. From the Menu Bar, open the Tools menu. 

2. Select Configuration and go to the Reports tab. 
 

 

3. In the Printer Pen Width field, enter a value to specify the line 
thickness with which you want to print.  A line thickness of 4-7 is 
usually a good width. 

4. If you're satisfied with the printer width, click on OK.  The system 
saves the updated configuration to the database and returns you to the 
previous screen. 

 

 

 

 



 

11-30 TOPS Pro (Version 6.50) User Guide 
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Chapter 12: Designing Box Styles 

Introduction 
TOPS Pro contains a number of pre-defined box styles in its database, but 
also allows you to design box styles to meet your unique needs.  When 
you design a box style, you'll use one of the following basic box drawing 
styles: 

 Common Footprint Standard 
 Display Case 
 Display Tray 
 HSC 
 HSC with Top 
 RSC 
 Shrinkwrap 
 Shroud 
 Solid 
 Strap Bundle 
 Tear Out 
 Tray 
 Tray/HSC 
 Tuck 
 Wrap Around 

 
These basic box drawing styles are your starting point.  Every box style in 
TOPS Pro is drawn as a variation of one of these nine box drawing types.  
However, note that thicknesses and export name are common to all box 
drawing styles.  You'll design a new box style primarily by revising the 
thicknesses built into the box style.  This chapter provides guidelines for 
working with the nine basic box drawing styles. 
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General Guidelines 
As you design box drawing styles in TOPS Pro, use the following 
guidelines: 

 Understand the assumed caliper of flutes. 

TOPS Pro calculates the allowance between 
inside dimensions (ID) and outside dimensions 
(OD) as the number of thicknesses of board 
times the caliper of the board.   

The various flutes shipped with TOPS Pro and 
their corresponding calipers are listed in the table 
to the right.  So, for a standard RSC there would 
be two thicknesses added along the length and 
width of a case, and four thicknesses added to the 
height of the case. 

Assuming the case was constructed of C-flute 
material, this would result in an ID-to-OD adjustment of 5/16” (2 × 
5/32”) along the length and width, and 5/8” (4 × 5/32") added to the 
height. 

Note:  If your company assumes that the ID/OD allowance for a C-
flute RSC is 3/8”, 3/8” and 3/4" instead of 5/16”, 5/16” and 5/8”, then 
you will most likely want to adjust the default caliper of C-flute from 
5/32” to 3/16”. 

To do so, enter the TOPS Pro Configuration program, open the Define 
menu and select Flutes.  On the Define Flute dialog box, change the 
thickness field to 3/16”.  All newly created work will use 3/16" for the 
caliper of the C-flute. 

 Calculate thicknesses for a standard box style. 

For box styles that use only one type of material (a standard 
container), count the number of thicknesses in each direction – length, 
width and height.  You'll enter the number of thicknesses for each 
direction on the Define Case Styles dialog box.  TOPS Pro will 
calculate the inside/outside thickness adjustment as the number of 
thicknesses × the caliper of the material. 

Shipped Flute 
Calipers 

Flute Caliper 
A 0.18750 
B 0.12500 
C 0.15625 
E 0.06300 
F 0.06300 

C/B 0.26700 
A/C 0.26700 
A/B 0.26700 
E/B 0.00000 
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 Calculate thicknesses for a non-standard container 

For a non-standard container (one that mixes materials), you'll have to 
make some adjustments.  For example, a telescoping box style with 
mixed material – a C-flute bottom and a B-flute top.  The thicknesses 
in this box style are non-standard, with different calipers for the top 
and bottom box material. In this case, calculate the thicknesses as 
follows: 

1. Measure the inside/outside dimensions of the box. 

2. Calculate the difference between the inside/outside dimensions for 
all three directions – length, width and height. 

3. Divide each direction by the thickness of the flute you plan to use 
for this box.  (TOPS recommends the B-flute in that it is a nice 
round 1/8th of an inch thick.) 

4. The resulting value, including decimals, is the number of 
thicknesses along the length, width and height for the box drawing 
style. 

If you need assistance with this process, please contact TOPS 
Technical Support. 

 Calculate thicknesses for a non-corrugated material. 

Suppose you're designing a milk crate, which in this example has an 
open top and wall made of one-inch thick plastic.  The difference 
between inside and outside dimensions is two inches along length and 
width, and one inch along the height.  Assume you'll use a B-flute 
when you use this box style.  Calculate how many B-flutes will be big 
enough to account for the walls of the milk crate.  Therefore, you'll 
design the box with 16 thicknesses along the length and width and 
eight thicknesses along the height. 

 Select a drawing style. 

As you design a box drawing style, the g.o.d. feature draws the box as 
you design it.  You want the picture to be as accurate as possible to 
your finished product.  On the Define Case Styles dialog box, go 
through the drawing styles and find the existing box style that best 
matches your needs. 
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Once you’ve selected the box style that comes closest to being drawn 
the way you would like, examine its box drawing style and parameters 
and use them as a base for creating your new style.  When designing a 
new box style, TOPS recommends that you give it a new description, 
different than those shipped by TOPS.  That way, when you upgrade, 
it will be possible to determine whether TOPS changed its data or you 
did. 

Note:  TOPS has provided Appendix E, Box Styles, to assist you in 
selecting a drawing style.  You may also print the current database of 
box styles through the File menu, selecting Print Databases, then Box 
Styles.  TOPS Pro will print all the box drawing styles in the database. 

 

Box Style Drawing Parameters 
In the following sections, the parameters to illustrate each box style will 
be explained.  However, only the drawing parameters will be described; 
these common parameters at the top half of each dialog box will not be 
repeated for each style: 

 Description:  Enter the name for the box style. 
 Drawing Style:  Select the box style from the drop list used to 

illustrate the new box style created. 
 Thicknesses Length/Width/Height:  These are self-explanatory and 

you should enter the thicknesses along the length, width and height of 
the box. 

 Export Name:  Enter the export name for the new box style.  (This is 
optional.) 

 Strength Factor (as % of RSC):  Enter the stacking strength of the 
box, as a percentage, in relation to an RSC box. 
 

Note:  The parameters in the following sections are drawing parameters 
only; they are not used in to construct the box style. 
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Common Footprint Standard  

 

 Side Tabs:  Select whether these tabs appear on the top and/or bottom 
side, then enter the number of tabs on the side of the box.  

 Side Tab Width and Height:  Select either Actual Size or % of Box 
Width, then enter the width and height of the tab. 

 Front-Back Tabs:  Enter the number of tabs on the front and back 
sides of the box. 

 Front-Back Tab Width and Height:  Select either Actual Size or % 
of Box Length, then enter the width and height of the tab. 

Display Case 

 

 Tray Height:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the tray height. 

 Window:  Select Front only, Front and Back, Left and Right sides or 
None to define which sides will be lowered for display purposes. 

 Window Height: Defines what portion of the sides will be lowered. 
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 Top Width: Defines what the top width of the side. 

 Bottom Width: Defines the bottom width of the side. 

Display Tray 

   

 Tray Height:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the tray height. 

 Tray Width:  Select either Actual Size or % of Box Height, then enter 
a value to define the width of the tray. 

HSC 
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HSC with Top 

 

 Cover Height: Enter the height of the cover as an overall percentage 
of the box. 

Octagonal 

  

 Cuff off Length: Enter the length for the cut off (measured from the 
corner of a rectangular box) to make the octagonal box.  Specify if the 
cut off length is in actual size (inches if in English and mm if in 
Metric) or as a percentage of the box width.  For the latter option, it 
should be less than 50%. 

 Covered:  Specify whether the box has a cover or not by clicking the 
corresponding radio button.  
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RSC 

 

 Major Flap:  Select either % of Box Width or % of Box Length, then 
enter a value to define the size of the major flap. 

 Minor Flap:  Select either Flap Gap or % of Box Width, then enter a 
value to define the size of the minor flap. 

 Back Flap Angle:  Select either Degrees or Radians, then enter a 
value to define the back flap angle. 

 Front Flap Angle:  Select either Degrees or Radians, then enter a 
value to define the front flap angle. 

 Minor Flap Angle:  Select either Degrees or Radians, then enter a 
value to define the minor flap angle. 

 
Shrinkwrap 
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Shroud 

 

 Tray Height:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the tray height. 

 Shroud Opening:  Select either Along Width or Along Length to 
specify where the shroud opening will appear. 

 Upper Bar Width:  Select either Actual Size or % of Box Height, 
then enter a value to define the size of the upper bar width. 

 Side Bar Width:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the side bar width. 

 
Solid 

 

 Shows Ends:  Select Yes to display the ends of the box.. 

 Show Sides:  Select Yes to display the sides of the box. 
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Strap Bundle 

 

 Length Straps:  Enter a value to define number of straps along the 
length of the box. 

 Width Straps:  Enter a value to define the number of straps along the 
width of the box. 

 Strap Width:  Enter a value to define the width of the straps. 

 

Tear Out 

  

 Tray Width:  Select either Actual Size or % of Box Height, then enter 
a value to width of the tear-out portion of the tray. 

 Tray Height:  Select either Actual Size or % of Box Height, then 
enter a value to define the height of the tear-out portion of the tray. 
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Tray 

 

 Tray Height:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the tray height. 

Note:  When filling trays designed with this box drawing style, TOPS Pro 
will automatically size the height of the tray to match the height of the 
product within the tray, plus the thicknesses along the tray height. 

Also, if the resulting height of the tray being designed is smaller than the 
specified height of the tray walls, TOPS Pro will reduce the drawn height 
of the walls.  That is, if you put a two-inch-high product into a three-inch-
height tray, the walls will be only two inches high – actually two inches 
plus the number of thicknesses of the material at the chosen caliper. 

Tray/HSC 

 

 Tray Height:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the tray height. 
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Tuck 

 

 Flap Lip Length:  Select either Actual Size or % of Box Height, then 
enter a value to define the size of the flap lip length. 

 Minor Flap:  Select either % of Box Width or % of Box Length, then 
enter a value to define the size of the minor flap. 

 Major Flap Angle:  Select either Degrees or Radians, then enter a 
value to define the major flap angle. 

 Lip Flap Angle:  Select either Degrees or Radians, then enter a value 
to define the lip flap angle. 

 Minor Flap Angle:  Select either Degrees or Radians, then enter a 
value to define the minor flap angle. 

Wrap Around 

   

 Major Flap Length:  Select either Actual Size or % of Box Height, 
then enter a value to define the size of the major (front) flap lip length. 
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 Flap Angle:  Select either Degrees or Radians, then enter a value to 
define the major flap angle. 

 Lip Flap Angle:  Select either Degrees or Radians, then enter a value 
to define the lip flap angle. 

 Wrapwnd Sitting:  Select either Along Length or Along Width to 
specify the wraparound sitting. 

 Minor Flap Length:  Select either Actual Size or % of Box Height, 
then enter a value to define the size of the minor (side) flap lip length. 

 Flap Gap:  Select either Actual Size or % of Box Height, then enter a 
value to define the space between the side flaps. 
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Chapter 13: Designing Divider 
Styles 

Introduction 
TOPS Pro contains a number of pre-defined divider styles in its database, 
but also allows you to design divider styles to meet your unique needs.  
When you design a divider style, you'll use one of seven basic divider 
drawing styles: 

 2-Way Divider 
 2-Way Air Cell 
 Z Partition 
 U Partition  
 U Simple 
 Zig Zag 
 Other Partitions 
 U Over 
 Custom 

 
These basic divider drawing styles are your starting point.  Every type of 
divider designed in TOPS Pro is a variation of one of these six divider 
drawing types.  This chapter provides guidelines for working with the six 
basic divider drawing styles. 
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General Guidelines 
As you design divider drawing styles in TOPS Pro, use the following 
guidelines: 

 Define number of thicknesses. 

On the Define Dividers dialog box, if you leave thicknesses zero (0), 
TOPS Pro will automatically calculate the number of thicknesses 
along the length and width. 

 Define an arrangement. 

On the Define Dividers dialog box, if you leave the arrangement zero 
× zero, TOPS Pro will autosize the divider to fit the quantity of items 
that go into the divider, if possible.  If you're calculating stacking 
strength, be sure to always enter a specific value for the arrangement; 
this is because stacking strength usually varies on arrangement.  If 
you're not calculating stacking strength, it's OK to leave the 
arrangement zero × zero. 

 Select a drawing style. 

As you design a divider drawing style, the g.o.d. feature draws the 
divider as you design it.  You want the picture to be as accurate as 
possible to your finished product.  On the Define Dividers dialog box, 
go through the drawing styles and find the divider that best matches 
your needs.   

Note:  For easy reference, please refer to Appendix F, Divider Styles.  
As an option, go to the Menu Bar, open the File menu, select Print 
Databases, then select Dividers.  TOPS Pro will print all the divider 
drawing styles in the database. 

Check the drawing parameters and revise them as necessary to meet 
your needs.  When you've designed a new divider, give it a description 
and save it to the database. 

Be aware that the drawn dividers in TOPS Pro are limited to the 
simplest row/column patterns, with all items in the arrangement 
oriented the same way. 
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2-Way Divider 
The 2-Way Divider drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

  

To use the 2-Way divider, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Drawing Parameters:  Select a type of closure – No, Partial, End, 
Middle or Full – to specify how TOPS Pro will draw the divider. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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2-Way Air Cell 
The 2-Way Air Cell drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

  

To use the 2-Way Air Cell, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Drawing Parameters:  Select an option – Perimeter Air Cell or 
Complete Air Cell – to specify how TOPS Pro will draw the divider. 

 Air Cell Width:  Enter the width of the air cell. 

 Air Cell Length:  Enter the length of the air cell. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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Z Partition 
The Z Partition drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

  

To use the Z Partition divider, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Divide Width:  Check the box to divide the divider along the width. 

 Width Tabs:  Check the box to add tabs to the width of the divider. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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U Partition  
The U Partition drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

  

To use the U Partition divider, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Divide Width:  Check the box to divide the divider along the width. 

 Inside/Outside Tabs:  Check the box to add tabs to the inside/outside 
of the divider. 

 Allow Cartons Outside:  Check the box to allow cartons on the 
outside of the divider. 

 Middle Space:  Enter the middle space of the divider in inches. 

 Tab Length:  Enter the length of the tabs in inches. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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U Simple 
The U Simple drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

   

To use the U Simple, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Divide Width:  Select this option to draw the divider across the width 
of the shipcase.  (As the default, TOPS Pro draws the divider across 
the length.) 

 Start Tabs:  Select this option to draw the divider with a tab at the 
starting point of the divider. 

 End Tabs:  Select this option to draw the divider with a tab at the 
ending point of the divider. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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Zig Zag 
The Zig Zag drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

  

To use the Zig Zag divider, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider. 

For example, if the divider will accommodate three rows of 10 
containers, enter 3 and 10. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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Other Partitions 
The Other Partitions drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

  

To use the Other Partitions divider, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Side/End Panels:  Check the box to draw the divider with side or end 
panels. 

 Width Tabs:  Check the box to draw the divider with width tabs. 

 Perimeter With Gap:  Check the box to draw the divider perimeter 
with a gap. 

 Length/Width Dividers:  Enter the length and width dividers in 
inches. 

 Tab Length:  Enter the length of the tabs in inches. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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U Over 
The U Over drawing style, pictured below, is designed with the 
parameters displayed in the Define Dividers dialog box. 

    

To use the U Over divider, work with the following parameters: 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 

 Divide Width:  Select this option to draw the divider across the width 
of the shipcase.  (As the default, TOPS Pro draws the divider across 
the length.) 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 
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Custom 
This option allows you to define or modify a custom divider via a 
graphical editor. 

   

To use the Custom divider, work with the following parameters and then 
click on the Modify button: 

 Description: Enter a name to be used for the new custom divider. 

 Support:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider. 

 Turn Rate:  Enter the turn rate for the divider. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 2 containers, enter 3 and 2. 

 Divider in edge:  Check this box if the divider partitions are to be 
used along the edge of the shipcase. You can always remove them in 
the graphical editor. 

 Thicknesses Lengths/Widths/Depths:  Enter the number of 
thicknesses along the length, width and depth of the divider. 

 Delete Button: Delete the current divider. You will be prompted for a 
confirmation to permanently remove the divider from the database. 
Click Delete to confirm. 

 Modify Button:  Click to open the divider custom design screen as 
described in the next section. 
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Create a Custom Divider 
 Follow these steps to create a custom 3x2 divider as 
shown here:  

1. Go to the Define menu and select Dividers. 

2. Select Custom from the Drawing Style list box 

 
 

3. Enter the name of the divider “3x2 Custom” in the Description field; 
arrangement of 3x2 and check the box to enable Divider in edge.  
 

 
4. Click on the Modify button.  You will be prompted whether to save 

the changes, click on Yes to continue. 

5. Click on OK on to confirm going to custom design. 
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6. This will open the divider editor as illustrated below. 
 

 
7. Enable Draw Mode and click on the Add All>> button to add all 

possible partitions around and between the cells. 

8. Click on the four highlighted sections 
(by arrows) shown on the right to 
remove those partitions. 

9.  With the mouse cursor placed on the 
section indicated by the arrow, click the 
right mouse button to access the edit 
menu as shown here. 

10. Select Size and then enter 50% of Box 
Width as shown below to change the size 
of that cell partition. 

    
11. With the mouse cursor at newly sized 

partition, access the right click menu, 
select Alignment and then Left. 

12. Repeat step 9 through 11 to bring the 
highlighted partition to 50% box width 
and then aligning right to get to the final 
divider. 

13. Click on OK and you will exit the Define 
Divider function. 

14. To view the newly created divider, go to Define Menu and select 
Dividers. Click the drop list for Description and scroll down to “3x2 
Custom” 
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Note:  This divider is only applicable to shipcase containing multiple of 6 
items. 
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Chapter 14: TOPS Pro Config 
Program 

Introduction 
The TOPS Pro Config program discussed in this chapter is separate from 
the TOPS Pro program.  To access the TOPS Pro Configuration program, 
go to the TOPS Pro Applications group and double-click on the TOPS Pro 
Config icon .  

After the login, you will see the Control Panel of the Configuration 
program as pictured below. 

 

This chapter outlines the three menus (File, Define and Supervisor) that 
comprise the Menu Bar in the TOPS Pro Configuration program, along 
with a brief description of the options available with each menu.  These 
options are also available via the direct links from the Control Panel as 
pictured above. 

Note:  Much of the Configuration functionality is covered in detail in 
other parts of this manual.  Rather than duplicate a lot of information, this 
chapter briefly describes the features and functions of the Configuration 
program and refers you to other places in the manual for more detailed 
information. 
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File Menu 
The File menu provides the following options: 

 User Login 
 User List 
 Import (Import Data quick link) 
 Export (Export Data quick link) 
 Exit 

 

User Login 
The User Login option displays the User Login dialog box and allows you 
to login to the system. 

 

 Add User: Click to add new user to the user list. Type in a new name 
at the pop up New User dialog box and click OK to add. 

 Delete User: Available only when logged in as Supervisor. Highlight 
a name in the User list and click the Delete User button.   
You will be prompted to confirm the deletion as this will also delete 
all analyses owned by this user. Click Yes to delete the analyses, No to 
keep the analyses but delete the user and Cancel to exit without 
making any change or deleting the user. 

 Rename User: Available only when logged in as Supervisor. 
Highlight a name in the User list and click the Rename User button. 
Type in a new user name in the pop up dialog to replace the existing 
name.  
You will be prompted whether to rename analyses associated with the 
existing user to the new user, click on Yes to do so, No to keep 
analyses under the existing user name or click Cancel to exit without 
renaming either user or analyses. 

For more information about the User Login dialog box, please refer to 
Appendix B, Dialog Boxes. 
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User List 
The User List option displays the User List dialog box, which displays the 
users currently logged onto the system.  This feature is critical for network 
users who have a limited number of TOPS Pro software licenses.  For 
example, if you have two licenses and two users are logged on, then a 
third user will not be able to logon until one of the current users logs off. 

You may find it necessary to logout someone if he or she logged onto 
TOPS Pro Configuration, then did not exit the system normally (e.g., in 
the event of a crash or power failure).  If you're unable to enter TOPS Pro 
Configuration to logout a missing user, you can always login as that user, 
replace that user, then exit. 

For more information about the User List dialog box, please refer to 
Appendix B, Dialog Boxes. 

 

Import 
The Import option displays the Import from ASCII dialog box, which 
allows you to import an ASCII comma delimited text file into the TOPS 
Pro System.  You can use this function to import shipcases and other 
containers into the TOPS Pro System. 

 

 Browse Button: Click to specify the location of the ASCII text file to 
be imported.  

 Import Button: Click the start the import action. 
For more information about the Import from ASCII dialog box, please 
refer to Appendix B, Dialog Boxes. 

 

Export 
The Export function opens the Export to ASCII dialog box, which allows 
you to export selected data from the TOPS Pro Configuration program to 
an ASCII comma delimited text file for use by other applications. 
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 Browse Button: Click this button to specify the location of the ASCII 
text file to be exported and saved. 

 Selected All Button:  Click this button to export all data within the 
TOPS Pro and Configuration programs. Upon clicking this button, all 
check boxes except for Messages and Defaults (Global) will be 
enabled with a “ ” mark. 

 Analysis/General/Box Compression/Messages: To export selected 
data, place “ ” mark against the desired items by clicking the 
corresponding boxes. 

 Export Button: Click this button when ready to export the selected 
data. 

For additional information about the Export to ASCII dialog box, please 
refer to Appendix B, Dialog Boxes. 

 

Exit 
The Exit option closes the TOPS Pro Configuration program. 
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Define Menu 
The Define menu provides the following options: 

 Configuration 
 Language 
 Defaults 
 Environment Factors (Environment Factors quick link) 
 Box Design Factors 
 Board Combinations (Board Combinations quick link) 
 Paper (Define Paper quick link) 
 Flutes (Define Flute quick link) 

 

Configuration 
The Configuration option displays the Configuration dialog box, which 
allows you to define the configuration of your TOPS Pro software by 
selecting and de-selecting a range of options. 

The configuration settings are organized under different tabs: 

 General Tab: To configure the graphic display settings for different 
elements in TOPS Pro. 

 Results Tab: To setup optional settings for the analysis folder path, 
auto recovery and data archive. 

 Reports Tab: To control font size and pen settings on report as well 
as default report image formats. 

 Dimensions Tab: To specify if inside and/or outside dimension will 
be displayed in reports and their unit of measure. 

 Numeric Tab: Specify if and when to use fractions and to control the 
number of decimal places to be used for different data types. 

 Statistics Tab: Available only when logged in Supervisor, you can 
select under this tab the rows and columns of data to appear in the 
statistics section of the program and report. 

  Global Tab: Available only when logged in Supervisor, this tab 
allows you to control how TOPS Pro will run and will apply to all 
users of the program. 

For more information, please refer to Appendix B, Dialog Boxes. 
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Language 
The Language option displays a second menu, which allows you to select 
the language to be used with the TOPS Pro software.  It also has an Edit 
option, which displays the Text Modification dialog box, allowing you to 
perform language editing on selected words. For more information about 
the Modification, please refer to Appendix B, Dialog Boxes. 

 

Defaults 
The Defaults option displays the Defaults dialog box, which displays in 
different variations and allows you to enter default values for the 
following: 

 Button Menu Styles 
 Product 
 Primary Package 
 Intermediate Pack View 
 Shipcase 
 Pallet 
 Vehicle 
 Carton/Bag Sizing 
 Intermediate Sizing 
 Shipcase sizing 
 Unitload sizing 
 Vehicle load sizing 
 Stack Strength 
 Print 
 Shipcase Patterns 
 UL Patterns 
 TV Patterns 
 Pallet Spec 

 
For more information about the various Default dialog boxes, please refer 
to Appendix B, Dialog Boxes. 

 

Environment Factors 
The Environment Factors option displays the Environment Factors dialog 
box, which allows you to assign numeric safety factors to a range of 
environmental factors including humidity, storage time, pallet spacing and 
whether the unitloads use interlocking patterns. 
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For more information about the Environment Factors dialog box, please 
refer to Appendix B, Dialog Boxes. 

 

Box Design Factors 
The Box Design Factors option displays the Box Design Factors dialog 
box, which allows you to enter default values for box design factors such 
as length-to-width ratio, shape factors, printing factors and flap gap 
factors. 

For more information about the Box Design Factors dialog box, please 
refer to Appendix B, Dialog Boxes. 

 

Board Combinations 
The Board Combinations option displays the Board Combinations dialog 
box, which allows you to define default board grades, as well as to 
change, delete or mark them unavailable.  Use this option to define a 
board's ECT or cost per 1,000 square feet. 

For more information about the Board Combinations dialog box, please 
refer to Appendix B, Dialog Boxes. 

 

Paper 
The Paper option displays the Define Paper dialog box, which allows you 
to define default parameters for different types of paper including RCF, 
weight, cost and type. 

For more information about the Define Paper dialog box, please refer to 
Appendix B, Dialog Boxes. 

 

Flutes 
The Flutes option displays the Define Flute dialog box, which allows you 
to enter default parameters for different types of flutes including 
allowance for scoring and specifics like flute constant, paper thickness, 
weight, etc. 

For more information about the Define Flute dialog box, please refer to 
Appendix B, Dialog Boxes. 
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Supervisor Menu 
The Supervisor menu provides the following options: 

 Login/Logout (Login quick link) 
 Global Configuration (Global Configuration quick link) 
 Maintenance Control 
 Check and Fix Database 

 

Login/Logout 
The Login/Logout option displays the Supervisor Login dialog box, which 
allows you to login to the system as a supervisor.  This is required in order 
to perform the following tasks: 

 Approve analyses 
 Rename and delete users 
 Change Supervisor login password 
 Change statistics settings 
 See all users' work 
 Log off other users 
 Change Quick Print templates 

For more information about the Supervisor Login dialog box, please refer 
to Chapter 15, Supervisor Functions, or Appendix B, Dialog Boxes. 

 

Global Configuration 
The Global Configuration option displays the Global Configuration dialog 
box, which allows the Supervisor to define a global configuration for your 
TOPS Pro software. 

The configuration settings are organized under different tabs: 

 General Tab: To configure the graphic display settings for different 
elements in TOPS Pro. 

 Results Tab: To setup optional settings for the analysis folder path, 
auto recovery and data archive. 

 Reports Tab: To control font size and pen settings on report as well 
as default report image formats. 

 Dimensions Tab: To specify if inside and/or outside dimension will 
be displayed in reports and their unit of measure. 
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 Numeric Tab: Specify if and when to use fractions and to control the 
number of decimal places to be used for different data types. 

 Statistics Tab: Visible to the Supervisor only, this tab allows the 
supervisor to specify what data will be included in the statistics section 
of the analysis report. 

 Global Tab: Visible to the Supervisor only, this tab allows the 
supervisor to setup specifics on user accounts, database control and 
availability of certain functionalities. 

For more information about the Global Configuration dialog box, please 
refer to Appendix B, Dialog Boxes. 

 

Maintenance Control 
The Maintenance Control option allows the supervisor to notify network 
users when TOPS will be shut down for maintenance or upgrade. It gives 
users time to work on an analysis and save it before the program shuts 
down. 

Follow these steps to use software Maintenance Control: 

1. Click the Login Quick Link and login as Supervisor. 

2. Go to the Supervisor menu and select Maintenance Control. This 
opens the Maintenance Mode dialog box as shown below.  
 

 
3. Enter the time in minutes to schedule maintenance to start and click 

the Set Time button. You will see a message confirming the start time 
for maintenance.  
 

 
4. Click on OK to confirm. 
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A warning will appear on the upper right side of the program, notifying 
users that they only have 5 minutes left before the program closes and 
maintenance begins.  

 

While on Maintenance, users will not be able to access the program. 
However, when maintenance is done, the supervisor can allow users on a 
network to get back into the program by following the steps above and 
clicking on Done Maintenance.  

 

Check and Fix Database 
The Check and Fix Database option enables the supervisor to check and 
rebuild the TOPS Pro database in the event of file corruption. This 
function requires all users to be logged out of the system. 

 

 

After all users are logged out of TOPS, click on the Start button to start 
the process. 

For more information, please refer to Appendix B, Dialog Boxes. 
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Chapter 15: Supervisor Functions 

Introduction 
This chapter discusses the functions available to a supervisor or under the 
Supervisor menu in the TOPS Pro System.  They include the following: 

 Login/logout as a supervisor 
 Change your password 
 Add a user to the system 
 Delete a user from the system 
 Rename a user in the system 
 Approve or deny an analysis 
 Open and transfer other users' analyses 
 Set up an analysis template 
 Set up a Quick Print template 
 Define global configuration settings 
 Set up the way statistics are displayed in the system 
 Set License 
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Login/Logout 
Before you can perform any of the supervisor functions in either TOPS 
Pro or the TOPS Configuration program, you have to login as a 
supervisor.  Start from the Menu Bar and follow these instructions: 

1. Open the Supervisor menu. 

2. Select Login/Logout.  The Supervisor Login dialog box appears, as 
pictured below. 
 

 

3. Enter the supervisor password. 

Note:  The default password is "tops software".  Note the space 
between "tops" and "software". 

4. Click on the Login button.  TOPS Pro logs you into the system as a 
supervisor. Once logged in, you should see the TOPS Pro title bar 
changes to “Untitled/or analysis name – TOPS Pro (Supervisor)”. 

5. To logout of the system once you have logged in, go back to the 
Login/Logout function under the Supervisor menu, click on the 
Logout button and TOPS Pro will log you out of the Configuration 
program. 
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Change Password 
Once you're logged in as a supervisor, you can change the login password 
if you want.  To change the password, start from the Supervisor Login 
dialog box and follow these instructions: 

1. Click on the Change Password button.  The Supervisor Login dialog 
box redisplays, as pictured below. 
 

 

2. Enter the old password in the first Password field. 

3. Enter the new password in the second Password field. 

4. Click on the Change button.  The Confirm Password dialog box 
appears, as pictured below. 
 

 

5. Enter the new password in the Password field. 

6. Click on OK and TOPS Pro changes the password and issues a 
message to this effect. 
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Logoff a User 
This function allows you to logoff a user from the system, which is critical 
for a network license whose number of simultaneous users is controlled by 
the number of licenses/seats purchased. For example, if you have a two-
user network license and two users are already logged on, then a third user 
will not be able to logon until one of the current users logs off. 

You may find it necessary to logoff someone if he or she logged onto 
TOPS Pro, then did not exit the system normally (e.g., in the event of a 
crash or power failure).  Use these guidelines: 

 If you're unable to enter TOPS Pro to logoff a missing user, you can 
always login as that user, replace that user, then exit. 

 If password access is enabled, the supervisor password grants access 
to users. 

 You can also logoff users from the TOPS Configuration program. 

To logoff a user from the system, start from the Menu Bar and follow 
these instructions: 

1. Use one of two options: 

 In the TOPS Pro system, open the Tools menu. 
 In the TOPS Configuration program, open the File menu. 

2. Select User List.  The User List dialog box appears, as pictured below. 
 

 
 
The User List dialog box displays all users currently logged onto the 
system.  The list above contains one user, but there can be as many 
users as there are purchased TOPS Pro software licenses. 

3. Select the user you want to log out of the system. 
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4. Click on the Logout button.  TOPS Pro asks if you're sure you want to 
log the user out of the system. 

5. Click on the Logout button.  The User List dialog box redisplays with 
an updated list of users logged onto the system.  The user you just 
logged out is deleted from the list. 

Add a User to the System 
To add a user to the system, you have to Login as Supervisor.  Start from 
the Menu Bar and follow these instructions: 

1. Open the File menu. 

2. Select User Login.  The User Login dialog box appears, as pictured 
below. 
 

 
3. Click on the Add User button.  The New User dialog box appears, as 

pictured below. 
 

 
4. Enter the name of the user you want to add to the system. 

5. Click on OK.  The User Login dialog box redisplays with the new user 
added to the user list. 

Note:  At this time, there is no way to prevent any user from adding a user 
to the system. 
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Delete a User from the System 
To delete a user from the system, start from the Menu Bar and follow 
these instructions: 

1. Open the File menu. 

2. Select User Login.  The User Login dialog box appears, as pictured 
below. 
 

 
3. Highlight the user to be deleted and click on the Delete User button. 

4. You will be prompted to confirm the deletion as this will also delete 
all analyses owned by this user. Click Yes to delete the analyses, No to 
keep the analyses but delete the user and Cancel to exit without 
making any change or deleting the user. 

Rename a User in the System 
To rename a user in the system, start from the Menu Bar and follow these 
instructions: 

1. Open the File menu. 

2. Select User Login.  The User Login dialog box appears. 
 

 
3. Highlight the user to be renamed and click on the Rename User button.  

The New User dialog box appears, as pictured below. 
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4. Enter the new (edited) name of the user you want to rename in the 

system. 

5. You will be prompted whether to rename all analyses associated with 
this existing user to the new user, click on Yes to do so, No to keep 
analyses under the existing user name or click Cancel to exit without 
renaming either user or analyses. 

 

Approve an Analysis 
When a user performs an analysis and saves it to the database, he or she 
will request approval for that analysis with the Request Approval option 
on the File menu.  TOPS Pro takes that request for approval and places it 
in a queue of analyses waiting to be approved or denied by a supervisor. 

Note:  You might be able to approve your own analysis. This depends on 
the global setting “User Approval” in the TOPS Pro Config program. If 
this option is checked, you can approve your own work; otherwise, you 
will need to submit them to the Supervisor for approval. 

To approve an analysis, start from the Menu Bar and follow these 
instructions: 

1. Open the Supervisor menu. 

2. Select Open Request.  The Open Request for Approval dialog box 
appears, as pictured below. 
 

 
3. Select an analysis you want to examine for approval or denial. 



 

15-8 TOPS Pro (Version 6.50) User Guide 

4. Click on OK.  TOPS Pro opens the selected analysis in the Analysis 
View. 

5. Examine the analysis to decide if you want to approve or deny it. 

6. To approve the analysis, open the Supervisor menu. 

7. Select Approve.  TOPS Pro asks if you want to approve the selected 
analysis. 

8. Click on OK.  TOPS Pro moves the analysis from the Request 
Approval queue and into the Approved portion of the database.   

Note:  If you look at the Open Analysis dialog box, you'll see the selected 
analysis listed in the Approved section of the analysis list. 

Deny Approval of an Analysis 
When a user performs an analysis and saves it to the database, he or she 
will request approval for that analysis with the Request Approval option 
on the File menu.  TOPS Pro takes that request for approval and places it 
in a queue of analyses waiting to be approved or denied by a supervisor.   

To deny approval of an analysis, start from the Menu Bar and follow these 
instructions: 

1. Open the Supervisor menu. 

2. Select Open Request.  The Open Request for Approval dialog box 
appears, as pictured below. 
 

 
3. Select an analysis you want to examine for approval or denial. 

4. Click on OK.  TOPS Pro opens the selected analysis in the Analysis 
View. 

5. Examine the analysis to decide if you want to approve or deny it. 

6. To deny approval of the analysis, open the Supervisor menu. 
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7. Select Deny Approval. TOPS Pro asks if you want to deny approval of 
the selected analysis. 

8. Click on OK.  TOPS Pro removes the analysis from the Request 
Approval queue. 

 

Open and Transfer Other Users' 
Analyses 
When you login as a supervisor, TOPS Pro allows you to open and view 
all analyses for all users.  TOPS Pro also allows you to transfer an analysis 
from one user to another.  To transfer an analysis, follow these 
instructions: 

1. Login as a supervisor. 

2. Login as the user to which you want to transfer the analysis.  For 
example, if you want to transfer an analysis from Package Design to 
Purchasing, login as Purchasing. 

3. Open the analysis you want to transfer. 

4. Open the File menu and select Save As.  The Analysis Save As dialog 
box appears. 

5. Click on OK.  TOPS Pro saves the analysis to the database and in the 
process transfers the analysis from the previous user to the current 
user. 

 

Set Up an Analysis Template 
TOPS Pro allows you to setup templates for analyses that you frequently 
perform and save them to the template toolbar to the left of the Control 
Panel. When you click on a template button, TOPS Pro will automatically 
insert the corresponding icons in the package design sequence and open 
the parameters dialog box for data entry. 

To set up an analysis template, start from the Menu Bar: 

1. Select Template Setup from the Supervisor menu.  The top portion of 
the Control Panel will have a red background. You are now in "edit 
template" mode, which allows you to open, save and change templates. 
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2. Click on the button style menus to create the design sequence for an 
analysis. There is no need to define the parameters at this time, you 
only need to specify the stages to be included. 
 
In this example, we are creating a template for to package blister packs 
into shipcase and then onto pallets. 
 

 
3. To save the design sequence as a template, go the File menu and select 

Save As Template. 

4. Enter the name for the template in the Name field and click on OK to 
return to the Control Panel. 
 

 
5. At the Control Panel. click on the “Exit templates” button.  
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The new sequence will now be available in the Template Toolbar. 
 

 

Delete an Analysis Template 
To delete an existing template, you will need to login as Supervisor. 

1. Go to the Supervisor menu, select Login/Logout.  

2. Enter password “tops software” and click on the Login button. 

3. Go to File menu and select New via Template. The Open Analysis 
dialog box opens. 

4. Highlight the template to be removed and click on the Delete button. 

 

Set Up a Quick Print Template 
As you work with TOPS Pro day-to-day, you'll find that you perform and 
print some analyses on a frequent basis.  TOPS Pro allows you to setup a 
Quick Print template for these routine printouts.  Instead of manually 
setting up print parameters, Quick Print builds the printout automatically. 

Note:  TOPS can customize each of these templates for you, or you can 
create your own templates from scratch.  For more information on how to 
access the Quick Print templates, please refer to Chapter 11, Printing. 

To set up a Quick Print template, start from the Menu Bar: 

1. Select QPrint Template from the Supervisor menu.  The top portion of 
the Control Panel will have a red background. You are now in "edit 
template" mode, which allows you to open, save and change templates. 
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2. Click on the button style menus to create the design sequence for an 

analysis. There is no need to define the parameters at this time, you 
only need to specify the stages to be included. 

3. When done with the analysis, open the File menu. 

4. Select Print Preview, then select Analysis.  The Print Parameters 
dialog box appears. 

5. Use the Print Parameters dialog box to set up report template. Please 
refer to Chapter 11 on how to setup the report. 
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6. Click on OK.  The Print Preview Screen appears. 
 

 
7. Use the Print Preview Screen to add any annotations or graphics, if 

desired. 

8. Save the Quick Print template by going to the File menu and select 
Save As. This opens the Analysis Save As dialog box as shown below. 
 

  
9. Enter a name for the Quick Print template in the Name field and click 

on OK to save. 

10. Click on Close button in the Preview screen to return to the Control 
Panel. 
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11. At the Control Panel. click on the “Exit templates” button.  

12. Clock on Yes when prompted to save changes. The Control Panel 
redisplays in its normal colors. 

Delete a Quick Print Template 
To delete an existing Quick Print template, you will need to login as 
Supervisor. 

1. Go to the Supervisor menu, select Login/Logout.  

2. Enter password “tops software” and click on the Login button. 

3. Go to the Supervisor menu, select QPrint Template. 

4. Go to File menu and select Open. The Open Analysis dialog box opens 
and is as shown next. 

5. Highlight the QPrint template to be removed and click on the Delete 
button. 
 

 
6. Click on the Delete button at the confirmation dialog box. 

7. Click on OK to exit.  
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Global Configuration 
In the TOPS Configuration program, a supervisor can select and de-select 
a number of configuration options that are not available in the TOPS Pro 
for Windows program or to anyone other than a supervisor.  This function 
allows you to define a global configuration for your TOPS Pro system.   

To define a global configuration, start from the TOPS Pro Configuration 
program and follow these instructions: 

1. Click the Login Quick Link or open the Supervisor menu and select 
Login/Logout. 

2. Type in the Supervisor password (“tops software”) and click the Login 
button. 

3. Click the Configuration quick link or go to the Supervisor menu and 
select Configuration.  

When the Configuration dialog box appears, click on the Global tab on the 
far right, as pictured below. 
 

 

 Global Tab: This tab displays configuration settings that affect how 
the TOPS Pro software runs – for example, whether or not to allow 
users to approve their own analyses, to allow duplicate products in a 
Package Profile or use a logo in reports, etc.   
 
These parameters affect all existing and/or new users.  Be aware that if 
you change these parameters, in order for the changes to "stick," all 
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users in TOPS Pro and TOPS Configuration must exit the respective 
systems. 

For detailed information about the Global Configuration dialog box, 
please refer to Appendix B, Dialog Boxes. 

Set Up Statistics 
TOPS Pro allows a supervisor to set up rows and columns of statistics that 
will display in the various Statistics View panes.  This allows you to 
eliminate unnecessary data from your reports.   

You can perform this function in either the TOPS Pro and TOPS 
Configuration program.  The statistics setup affects all users.  Be aware 
that when you set up or change statistics parameters, in order for the setup 
or changes to "stick," all users in TOPS Pro and TOPS Configuration must 
exit the respective systems. 

To set up statistics, follow these instructions: 

1. Login as a supervisor. 

2. Use these guidelines to open the Statistics dialog box: 

 In the TOPS Pro system, open the Tools menu and select 
Configuration and click on the Statistics tab. 

 In the TOPS Configuration program, open the Supervisor menu, 
select Configuration and click on the Statistics tab. 
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3. Set up rows and columns of statistics to construct the various Statistics 
View panes as you want. 

4. Click on OK.  TOPS Pro saves your statistics setup to the database. 

For detailed information about the Statistics Setup dialog box, please refer 
to Appendix B, Dialog Boxes. 

Set License 
This supervisor function allows you to reset the license on your TOPS Pro 
software. You will only use this function upon instruction from TOPS 
technical support team. It provides easy access to the licensing screen 
should you have upgraded your network license or want to change the 
licensee information. 

 
This dialog box is the same as the one you see upon initial installation and 
setup of the TOPS program. 

 Company Name:  Enter the registered licensee name. Make sure to 
enter the name EXACTLY as provided to you. If you receive a 
checksum error when you setup the license, this means the Company 
Name you entered does not match the one provided to you. 

 Serial Number:  Enter the serial number provided to you by TOPS. 
The first 7-digit will be your short form serial number as marked on 
the face of you TOPS software CD or plastic CD case. 
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 Key:  Provide this number to TOPS when you contact us to setup the 
license. 

 Verification Code:  This will be provided to you when you contact us 
to setup the license. 

 Apply button:  After all the information has been entered, click this 
button to complete license setup. You will see a message 
“Successfully Set License” if all data are entered correctly. Check the 
License Information section at this time to verify your license 
configuration: stand-alone versus network and the number of users if 
yours is a network license. 
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Chapter 16: RFID Analysis 

Introduction 
This chapter introduces the basic functions of the RFID location 
optimizer in TOPS Pro.  The RFID optimizer allows users to optimize 
pallet patterns for maximum RFID readability. 

To use RFID optimizer, first create a Shipcase → Pallet analysis as 
described in earlier chapters of the User Guide.  In this example, we’ll 
use the following shipcase and pallet parameters: 

 Shipcase Length (in):  Enter 16 
 Shipcase Width (in):  Enter 10 
 Shipcase Height:  Enter 10 
 Pallet:  Use the default GMA (Notched) with the default settings 

 
You will get the solutions as pictured below. 

 

Note that the thumbnails for Unitload list (under Tools, Configuration, 
General tab) is disabled to show more solutions on the screen. 

Click on the RFID button to access these two functions. 
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 Sort by RFID:  Sorts the unitload solutions according to the amount 
of RF blockage, from the least to the greatest.  

 RFID:  Takes the current pallet pattern and displays it in the RFID 
Dialog Box. Here you can select various options regarding the 
location and placement of the RFID tags on the shipcases.  You also 
have the option to rotate shipcases within the pallet pattern to 
maximize RF readability. 

 

Sort by RFID 
To obtain the best pattern for RFID tag placement (on shipcases), click 
on the “Sort by RFID” button, you will see the solution as pictured 
below. 

 

This will add an extra (last) column of statistics to the UnitLoad List pane 
with heading RFID Blockage.  The unitload solutions are sorted such 
that patterns with the least RFID blockage will appear on the top of the 
list. 

The letter in brackets to the right of the RFID factor represents the 
shipcase face on which the tag is located.  This will be the face where the 
tag will have maximum readability.  The percentage (%) represents the 
maximum amount of blockage that a shipcase in the current pattern 
would have using the default values. 
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(F) – Front  (L) – Left  (T) – Top 
(B) – Back  (R) – Right  (BT) – Bottom 
 
The top 3 solutions will appear as below: 

                     

  
 
Notice that the 3 solutions all have a RFID factor of 0%, meaning that 
none of the RFID tags on the shipcases are obstructed from the scanner. 
To get back to your original sort order, click on the “Sort by Eff” 
(Efficiency) button in the unitload view pane. 
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RFID Analysis 
The RFID button leads to the functionality which optimizes placement of 
RFID tags for an existing pallet pattern. 

To illustrate this function, we use the first unitload solution in the current 
analysis.  To do so, make sure you highlight the first solution and click 
the RFID button in the unitload view pane.  The RFID Dialog Box, as 
shown below, opens. 

Note:  The small dark rectangles in the Unitload Plan View at the bottom 
represent the RFID tags. 

 

The following list gives a brief overview of the different options in RFID: 

 Box Face for tag:  Click the radio button to specify the shipcase face 
where the tag will be placed. 

 Tag Position for selected Face:  Click the selection as to where on 
the selected shipcase face the tag will be placed. 

 RF Blockage Consideration: Click the selection to specify the 
blockage factor which TOPS Pro should consider when placing RFID 
tags: product, the box or both. 

 RF Signal with Box Wall: Enter an estimate in percentage (%) the 
amount of RF pass through or blockage imposed by the walls of the 
shipcase. 
 
Note:  You will need to enter only one of the two values, the other 
percentage will be populated automatically based on a total of 100%. 
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 RF Signal with Product: Enter an estimate in percentage (%) the 
amount of RF blockage imposed by the contents inside the shipcase 
along the Length, Width and Height of the shipcase. 
 
Note:  You will need to enter only one of the two numbers for each 
line, the other percentage will be populated automatically based on a 
total of 100%. 

 Optimize Solutions for RFID:  If checked, this option enables 
rotation of shipcases on the current pallet pattern by 180 degrees to 
obtain the most visibility to the RFID tags. 
 
The illustrations below show how optimizing the solution by rotating 
the shipcase at the top by180 degrees cuts average RF blockage from 
18.46% to 9.23% for the current example. 
 

       
 
Note: The shaded shipcases are the ones with maximum RF blockage. 
 

 Recommend Best Solution/Recalc Recommendations: Click this 
button to have TOPS Pro start RFID tag optimization based on the 
options selected above for the current pallet pattern.  The results are 
displayed in the RFID Solution List. 
 
If you have changed any parameters, click this button again (now 
labeled as Recalc Recommendations) to recalculate the solutions. 

 RFID Solution List: Displays the list of RFID tag placement 
solutions, sorted by the amount of RF blockage. 
 
In the RDIF Solution List below, it lists the maximum and average 
blockage when the tags are placed on the 
left, right, front, and top face of the 
shipcase respectively.  You can click on 
each solution to have the 3D and plan 
views of the unitload. 
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Chapter 17: Eco Savings Report 

Introduction 
The Eco Savings Report allows you to compare up to 5 solutions the 
effects different package size, case size and pallet and vehicle loads have 
on the environment in terms of carbon emission and corrugated and 
packing material wastage or usage.   

To begin, first create the analysis and enter the package dimensions and 
sizing that you’d like to evaluate, then setup the cost parameters for the 
analysis. Once these are setup, you can compare the eco savings data 
among various solutions in different stages. 

Please follow these instructions to go through an example. 

 

Create the Analysis 
1. Go to the File menu, select Open. 

2. At the Open Analysis dialog box, highlight Cookies(Boxed and 
Palletized) and click on OK to open. 
 
TOPS will open the analysis with the previously saved solution. 

3. Click on the Cancel button ( ) in the Tool Bar to go back to the 
Control Panel. 

4. Click on the Calc button to re-generate all solutions. 

 

Set up Cost Factors 
5. Go to the Tools menu, then ESR and select ESR Configuration.  You 

will see the Eco Savings Report (ESR) dialog box as pictured below. 
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6. Let’s set up a route called Route1 and input the data as pictured 
below. 
 

 
 

7. When done, click on OK to save the parameters into the TOPS 
database. 
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Select the Solutions 
8. Select the Intermediate pack solution as pictured below and proceed 

to the shipcase stage by clicking on the Next button ( ) on the Tool 
Bar. 
 

 
9. At the Shipcase Solution View, we’ll create the Eco Savings Report 

by comparing the first, second, third and seventh shipcase solution. 

10. Select the shipcase solution by double clicking the solution, a check 
mark appears under the Select column in the solution view once the 
solution is selected. 
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11. Continue step 10 until all 4 solutions are selected as pictured below. 
 

 
12. Go to the Tools menu, select ESR and then ESR for Analysis. 

13. A pop-up dialog box appears to prompt for additional parameters. 
Select Route1 from the Route field and enter other relevant 
information as pictured below. 
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14. Click on OK to view the report for the four selected solutions as 
pictured below. 
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15. To view the ESR statistics, click on the Statistics button. 
 

 
16. To compare the Unitload and/or Transit Vehicle stages, click on 

Close to return to the solution view. 

17. Use the Next button ( ) to proceed to the Unitload stage. 

18. Repeat steps 10 through 15 to select multiple solutions and generate 
the reports as described. 

 

Note that the ESR provides the following comparison data: 

Costing   Wastages  
Transportation Cost  CO2 Emissions 
Corrugated Cost  Corrugated Material Used 
Miscellaneous Cost  Corrugated Material Wasted 
Total Cost   Additional Material Used 
    Additional Material Wasted  
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Chapter 18: Send to MS Office 

Introduction 
The Send to MS function under the Export menu allows you to export the 
current analysis to a MS Word or MS Excel file with a pre-defined 
template.  This chapter will discuss the following: 

 Export an analysis to a predefined Word template from TOPS 
 Export an analysis to a predefined Excel template from TOPS 
 Create a new Word template for use with TOPS data 
 Create a new Excel template for use with TOPS data 

 
 

MS Office Templates 
TOPS Pro comes with Word and Excel templates pre-formatted to 
display graphics and statistics from a TOPS analysis.  These templates 
contain special bookmarks (for Word) and field names (for Excel) to 
refer different data from the analysis.  Please refer to Appendix G for a 
list of bookmarks and field names used for Word and Excel respectively. 
 
The MS Office templates for TOPS are saved in the 
\TOPSAPPS\TOPSPro\msword\ folder and can be easily modified to 
display data in the desired format.  You can also design new templates 
from an existing document and apply relevant bookmarks or field names 
at the corresponding locations.  
 
For any newly created templates, they have to be saved in the same folder 
as referenced above in order for TOPS to display them as available 
selection in the Select template to export dialog box. 
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Export to MS Word 
In this example, we will use sample analysis Cookies(Boxed and 
Palletized) to illustrate the send to MS Office function.    

1. Go to the File menu and select Open. 

2. At the Open Analysis dialog box, select Cookies(Boxed and 
Palletized) under the Approved section of list in the Main Folder and 
click on OK. 

3. The saved analysis will be opened as pictured below. 
 

 
 
Note:  If your screen layout looks different from the one above, go to 
the View menu and select “Split Screen”. 

4. Go to the Export menu and select Send to MS Office or click on the 
 icon on the tool bar and select Send to Word.  This opens the 

Select template to export dialog box as pictured below. 
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5. Highlight XMLWord.dot and click on OK. 

6. TOPS will instruct your system to open MS Word. 
 
Note: You might see a security warning as shown below depending 
on the security setting in your MS Word.  
 

 
 

7. Click on Enable Macros if you see the above message to proceed with 
data export from TOPS to Word. 

8. MS Word will start placing different data at assigned locations and 
when done, you’ll see a three page document as pictured below. 
 

  
9. Save the document as desired using Word’s File, Saved as function. 

 

Note: To enable Macros in MS Word 2007, please follow these steps: 

1. Click the Microsoft Office Button , and then click on Word 
Options. 

2. Click Trust Center, click Trust Center Settings, and then click Macro 
Settings. 

3. Click Enable all macros.  
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Export to MS Excel 
In this example, we will again, use sample analysis Cookies(Boxed and 
Palletized) to illustrate the send to MS Office function.    

1. Go to the File menu and select Open. 

2. At the Open Analysis dialog box, select Cookies(Boxed and 
Palletized) in the Main Folder and click on OK. 

3. The saved analysis will be opened. 

4. Go to the Export menu and select Send to MS Office or click on the 
 icon on the tool bar and select Send to Excel.  This opens the 

Select template to export dialog box as pictured below. 
 

 
5. Highlight TOPSSampleTemplate.xls and click on OK. 

6. TOPS will instruct your system to open MS Excel. 

7. MS Excel will start placing different data at assigned locations and 
when done, you’ll see a worksheet with the following layout. 
 

 
8. Save the document as desired using Excel’s File, Saved as function. 



 

Chapter 18:  Send to MS Office 18-5 

Create a Custom Word Template 
To create a custom Word template for TOPS Pro, these are the steps you 
should follow: 

 Copy an existing Word template from TOPS system 
 Format the document to the report format as desired 
 Place data and graphic using TOPS bookmarks in corresponding 

locations 
 Save the document as a Word template in 

\TOPSAPPS\TOPSPro\msword folder 
 

Followed are the instructions in more detail: 

Copy Blank.dot to MyTemplate.dot 
1. Right click on the My Computer icon on your desktop and select 

Explore on the pop-up menu. 

2. Navigate to the folder where document templates for TOPS Pro were 
installed (normally \PROGRAM FILES\TOPSAPPS\TOPSPRO\msword\ 
folder) as pictured below. 
 

 
3. Right click on the document Blank.dot and select Copy at the pop-up 

dialog box. 

4. With the mouse button anywhere in the folder list, right click the 
mouse button and select Copy at the pop-up dialog box as pictured 
below. 
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5. A new file call Copy of Blank.dot will be created. 

6. Right click on the new file Copy of Blank.dot and select rename at 
the pop-up dialog box. 

7. When the filename is highlighted, edit the text to “MyTemplate.dot” 
and press Enter on the keyboard. 

We have just created a new blank template file named MyTemplate.dot in 
the \TOPSAPPS\TOPSPro\msword\ folder. 
 

Format the Template 
In this illustration, we are using Word 2003.  If you are using other 
versions of Word, please use the corresponding commands. 

1. Right click the file MyTemplate.dot and select Open in the pop-up 
menu to open it in Word. 
 
Note:  Make sure that you open the dot file as instructed or directly 
from within Word.  Double clicking a dot file would only create a 
new document file based on the dot file but not opening the dot 
file. 

2. Click on Enable Macros to use macros created for the template file.  
You will see a new blank document opened in Word. 

Note that there is a new menu item “Tops” in the Menu Bar and when 
clicked on gives the option Tops Bookmark as pictured on the next 
page. 
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Note:  In Word 2007, you will find “Tops” option under the “Add-
Ins” menu. Click on the drop down arrow next to “Tops” to view the 
defined bookmarks. 
 

 
3. Format the new Word report as needed.  In the sample report below, 

the different areas contain statistics and images from TOPS as 
pictured below. 
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Add Tops Bookmarks 
To add the graphics and statistics in the marked area, we will use the 
Tops Bookmarks saved in this word template file.  A list of Tops 
bookmarks is available in Appendix G. 

Before adding the bookmarks, please make sure bookmarks ( I ) are 
visible within Word.  Go to Word’s Tools menu and select Options…, 
make sure the Bookmarks check box under the View tab is checked as 
pictured below.  Click on OK to save the setting. 

 
 

In World 2007, click the Microsoft Office button  and then click on 
Word Options. Click Advanced and then scroll down to the Show 
document content section and check “Show Bookmarks”.  

 
 
In this example, we will add the following bookmarks in the highlighted 
areas of the report as shown on the previous page: 

 Area 1: Shipcase length in inches (STATS_SHIPPER_LEN) 
 Area 2: Shipcase cube in cubic inches (STATS_SHIPPER_CUBE) 
 Area 3: Number of shipcase per layer (STATS_UL_PER_LAYER) 
 Area 4: Unitload 3D view (IMAGE_UL_SINGLE_STACK_3D) 
 Area 5: Intermediate Pack 3D view (IMAGE_IP_SINGLE_STACK_3D) 
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1. To insert Shipcase length in inches, click in the area marked , go to 
Tops menu and click on Tops Bookmarks.  The Tops Bookmarks 
dialog box, as pictured below, appears. 
 

 
 
Note that you can also check the Show All bookmarks option in this 
dialog box to show added bookmarks in the document. 

2. Click on the drop-down list, scroll though the list and highlight 
STAT_SHIPPER_LEN; click on the Add button as pictured below. 
 

 
3. The text cursor ( | ) now changes to a bookmark indicator ( I ) in the 

highlighted above. 

4. Now select bookmark STATS_SHIPPER_CUBE from the list, click on 
the Shipper Cube field, area  and click on the Add button in the 
TOPS Bookmarks dialog to add the bookmark. 
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5. To add shipper per unitload layer, select STATS_UL_PER_LAYER 

from the list, click on the area as pictured below and click on the Add 
button in the TOPS Bookmarks dialog to add the bookmark. 
 

 
6. To add the intermediate pack 3D graphic, select 

IMAGE_IP_SINGLE_STACK_3D from the list, click on the area as 
pictured below and click on the Add button in the TOPS Bookmarks 
dialog to add the bookmark. 
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7. To add the unitload 3D graphic, select 

IMAGE_UL_SINGLE_STACK_3D from the list, click on the area as 
pictured below and click on the Add button in the TOPS Bookmarks 
dialog to add the bookmark. 
 

 
8. After all 5 bookmarks have been added, go to Word’s File menu and 

select Save to save the changes to the MyTemplate.dot file.  Exit MS 
Word.  This template is now ready for use in TOPS. 

9. Now go back to TOPS Pro, with the current analysis Cookies(Boxed 
and Palletized) still open, go to the Export menu and select Export to 
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MS Office.  You should now see the MyTemplate.dot under the list of 
available Templates. 

10. Highlight MyTemplate.dot and click on OK. 

11. MS Word will open with the Security Warning message.  Click on 
Enable Macros and a new document using the selected template will 
be open as pictured on the next page.   
 
Note the five areas we have bookmarked are now populated with the 
corresponding data and graphics. 
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Tips on Using Bookmarks in MS Word 
1. The TOPS menu on Word’s menu bar is only available when you 

open the template file in the \TOPSAPPS\TOPSPro\msword\ but not 
a word document based on the TOPS template file.  

2. If you want to review an assigned bookmark in a Word template, go 
to Tops menu and open Tops Bookmarks.  Place the text cursor next 
to the bookmark, the Tops Bookmarks dialog box will display the 
name of the bookmark. 

3. To delete an assigned bookmark, follow tip #2 above and then click 
on the Delete button.  The bookmark cursor ( I ) will be removed. 

4. The state of the Add, Delete and Goto buttons – active or being 
grayed out – gives you the hint if the selected bookmark has been 
assigned in the template.   

 When the Add button is active -  the selection has not been 
bookmarked 

 When the Add button is inactive (gray out), the selected 
bookmark exists in the current document.  Click on the Goto 
button to bring the text cursor to the selected bookmark, then 
click on the Delete button should you want to remove the 
bookmark.  



 

18-14 TOPS Pro (Version 6.50) User Guide 

Create a Custom Excel Template 
In MS Excel, TOPS data, including both images and statistics, are placed 
into designated cells defined by Range Names.  These names are similar 
to bookmarks in MS Word and given cell references for placement of 
different data. 

The TOPSSampleTemplate.xls provided with TOPS contains defined 
names for most statistics and most 3D images from different stages of a 
TOPS analysis.  The easiest way is to adapt this template and redefine the 
cell reference for data placement. 

Please follow these instructions to create a custom Excel template.  

 Save a copy of the TOPSSampleTemplate.xls to a new file and make 
sure it is saved in the \TOPSAPPS\TOPSPRO\msword\ folder 

 Change the layout of the worksheet as desired 
 Change the cell reference of the Range Names  

 

Create & Format a New Worksheet in Excel Template 
1. Open Excel, browse to the folder \TOPSAPPS\TOPSPRO\msowrd\ 

and open TOPSSampleTemplate.xls as pictured below. 
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The circled area is called is the Name Box and displays any name 
defined for the active cell (C5 in this example on the previous page). 
 
If you click the drop down triangle next to the Name Box, you will 
see a list of names defined in the current workbook. When you click 
on any of these names, Excel will go to the cell or cell range where 
the name is referenced.  For example, the name 
IMAGE_SC_POPTOP_3D refers to the cell G15 which has been 
merged to two columns on its right and nine rows beneath it. 
 

 
2. Go to File menu, select Save As and enter “New TOPS Template.xls” 

in the File name field and click on the Save Button to save the sample 
template under the new name. 

3. Now insert a new worksheet in current workbook by going to the 
Insert menu and then select Worksheet.  A new worksheet called 
Sheet2 will be added. 

4. Go to Sheet2 and create the report layout as desired.  An example 
similar to the one created in MS Word example is pictured on the 
next page. 
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Assign New Cell References 
In this illustration, we are using Excel 2003.  If you are using another 
version of Word, please use the corresponding commands.  There are two 
ways to assign new cell reference to defined names: 

 Go to the Insert menu, select Name and then Define.  Change the cell 
reference to the new worksheet and new cell. 

 Drag and drop existing cell content from the existing worksheet 
(Output) to the new worksheet (Sheet2). 
 
Note:  The source and target cell need to be of the same dimension.  
Note: To drag across worksheet, bring the mouse cursor to the 
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worksheet tabs and press the [Alt] key to highlight the new 
worksheet, release the [Alt] key when you are in the new worksheet.  
You will need to keep the left mouse button pressed all this time with 
the cell content until you reach the destination cell in the new 
worksheet. 
 
Note:  When using the drag-and-drop method, any cell formatting 
will also be brought over to the new cell. 

We will illustrate the first method of changing cell reference using the 
menu function. In this example, we will add the following in the 
highlighted areas of the report as shown on the previous page: 

 Area 1 (cell B21): Intermediate Pack pop top 3D view 
(IMAGE_IP_POPTOP_3D)  

 Area 2 (cell G21): Unitload 3D view 
(IMAGE_UL_SINGLE_STACK_3D) 

 Area 3 (cell C16): Shipcase outside length dimension (SCOUT_LEN) 
 Area 4 (cell H16): Number of shipcase per layer 

(UL_CASESPERLAYER) 
 Area 5 (cell H17): Number of shipcase layer per pallet 

(UL_LAYERSPERLOAD) 
 

1. Go to Insert menu, select Name and then Define, the Define Name 
dialog box appears as pictured below. 
 

 
2. Scroll down the list until you see IMAGE_IP_POPTOP_3D.  The 

Refers to: field shows  “=Output!$D$15” – the cell reference in the 
existing sample worksheet. 

3. With the name highlighted, change the reference field to 
“=Sheet2!$B$21” as pictured on the next page and click on the Add 
button. 
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4. Next, highlight IMAGE_UL_SINGLE_STACK_3D and change the 

reference to “=Sheet2!$G$21” and click on the Add button. 
 

 
5. To assign new reference to shipcase length, select SCOUT_LEN from 

the list and change the cell reference to “=Sheet2!$C$16” and click 
on the Add button. 
 

 
6. Repeat the step and assign UL_CASESPERLAYER to cell Sheet2!$H$16 

and UL_LAYERSPERLOAD to cell Sheet2!$H$17 respectively. 

7. Click Ok to close the Define Name dialog box. 

8. Save the workbook and exit MS Excel. 

9. Now, go back to TOPS Pro and open analysis “Cookies (Boxed and 
Palletized). 
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10. Click on the  icon on the tool bar and select Send to Excel to 
open the Select template to export dialog as pictured below. 
 

 
11. Select New TOPS Template.xls and click on the OK button. 

12. MS Excel will open displaying the contents of the Output worksheet 
in the workbook.  Click on the Sheet2 tab to view the new populated 
report as pictured below. 
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Tips on Using TOPS Templates in MS Excel 
1. Make sure the Excel template is saved in the 

\TOPSAPPS\TOPSPro\msword\ folder in order to appear in the 
template list in TOPS Pro. 

2. You can hide the Output worksheet from the workbook so it will 
show your report on Sheet2 right away.  To do so, click the tab 
“Output” to make it active, then go to Format menu, select Sheet and 
then Hide. 

3. The Name Box shows all Names used in the current workbook.  To 
view all available defined names, including those with no reference, 
you’ll need to go to the Inset menu, select Name and then Define. 

4. Do not delete any Defined Names in the workbook. 

5. If you need images that are not currently defined, please contact 
TOPS technical support. 
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Chapter 19: TOPS Enterprise 
Version (Pre-Release) 

Introduction 
In the standard version of TOPS Pro, all data and analyses are saved in a 
ctree database and the program accesses the data files saved in “DATA” 
folder.  If the “DATA” folder resides on a network drive, each user needs 
to have “WRITE” permission to all data files.  In addition, each instance 
of TOPS requires a separate connection to the network server and handles 
its own data exchange with the database. 

 
 
TOPS Enterprise version uses Microsoft SQL Server database to manage 
data. Users have no direct access to files on the server as MS SQL 
Database Server handles all the data exchange between TOPS clients and 
database. 

 
TOPS Enterprise version can be installed over an existing standard 
installation of TOPS Pro or as a new installation.  If you are upgrading 
from the standard version, you will receive: 

 The new executable to overwrite the existing TOPS program. 
 Scripts to help you create the database on MS SQL server or Oracle 

database. 
 Detailed instructions to import data from existing TOPS database, if 

applicable. 
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Benefits 
 Optimized Database 

For companies with lots of analyses, the database engine used by the 
standard TOPS version might result in data fragmentation overtime.  
The data files keep growing and the performance of software might 
get slow.  The Enterprise version uses SQL Database Server which is 
optimized for large amount of data with its built-in file management 
function. 

 Better Performance 
The SQL Server manages all connections between TOPS clients and 
the central database instead of having each TOPS user making a 
separate connection.  The multiple connections coordinated by SQL 
can share resources and boost performance. 

 Data Security 
Regular TOPS requires each user has an account on the file server 
and each account must have write privilege to the data folder.  The 
Enterprise SQL version uses the authorization mechanism of MS 
SQL Server. Clients do not have direct access to any file on the 
server. 

 Ease of Maintenance 
TOPS provides scripts to take advantage of the built-in functionality 
of MS SQL Server for periodically cleaning up old manifest data. MS 
SQL Server also has powerful tools to easily backup or duplicate 
database. 

 Expandability and Flexibility 
With minor changes, SQL version of TOPS can support other popular 
databases like Oracle or IMB DB2. 

 

Who can Benefit from TOPS Pro Enterprise Version 
TOPS Pro Enterprise version is designed for customers with at least five 
users working collaboratively for enterprise wide packaging and 
palletization solutions.   

Companies with thousands of existing analyses will also benefit from the 
Enterprise version which offers an interface table to SQL and allows for 
easy data export to other subsystems. 
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Additional Functionalities 
 Secured Single Sign-on – Users can log into TOPS Pro using their 

Windows login name, eliminating a separate login when accessing 
TOPS Pro.  This is a global setting that can be enabled via TOPS 
Configuration settings, accessed by system supervisor only. 

 Secured User Roles – TOPS Program supervisor can assign users 
with different user roles for different access rights to TOPS: 
 

 

Viewer – Access to TOPS Viewer program only; this ensures 
selected uses can only open and view existing analyses but not 
making any modifications. 

Standard User – This group of users will be granted rights to create 
analyses but with no authority to change configuration settings, 
import/export, or define products. 

Power User – These users can access all functionalities except for 
global configurations. 

Supervisor – Supervisor has full access to all functions of TOPS. 
 

 License Manager – TOP Enterprise version comes with a License 
Manager which enables users to detach one license from the work 
group and place it temporarily onto a separate machine.  If the 
detached license is not put back to the network within 30 days, it will 
expire automatically and the number of seats on the network will 
revert back to its original count. 

 Enhanced Analysis Management – For better work collaboration, 
users can use the Check In/Check Out function to control work flow 
of analyses.  A revision history is also available for each analysis to 
provide a timeline of changes made. 
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 Shipcase Search – This new function allows users to search through 
existing analyses any shipcase bearing similar dimensions to the one 
being used in the current analysis.  Users can specify the amount of 
deviation from current shipcase for TOPS to search through the 
database or archived analyses. 

System Requirements 
TOPS Enterprise version supports Microsoft SQL server 2000 and above, 
Oracle server 9i and above. 

 Client Hardware Requirements 
 Processor: Pentium III 450 MHZ or better 
 RAM: 512 MB or more 
 Hard Disk Space: 50 MB 
 Video Card: 640x480, 256-color, 800x600, 16-bit color or higher 

recommended 
 Client Software Requirements 

 Operating System: Windows NT/2000/XP/Vista/Windows 7 
 DirectX: 6.0 or above 
 OLE DB Provider: No additional component required for MS 

SQL Server. Oracle client full installation is required to setup the 
Oracle OLEDB provider if the database server is Oracle. 

 Database component: MDAC 2.8 or above.  This is already built 
into Windows XP, Vista and Windows7. It only needs to be 
installed for earlier version of Windows. 
 

Note:  TOPS Pro does NOT require Microsoft .Net platform. However, it 
can work on any PC with Microsoft .Net platform. 

If you need more information, please contact your MVP Account 
Manager or our sales team. 
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Appendix A: Frequently Asked 
Questions 

Introduction 
As you read through the questions and answers in this appendix, be aware 
of the following guidelines: 

 In the text, references to "A:" assume that "A:" is your floppy drive.  
References to "C:" and "C:\TOPSPRO" assume that C:\TOPSPRO is 
your installation directory.  Adjust the instructions as necessary for 
your specific situation. 

 Depth is the same as Height. 

 For best results, run TOPS Pro in full-screen mode.  (On many 
screens, the information displayed depends on the amount of room 
available.) 

Q1:  What special steps should I take to move the TOPS Pro software 
to a different machine? 

If you are still using a floppy license key, moving the software to a new 
machine requires uninstalling the authorization back onto the floppy.  
Follow these instructions:  

Place the floppy diskette in floppy drive  

From the Start | Programs, open the TOPS for Windows Apps group. 

Run the TOPS Pro Move program (or winmove.exe file in the 
TOPSAPPS/TOPSPRO/ folder). 

Select “Uninstall license to Floppy.” 

Adjust the source and destination directories as needed, then select OK  

Once the authorization has been moved back onto the floppy, you may re-
install the software as if it were freshly shipped from TOPS.  To maintain 
your old data, copy the subdirectories from under the old TOPS Pro 
installation over to the new TOPS Pro installation. 

Note:  This does not apply to upgrades which should use the 
import/export functionality, as the data will be formatted differently. 

For electronic license, you will need to contact TOPS to move license. 
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Q2:  When I try to run TOPS Pro, I get an error message that says, 
"Maximum of 1 user(s) already logged in."  But I know that no one 
else is using the program.  What's going on? 

This message most often occurs when someone has logged into TOPS Pro 
and crashed out of the program instead of exiting normally.  TOPS Pro 
thinks the user is still logged in.  If someone attempts to login as the same 
person, TOPS Pro will warn them with the message, "User already logged 
in.  Replace?"  Answer Yes to log that person off the system and allow the 
new user to login. 

If you login as someone other than the user who crashed out, TOPS Pro 
issues the message, "Maximum of N users already logged in.”  The "N" 
value is normally one (1) unless you've purchased additional user licenses.  
You can get around this message with one of two options 

 Login as the same person that crashed, then log him or her out  

 Login as supervisor in the TOPS Pro Config program, open the File 
Menu and Select User List to Logout any extra user (s)  

Q3:  What does selecting the various pattern styles do?  You know, 
the ones displayed after you press the Options button in the Shipcase 
Parameters dialog box (also the Unitload Parameters and Transit 
Vehicle Parameters dialog boxes). 

The pattern style checkboxes determine what arrangements TOPS Pro will 
attempt to use when placing your carton/shipcase/ pallet into its respective 
shipcase/pallet/vehicle. 

Depending on your situation, you may choose to check additional patterns 
to attempt to get a tighter load.  You may uncheck some patterns because 
you want simpler patterns; e.g., perhaps your stacking machine can handle 
only simple 1-block patterns. 

Q4:  I can't find yesterday's work.  What happened to it? 

You've probably logged in with a user name other than one you used when 
you saved the analyses.  Each user's analyses are only visible to him or her 
and to someone logged in as Supervisor.  If you login in as Supervisor, 
open the File menu and select Open, you can see everyone's work with 
their name after it.  For more information, please refer to Login/Logout as 
a Supervisor. 
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Q5:  How do I tell what version of TOPS Pro I have? 

In either TOPS Pro or the TOPS Configuration program, open the Help 
menu and select About.  A dialog box appears with version information 
and the name of the company who purchased the copy.  Complete version 
information includes the date, which appears to the left of the OK button 
on the dialog box. 

Q6:  Can I have the program print fractions instead of decimals? 

To use fractional output, follow these instructions:  

Open the Tools Menu and select Configuration. 

Click on the Fractions button. 

Use the checkboxes to adjust the points at which you would like the 
program to operate in fractional mode.  

All fractions will be to the nearest 1/2, 1/4, 1/8, 1/16, 1/32 and 1/64.  Note 
that this will only change the output and display of a value.  The numbers 
that are stored and manipulated are the actual decimal values – not their 
"nearest fractional" equivalents. 

Hint:  Even when not in fractional mode, the program will accept 
fractional input and convert the value to its exact decimal equivalent, just 
as if you had typed in the decimal value in the first place. 

Simply hit the spacebar – or the decimal point – and type the fraction after 
the whole-number portion of the number.  That is, the value 4 1/8 and 
4.1/8 becomes 4.125 after leaving the field. However, values imported 
from external sources must be in decimal form for TOPS Pro to recognize 
them.  

Q7:  Assuming I want my outputs in decimal format, how do I change 
the number of decimals for my results? 

Follow these instructions:  

Open the Tools Menu and Select Configuration. 

Click on the Numeric tab. 

Under the Decimals section, change the appropriate numbers. 

Note:  Adjustments to these values only change the output and display of 
the numbers.  The numbers stored and manipulated are their actual 
decimal values – not the "rounded" display equivalents. 
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Q8:  How do I change the default printing arrangements in my 
analysis reports? 

The default print arrangement is defined in TOPS Configuration program. 
To change the defaults, follow these steps:  

Run TOPS Pro Configuration program and Login as Supervisor. 

Click on Setup Defaults quick link under the Data section or go to the 
Define menu and select Defaults. 

Click on the radio button for Print. 

TOPS Pro displays the default printing arrangement as shown below. You 
can assign different default graphics or statistics in each of the 6 print 
areas using the single-letter abbreviations illustrated on the following 
page.  

 

Note:  The letters are case sensitive. 

Note:  Use uppercase "N" (none) in an Area field to get an empty pane.  
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Codes for Print Layout: 

 

Codes for Area 1 – 6: 

 Primary 
Pack 

Bundle 
Pack 

Intermediate 
Pack Case 

Case Unitloa
d 

Vehicle 

3D x b i D 3 V 

Plan  j p A T L 

Dual Plan     U  

Pop Top     P  

Side  g s G S I 

Front  e f B F R 

Statistics   t C X E 

No View N      

 

 
Q9:  How do I change the graphical online drawing (g.o.d) window 
images? 

The (g.o.d.) system's static pictures are stored as bitmaps in the Pict 
directory, which is located off of your TOPS Pro directory.  You can use 
the Windows Paintbrush to change, edit or replace the pictures. 
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Q10:  Ich bin Berliner; I am a Berliner.  Ich sprache ein kleinste 
Englisch; I speak a little English.  Was kannst du auf mir tunnen?  
What can you do for me? 

The TOPS Pro software comes in several languages, including English, 
Japanese, Spanish, Finnish, French, Portuguese, Chinese and German.  In 
addition, each language is fully configurable, so if you don't like the way 
we said it, you can say it yourself. 

The Text Modification dialog box allows you to perform language editing. 
Use these guidelines: 

 To choose a language, open the Tools menu and select Language  

 To change individual strings, open the Tools menu, select Language, 
then select Edit  

Q11:  The lines on TOPS Pro's reports are too fine.  When I fax the 
reports, the lines are so narrow they almost disappear and have gaps.  
How do I fix this? 

Follow these instructions: 

Open the Tools menu and select Configuration. 

Go to the Reports tab and make Printer Pen Width non-zero; larger 
numbers indicate thicker lines. 

This only affects printed output.  The Print Preview and other on-screen 
drawings will still appear with normal (one-dot width) lines. 
 
Q12:  How do I change the colors of the cartons, shipcases, etc.?  
When I print in color, some colors are so dark they print nearly 
black. 

To select color, open the Tools menu and select Color Selection.  Color 
changes are specific to each user name, not each analysis. 

Q13:  What is "pitch?" 

Ever tried to stack cups?  Some cups will stack very closely together; 
others will barely fit into one another.  Pitch is the distance by which a cup 
sticks out from the cup underneath it.  The more it sticks out, the greater 
the pitch.  A pitch of zero assumes that the tubs/buckets are not nested at 
all.  
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Q14:  I use dividers and box styles different than the ones that come 
with the program.  How can I make my own? 

You can define your own box styles, dividers and pallets from the Define 
menu options.  Also, in the TOPS Configuration program, the Define 
menu provides a wider range of things you can define, such as papers, 
board combinations, flutes and environmental factors.  Any and all data 
that can influence your single-box compression and stacking strength 
results is fully configurable. 

For more information, please refer to Chapter 12, Designing Box Styles, 
Chapter 13, Designing Divider Styles and Chapter 5, Package Pattern and 
Divider Editor. 

Q15:  What is Secondary Pallet Pattern and how do I use it? 

The "secondary pattern" is used to create mixed-layer pallet patterns. 
These are alternating layer pallet patterns in which some of the layers may 
be "borrowed" from other pallet patterns.   To use this feature, follow 
these instructions:  

Find a non-multi-dimensional pallet pattern to use as a secondary pattern. 

Open the Edit menu and select Select as Secondary Pattern. 

Now view another solution from the solution list. 

Open the Edit menu, select Layer Parameters, then select which layer(s) 
you want to use the Secondary Pattern. 

As you scroll through the other patterns, you'll see a mixture of pallet 
layers. Note that the statistics will not be accurate for alternating layer 
unitloads, but will reflect the original unitload before mixing the layers. 

 

Q16:  I'm trying to remove all the TOPS Pro files after uninstalling.  
What do I need to delete? 

Other than the files in the TOPS Pro directory and its subdirectories, 
TOPS Pro makes the following adjustments to your system: 

 It creates a TOPSPRO.INI file in the local Windows directory  
 It creates the icons/shortcuts used to start the program  
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Q17:  How is RSC board area calculated? 

(2L + 2W) (W + H)  

Q18:  How does the program estimate the weight of my box? 

TOPS Pro estimates the weight of a newly designed carton/case or a 
packed carton/case as follows: 

 For Cartons: {((Length*Width*2) + (Length*Height*2)) + 
(Width*Height*2))/144} * {(Caliper/.024*100)/1000} 

 For Shippers or Intermediate Packs: {((Length*Width*2) + 
(Length*Height*2)) + (Width*Height*2))/144} * 
{(Caliper/.018*100)/1000} 

 For Corrugated cases: {((Length*Width*2) + (Length*Height*2)) + 
(Width*Height*2))/144} * {(LBSper1000ft2) / 1000}  

 
Q19:  What are the TOPS Pro Command Line Parameters? 

The following command line parameters work with TOPSPRO.EXE, 
CONFIG.EXE and VIEWER.EXE. 

 -DBPath="C:\APPS\TOPSPRO\DATA":  Overrides any entries in 
the INI file. 

 -ini="C:\WINDOWS\TOPSPRO.INI":  Use the specified INI file 
instead of the default TOPS.INI in the Windows Directory.  Avoid 
sharing INI files. 

 -u "User Name":  Automatically login under the name "User Name." 
 -a "Analysis Name":  Bring up the specified analysis.  Approved 

analyses are opened first (if there is one). 
 -print:  Auto-print and exit.  Used with –a. 
 -printcs:  Auto-print package profile and exit.  Used with –a. 
 -viewcs:  Auto-view package profile.  Used with -a.  

Q20:  How do I calculate Stacking Strength? 

TOPS Pro uses the McKee Formula to calculate stacking strength. First, 
create your analysis in TOPS Pro, then calculate it.  Make sure to have the 
weight entered in for shipcase.  Next, go to the Tools/Stacking Strength 
menu.  From there, enter your factors into the screen, then click OK to 
view the stacking strength results.  
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Q21:  How do I insert pads between layers, or add caps to a pallet 
pattern? 

After you have calculated a pallet pattern, click on the Unitload window to 
highlight it.  Next, go to the Edit/Layer Parameters menu.  Here add what 
you like to your layers or pallet patterns.  You can also click the  
button in the unitload view window to quickly access the Layer 
Parameters menu. 
 
Q22:  How do I use the modify feature to create alternate pallet 
patterns? 

Before you use the Modify feature, we suggest you turn off the Layer 
Rotation feature.  Follow these instructions: 

From the Edit menu, select Layer Parameters. 

In the Layer Parameters dialog box, look at the Rotate column and delete 
any check marks you see.  (Once your pallet pattern is column-stacked it 
will be much easier to deal with.) 

Click on OK to close the Layer Parameters dialog box. 

For detailed instructions on how to modify a pallet pattern, please refer to 
Chapter 5, Package Pattern and Divider Editor. 

Q23: How do I specify what dimension (inside versus outside) and 
unit of measure to display on Cartons, Intermediate Packs, and 
Shipcases? 

Open the Tools menu and select Configuration. 

Go to the Dimensions tab. 

Check the radio buttons that correspond with which inside dimensions you 
would like to see. (Carton, IP, or Cases). 

 

Q24:  How do I create PDF documents from TOPS Pro? 

Direct PDF outputs are available from TOPS Pro version 5.60 and later.  
PDF outputs are only available for reports, but not individual images in 
the solution views. To use this, follow these instructions: 

Highlight the graphics in the solution view you want to export. 

Go to the Export menu and select PDF.  You can also use the right click 
menu, select Save Image and then PDF. 
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At the Get Export File Name dialog box, select the directory path and 
enter the name for the PDF output file. 

The analysis report, in the predefined print preview format will be created. 

You can also access the Get Export File Name dialog box from the Print 
Preview screen.  Just go to Export menu and select PDF or click on the 
PDF button directly. 

The new PDF button ( ) on the Windows toolbar allows you to create 
analysis report, pallet report or package profile.  Just click on the button 
and select the report type. 

Q25:  How do I print a list of shipcases or pallets I have saved in 
TOPS Pro? 

You can print databases from TOPS Pro.  Go to the File/Print Databases 
menu and select Shipcases, Pallets or other databases, such as Cartons, 
Products, Vehicles, etc. 

Q26:  How do I login as Supervisor? 

In TOPS Pro, the Supervisor user has the rights to delete users, see all 
analysis files and other handy things.  To login as a Supervisor, follow 
these instructions: 

Login as any user. 

Open the Supervisor menu and select the Login\Logout option. 

Enter the supervisor’s password.  (The default Supervisor password is 
"tops software".) 

Q27:  How do I change the defaults in TOPS Pro? 

All defaults in TOPS Pro are set in the TOPS Pro Configuration program. 
Here you can change just about anything from the default pallet overhang 
to how your printouts look.  Follow these instructions: 

Login to TOPS Pro Configuration program as Supervisor. 

Open the Define menu and select an option. 

 
Q28:  How do I replace the default TOPS logo with my company 
logo? 
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Follow these instructions: 

Open the TOPSPRO.INI file from your Windows folder. 

Look for the line that reads "Logopath." 

Change the path to point to the location of your BMP file (e.g., 
C:\temp\tops.bmp). 

Q29:  How do I turn on user passwords? 

Follow these instructions: 

Login to TOPS Pro Configuration as the Supervisor. 

Open the Supervisor menu and select Global Configuration. 

Go to the Global tab and place a check mark against the User Passwords 
option. 

 

Q30:  Is there any way to change the arrow shape that shows the 
shipper flaps to a simple straight line? 

The direction where the arrow is pointing indicates the front of the carton 
or shipcase. To disable this function, go to the Tools Menu and select 
Configuration. Under the General tab, remove the “ ” next to “Show Face 
Direction”. This will turn off the face direction arrow and put it back as a 
flap line indicator. 

 

Q31: Why can I only view part of the graphics in the solution screen?  

This might happen in Vista and it can usually be corrected by lowering 
your color settings from 32 bit to 16 bit.  In order to make this change, 
right click anywhere on the desktop. When the option menu appears 
choose ‘Personalize’.  This will bring up a new box and you should see 
‘Display Settings’ within there. You should be able to make this change 
inside the ‘Display Settings’ area. 

 

Q32: Why do I keep getting an error saying please enter valid 
characters or N8068NF? 

Often times the Description of trucks or shippers that were imported into 
your new version of TOPS Pro contain invalid characters, sometimes from 
previous versions of TOPS. One common example is the (ft’) sign. 

In the Vehicle Parameters dialog box select “New Veh.”. 
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In the Define Vehicle dialog box select the vehicle you are going to use 
from the Description field. 

Remove the (ft’) sign from the description and click on Save. 

Now if you choose, you can go back to the description box and select the 
vehicle with an invalid description and delete it. 

 

Q33: I try to get 224 cases per pallet with 7 layers and 32 per layer. I 
made that clear in my pallet selection but it doesn't work, why is that?  

It's caused by some of the patterns currently selected. Open the UnitLoad 
Option dialog by clicking the Options button in the UnitLoad Parameters 
dialog box, unselect ‘Soldiered’ and all of the ‘Multi-*’ pattern styles. 

    

Q34: I want to use the Unitload View in TOPS as part of a Corel 
drawing but the BMP or JPEG file I exported is of low resolution and 
the lines are jagged.  Is there a way to get a better image? 

For bitmap files like BMP and JPEG, the image size is dictated by how 
big the window is when you save the file. Try maximize the unit load view 
when you issue the save command. Another way to get a better image is to 
save the image as a line drawing. That means you will need to save the 
image as a WMF file. To do so, right click while under unitload view, 
select Save Image and then WMF file. 

 

Q35: How does TOPS calculate Area and Cubic efficiency for 
unitloads? 

For area efficiency = L(OD)*W(OD)* (no. of shippers per layer) / L*W of 
pallet) 

Cubic efficiency = L(OD)*W(OD)*H(OD)*Qty on unitload / 
L*W*loadable height of unitload (this is the max allowable height - pallet 
height) 

 

Q36: How does TOPS calculate Area and Cubic efficiency for 
shipcase? 

Area efficiency = area using outside*qty / inside dimension of shipcase 

Cubic efficiency = volume using OD*qty / vol of shipcase using ID 
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Appendix B: Dialog Boxes 

Introduction 
This appendix presents the primary dialog boxes (in alphabetical order) 
used in the TOPS Pro System and its Configuration program.  This chapter 
provides a quick and easy way to locate information on individual dialog 
box and its associated functions during the course of using TOPS Pro 
software. 

For each dialog box, this appendix provides the following information: 

 The function of the dialog box 
 A graphic image of the dialog box 
 Instructions on how to access the dialog box 
 Descriptions of major fields on the dialog box (repetitive and 

obvious fields will not be described) 
 Any special features included on the dialog box 

 
In addition, this appendix addresses features that are common to many of 
the dialog boxes, such as the Graphic Online Display (g.o.d.) feature and 
routine function buttons. 

Common Features 
TOPS Pro includes some features that are common to many dialog boxes.  
Rather than discuss these features with each dialog box, we'll introduce 
them here.  This section presents three common features that you'll use 
with many dialog boxes: 

 Graphic Online Display (g.o.d.) feature 
 Bulge factor, both positive and negative 
 Function buttons – OK, Cancel, Save and Delete 

 

Graphic Online Display (g.o.d.) Feature 
Many dialog boxes allow you to define parameters for the various items in 
an analysis.  For example, you'll use the ShipCase Parameters dialog box 
to define shipcase parameters.  When you first display this dialog box, 
TOPS Pro displays a graphic illustration of a shipcase in the bottom, right 
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hand corner of the screen.  This illustration is termed the Graphic Online 
Display, or g.o.d. feature. 

As you define the length, width and height dimensions for the shipcase, 
the g.o.d. feature redisplays to reflect those dimensions.  For example, if 
you increase the length, TOPS Pro redraws the shipcase to increase the 
length precisely, based on your input.  The g.o.d. feature allows you to see 
exactly what your shipcase looks like as you define it.  If you make a 
mistake, you'll be able to see it and correct it before you calculate the 
analysis. 

Note:  To see your changes take effect, you might need to refresh the 
display by pressing the Tab key, then the Shift and Tab keys 
simultaneously. 

Bulge Factor 
A number of dialog boxes allow you to account for the bulge factor as you 
define parameters for an item – bottle, can, shipcase, etc.  What is bulge?  
Bulge is space inside a container that can be measured as positive or 
negative.   

If a container expands when you fill it with product, the result is a positive 
bulge.  If a container is compressed when it's packed, the result is a 
negative bulge.  The bulge factor allows you to shift the amount of space a 
container takes up without changing its reported size.  Let's consider two 
examples. 

Positive Bulge 
A gallon bottle of bleach may have a designed diameter of seven inches.  
However, once the liquid is poured into the bottle, the bottle may expand 
(bulge) another quarter-inch.  By adding a bulge of 0.25 inches along the 
diameter of the bottle, TOPS Pro will design the bottle as if it has a 
diameter of 7.25 inches, but will report its size as a seven-inch bottle. 

Negative Bulge 
Suppose you're packing rolls of paper towels into a bundle; each roll has a 
diameter of six inches.  However, once the rolls are packed they might 
compress up to an inch, resulting in a negative bulge of one inch. TOPS 
Pro will report the rolls as having a six-inch diameter, but in fact the rolls 
will take up only five inches in the bundle. 
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Printing Bulge Data 
TOPS Pro does not usually report bulge data.  If you want the system to 
report bulge data, follow these instructions: 

1. From the Menu Bar, open the Supervisor menu, select Login/Logout 
and login as a supervisor. 

2. Open the Tools menu and select Configuration. 

3. Click on the Statistics button. 

4. Check the Bulge box under the appropriate column to print bulge data. 

Common Buttons and Functions 
Many dialog boxes feature routine function buttons that are common 
throughout the system.  Some of these common buttons are listed below: 

 OK Button:  Stores your entries and edits to memory, closes the 
active dialog box and takes you back to the previous dialog box or 
screen. 

 Cancel Button:  Closes the active dialog box and takes you back to 
the previous dialog box or screen. 

 Save Button:  Saves your entries and edits to the database. 

 Delete Button:  Erases all your entries and edits and restores the 
previous parameters. 

 Units Function:  To specify the unit of measure in English or Metric.  
You can use the Global Configuration to set the unit of measure 
globally within TOPS or specify the unit in each screen. 

 Dimensions (Length, Width, Height and Weight):  These are self-
explanatory and will not be included for explanation under each dialog 
box. 

 Dimensions:  Select either Inside or Outside to specify how the carton 
dimensions are measured. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the carton. 

 Add Products Button: Displays the Primary Pack Products dialog 
box, which allows you to specify the product parameters and quantity 
of product being place into a primary pack. 
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About TOPS Pro 
Function:  This dialog box provides you with information about your 
TOPS Pro software and how to contact TOPS for support and assistance. 

 
To access, from the Help menu, select About. 

You will find the following information useful when calling in for 
support: 

 TOPS Pro Version:  The version of TOPS Pro software you are 
currently running. 

 Registered to:  The official licensee of the TOPS Pro software. 

 Serial Number:  The serial number of your TOPS software. When 
calling in for support, we only need the first 7 digits of this serial 
number. 

 Simultaneous Users:  The number of concurrent users available for 
your TOPS Pro software.  This number will be 1 for stand-alone 
license and varies for Network license depending on the number of 
seats you have purchased. 

 Current User:  The login name of the current user. 
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 TOPS Protected:  This shows whether the license is a stand-alone or 
network license. 

 Command Line:  Display any command line instructions when you 
launch TOPS.  The most common command line instruction is to tell 
TOPS the location of your TOPSPRO.INI file where TOPS basic setup 
information is saved. 

 App Path:  Display where your TOPS Pro software was installed. 

 Database Path:  Display where your TOPS data folder is located. 

 Language Path:  Display where the language files of your TOPS 
program are located. 

 INI Path:  Display where your TOPSPRO.INI file is located. 
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Additional Costing Data 
Function:  This dialog box allows you to enter additional costing data 
related to a number of items.  Additional Costing Data applies to bags 
only. 

 

To access, from the Define menu, select Bag Costing. At the Costing Data 
dialog box, click on the More button. 

Field Descriptions and Instructions 
 Distribution Center Whse hourly rate:  Enter the hourly expenses 

accrued by your distribution center. 

 Distribution Center Whse cases/hr:  Enter the number of cases per 
hour that your distribution center currently handles. 

 Distribution Center Whse % movement:  Enter the percentage of 
cases in your distribution center that are moved per hour. 

 Route truck cost ($/case cube):  Enter the transportation costs per 
case associated with your delivery trucks. 
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Analysis Save As (Template) 
Function:  This dialog box allows you to save the design sequence of the 
current analysis as a template for future use.  

 

To access, go to the Menu Bar, open the File menu and select Save as 
Template.  

Field Descriptions and Instructions 
 Name:  Enter the name of the template for the design sequence. 

 Sort By: This function will sort the existing templates in the list by 
Name, User or Date. Users will select the sort option in the drop down 
list box. 

 Show: The option is not applicable to templates. 

 Revision History:  Enter any notes related to revisions to the analysis. 
 
Note:  When you perform a Print Preview for the analysis, TOPS Pro 
attaches the revision history notes to the bottom of the screen – if the 
Print Revision option is activated on the Configuration Screen. 
 
The Print Preview will display up to five lines of revision history text.  
After the revision history exceeds five lines, adding more text will 
delete your oldest revision history entry. 

 Save SC:  The option is not applicable to templates. 
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Analysis Search 
Function:  This dialog box allows you to search for a specific analysis 
record when the list of analysis names is too large; when you can't 
remember the exact name of the analysis; when you're trying to find an 
analysis that has certain products attached through its packaging profile. 

The search function works in conjunction with the Open and Export 
Analysis dialog box; it limits the display of analyses on that dialog box to 
only those analyses that match your search criteria. TOPS Pro performs a 
case-insensitive search for partial matches within a field. 

For example, if you enter "bag" in the Analysis Name field, TOPS Pro 
might find analyses with the names, "Bag>Truck," "New Baggage" and 
"Bags."  If you enter "48 CNT" in the Description field, TOPS Pro might 
find analyses with packaging profiles that have "48 CNT" somewhere in 
their Description fields; for example, "Cereal, 48 cnt" or "48 cnt - 
Hammers."  If you enter search criteria in more than one field, TOPS Pro 
searches for only those analyses that match all your criteria. 

Note:  On the Open Analysis dialog box, the Reset button "resets" the 
search to everything. 

 

Use one of these two options to access the dialog box: 

1. From the Menu Bar, go to Export Menu, select Analysis to open the 
Export Analysis dialog box, click on the Search button. 

2. From the Menu Bar, open the File menu and select Open.  From the 
Open Analysis dialog box, click on the Advanced Search button. 
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Field Descriptions and Instructions 
 Analysis Name:  Enter the name, or the first few letters, of the 

analysis. 

 Profile #:  Enter the profile number used in the packaging profile for 
the analysis, if any. 

 User Name:  Enter the name of user whose analyses you need to 
search. 

 Modify Time: Enter a date range here to search within a specific time 
frame for when an analysis was created or last modified.  

 Comments: Enter comment details used in the packaging profile for 
the analysis. 

 Customer:  Enter the Customer name used in the package profile for 
the analysis. 

 Product Code:  Enter the product code for a product attached to the 
packaging profile for the analysis. 

 UPC Code:  Enter the UPC code for a product attached to the 
packaging profile for the analysis. 

 Description:  Enter the description used in the packaging profile for 
the analysis. 

 Approved:  Uncheck the box to hide the approved indicator. 

 Work in Progress:  Uncheck the box to hide the unapproved 
indicator. 
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Assign Graphics 
Function:  This dialog box allows you to select a graphic image to be 
displayed on a carton.  Note:  To display graphics on unitload cases, the 
Show Graphics option – located on the View menu – must be turned on. 

 

When available, for example, from the following dialog boxes, click on 
the Graphic button to open the dialog box: 

 Define Carton 
 Define Shipping Case 
 Intermediate Pack Parameters 
 Mike Carton Parameters 
 Shipcase Parameters 
 Define Shipcase dialog box in MixPro 

Field Descriptions and Instructions 
 Top:  Click on the Browse button to select a graphic image (bitmap 

file) that will appear on the top of the item (carton, shipcase, etc.). 

 Front:  Click on the Browse button to select a graphic image (bitmap 
file) that will appear on the front of the item (carton, shipcase, etc.). 

 Back: Click on the Browse button to select a graphic image (bitmap 
file) that will appear on the back of the item (carton, shipcase, etc.). 

 Right / Left Side:  Click on the Browse button to select a graphic 
image (bitmap file) that will appear on the side of the item (carton, 
shipcase, etc.). 

 Rotate Buttons:  These buttons correspond to the graphic image 
displayed in the g.o.d. feature at the bottom, right corner of the screen.  
Click on the left Rotate button to rotate the graphic counter-clockwise 
by 90 degrees.  Click on the right Rotate button to rotate the graphic 
clockwise by 90 degrees. 
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Auto Recover 
Function:  This dialog box allows you to recover any analyses have not 
been previously saved before you exit TOPS. 

 

To access, go to the Tools Menu and select Recover Analyses. 

Field Descriptions and Instructions 
 File List:  When available, you will see a list of analyses not 

previously saved.  This may be the result of program crash or power 
outage. 

 Recover:  Click on this button to recover the highlighted analysis in 
TOPS. You can then resume and save your work. 

 Delete:  Click on this button to delete the highlighted analysis.  
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Bag Options 
Function:  This dialog box allows you to define additional parameters for 
a bag, including minimum/maximum headspace, a maximum repeat to 
former value, bulge and seal dimensions. 

Note:  This dialog box displays a different set of fields – as pictured 
below – depending on whether you selected Former-Repeat-Air Fill or 
Length-Width-Height in the Based On field on the Bag Parameters dialog 
box. 
 

 
Bag Options Dialog Box for bags based on Former-Repeater-Air Fill 

 
Bag Options Dialog Box for bags based on Length-Height-Width 

Headspace 
Headspace applies only when you're putting bulk product into a bag.  
Minimum and maximum headspace refers to the volume of air needed 
inside the bag prior to sealing.  For example, when you fill a bag with 
potato chips, you'll want to add headspace to the bag to prevent the chips 
from being crushed or broken.  The headspace dimension will give the bag 
additional "wasted" space above the contents of the bag. 

To access the Bag Options dialog box, click the Options button from the 
Bag Parameters dialog box. 
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Field Descriptions and Instructions 
The following three fields – Min Headspace, Max Headspace and Max 
Repeat to Former Ratio – are used only to design a new bag.  These 
fields do not display for a fixed bag. 

 Min Headspace:  Enter a percentage of the bag's volume to specify 
the minimum headspace allowed in the bag. 

 Max Headspace):  Enter a percentage of the bag's volume to specify 
the maximum headspace allowed in the bag. 

 Max Repeat to Former Ratio:  This value forces the repeat 
dimension of the bag to be less than X times the former dimension of 
the bag, where X is the value you'll enter in this field. 

 Note:  This feature weeds out bag designs that are extremely 
elongated.  If your bag is naturally very long, you might need to 
increase this value. 

 Bulge:  Enter the different distances for a flattened bag in inches or 
millimeters, depending on the bag specifications: 
 
When bag parameters are based on FxRxA, enter the Bulge Former,  
the distance across a flattened bag, Bulge Repeat, the distance 
between cuts of a flattened bag and Bulge Air Fill, the thickness of the 
filled bag respectively. 
 
When bag parameters are based on LxWxH, enter Bulge Length, 
Bulge Width and Bulge Height of a flattened bag respectively. 

 Seal Dims: Enter the top, bottom and back of the seal respectively. 

 



 

B-14                                                                         TOPS Pro (Version 6.50) User Guide 

Bag Parameters 
Function:  This dialog box allows you to define parameters for different 
types of bags.  For example, the Former-Repeat-Air Fill feature allows 
you to design a potato chip bag.  The Length-Width-Height feature allows 
you to design a candy bar bag.  A bag may contain only bulk product.  
Further, a bag must always be inserted into another container; the bag 
element cannot be the last stage of an analysis. 

Note:  The Bag Parameters dialog box displays in a variety of ways, each 
with a slightly different set of fields, depending on a few variables: 

 If you select the green Film Bag icon from the Primary Pack Button-
Style Menu, the Film type and Film Cost fields will be active in the  
Bag Parameters dialog box. 

 If you select the yellow Bag icon from the Shipcase Button-Style 
Menu, the Bag Parameters dialog box does not provide the film-related 
fields. 

 If you enter bag parameters based on Former-Repeat-Air fill (F×R×A), 
the dialog box displays fields for Former, Repeat and Air Fill. 

 If you enter bag parameters based on Length-Width-Height (L×W×H), 
the dialog box displays fields for Length, Width and Height. 

The Bag Parameters dialog box below shows all options being active: 
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Primary Pack vs. Shipcase Bag Parameters 
Both the Primary Pack and Shipcase elements of an analysis include a Bag 
Parameters icon.  Be aware of one important difference:  If you need to 
design a new bag, use the Carton/Film Bag parameters.  The Shipcase/Bag 
element will not accept bulk product and allows you to work with fixed 
bags only; the Shipcase/Bag element will not allow you to design a new 
bag.  Also, both the Primary Pack bag and the Shipcase bag can be loaded 
onto a pallet. 

Bags Shaped Like Cartons 
If your bag has a rectangular shape – like a carton – use the Primary Pack 
parameters to design the bag.  For example, the best way to design a dog 
food bag is to use the Milk Carton parameters.  For a flour bag, use a 
Primary Pack with the bag_top.bmp graphic pasted on top. 

Note:  TOPS Pro uses the shapes you see for aesthetic purposes only.  If 
you are using Milk Carton or Bag shapes, there are no inside/outside 
dimensions.  If you decide to use a Carton, the dialog box does allow for 
inside/outside dimensions. 

To access, use one of two options from the Control Panel: 

Click on the Film Bag icon   or click on the Bag icon  . 

Field Descriptions and Instructions 
 Bag:  Select either Fixed or New to specify the type of bag you want 

to use in your analysis. 

A fixed analysis requires you to enter the dimensions of a fixed bag. 

A new analysis will create a new bag based on other information you 
enter on the screen.  The new analysis will require you to enter 
minimum, maximum and incremental dimensions for the bag. 

 Seal Style:  Select either Lap or Fin to specify how the bag will be 
sealed. 

 Based On:  Select either FxRxA or LxWxH to specify whether the 
bag if defined by Former-Repeat-Air Fill or Length-Width-Height. 

For example, FxRxA defines a potato chip bag.  LxWxH defines a 
candy bar bag. 
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 Description:  Select from the drop-down list the film bags to be used 
if previously defined in the database.  

 Film:  Select the film style to be used for the bag. 

Note:  TOPS Pro assumes film thickness to be inconsequential.  Also, 
the drop-down list contains film types that are already set up in the 
database.  If the film type you want is not on the list, you can add it to 
the database using the Define Film dialog box.  For more information, 
please refer to page B-96. 

 Stand-Up Bag:  Click this box to enable the stand-up bag option. 

 Inverted Nest: Click this box to enable inverted nesting. 

 Pack Tightly when Nested: Click this box to enable the pack tightly 
option when using enabling the Inverted Nest option. 

 Film Cost:  Displays the film cost and waste factor for the selected 
film. 

 C.A.S.Y. Style:  Select a CASY style to display for the bag. 
 
The following three fields – Former, Repeat and Air Fill – display 
only if you select Based On FxRxA.  Also, if you selected New Bag, 
you'll need to enter Minimum, Maximum and Incremental 
dimensions for these three fields. 

 Former:  The distance across a flattened bag. 

 Repeat:  The distance between cuts of a flattened bag. 

 Air Fill:  The thickness of the filled bag. 

Note:  If you need to convert the air fill value to inches, select LxWxH 
in the Based On field, enter air fill in inches, then switch Based On 
back to FxRxA. 

The following three fields – Length, Width and Height – display only if 
you select LxWxH in the Based On field.  Also, if you selected New Bag, 
you'll need to enter Minimum, Maximum and Incremental dimensions 
for these three fields. 

 Length:  The  length of the bag. 

 Height:  The height of the bag which does not include end seams. 

 Width:  The width of the bag. 

 Volume:  Enter the actual volume of the bag in inches cubed or liters, 
depending on your Units. 
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Note:  If you selected New Bag, enter two volume dimensions – 
Minimum and Maximum – and adjust the bag's volume to eliminate 
any undesired dimensions. 

If you selected Fixed Bag, TOPS Pro will automatically calculate the 
volume of the bag. 

 Net Weight:  The net weight of the bag. 

Note:  This value allows you to work with product and headspace 
related to the bag. 

 Overlap:  The amount of overlapping seal at the end of the bag. 

 Add Product:  Opens the Primary Pack Products dialog box to specify 
the products going into the primary pack.  The data will be used to 
calculate Wal-Mart efficiency values in the Pallet report statistics. 

 Vert:  Check a box beside one of three fields – Former, Repeat or Air 
Fill – to specify the vertical dimension of the bag relative to the 
ground. 

Note:  If you check Repeat Vertical, then TOPS Pro will design the 
bag on end.  If you check Air Fill Vertical, then TOPS Pro will design 
the bag lying down. 

The following two Volume fields display only for a bulk product-into-bag 
analysis. 

 Volume based on size:  Displays the volume of the bag based on size.  
TOPS Pro automatically calculates this value. 

 Volume based on weight:  Displays the volume of the bag based on 
weight.  TOPS Pro automatically calculates this value. 

 Options Button:  Displays the Bag Options dialog box, which allows 
you to enter additional dimensions for a bag.  
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Blister Pack Options 
Function:  This dialog box allows you to define the height of bulge for a 
blister pack. 

 

To access, open the Blister Pack Parameters dialog box and click on the 
Options button. 

Field Descriptions and Instructions 
 Height:  Enter the height of bulge for the blister pack.   

 
You can also use this parameter to nest blister shells together for 
packing.  To do so, enter a negative number and make sure the 
absolute value is smaller than the height of the blister pack. 
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Blister Pack Parameters 
Function:  This dialog box allows you to define parameters for blister 
packs.  

 

To access, click on the Blister Pack icon    to open the Blister Pack 
Parameters dialog box. 

Field Descriptions and Instructions 
 Blister Pack: Select Fixed to enter fixed dimensions or select New to 

enter a range of blister pack dimension for TOPS to evaluate, 

 C.A.S.Y. Style:  Selects a CASY style to display for the blister pack. 

 Length:  The length of the blister package including the backing 
cardboard. 

 Width:  The width of the blister package including the backing 
cardboard. 

 Height:  The height of the of the blister package including the backing 
cardboard. 

 Top Indent: The position of the blister from the top edge of the 
package. 

 Bottom Indent:  Thee position of the blister from the bottom edge of 
the package. 

 Side Indent:  The position of the blister from each side of the 
package. 
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 Vert:  Checks a box beside one of three fields – Length, Width or 
Height – to specify the vertical dimension of the blister pack relative 
to the ground. 

 Indent:  Selects whether the blister indent is expressed as a percentage 
of the overall package size or in actual dimension. 

 Nest Packs:  Check this box to nest inverted blister packs in the 
carton/shipcase.  The pictures below illustrate the blister pack, blister 
packs in shipcase and nested blister packs in shipcase. 
 

                                             
                  Single blister               Blister packs without nesting         Nested blister packs 

 Bundle Button:  Opens the Bundle Parameters window. For more 
information on this function, see Bundle Parameters dialog box.  
When this option is checked, the bundle function will be used. 
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Board Combinations 
Function:  This dialog box allows you to define default board grades, as 
well as change, delete or mark them unavailable.  Use this option to define 
a board's ECT or cost per 1,000 square feet. 
 

 

To access the dialog box, open the TOPS Configuration program.  From 
the Menu Bar, open the Define menu and select Board Combinations or 
click the Board Combination quick link in the Control Panel. 

Field Descriptions and Instructions 
 Description:  Select a type of board. 

Note:  When naming a new board combination, do not include the 
papers in the board name.  TOPS Pro will automatically add the papers 
to the board name. 

 Double Wall:  Check the box to specify a double-wall board. 
 
Note:  For the next two fields – Inside and Outside Liners – you 
must use the drop-down list to select a value, even if the correct value 
is already displayed in the field.  TOPS Pro will not calculate the Edge 
Crush values unless you select these fields. 

Also, for the next three fields – Inside and Outside Liners and Inside 
Mediums – you can add or change papers using the Define Paper dialog 
box. 
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 Inside Liners:  Select an inside paper liner for the board. 

 Outside Liners:  Select an outside liner for the board. 

 Inside Mediums:  Select an inside corrugated paper/medium for the 
board. 

 Flute Type:  Select one or more flute types. 

Note:  If you don't see the flute type you want, contact TOPS 
Technical Support. 

 Thickness:  Enter the thickness of the flute in inches or millimeters, 
depending on the Units selected. 

 Edge Crush:  Enter the edge crush test value for the flute in pounds 
per inch or kilograms per millimeter, depending on the Units selected.   

Note:  If you want TOPS Pro to calculate the ECT value, click on the 
Recalculate button. 

 HFF:  Enter the horizontal flute factor as a percentage. 

 Cost/1000ft2:  Enter the flute cost per 1,000 square feet or square 
meters, depending on the Units selected. 

 Available:  Check the box to indicate that this board type is available. 

Note:  If you leave this field unchecked, the board combination will 
remain in the database, but will not appear in any reports. 

 Locked:  Indicates that only a supervisor can enter or change 
parameters on this dialog box. 

For the following, TOPS Pro calculates values based on the component 
papers.  Please refer to Chapter 9, Stacking Strength. 

 ECT Button:  Recalculates the edge crush test value for the board. 

 Cost:  Recalculates the cost per 1,000 square feet of the board. 
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Bottle Options 
Function:  This dialog box allows you to enter bulge dimensions for a 
bottle. 

Note:  This dialog box displays a different set of fields – as pictured 
below – depending on whether you selected Round, Oval or Rectangular 
in the Body Shape field on the Bottle Parameters dialog box. 

 
Bottle Options Dialog Box/Round Body Shape 

 
Bottle Options Dialog Box/Oval or Rectangular Body Shape 

To access the Bottle Options dialog box, click the Options button from the 
Bottle Parameters dialog box. 

Field Descriptions and Instructions 
 Diameter:  For round bottles, enter the bulge diameter for the bottle. 

 Width:  The bulge width for rectangular bottles. 

 Length:  The bulge length for rectangular bottles. 

 Height:  The bulge height for round or rectangular bottles. 

Note:  TOPS Pro does not usually report bulge data.  For information 
about how to report bulge data, please refer to page B-2. 
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Bottle Parameters 
Function:  This dialog box allows you to define parameters for different 
types of bottles – perfume bottles, shampoo bottles, etc.  You can also use 
bottle parameters to design shapes for toilet tissue and paper towel rolls. 

Note:  If your analysis includes a bottle, the bottle element must be the 
first stage of the analysis.  Further, the bottle element cannot be the last 
stage of the analysis. 

 
Bottle Parameters Dialog Box/Round Body Shape 

 
Bottle Parameters Dialog Box/Oval or Rectangular Body Shape 

To access the Bottle Parameters dialog box, click on the Bottle Parameters 

icon  at the Control Panel. 
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Field Descriptions and Instructions 
 Description: Select a predefined bottle from the drop list, if available. 

 C.A.S.Y. Style:  Select a CASY style to display for the bottle. 

 Body Diameter:  Enter the body diameter for round bottles. 

 Body Length:  Enter the body length for oval or rectangular bottles. 

 Body Width:  Enter the body width of the bottle. 

 Neck Diameter:  Enter the neck diameter of the bottle (top rim). 

Note:  For a round bottle, the neck diameter should be less than the 
body diameter.  For an oval or rectangular bottle, the neck diameter 
should be less than the smaller of length or width.  This value must be 
greater than zero, but it can be very small (for example, .001). 

 Height:  Enter the height of the bottle – including body, shoulder and 
neck. 

 Neck Hgt:  Enter the neck height of the bottle. 

Note:  The neck height is the distance from the top of the bottle to the 
top of the shoulder.  Neck height must be greater than zero.  This value 
must be greater than zero, but it can be very small (for example, .001). 

 Shoulder Hgt:  Enter the shoulder height of the bottle. 

Note:  The shoulder height is the distance between the neck and the 
base of the bottle, and represents the transition point of the bottle.  
This value must be greater than zero, but it can be very small (for 
example, .001). 

 Vert:  Check a box beside one of four fields – Body Diameter, Body 
Length, Body Width or Height – to specify the vertical dimension of 
the bottle relative to the ground. 

Note:  This field allows you to change the vertical position of the 
bottles as they're placed into a tray, shipper, pallet or truck.  Further, at 
this time TOPS Pro does not allow you to indicate which direction a 
bottle will be "pointed;" that is, which end is pointed up or to the left 
or right. 

 Net Weight:  Enter the net weight of the bottle. 

 Gross Weight:  Enter the gross weight of the bottle. 

 Body Shape:  Select either Round, Oval or Rectangular to specify the 
body shape of the bottle. 
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Note:  Oval bottles are packed as if they were rectangular; i.e., they're 
not staggered. 

 Options Button:  Displays the Bottle Options dialog box, which 
allows you to enter bulge dimensions for a bottle. 

 Bundle Button:  Opens the Bundle Parameters window. For more 
information on this function, see Bundle Parms dialog box.  When this 
option is checked, bundle function is enabled. 



 

Appendix B:  Dialog Boxes                                                                                   B-27 

Box Design Factors 
Function:  This dialog box allows you to change the default stacking 
strength values for box design factors such as length-to-width ratio, shape 
factors, printing factors and flap gap factors. 

Note:  For detailed information about box design factors as they relate to 
stacking strength, please refer to Chapter 9, Stacking Strength. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define menu and select Box Design Factors. 

Field Descriptions and Instructions 
 Length to Width Ratio:  Displays a list of length-to-width ratios 

ranging from 1.0 to over 2.5.  For each length-to-width ratio, enter the 
safety factor value. 

 Shape Factors:  Enter the shape factor when length/width/ height is 
the vertical dimension for the following shape scenarios: 

 L > D and D > 1.5W 
 L > D and W > 1.5D 
 L > D and W = D 
 D > L 
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 Printing Factors:  Enter the printing factor when Flexo/Quick 
printing is used for the following box printing scenarios: 

 Sample 
 None 
 Simple 
 Average 
 Heavy 
 Complete 

 
 Tight:  Enter the flap gap factor if the flaps are tight when closed. 

 Up to 2 in:  Enter the flap gap factor if the flaps leave a space of up to 
two inches when closed. 

 2 in +:  Enter the flap gap factor if the flaps leave a space of more than 
two inches when closed. 

 Locked:  Indicates that only a supervisor can enter or change 
parameters on this dialog box. 

Note:  A value of one (1) in these fields means that this scenario will have 
no effect on the stacking strength calculation.  Any number multiplied by 
one (1) equals that number, so there is no change to the result.  A value of 
less than one (1) has a negative effect on the result; a value greater than 
one (1) has a positive effect. 
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Bucket Options 
Function:  This dialog box allows you to enter bulge dimensions for a 
bucket. 

Note:  This dialog box displays a different set of fields – as pictured 
below – depending on whether you selected Round or Rectangular in the 
Body Shape field on the Bucket Parameters dialog box. 

 
Bucket Options Dialog Box/Round Body Shape 

 
Bucket Options Dialog Box/Rectangular Body Shape 

To access Bucket Options dialog box, click the Options button from the 
Bucket Parameters dialog box. 

Field Descriptions and Instructions 
 Diameter:  Enter the bulge diameter for round buckets. 

 Width:  Enter the bulge width for rectangular buckets. 

 Length:  Enter the bulge length for rectangular buckets. 

 Height:  Enter the bulge height for round or rectangular buckets. 
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Bucket Parameters 
Function:  This dialog box allows you to define parameters for different 
types of round or rectangular buckets.  With the round bucket parameters, 
you can design hub caps, plates, flower pots, etc.  With the rectangular 
bucket parameters, you can design trays, cookie sheets, etc. 

Note:  When you use a bucket in an analysis, TOPS Pro will not allow 
you to place any items inside the bucket.  Further, the bucket itself can be 
placed only on a pallet or in a vehicle.  If you're thinking of placing a 
bucket inside a shipper, use a tub instead.  (The tub comes from the 
Primary Pack (green) Button-Style Menu.) 

Also, this dialog box displays a different set of fields – as displayed below 
and on the next page – depending on whether you select Round or 
Rectangular in the Body Shape field. 

 
Bucket Parameters Dialog Box/Round Body Shape 
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Bucket Parameters Dialog Box/Rectangular Body Shape 

From the Control Panel, click on the Bucket Parameters icon  to access 
the Bucket Parameters dialog box. 

Field Descriptions and Instructions 
 C.A.S.Y. Style:  Select a CASY style to display for the bucket. 

 Top Diameter:  Enter the top diameter or rim for round buckets. 

 Bottom Diameter:  Enter the bottom diameter for round buckets. 

 Top Length:  Enter the top length for rectangular buckets. 

 Top Width:  Enter the top width for rectangular buckets. 

 Bottom Length:  Displays the bottom length for rectangular buckets. 
TOPS Pro automatically calculates this value based on the proportions 
of top to bottom width. 

 Bottom Width:  Enter the bottom width for rectangular buckets 

 Height:  Enter the height for round or rectangular buckets. 

 Pitch:  Enter the distance between stacked buckets. 

Note:  Pitch allows you to define the dimensions of the buckets so 
they can be stacked inside one another.  This value represents the 
distance between the rims of the nested buckets; that is, how far one 



 

B-32                                                                         TOPS Pro (Version 6.50) User Guide 

bucket protrudes from the one it's placed into.  If you leave pitch at 
zero, TOPS Pro assumes that the buckets don't nest inside one another. 

 Inverted Nest:  Check the box to load nested buckets in inverted rows 
as the illustrations below: 

                                 

 Pack tightly when Nested:  This option can tightly pack flower pots, 
plumbing parts, water glasses and more by removing any space 
between the objects. 

 Nest direction (w.r.t Tub dims):  This allows you to choose the 
different variations of nesting within the shipcase.  Check available 
nested directions from Both Sides, Single Side and/or Height.  The 
picture below shows nesting in both directions. 
 

                                 
 Vert:  Check a box beside one of four fields – Top Length, Top 

Width, Top Diameter or Height – to specify the vertical dimension of 
the bucket relative to the ground. 

 Weight:  Enter the weight of the bucket. 

 Body Shape:  Select either Round or Rectangular to specify the body 
shape of the bucket. 

 Options Button:  Displays the Bucket Options dialog box, which 
allows you to enter bulge parameters for a bucket. 
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Bundle Parameters 
Function:  This dialog box allows you to enter parameters for bundling 
primary packs. 

 

To access, click on the Bundle button from any primary pack parameter 
dialog box: 

Field Descriptions and Instructions 
 Material:  Select either Corrugated or Other to specify the material 

used to make the bundle. 

Note:  The type of material is important to determine stacking strength 
and board thickness. 

 Style:  Select a pre-defined style or type in the first few letters of the 
style. 

 Flute/Caliper:  Select the flute size or caliper for corrugated or other 
material used for casing the bundle. 

The following three fields – Slack Length, Slack Width and Slack 
Height – refer to the extra (wasted) space you intend to include in the 
bundle configuration.  For example, you might figure in two inches of 
slack space at the top (height) to more easily insert items into the bundle. 

 Slack Length:  Enter the extra space intended for the length of the 
bundle. 

 Slack Width:  Enter the extra space intended for the width of the 
bundle. 
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 Slack Height:  Enter the extra space intended for the height of the 
bundle. 

 Dim Vert:  Select either PriPack or Bundle beside one of three fields 
– Length, Width or Height – to specify the vertical dimension of the 
bundle relative to the ground. 

Note:  If you use height as the vertical dimension, you can select both 
PriPack and Bundle. 

In packaging, height (depth) is normally the distance through the flaps.  
Length is the greater of the two remaining dimensions. 

The following four fields – Length, Width, Height and Along 
Length/Width – allow you to define the bundle arrangement. 

 Length:  Enter the number of primary packs to be arranged along the 
length of the bundle. 

 Width:  Enter the number of primary packs to be arranged along the 
width of the bundle. 

 Height:  Enter the number of primary packs to be arranged along the 
height of the bundle. 

 Along Length/Width:  Specify whether the bundle will be arranged 
along its length or width. 

 Bundle Size:  Displays the overall dimensions of the bundle based on 
the specified arrangement. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the bundle. 
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Calculate MixPal 
Function: This dialog box allows you to use Mixpro to automatically 
generate mix pallet for display based on layer or column optimization. 
 
To access, click on the MixPro icon  in the tool bar and select 
MixPro Mixed Pallet Editor.  When the MixPro program opens, click on 
the Calc Wizard button. 
 

 
 

 Add Button:  Click to add the highlighted shipcase from the left side 
to the load list on the right hand side. 

Note: Shipcases added to the load list on the right will have a 
minimum quantity of 1 and maximum quantity of 99. To adjust these 
quantities, click on the quantity value and type in a new number. 

 Remove Button:  Click to remove highlighted shipcase from the load 
list on the right back to the left side.  This will remove the shipcase 
from being placed on the mix pallet. 

 Calc by Layer:  Select this option to generate the mixed load by 
optimizing layer. 

 Calc by Column:  Select this option to optimize the mixed load by 
column. 

 Pallet Button:  Click to open the Pallet Parameters dialog box where 
you can select a pallet to be used for this mixed pallet.  Enter also any 
allowable overhangs, weight and height limit for the pallet load to be 
created. 
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 Speed-Space Optimization:  This controls how optimized the mixed 
pallet will be created using the selected shipcases.  Set this to speed on 
the left as the mixed pallet load is normally quite straight forward. 

 Calc:  Click to start the calculation. 
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Can Options 
Function:  This dialog box allows you to enter bulge dimensions for a can 
(cylinder). 

 

From the Can Parameters dialog box, click on the Options button to access 
the Can Options dialog box. 

Field Descriptions and Instructions 
 Diameter:  Enter the bulge diameter for the can. 

 Height:  Enter the bulge height for the can. 
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Can Parameters 
Function:  This dialog box allows you to define parameters for different 
types of cans – soup cans, cookie cans, etc.  You'll also use Can 
Parameters to define round tubs and round bottles, canisters or drums. 

Note:  If your analysis includes a can, the can element must be the first 
stage of the analysis.  Further, the can element cannot be the last stage of 
the analysis. 

Note:  TOPS Pro does not currently stagger cylinders while on their side, 
although this functionality may be added in the future. 
 

 

Designing Soda Cans 
Be aware that if you're designing a soda can, it may be better to use bottle 
parameters because a soda can has a neck, shoulder and body, just like a 
bottle. 

From the Control Panel, click on the Can Parameters icon  to access 
the Can Parameters dialog box. 



 

Appendix B:  Dialog Boxes                                                                                   B-39 

Field Descriptions and Instructions 
 Description: Select from the drop list a predefined can, if available. 

 C.A.S.Y. Style:  Select a CASY style to display for the can. 

 Diameter:  Enter the diameter of the can. 

 Note:  This dimension is used for a can that has a uniform diameter 
from top to bottom.  If your can has different diameter measurements 
at the top and bottom, use the Tub or Bucket in your analysis. 

 Height:  Enter the height of the can. 

 Vert:  Check a box beside one of two fields – Diameter or Height – to 
specify the vertical dimension of the can relative to the ground. 

 Net Weight:  Enter the net weight of the can. 

 Gross Weight:  Enter the gross weight of the can. 

 Options Button:  Displays the Can Options dialog box, which allows 
you to enter bulge dimensions for a can. 

 Bundle Button:  Opens the Bundle Parameters window. For more 
information on this function, see Bundle Parms dialog box.  When this 
option is checked, bundle function is enabled. 
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Carton Options 
Function:  This dialog box allows you to enter additional dimensions for 
a carton, such as headspace and bulge. 

 

From the Carton Parameters dialog box, click on the Options button to 
access the Carton Options dialog box. 

Headspace 
When you create a new carton designed to contain a bulk product, such as 
cereal, you'll need to allow for headspace at the top of the carton.  
Minimum and maximum headspace refers to the volume of air needed 
inside the carton prior to sealing. 

For example, when you fill a carton with cereal, you'll want to add 
headspace to the carton to prevent the cereal from being crushed or 
broken.  The headspace dimension will give the carton additional "wasted" 
space above the contents of the carton. 

From the Carton Parameters dialog box, click on the Options button to 
access the Carton Options dialog Box. 

Field Descriptions and Instructions 
The following two fields, Min Headspace and Max Headspace, display 
only if you selected New Carton on the Carton Parameters dialog box. 

 Min Headspace:  Enter a percentage of the carton's volume to specify 
the minimum headspace allowed in the carton. 

 Max Headspace:  Enter a percentage of the carton's volume to specify 
the maximum headspace allowed in the carton. 

 Bulge Length, Width and Height:  The amount of bulge allowed in 
the carton's length, width and height dimensions. 
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Carton Parameters 
Function:  This dialog box allows you to define parameters for different 
types of cartons. 

 

From the Control Panel, click on the Carton Parameters icon  to access 
the Carton Parameters dialog box. 

Field Definitions and Instructions 
 Carton:  Select Fixed, New or KnockDown to specify the type of 

carton you want to use in your analysis. 

A fixed analysis requires you to enter the dimensions of an existing 
carton.  A new analysis will create a new carton based on other 
information you enter on the screen.  A KnockDown will create a flats 
based on the dimension of an erected carton. 

 Description:  Select a pre-defined carton from the drop-down list for a 
Fixed Carton analysis only. 

Note:  The drop-down list contains carton types that are already set up 
in the database.  If the carton type you want is not on the list, you can 
add it to the database using the Define Carton dialog box. 

Note:  If you select a pre-defined carton, TOPS Pro will automatically 
insert dimensions in the Length, Width and Height fields, as well as 
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any pre-defined graphics.  If you select User Defined, you'll need to 
manually enter dimensions in the Length, Width and Height fields 

 Style:  Select the style of the carton. 

 C.A.S.Y. Style:  Select a CASY style to display for the carton. 

For the following three fields – Length, Width and Height – if you 
selected New Carton, you'll need to enter Minimum, Maximum and 
Incremental dimensions. 

 Length:  The length of the carton. 

 Width:  The width of the carton. 

 Height:  The height of the carton. 

For the following Volume field, if you selected New Carton, the system 
will prompt you to enter Minimum and Maximum volume dimensions. 

 Volume:  The volume of the carton (volume of inside of box). 

Note:  This field allows you to adjust the carton's volume to eliminate 
any undesired dimensions.  If you selected Fixed Carton, TOPS Pro 
will automatically calculate the volume of the carton. 

 Vert:  Check a box beside one of three fields – Length, Width or 
Height – to specify the vertical dimension of the carton relative to the 
ground. 

 Net Weight:  Enter the net weight of the carton. 

 Gross Weight:  Enter the gross weight of the carton. Gross weight 
must be greater than or equal to net weight. 

 Caliper: Enter the caliper of the carton. This is the thickness of the 
cardboard used for the carton. 

Note:  The caliper is used to calculate the inside vs. outside 
dimensions of the carton. 

The following two Volume fields display only for a bulk product into a 
new carton analysis. 

 Volume based on size:  Displays the volume of the carton based on 
size.  TOPS Pro automatically calculates this value. 

 Volume based on weight:  Displays the volume of the carton based 
on weight.  TOPS Pro automatically calculates this value. 
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 Options Button:  Displays the Carton Options dialog box, which 
allows you to enter additional parameters for a carton, such as 
minimum/maximum headspace and bulge dimensions. 

 Knockdown Button:  Available when KnockDown carton is selected, 
click this button to automatically calculates the length, width and 
height parameters of an erected RSC box or folded carton to its 
knockdown dimensions as explained below: 

  Erected Box   Knock Down 
Length (L) 14 in  = L+W  = 24 in 
Width (W) 10 in  =2*C    = 0.1 in 
Height (H) 8 in  = W+H = 18 in 
Caliper (C) 0.05 in   

 Bundle Button:  Opens the Bundle Parameters window. For more 
information on this function, see Bundle Parms dialog box.  When this 
option is checked, bundle function is enabled. 



 

B-44                                                                         TOPS Pro (Version 6.50) User Guide 

Case Styles 
Function:  This dialog box allows you to define parameters for a new case 
(one that's not already defined in the system).  This dialog box also allows 
you to change parameters for an existing case. 

 

To access the Case Styles dialog box, open the Define Menu from the 
Menu Bar and select Box Styles. 

Field Descriptions and Instructions 
 Description:  For a new case, type in a description.  For an existing 

case, select a pre-defined case or type in the first few letters of the 
case. 

Note:  If you select a pre-defined case, TOPS Pro will automatically 
insert values in the various dimension fields.  If you select User 
Defined in the Shipcase Parameters dialog box, you'll need to 
manually enter dimensions. 

 Drawing Style:  Select a pre-defined drawing style as illustrated by 
the g.o.d. image. 

 Thicknesses - Length:  Enter the number of thicknesses along the 
length of the case.  This corresponds to the number of times you’ll 
encounter any wall of the box along the length direction.  This is 
normally two for length. 

 Thicknesses - Width:  Enter the number of thicknesses along the 
width of the case.  This corresponds to the number of times you’ll 
encounter any wall of the box along the width.  This is normally two 
for width 
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 Thicknesses - Depth:  Enter the number of thicknesses along the 
depth of the case.  This corresponds to the number of times you’ll 
encounter any wall of the box along the height.  This is normally four. 

 Export Name:  Enter the export name for the case. 

 Strength Factor (as % of RSC):  In the TOPS system, stacking 
strength is only available to RSC boxes.  This Strength Factor is used 
to provide strength analysis for non-RSC boxes and is expressed as a 
percentage when compared to that of an RSC box.  For example, if 
stacking strength for this box is 90 percent when compared to that of 
an RSC box, enter 90.00. 

 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

The available drawing parameters vary according to the drawing style 
selected and are listed as below. 

For RSC Boxes  

 Major Flap:  This is the distance between the 
two major flaps  when the box is closed.  
Select either Flap Gap or % of Box Width, then 
enter a value to define the size of the major flap.  
Use a value of 0.0 as Flap Gap or 50% Box 
Width to ensure the major flaps meet halfway 
and close the box completely 

 Minor Flap :  Select either % of Box Width or % of Box Length, 
then enter a value to define the size of the minor flap.  The illustration 
(above right) represents a 100% box width. 

 Back Flap Angle:  Use this to define how far back the back flap  
will be illustrated within TOPS.  Select either Degrees or Radians, 
then enter a value to define the back flap angle. 

 Front Flap Angle:  Use this to define the front flap  angle.  Select 
either Degrees or Radians, then enter a value. 

 Minor Flap Angle:  Select either Degrees or Radians, then enter a 
value to define the front flap angle to illustrate the drawing of the two 
minor flaps . 
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For Shrouded Box, Trays  

 Tray Height :  Select either in Actual Size or as a 
% of Box Height, this is bottom portion of the 
shrouded box and is obvious for trays. 

 Shroud Opening:  Select if the opening is along the 
width of length of the box. 

 Upper Bar Width :  Select either in Actual Size or as a % of Box 
Height, enter a value to represent the top shrouded portion for the box. 

 Side Bar Width :  Select either in Actual Size or as a % of Box 
Height, enter a value to represent the two side bars for the box. 

 

For Wrap Around Boxes  

 Major Flap :  Select either in Actual Size or as a 
% of Box Height, enter a value to represent the size 
of the major flap as pictured to the right. 

 Flap Angle: Use this to define how far up the cover 
will be illustrated for this box type.  Select either 
Degrees or Radians, then enter a value. 

 Lip Flap Angle: Use this to define the angle the three lip flaps of the 
cover. Select either Degrees or Radians, then enter a value. 

 Wrapwnd Sitting:  Select to illustrate the box opening along the 
length of width of the box. 

 Minor Flap:  Select either in Actual Size or as a % of Box Height, 
enter a value to represent the size of the three minor flaps. 

 Flap Gap:  Select either in Actual Size or as a % of Box Height, enter 
a value to represent any space  between the material which make up 
the side wall. 

 

For Strapped Bundle 

 Length Straps: The number of straps along the length of 
the bundle, 2 in this example. 

 Width Straps: The number of straps along the Width of the bundle, 
only 1 in this example. 

 Strap Width:  The width of the straps. 
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For lay Case  

 Show Window on:  Select either to show a window 
only at the front  or at both front and back. 

 Show Window on:  Select either to show windows 
on both left and right sides as pictured here or none 
at all. 

 Window Height:  Enter a value to represent the size of all windows as 
a % of the tray Height 

 Top Width:  Enter a value to represent the top width of all windows 
as a % of the tray Length/width. 

 Bottom Width:  Enter a value to represent the bottom width of all 
windows as a % of the tray Length/width. 

 

For Display Tray/ Tear Out  

Tray Height:  Select either as a % of Box Height or in 
Actual Size, enter a value for the height of the tray . 

Tray Width:  Select either as a % of Box Height or in Actual Size, enter a 
value for the width of the tray . 

 

For Common Footprint Standard 

 Side Tabs:  Enter the number of side tabs  and select 
if they are for both Top and Bottom or just Bottom 
Only. 

 Side Tab Width:  Enter the size of the side tab as a % 
of Box Width of Actual Size. 

 Side Tab Height:  Enter the height of the side tab as a % of Box 
Width of Actual Size. 

 Front-Back Tabs:  Enter the number of front and back tabs  to be 
used for the box. 

 Front Tab Width:  Enter the size of the side tab as a % of Box Width 
of Actual Size. 

 Front Tab Height:  Enter the height of the side tab as a % of Box 
Width of Actual Size. 
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Color Selection 
Function:  This dialog box allows you to select a color for a number of 
images in the system – blocks, packers, shippers, etc.  Color Selection is 
most often used to select lighter colors for printing in color. 

 

From the Menu Bar, open the Tools menu and select Color Selection to 
access the dialog box. 

Field Descriptions and Instructions 
The dialog box displays a number of images in the system – blocks, 
packers, shippers, etc.  To select a color for a particular image, use the 
drop-down list next to the image to select a specific color or type in the 
first few letters of the color. 

Note:  Color selections are specific to the user, not to the analysis. 
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Combined Report Parameters 
Function:  The combined report function places two analyses side-by-
side. Users can specify which sequence of the analysis (intermediate pack, 
shipcase or unitload) to appear in the report. 

 
 
To access, go to the File menu, select Print or Print Preview, and then 
Combined Report. 

Field Descriptions and Instructions 
 Analysis: Click the Browse button to select a second analysis to 

compare to the currently opened analysis. 

 Sequence: Select from the drop-down list the sequence with the 
analysis to appear in the report 
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Configuration 
Function:  This dialog box allows you to define the configuration of your 
TOPS Pro system by selecting and de-selecting a range of options. 

From the Menu Bar, open the Tools menu and select Configuration. 
 
Note: The Statistics and Global tabs are only available when you run 
TOPS Pro Config program and login as Supervisor.  

General Tab  

 

 UL Size as Pallet Size:  Use these guidelines: 

Leave the box unchecked if you’d like TOPS Pro to report the actual 
size of the unitload, that is, the actual dimensions of the stack 
shipcases.  

If you check the box, TOPS Pro reports the size of the unitload versus 
pallet, whichever is larger. 

For example, if you have a load that does not overhang the pallet and 
you are interested in the dimensions of the stacked shipcases, you can 
uncheck this option. Otherwise, the length and width listed on the 
unitload will reflect the pallet dimensions. 

 Show Flaps on Cartons:  Check the box to display the flaps on 
cartons.  (Some users may wish to hide the flaps in the display.) 

 Thumbnails for Unitload list:  Check the box to display thumbnail 
images of pallet patterns on a Unitload List. (The default is to show 
thumbnails for unitload list.) 

 Show Info Tips:  Check the box to activate popup information tips in 
the system. 
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 Show g.o.d. window:  Check the box to display the g.o.d. window for 
the various parameter dialog boxes.  It is recommended to enable this 
option so you can easily see what each parameter is referring to. 

No Buttons on Graphic Window:  Check the box to hide the buttons 
(e.g. Divider, Modify, Print, Strength, etc) at the bottom of each 
graphics pane. When the buttons are hidden, their functions can be 
accessed via a short cut menu located at the top left hand corner of 
each graphic pane.  

To access, highlight the graphic pane (now with a blue title bar) and 
bring the mouse cursor to the triangle at the top left hand corner to 
bring down the short cut menu. 

     
 

 Show Face Direction: Check the box to display the hash mark (a 
large open V) to indicate the display face of a shipcase. (The default is 
to show the face direction as shown on the left carton.) 

                  

 Display Template Buttons:  Check the box to display the Template 
Toolbar (  ) on the left side of the Control Panel.  
Click this toolbar to expand and view the available templates.   

 Show Contents for all styles:  Check the box to enable the ability to 
display the contents of all styles of containers.  When enabled, you 
still need to issue the command of Show Contents under the View 
menu or the right click pop-up menu. 

Note:  Normally, TOPS Pro will let you show the contents of trays and 
shrinkwrap containers because they don't have flaps that protrude.  
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With this feature turned on, you can try it for any style of container, 
even those for which it might not look good. 

 Show Graphics/C.A.S.Y.:  Check the box to display paste-on 
graphics on the front, back or top of your shipcases, or to display a 
CASY style designed for a container.  For a faster display, leave this 
feature turned off. 

 Default Screen View:  Use this dropdown selector to specify the 
default screen view among split screen, tri-screen, tri-screen with 
statistics, quad-screen or hex screen. The actual screen views available 
will depend on the number of stages in the design sequence.  For 
example, the hex screen will not be available for shipcase to pallet 
analysis (2-stage). 

Results Tab 

 

 Round to nearest 1/16":  Check the box to round solutions to the 
nearest 1/16 of an inch when TOPS Pro calculates an analysis. 

 Recalculate on Open:  Check the box to recalculate a solution when 
you open that solution record answer – if there is no viewed answer. 

 Save Analysis to XML:  When checked, this option allows you to 
also save TOPS analyses in XML format in the …\DATA\xml\ folder. 
This is similar to the Save As XML command under the File menu 
except that this option will automatically save all analyses as XML. 

 Draw Profile cases upright:  Check the box to draw cases in an 
upright position on the packaging profile. 

 View old solution on Open:  Check the box to view an old solution 
when you open that solution record – if a solution record exists. 
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 Use User’s Folder, Current Folder: This option, when checked, 
allows you to save your analyses to a folder named \TopsData\ under 
your local document (My Documents) folder. 

If left unchecked, analyses will be saved in the default data folder 
where the TOPS installation has been installed, that is, 
...\TOPSAPPS\TOPSPro\DATA\. 

 Save AutoRecover Info Every ( ) Seconds:  This setting turns on the 
AutoRecover feature so a user’s work is saved automatically.  This 
ensures work is not lost if there is a power outage or system crash. 
When enabled, enter the time lapse between each automatic save. 

 Run AutoArchive Every ( ) Days:  Allows you to archive 
infrequently used analyses and remove them from the active file list 
after a predetermined amount of time. 

Enter the frequency in number of days to run auto archive and specify 
what analyses to archive by their creation date. 

Note: Archived analyses can be restored any time and posted back to 
the main folder for review.  To restore archived analyses, go to the File 
menu and then select Open Archive.  At the dialog box, highlight the 
analyses to be restored and click on the Restore button.  You can then 
specify the location where the analysis will be restored to. 
 

Reports Tab 

 

 Print Font: Used to specify the size of the Print Front. 

 Print Revision:  Check the box to print any revision history entered 
for an analysis. 
 
Note:  The Analysis Save As dialog box has a field labeled “Revision 
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History” that allows you to enter revision notes for the analysis.  When 
you perform a Print Preview for the analysis, the revision history notes 
are attached to the bottom of the screen – if the Print Revision option 
is activated. 

 Printer Pen Width:  Enter the output of the printer's line width.  If 
you want your printouts to have a darker, thicker line, increase the pen 
width.  A printer pen width of 4 to 7 is good. 

Note:  If the Show Graphics function is turned on, TOPS Pro ignores 
printer pen width.  To use the printer pen width function, be sure to 
turn off the Show Graphics function on the View menu. 

 Quick Print Count:  Enter the beginning number of a Quick Print 
counter sequence. 

Note:  TOPS Pro tracks the number of times you've created PDF files 
and increments the counter by one each time a new file is created 

 Email Format:  Allows you to specify whether the email format will 
be HTML With Image or Single Image Only 

 Image Format: This setting will determine the default image format 
(JPEG or PNG) 

 
 Email Analysis As XML: determines whether to email analysis in 

XML format instead of TXT 
 

Dimensions Tab 

 
 



 

Appendix B:  Dialog Boxes                                                                                   B-55 

 Show Dimensions on pictures:  Check the box to display the 
dimensions on the graphic images associated with an analysis. 

When enabled, specify whether to display inside, outside or both 
inside and outside dimensions on the graphics. Click the 
corresponding radio buttons for each stage of the analysis including 
primary package, intermediate package and shipcases. 

 Unit Defaults: The Display Units controls what units of measure to 
display.  Click the radio button to select among English, Metric, 
English with Metric in parenthesis or Metric with English in 
parenthesis. 

 Use Advanced unit Options: Click this option to enable Advanced 
Unit Options. This will allow you to specify independent unit settings 
for Primary, Packer, Shipcase, UnitLoad and Vehicle. 

Numeric Tab 

 

 Output Fractions on:  Allows the user to enable the output of 
fractions. Place check mark ( ) against items accepting fraction 
outputs. 

 Decimals:  Allows you to specify the number of decimals places a 
value will be rounded to when displayed or printed for a particular 
item, in both English and Metric units. 
 
For example, if you enter 4 for a carton, TOPS Pro will display the 
solution as .1234.  If you enter 2, TOPS Pro will display the solution 
as .12.  These settings change the way numbers are displayed – not the 
actual values. 
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Statistics Tab 
Function:  The Statistics tab allows you to set up rows and columns of 
statistics that will display in the various Statistics View panes.  This 
allows you to eliminate unnecessary data from your reports.  To include 
the data in the statistics, make sure the corresponding boxes are checked. 

Note:  The Statistics tab in the Configuration dialog box is only available 
in the TOPS Pro Config program after you login as the Supervisor. 

 

 There's a list of items on the left side of the dialog box – Net, Grs, 
Cube, Dim Vert, etc. 

 There are a number of items that make up six columns across the top 
of the dialog box – Carton, Bundle, Packer, Shipcase, UnitLoad and 
Vehicle Load. 

 Under the Carton, Bundle, Packer and Shipcase columns are a number 
of sub-columns – ID, OD and/or Bulge, Slack sub-columns. 

 Each report item in the list on the left has one or more statistics 
switches attached to it, which are represented by the checkboxes.  For 
example, the Dim Vert item has four statistics switches:  Carton OD, 
Bundle OD, Packer OD and Shipcase OD. 

 To turn on the statistics switches for an item, check the box for that 
item.  TOPS Pro automatically turns on the switches for the statistics 
attached to that item.  For example, if you check the box for the Dim 
Vert item, TOPS Pro automatically turns on the three statistics 
switches attached to it.  Likewise, you can turn on the switches 
attached to the items at the top of the dialog box. 



 

Appendix B:  Dialog Boxes                                                                                   B-57 

If the statistics setup is the way you want it, click on OK.  TOPS Pro saves 
the setup and returns you to the Configuration dialog box. 

Global Tab 
Note:  The Global tab in the Configuration dialog box is only available in 
the TOPS Pro Config program after you login as the Supervisor. 

The settings in the Global tab affect how the TOPS Pro software runs. For 
example, whether or not to allow users to approve their own analyses, etc.  
These parameters affect all existing and/or new users. Be aware that if you 
change these settings, in order for the changes to “stick”, all users in 
TOPS Pro and TOPS Config programs must exit the respective systems. 

 

 (User Login) User Login:  Check the box to display the User Login 
dialog box at the start of the program. 

Important:  TOPS strongly recommends that this option be turned on! 

 (User Login) User Passwords:  Check the box to turn on a password 
setting for all users. 

 (User Login) User Approval:  Check the box to allow users to 
approve their own analyses, as opposed to requiring supervisor 
approval. 

Note:  For more information about the approval process, please refer 
to Chapter 15, Supervisor Functions. 

Checking this box allows users to change or add items to the product 
database in the Define Menu.  When this box is unchecked, only a 
supervisor can make changes. 
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 (User Login) Allow User Defines:  Check the box to limit the 
changes to the Define dialog boxes; reverts to supervisor only. 

 (User Login) Analysis-no username filter:  Check the box to disable 
the use of username to filter analyses in the database. 

  (Database Control) Multi User:  Check the box to turn on record 
locking for the databases.  This option is automatically turned on for 
networks. 

 (Database Control) User database in App Path:  Check the box to 
save all data to the directory path where the TOPS system has been 
installed. 

 (Viewer) Appr Analyses Only:  Check this option to show only 
approved analyses when running the TOPS Pro Viewer program 
(available in TOPS network version only). 

 (Viewer) All Analyses:  Check this option to show all analyses, 
including both approved and working ones when running the TOPS 
Pro Viewer program (available in TOPS network version only). 

 (General) Show Product:  Check the box to display the Product 
Button-Style Menu, which includes the Granular, Bulk and Powder 
icons.  Leaving this option turned off saves space on the Control 
Panel. 

 (General) Allow Duplicate Products:  Check the box to allow 
products with the same product code in a single Package Profile. 

 (General) Use Product Brands:  Check the box to use product brands 
or duplicate Divisions. 

 (General) Allow New Products:  Check the box to allow the user to 
add products or change a package profile after it has been approved, 
without requiring new approval. 

 (General) Abbreviated Statistics:  Check the box to shorten statistics 
for vehicle solutions and to exclude some rows of statistics. 

 (General) Department:  Check the box to show department in reports 

 (General) CubeSpec Needed:  Check the box to specify that a 
package profile is required before you can request approval of an 
analysis.  

 (General) Show closed Cartons (Print):  Check the box to not 
illustrate carton flaps in Print reports for primary packs and shipcase. 

 (General) No Logo in Print:  Check the box to remove logos in 
TOPS reports. 
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 (General) International Date:  Check the box to display dates in the 
international (DD/MM/YY) format, rather than the American 
(MM/DD/YY) format. 

 (General) Logo:  Enter the location of the image file to be used as 
logo in reports. 

 (General) Max history for analysis: Enter the maximum number of 
modification history to be tracked for the analyses. 

 (General) Default Language:  Select the default language used in 
TOPS Pro Viewer for users not logging into the system. 
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Container Diagram Spec 
Function:  This dialog box allows you to enter or update specifications 
for a specific container diagram. 

 

Note: To create a container diagram, you must first complete a package 
analysis and save it to the database.  Then go to the Menu Bar, open the 
File menu, select Print Preview, then select Package Profile.  After the 
Print Preview displays, click the Close button.  At this time, go to the 
Menu Bar, open the File menu and select Container Diagram. 

Field Descriptions and Instructions 
 Description:  Select a description of the container diagram or type in 

the first few letters of the description. 

 Designed By:  Enter the name of the person who designed the 
container diagram.  This information will be printed on reports. 

 Designed Date:  Enter the date the container diagram was designed.  
This information will be printed on reports. 

 Revised By:  Enter the name of the person who revised the container 
diagram.  This information will be printed on reports. 

 Revised Date:  Enter the date the container diagram was revised.  This 
information will be printed on reports. 

 Glue Flap Width:  Enter the width of the glue flap in inches or 
millimeters, depending on the Units selected. 

Note:  The glue flap is used to glue the end panels of a shipping case 
together. 
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 Glue Flap Ext Length:  Enter the extended length of the outside box 
flaps in inches or millimeters, depending on the Units selected. 

 Additional Flap Gap:  Enter the gap between the outside box flaps in 
inches or millimeters, depending on the Units selected. 

Note:  Remember that this value affects stacking strength.  Consider 
this before you change the value. 

 Bar Code Area Width:  Select the width of the bar code. 

 Code Date Area Width:  Select the width of the code date area. 

 Comments:  Enter any comments that are relevant to the container 
diagram. 

 Show Index Mark:  Check the box to show an index mark for 
location of the UPC code on the container diagram. 

 Units:  Select either English or Metric to specify how the container 
units will be measured. 

 New CD Button:  Allows you to create a new, blank container 
diagram. 

 Pattern Button:  Displays the Container Pattern dialog box, which 
allows you to define the pattern for a container. 
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Container Pattern 
Function:  This dialog box allows you to define a container pattern, 
including how the container is stacked, location of minor flaps, glue lap 
and pattern options. 

 

From the Container Diagram Spec dialog box, click on the Pattern button 
to access the Container Pattern dialog box. 

Field Descriptions and Instructions 
 Stacked:  Select End, Side or Bottom to specify how the container 

will be stacked. 

 Pattern:  Select an option to specify the container pattern. 

 Minor Flaps:  Select either In or Out to specify how the minor flaps 
will be positioned. 

 Glue Lap:  Select either Inside or Outside to specify where the glue 
lap will be positioned. 
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Costing Data 
Function:  This dialog box allows you to enter costing data related to a 
number of bag-related items. 

Note:  Costing Data applies only to an analysis that loads bags into an 
intermediate packer or shipcase, then onto a pallet. 

 

To access, from the Menu Bar, open the Define Menu and select Bag 
Costing. 

Field Descriptions and Instructions 
 Seconds to pack bag into case:  Enter the number of seconds in takes 

to pack a bag into a shipcase. 

 Seconds to select, erect, label, close & discard case:  Enter the 
number of seconds in takes to select, erect, label, close and discard the 
shipcase. 

 Seconds per divider insertion:  Enter the number of seconds it takes 
to insert a divider into the shipcase. 

 Number of packer:  Enter the number of people who are working as 
packers. 

 Remainder of crew:  Enter the number of people who comprise the 
remainder of the crew. 
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 Packer Labor Cost ($/hr):  Enter the packer labor cost in dollars per 
hour. 

 Production Transfer shipping rate (pallets/hr):  Enter the 
production transfer shipping rate in number of pallets per hour. 

 Production transfer labor cost ($/hr):  Enter the production transfer 
labor cost in dollars per hour. 

 Shipping case handling rate (cases/hr):  Enter the shipcase handling 
rate in number of cases per hour. 

 Shipping/Handling labor cost ($/hr):  Enter the shipping and 
handling labor cost in dollars per hour. 

 OTR Variable distribution cost ($/cube):  Enter the OTR variable 
distribution cost in dollars per cube. 

 OTR Variable distribution unload cost ($/case):  Enter the OTR 
variable distribution unload cost in dollars per case. 

 Warehouse cost ($/pallet):  Enter the warehouse cost in dollars per 
pallet. 

 Pallet movement (#/year):  Enter the number of pallets that are 
moved in a year. 

 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

 More Button:  Displays the Additional Costing Data dialog box, 
which allows you to enter more costing data. 
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Defaults (Button Menu Styles) 
Function:  This dialog box allows you to enter default items and values 
for a number of button style menus. 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu and select Defaults or click on the Setup Defaults quick 
link in the Control Panel.  On the Defaults dialog box, select Button Menu 
Styles. 

 

Field Descriptions and Instructions 
 Carton-Carton:  Select from the drop-down list the default carton 

style for your primary (green) Carton icon. 

 IP-Shipper:  Select from the drop-down list the default intermediate 
pack shipper for your primary (blue) Packer icon. 

 IP-Tray:  Select from the drop-down list the default intermediate pack 
tray for your primary (blue) Tray icon. 

 IP-Carton:  Select from the drop-down list the default intermediate 
pack carton for your primary (blue) Carton icon. 

 ShipCase-Shipper:  Select from the drop-down list the default 
shipcase style for your shipcase (yellow) icon. 

 ShipCase-Tray:  Select from the drop-down list the default shipcase 
tray style for your shipcase (yellow) Tray icon. 
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 UL-Pallet:  Select from the drop-down list the default pallet used for 
the unitload. 

 UL-Slipsheet:  Select from the drop-down list the default unitload 
slipsheet. 

 UL-None:  Select from the drop-down list the default none-type pallet. 

 Vehicle-Truck:  Select from the drop-down list the default truck. 

 Vehicle Sea Van:  Select from the drop-down list the default sea van. 

 Vehicle-Railcar:  Select from the drop-down list the default railcar. 
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Defaults (Carton/Bag Sizing) 
Function:  This dialog box specifies the default items and values for a 
number of sizing parameters for the green carton/bag containers in the 
Primary Pack Button-Style Menu, located on the TOPS Pro Control Panel. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu, select Defaults and then Carton/Bag Sizing. 

Field Descriptions and Instructions 
 Len Incr, Wid Incr, Hgt Incr:  Enter the default increment for 

length, width and height for new packages respectively. 

 Seal Style: Enter the default seal style.  Enter Lap or Fin in the field. 

 Rep. to Form %: Enter the default repeat to former ratio. This value 
forces the repeat dimension of the bag to be less than X times the 
former dimension of the bag, where X is the value you'll enter in this 
field. 

 Back Seal: Enter the default back seal size. 

 Bottom Seal: Enter the default bottom seal size. 

 Top Seal: Enter the default top seal size 

 Film: Enter the default film.  Make sure to type in the file type exactly 
as they appear in the Film database. 
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Defaults (Intermediate Pack View) 
Function: This dialog box allows you to enter default items and values for 
a number of parameters for the blue containers in the Intermediate Pack 
Button-Style Menu, located on the TOPS Pro Control Panel. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu, select Defaults and then Intermediate Pack View. 

Field Descriptions and Instructions 
 Flute:  Enter the default flute. 

 Len Slack, Wid Slack, Hgt Slack:  Enter the default slacks for 
length, width and height respectively. 

 Len Slack, Wid Slack, Hgt Bulge:  Enter the default bulge for length, 
width and height respectively. 

 Len Vert:  Check the box to specify to use length vertical as a default. 

 Wid Vert:  Check the box to specify to use width vertical as a default. 

 Hgt Vert:  Check the box to specify to use height vertical as a default. 
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Defaults (Intermediate Sizing) 
Function:  This dialog box allows you to enter default values for the 
sizing parameters for the blue containers in the Intermediate Pack Button-
Style Menu, located on the TOPS Pro Control Panel. 

 

To access, open TOPS Configuration program.  Click on Setup Defaults in 
the Control Panel and then select Intermediate Sizing. 

Field Descriptions and Instructions 
 Min Count, Max Count:  Enter the default minimum and maximum 

values respectively for the Sizing: Range option. 

 Set Count 1 through 5:  Enter the five default values for the Sizing: 
Values option. 

 Max Cartons Len:  Enter the default for the maximum cartons along 
the length of the intermediate packer for the Sizing option. 

 Max Cartons Wid:  Enter the default for maximum cartons along the 
width of the intermediate packer for the Sizing option. 

 Max Cartons Hgt:  Enter the default for maximum cartons along the 
height of the intermediate packer for the Sizing option. 

 Len to Wid Ratio:  Enter the default length-to-width ratio used for the 
Sizing option. 
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 Hgt to Wid Ratio:  Enter the default height-to-width ratio used for the 
Sizing option. 

 Staggered (cans):  Check the box to include staggered arrangements 
for cans as default Pattern Styles. 

 Row-Column (cans):  Check the box to include row-column 
arrangements for cans as default Pattern Styles. 
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Defaults (Pallet) 
Function:  This dialog box allows you to enter default values for new 
pallet definition and setup default unitload optional values.  

 

To access, open TOPS Configuration program, click on Setup Defaults 
and then select Pallet. 

Field Descriptions and Instructions 
 Deck Board Count:  The default deck board count for new pallets. 

 Deck Board Height:  The default deck board height for new pallets. 

 Inside Deck Brd Wid:  The default width for inside deck boards. 

 Outside Dck Brd Wid:  The width for outside deck boards. 

 Stringer Width:  The default stringer width for new pallets. 

 Length Clamp:  Check the box to use Length clampable as default. 

 Width Clamp:  Check the box to use Width clampable as default. 

 Corner Posts:  Check the box to use corner posts as an default option 

 Corner Post Len:  The default value for corner post length. 

 Corner Post Thick:  The default value for corner post thickness as 
unitload option. 
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Defaults (Pallet Spec) 
Function:  This dialog box allows you to enter default values for a 
number of pallet parameters. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu and select Defaults.  On the Defaults dialog box, select 
Pallet Spec. 

Field Descriptions and Instructions 
 Max UL High:  Enter the default maximum unitloads that can be 

stacked on the pallet. 

 Clamp Direction:  Enter the default clamp direction among from 
N/A, non-clampable, Length, Width or both. 
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Defaults (Primary Package) 
Function:  This dialog box allows you to enter default values for a 
number of parameters for the green containers in the Primary Package. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu and select Defaults.  On the Defaults dialog box, select 
Primary Package. 

Field Descriptions and Instructions 
 Inside/Outside Dims:  Enter either Inside or Outside to use as the 

default dimensions. 

 Len Vert:  Check the box to include length vertical as the default. 

 Wid Vert:  Check the box to include width vertical as the default. 

 Hgt Vert:  Check the box to include height vertical as the default. 

 Caliper:  Enter the default caliper for the primary pack. 

 Head Space:  Enter the default head space for the primary pack. 

 Length Bulge, Width Bulge, Height Bulge:  Enter the default values 
for bulge along the length, width and height dimensions for the 
primary pack respectively. 
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Defaults (Print) 
Function:  This dialog box allows you to enter default values for a 
number of print parameters. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu and select Defaults.  On the Defaults dialog box, select 
Print. 

Field Descriptions and Instructions 
 Print Layout:  Enter the code for the corresponding default print 

layout as provided below. 
 
Full Page = 1  Horiz Split = H Vertical Split = V 
3 Way Top = T  3 Way Left = L 3 Way Right = R 
3 Way Bottom = B Quad Split = 4   
5 Way = 5   5 Way Down = 3 
6 Way Fixed = 6  6 Way Scaled = S 6 Way Down = D 

 Header:  Enter the default header for print output. This is the place 
where you will put your company name to appear on all printouts. 

 UL High:  Enter the number of unitloads that will be stacked on top of 
one another. 

 Color:  Check the box to specify color printing as the default. 
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 Area 1, 2, 3, 4, 5 and 6:  Using the following table as reference, enter 
a code for each Area to represent the information, image or data, to be 
printed in each area. 

 

 

 

 

 

 

  
 
 

 Analysis Name:  Check the box to print the analysis name by default. 

 QPrint Template:  Enter the default Quick Print template. 

 QPrint Send To:  Enter the default printing destination, select from 
PDF, Print or Both. 

 QPrint Analysis:  Check the box to include the analysis in a Quick 
Print report by default. 

 QPrint Statistics:  Check the box to include statistics in a Quick Print 
report by default. 

 QPrint Pallet Spec:  Check the box to include pallet specifications in 
a Quick Print report by default. 

 QPrint Problem Def:  Check the box to include the problem 
definition in a Quick Print report by default. 

 QPrint Show Dims:  Check the box to show dimensions in a Quick 
Print report by default. 

 Primary 
Pack

Bundle 
Pack

Intermediate 
Pack

Case Unitload Vehicle 

3D x b i D 3 V 
Plan  j p A T L 

Dual Plan     U  
Pop Top     P  

Side  g s G S I 
Front  e f B F R 

Statistics   t C X E 
No View N      
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Defaults (Shipcase) 
Function:  This dialog box allows you to enter default values for a 
number of parameters for the yellow containers in the Shipcase Button-
Style Menu, located on the TOPS Pro Control Panel. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select Shipcase. 

Field Descriptions and Instructions 
 Flute:  Enter the default flute. 

 Inside/Outside Dims:  Enter to use Inside or Outside as the default 
dimensions. 

 Length Slack, Width Slack, Depth Slack:  Enter the default slack 
values to be used for length, width and depth respectively. 

 Max Weight:  Enter the default maximum weight. 

 Length Bulge, Width Bulge, Depth Bulge:  Enter the default values 
for bulge along the length, width and depth dimensions respectively. 

 Len Vert:  Check the box to include length vertical as a default. 

 Wid Vert:  Check the box to include width vertical as a default. 

 Hgt Vert:  Check the box to include height vertical as a default. 
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Defaults (Shipcase Patterns) 
Function:  This dialog box allows you to enter default values for a 
number of shipcase parameters. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select Shipcase Patterns. 

Field Descriptions and Instructions 
 1 Block, 2 Block, 3 Block, 4 Block:  Check the corresponding box(es) 

to include the block pattern(s) as default patterns for shipcase. 

 Diagonal, Multi Dim, Multi Surface, Multi-Layer:  Check the 
corresponding box(es) to include these special pattern(s) as default. 

 Staggered (cans):  Check the box to include staggered patterns for 
cans as the default. 

 Row-Column (cans): Check the box to specify a row-column pattern 
for cans as the default. 

 Min Range For Fixed:  Enter the default minimum range. 

 Max Range For Fixed:  Enter the default maximum range. 



 

B-78                                                                         TOPS Pro (Version 6.50) User Guide 

Defaults (Shipcase Sizing) 
Function:  This dialog box allows you to enter default values for a 
number of sizing parameters for the yellow containers in the Shipcase 
Button-Style Menu, located on the TOPS Pro Control Panel. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select Shipcase Sizing. 

Field Descriptions and Instructions 
 Len Incr, Wid Incr, Hgt Incr:  Enter the default increment for 

length, width and height for new shipcases respectively. 

 Min Count, Max Count:  Enter the default minimum and maximum 
values respectively for the Sizing: Range option. 

 Set Count 1 through 5:  Enter the five default values for the Sizing: 
Values option. 

 Max Cartons Len:  Enter the default for the maximum items along 
the length of the shipcase for the Sizing option. 

 Max Cartons Wid:  Enter the default for maximum items along the 
width of the shipcase for the Sizing option. 

 Max Cartons Hgt:  Enter the default for maximum items along the 
height of the shipcase for the Sizing option. 
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 Len to Wid Ratio:  Enter the default length-to-width ratio used for the 
Sizing option. 

 Hgt to Wid Ratio:  Enter the default height-to-width ratio used for the 
Sizing option. 

 Note:  In TOPS Pro, the Length and Width to Height ratios yield 
boxes that are closer to a cubic-type shape. 

 Maximum Length:  Enter the default maximum length for the 
shipcase. 

 Maximum Width:  Enter the default maximum width for the 
shipcase. 

 Maximum Height:  Enter the default maximum height for the 
shipcase 
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Defaults (Stack Strength) 
Function:  This dialog box allows you to enter default values for a 
number of stacking strength parameters. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select Stack Strength. 

Field Descriptions and Instructions 
 Calc Method:  Enter the default method for calculating stacking 

strength – R (Ring Crush), E (Edge Crush) or K (Kellicut). 

 Humidity:  Enter the default humidity percentage used for stack 
strength analysis. 

 Stack Time:  Enter the index number for stack or storage time as 
defined below: 

0 = 0 day  4 = 2 months 
1 = 3 days  5 = 3 month 
2 = 10 days  6 = 6 months 
3 = 1 month  7 = 1 year 

 
 UL High:  Enter the default number of unitloads to be stacked. 
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Defaults (Transit Vehicle Patterns) 
Function:  This dialog box allows you to enter default values for a 
number of transit vehicle parameters. 

Note:  For detailed information about pallet patterns, please refer to 
Appendix E, Pallet Patterns. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select TV (Transit Vehicle) Patterns. 

Field Descriptions and Instructions 
 1 Block, 2 Block, 3 Block, 4 Block, 5 Block, 5 Block Plus:  Check 

the corresponding box(es) to include the block pattern(s) as default 
patterns for shipcases or unitloads when they are loaded inside transit 
vehicles. 

 Solder, Diagonal, Repeater, Multi Dimension, Multi Surface, 
Multi Layer:  Check the corresponding box(es) to include these 
special pattern(s) as default patterns for shipcases or unitloads when 
they are loaded inside transit vehicles. 

 Staggered (drums):  Check the box to include staggered patterns as 
default when loading drums inside transit vehicles. 
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Defaults (UnitLoad Patterns) 
Function:  This dialog box allows you to enter default values for a 
number of unitload pattern parameters. 

Note:  For detailed information about pallet patterns, please refer to 
Appendix D, Pallet Patterns. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select UL (UnitLoad) Patterns. 

Field Descriptions and Instructions 
 1 Block, 2 Block, 3 Block, 4 Block, 5 Block, 5 Block Plus:  Check 

the corresponding box(es) to include the block pattern(s) as default 
patterns for shipcases when they are loaded on pallets. 

 Diagonal, Soldier, Multi Dimension, Multi Surface, Multi Layer:  
Check the corresponding box(es) to include these special pattern(s) as 
default patterns for shipcases when they are loaded on pallets. 

 Staggered (drums):  Check the box to include staggered patterns as 
default when loading drums on pallets. 
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Defaults (UnitLoad Sizing) 
Function:  This dialog box allows you to enter default values for a 
number of sizing parameters for the brown unitloads in the Unitload 
Button-Style Menu, located on the TOPS Pro Control Panel.  This feature 
relates to how your items can be placed on a pallet. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select UnitLoad Sizing. 

Field Descriptions and Instructions 
 Max Height:  Enter the default maximum height for the unitload, note 

that this value also includes the height of the selected pallet. 

 Max Weight:  Enter the default maximum weight for the unitload 
which also includes the weight of the pallet itself. 

 Length Overhang:  Enter the default maximum length overhang for 
unitload parameters. 

 Length Underhang:  Enter the default length underhang for the 
unitload.  It is recommended to use 15 as the default value and not be 
changed for calculation. 

 Width Overhang:  Enter the default maximum width overhang for 
unitload parameters. 
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 Width Underhang:  Enter the default width underhang. It is 
recommended to use 15 as the default value and not be changed for 
calculation. 

 Draw Pad:  Enter the default value for pad thickness when depicting 
pads on a unitload. 

 Actual Pad:  Enter the default value for the actual pad thickness used 
for unitloads. 

 Cap Thickness:  Enter the default value for cap thickness used for 
unitloads. 

 Rotation Type:  The default rotation type for unitload layer 
parameters, enter Length, Width, Both or 90 Degrees for length flip, 
width flip, length and width flip and rotate 90 degrees respectively. 

 Rotate Top Two:  Check the box to rotate the top two unitload layers 
as a default unitload layer parameter. 

 Rotate All:  Check the box to rotate all unitload layers as a default 
unitload layer parameter. 

 Spread Type:  The default spread type for unitload layer parameter, 
enter Pack, Layer or Pallet for pack tightly, spread to layer edge or 
spread to pallet respectively as pictured below. 
 

                             
                                  No spread                 Spread to layer edge         Spread to pallet edge              

 Filler Type:  The default filler type for unitload layer parameter, enter 
None, Middle or End for no filler, middle filler or end filler 
respectively. 

 Draw SlipSheet Thickness:  Enter the default value for slipsheet 
thickness when depicting pads on a unitload. The default thickness for 
slipsheet illustrated for unitload. 

 Actual SlipSheet Thickness:  Enter the default value for the actual 
slipsheet thickness used for unitloads. 
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Defaults (Vehicle Load Sizing) 
Function:  This dialog box allows you to enter default values for a 
number of sizing parameters for the red vehicle loads in the Vehicle 
Button-Style Menu, located on the TOPS Pro Control Panel. 

 

To access, open TOPS Configuration program, click on Setup Defaults 
and the select Vehicle Load Sizing. 

Field Descriptions and Instructions 
 Max Weight:  Enter the default maximum weight for vehicle load.   

 Rotation Type:  Enter the default rotation type for the vehicle layer 
parms dialog box.  Use value from None, Length, Width and both for 
no rotation, length flip, width flip and length and width flip 
respectively. 

 Rotate Top 2:  Check the box to rotate the top two layers by default 
for vehicle loads. 

 Rotate All:  Check the box to rotate all layers by default for vehicle 
loads. 

 Spread Type:  The default spread type for vehicle layer parameter, 
enter Pack, Layer or Pallet for pack tightly, spread to layer edge or 
spread to pallet (vehicle) with rotation respectively as pictured on the 
next page. 
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                    No spread                 Spread to layer edge                     Spread to vehicle edge              

 Grams/CC:  Enter the default grams per cubic centimeter.  This value 
is a conversion factor for calculating density. 

 Width For Density:  Enter the direction used for the width when 
calculating density.  Use these guidelines: 

0 = Length 
1 = Width 
2 = Height 

 Just along Length:  Enter L, R or C (for Left, Right and Center) as 
the default alignment direction for unitloads along the length of the 
vehicle. 

 Just along Width:  Enter L, R or C (for Left, Right and Center) as the 
default alignment direction for unitloads along the width of the 
vehicle. 

 Just along Height:  Enter L, R or C (for Left, Right and Center) as the 
default alignment direction for unitloads along the height of the 
vehicle. 

 Len Slack, Wid Slack, Hgt Slack:  Enter the default slack values to 
be used for length, width and height respectively. 
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Define Bag 
Function:  This dialog box allows you to define parameters for different 
types of bags.  For example, the Former-Repeat-Air Fill feature allows 
you to design a potato chip bag.  The Length-Width-Height feature allows 
you to design a candy bar bag.  A bag may contain only bulk product.  
Further, a bag must always be inserted into another container; the bag 
element cannot be the last stage of an analysis. 

 

From the Menu Bar, open the Define Menu and select Film Bag. 

 Seal Style: Select either Lap or Fin to specify how the bag will be 
sealed. 

 Based On: Select either FxRxA or LxWxH to specify whether the bag 
if defined by Former-Repeat-Air Fill or Length-Width-Height. 

 Stand-Up Bag: Select this box to make the bag flat on the bottom. 

 Description: Select a pre-defined carton or type in the first few letters 
of the carton for modification or enter a new name to define a new bag 
for use in TOPS Pro. 

 Film: Select the film style to be used for the bag. 

Note:  TOPS Pro assumes film thickness to be inconsequential.  Also, 
the drop-down list contains film types that are already set up in the 
database.  If the film type you want is not on the list, you can add it to 
the database using the Define Film dialog box. 

 Film Cost: Displays the film cost and waste factor for the selected 
film.  The film cost is defined under the Define, film dialog box. 

 Former: Enter the distance across a flattened FxRxA type bag. 

 Repeat: Enter the distance between cuts of a flattened FxRxA type 
bag. 
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 Air Fill: Enter the thickness of a filled FxRxA type bag. 

 Length: Enter the distance across a flattened LxWxH type bag. 

 Height: Enter the distance between cuts of a flattened LxWxH type 
bag. 

 Width: Enter the thickness of a filled LxWxH type bag. 

 Weight: Enter the Weight of the bag 

 Seal Dims: Enter the dimensions of the top, bottom and back seal of 
the bag. 
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Define Bottle 
Function:  This dialog box allows you to define parameters for different 
types of bottles – perfume bottles, shampoo bottles, etc.  You can also use 
bottle parameters to design shapes for toilet tissue and paper towel rolls. 

 

From the Menu Bar, open the Define Menu and select Bottle. 

 Description: Select a predefined bottle from the drop down list for  
modification or type in a new name to define an new bottle for future 
use. 

 Body Length: For rectangular or oval bottles, enter the total length of 
the bottle body. 

 Body Width: For rectangular or oval bottles, enter the body width of 
the bottle. 

 Body Diameter: For round bottles, enter the diameter of the widest 
part of the bottle. 

 Neck Diameter: Enter the neck diameter of the bottle. 

Note:  For a round bottle, the neck diameter should be less than the 
body diameter.  For an oval or rectangular bottle, the neck diameter 
should be less than the smaller of length or width.  This value must be 
greater than zero, but it can be very small (ie, .001) 

 Height: Enter the total height of the bottle – including body, shoulder 
and neck. 

 Neck Hgt: Enter the height of the portion of the bottle. 

 Note:  The neck height is the distance from the top of the bottle to the 
top of the shoulder.  Neck height must be greater than zero.  This value 
must be greater than zero, but it can be very small (ie, .001) 



 

B-90                                                                         TOPS Pro (Version 6.50) User Guide 

 Shoulder Hgt: Enter the shoulder height of the bottle. 

Note:  The shoulder height is the distance between the neck and the 
base of the bottle, and represents the transition point of the bottle.  
This value must be greater than zero, but it can be very small (ie, .001) 

 Weight: Enter the net weight of the bottle. 

 Body Shape: Select either Round, Oval or Rectangular to specify the 
body shape of the bottle. 
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Define Can / Drum 
Function:  This dialog box allows you to define parameters for different 
types of cans – soup cans, cookie cans, etc.  You'll also use Can 
Parameters to define round tubs and round bottles, canisters or drums. 

 

From the Menu Bar, open the Define Menu and select Can. 

 Description: Select from the drop list a predefined can for 
modification or type in a new name to define a new can/drum for 
future use. 

 Diameter: Enter the diameter of the can or any cylindrical pack. 

Note:  This dimension is used for a can that has a uniform diameter 
from top to bottom.  If your can has different diameter measurements 
at the top and bottom, use the Tub or Bucket in your analysis. 

 Height: Enter the height of the can. 

 Weight: Enter the net weight of the can. 
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Define Carton 
Function:  This dialog box allows you to define parameters for a new 
carton (one that's not already defined in the system).  This dialog box also 
allows you to change parameters for an existing carton. 

 

From the Menu Bar, open the Define Menu and select Carton. 

Field Descriptions and Instructions 
 Description:  For a new carton, type in a new name in the description 

field.  For an existing carton, select a pre-defined carton from the drop 
list for review or modification. 

Note:  If you select a pre-defined carton, TOPS Pro will automatically 
insert dimensions in the Length, Width and Height fields, as well as 
any pre-defined graphics.  If you select User Defined in the Carton 
Parameters dialog box, you'll need to manually enter dimensions in the 
Length, Width and Height fields. 

 Style:  Select the style of the carton. 

 Length, Width, Height, Weight:  Enter the length, width, height and 
weight of the new carton. 

 Caliper:  Enter the caliper of the carton. The caliper is used to 
calculate the inside vs. outside dimensions of the carton. 

 Dimensions:  Select either Inside or Outside to specify how the carton 
dimensions are measured. 

 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the carton. 
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Define Dividers 
Function:  This dialog box allows you to define parameters for a new 
divider (one that's not already defined in the system).  This dialog box also 
allows you to change parameters for existing dividers. 

 

From the Menu Bar, open the Define Menu and select Dividers. 

Field Descriptions and Instructions 
 Description:  For a new divider, type in a description and define the 

corresponding parameters.  For an existing divider, select a pre-
defined divider from the drop-list or type in the first few letters of the 
divider. 

 Drawing Style:  Select a pre-defined drawing style or type in the first 
few letters of the drawing style. Available styles are depicted in 
Appendix F of this guide. 

 Support Factor:  Enter the support factor provided by the divider. 

 Cost per 1000:  Enter the cost per 1000 units of the divider.  This field 
is used only for film bag calculations. 

 Turn Rate:  Enter the turn rate for the divider.  This field is used only 
for film bag calculations. 

 Arrangement:  Enter the arrangement of primary containers within 
the divider.  For example, if the divider will accommodate three rows 
of 10 containers, enter 3 and 10. 
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 Drawing Parameters:  Depending on the drawing style, check the 
box(es) to include the type(s) of closure to be built into the divider. 
 
2-Way Divider Closure Types (example 3x2): 
 

             
        No                    Partial               End                   Middle                  Full 
 
2-Way Air Cell (example 3x2 with Air Cell Width = 0.75 and Air 
Cell Length = 0.25) 
 

       
Perimeter Air Cell          Complete Air Cell 
 
Z Partition (example 3x2) 
 

                        
   Standard            Divider width                Cell Width 
                              no width tabs               width tabs 
 
U Partition (example 3x2 with Middle Space = 0.75 and Tab Length 
= 0.5) 
 

                    
Divider Width       Cell width              Cell Width                   Divider Width 
   no tabs            inside tabs            Outside tabs                       no tabs 
                                                 Allow cartons outside      Allow cartons outside 
 
U Simple (example 3x2) 
 

                          
 Cell Width        Divider width         Divider Width                Cell Width 
   no tabs            no tabs                start & end tabs           Start tab only 
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 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

 Thicknesses Lengths:  Enter the number of thicknesses along the 
length of the divider. 

 Thicknesses Widths:  Enter the number of thicknesses along the 
width of the divider. 

 Thicknesses Depths:  Enter the number of thicknesses along the depth 
of the divider. 
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Define Film 
Function:  This dialog box allows you to define parameters for a new film 
(one that's not already defined in the system).  This dialog box also allows 
you to change parameters for existing film. 

 

To access, open the Define Menu and select Film from the Menu Bar. 

Field Descriptions and Instructions 
 Description:  For a new film, type in a description.  For an existing 

film, select a pre-defined film from the drop list or type in the first few 
letters of the film. 

Note:  If you select a pre-defined film, TOPS Pro will automatically 
insert values in the various dimension fields.  If you select User 
Defined, you'll need to manually enter dimensions. 

 Cost ($/msi):  Enter the cost per million square inches of the film. 

 Waste (%):  Enter the percentage of waste incurred for the film. 

 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 
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Define Flute 
Function:  This dialog box allows you to enter default parameters for 
different types of flutes. 

 

To access the Define Flutes dialog box, open TOPS Configuration 
program.  From the Menu Bar, open the Define Menu and select Flutes or 
click on the Define Flute quick link. 

Field Descriptions and Instructions 
 Flute:  Select a type of flute or enter a new flute type for definition. 

 Glue Lap:  Select either Inside or Outside to specify the position of 
the glue lap. 

 Top Flap:  Enter the thickness of the top flap in inches or millimeters, 
depending on the Units selected. 

 Bottom Flap:  Enter the thickness of the bottom flap in inches or 
millimeters, depending on the Units selected. 

 Height:  Enter the height of the flute in inches or millimeters, 
depending on the Units selected. 

 Length 1:  Enter the first length in inches or millimeters, depending 
on the Units selected. 

 Width 1:  Enter the first width in inches or millimeters, depending on 
the Units selected. 
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 Length 2:  Enter the second length in inches or millimeters, depending 
on the Units selected. 

 Width 2:  Enter the second width in inches or millimeters, depending 
on the Units selected. 

 Glue Lap:  Enter the thickness of the glue lap in inches or millimeters, 
depending on the Units selected. 

 Units:  Select either English or Metric to specify how the product 
units are measured. 

 Locked:  Indicates if only a supervisor can enter or change parameters 
on this dialog box. 

 Flute Const:  Enter the flute constant in inches or millimeters, 
depending on the Units selected. 

 Thickness:  Enter the flute thickness in inches or millimeters, 
depending on the Units selected. 

 Takeup Flute 1:  Enter the takeup flute 1 value in inches or 
millimeters, depending on the Units selected; used for stacking 
strength calculations. 

 Takeup Flute 2:  Enter the takeup flute 2 value in inches or 
millimeters, depending on the Units selected; used for stacking 
strength calculations. 

 (lbs/1000ft2)/(gr/m2):  Enter the pounds per 1,000 square feet or 
grams per square meter, depending on the Units selected. 

 Flute Const (Kellicut):  This field is reserved for Japanese customers. 

 Box Const (Kellicut):  This field is reserved for Japanese customers. 
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Define Milk Carton 
Function:  This dialog box allows you to define parameters for different 
types of milk cartons, as well as containers such as dog food bag and 
cookie bags. 

 

From the Menu Bar, open the Define Menu and select Milk Carton. 

 Description: For a new milk carton, type in a description.  For an 
existing milk carton, select a pre-defined item from the drop down or 
type in the first few letters of the film. 

 Length: Enter the length of the milk carton. 

 Width: Enter the width of the milk carton. 

 Height: Enter the height of the milk carton. 

 Weight:  Enter the weight of the milk carton. 

 Caliper: Enter the caliper of the milk carton. 



 

B-100                                                                         TOPS Pro (Version 6.50) User Guide 

Define Package Info (MixPro) 
Function:  This dialog box allows you to create products which can later 
be used inside mixed trays for presentation purposes and also for light 
applications involving multiple shipcase sizes. 

 

Select MixTray Mixed Tray Editor from the MixPro Tool button  
When in MixPro, go to the Define Menu and select Package. 

 Style: Select the CASY shape you would like to use in creating your 
product from the drop list. 

 Name: Enter the name of your new product to be used to create the 
mix tray. 

 Length, Width, Height, Weight: Enter the length, width, height and 
weight of the new product to be used to create the mix tray. 

 Label: Enter a label that you would like for your product.  This label 
will appear across the products when the option is turned on by 

clicking the  button on the tool bar. 



 

Appendix B:  Dialog Boxes                                                                                   B-101 

Define Pallet 
Function:  This dialog box allows you to define parameters for a new a 
pallet (one that's not already defined in the system).  This dialog box also 
allows you to change parameters for an existing pallet. 

 

To access, use one of two options: 

 From the Menu Bar, open the Define Menu and select Pallet. 
 From the UnitLoad Parameters dialog box, click on the New Pallet 

button. 

Field Descriptions and Instructions 
 Description:  For a new pallet, type in the name of the new pallet.  For 

an existing pallet, select a pre-defined pallet from the drop list or type 
in the first few letters of the pallet. 

Note:  When you select a pre-defined pallet, TOPS Pro will 
automatically insert values in the various dimension fields.   

 Style:  Select the style of pallet you want to define. 
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The Stringer, Notched Stringer, Block and EuroPallet styles are 
common.  The Slipsheet option allows you to define a slipsheet.  
Select No Style option to create a loading footprint without labeling it 
as one of the existing pallet styles, or to perform an analysis without 
showing the pallet. 
 
Followed are the newer pallet styles supported by TOPS Pro. 

                                                              
                OptiLedge             Litco Presswood pallet           Chep Pallet 

Remember:  TOPS Pro needs an area of space to use in order to 
palletize, even if you don't need to use a pallet. 

 Construction:  Select Single Face, Double Face or Reversible to 
specify how the pallet will be constructed. 

 A single face construction has deck boards on one side. 
 A double face construction has deck boards on both sides. 
 A reversible construction is a pallet that is identical on both sides. 

 
 Autosize:  Available for slipsheets only, check the box to tell TOPS 

Pro to automatically size the slipsheet to the size of the unitload. 

 Length, Width, Height:  Enter the length, width and height of the 
pallet. 

 Weight:  Enter the weight of the pallet. 

 Max Height:  Enter the maximum height of the unitload when this 
pallet is used for calculation.  Use a value of 0.00 if no height limit is 
desired.  

The following Alignment fields display only if you select Stringer, 
Notched Stringer, Block, EuroPallet, Optiledge, Litco or Chep in the Style 
field. 

 Alignment:  Select from Flush, Single Wing or Double Wing to 
specify how the stringer will be positioned in relation to the deck 
boards of the pallet. 

 A flush alignment positions the stringer flush to the outside edges 
of the deck boards. 

 A single wing alignment allows you to offset the stringers on a 
pallet.  For double-faced pallets, single wing has offset deck 
boards on the top, but flush deck boards on the bottom of the pallet 
as pictured below (with alignment offset of 5 inches and Align 3 
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inches from the left). 
 

                   
       Single wing alignment                Double wing alignment 
 

 A double wing alignment allows you to offset the stringers on a 
double-faced pallet.  Double wing has both the top and bottom 
deck boards offset from the stringers.  

 
 Alignment Offset:  Enter the distance the stringers will be offset from 

the edge of the pallet.  The above pallets has alignment offset of 5 
inches and Align distance (see below) of 3 inches. 

 Align (Distance from left):  Enter the distance for the alignment 
offset from the left side of the pallet. 

The following Deck Boards fields will not display if you selected 
Slipsheet or No Style in the Style field. 

 Outside deck board width:  Enter the width of the two outside deck 
boards for the pallet. 

 Number of inside deck boards:  Enter the number of inside deck 
boards for the pallet. 

 Inside deck board width:  Enter the width of inside deck boards. 

 Middle Board Width: Enter the width of the middle deck board. 

 Deck board height:  Enter the height of the deck boards. 

 Stringer width:  Enter the width of the stringers. 

 The following Slipsheet fields display only if you select Slipsheet in 
the Style field. 

 Slipsheet Length Tab:  Click on the box to add a tab to the length of 
the slipsheet. 

 Slipsheet Width Tab:  Click on the box to add a tab to the width of 
the slipsheet. 

 Slipsheet Both Sides:  Click on the box to add a tab to both sides of 
the slipsheet. 

 Slipsheet Tab Width:  Enter the width of the tab in inches or 
millimeters, depending on the Units selected. 
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 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

 Display: This box allows some visual elements to be added to your 
pallet. 

 Color: Select the color you would like to use for your pallet from 
the drop list.  

 Graphic: Select the graphic you would like added to the top of the 
pallet. 

 Design Def. File: For future use only, this provides an easy way to 
import special pallets. 
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Define Pallet Accessories 
Function:  This dialog box allows you to define custom pad, slipsheet, 
tray or cap.  

 

To access, use one of two options: 

 From the Define Menu, select Pallet Accessories. 
 From the UnitLoad Layer Parameters dialog box, go to the 

Advanced tab. Select Pre-defined for the selected accessory (for 
example, slipsheet) and then click on the New button. 

Field Descriptions and Instructions 
 Description:  For a new pallet, type in the name of the new pallet.  For 

an existing pallet, select a pre-defined pallet from the drop list or type 
in the first few letters of the pallet. 

 Type:  Select from among the drop list (slipsheet, pad, tray and cap), 
the type of pallet accessory to be defined. 

 Length, Width, Thickness, Weight:  Enter the corresponding 
physical dimensions for the accessories. 

 Side Height:  Available for tray and cap only, this represents height of 
the accessory that will cover part of the unitload. 

 Save:  Click to save the newly defined accessory to the TOPS 
database. 

 Delete:  Click to remove the selected accessory from the TOPS 
database. 
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Define Paper 
Function:  This dialog box allows you to define default parameters for 
different types of paper, or board combination components. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu and select Paper or click on the Define Paper quick link. 

Field Descriptions and Instructions 
 Description:  Select a type of paper from the drop list for review or 

modification or enter a name for the new paper. 

 RCF (lb/6 in strip)/(N/m):  Enter the ring crush factor in pounds per 
six in strip or Newtons per meter, depending on the Units selected. 

Note:  For more information about the ring crush factor, please refer to 
Chapter 9, Stacking Strength. 

 Paper Weight (lbs/1000ft2)/(gr/m2):  Enter the paper weight in 
pounds per 1,000 square feet or grams per square meter, depending on 
the Units selected. 

 Cost/Ton:  Enter the cost of the paper per ton. 

 Type:  Select either Liner or Medium to specify the type of paper. 

 Locked:  Indicates if only a supervisor can enter or change parameters 
on this dialog box. 

 List Metric: This button toggles the description drop down between 
papers created in Metric units and papers created in English units.  
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Define Product 
Function:  This dialog box allows you to define parameters for a new 
product (a product that's not already defined in the system).  You can also 
use this dialog box to change parameters for an existing product. 

 

To access, use one of two options: 

 From the Menu Bar, open the Define Menu and select Product. 
 From the File menu, go to Package Profile.  Select Add Products and 

from the Specification Products dialog box, click on the New 
Product button. 

Field Definitions and Instructions 
Note:  The following three fields – Product, Manufacturing, 
Description and UPC Code – are used only in the Packaging Profile 
function. 

 Product:  To define a new product, enter the name of the new product.  
To change parameters for an existing product, select a product or type 
in the first few letters of the product. 

 Manufacturing:  Select from the drop list a manufacturing option for 
the product. 

 Description:  Enter a description of the product. 

 UPC Code:  Enter the Universal Product Code for the product. 

 Density (oz/100 in3 or g/l):  Enter the density of the product in ounces 
per 100 inches cubed or in grams per liter, depending on the Units 
selected. 
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Note:  If your analysis includes a product, TOPS Pro considers the 
density of the product when it generates solutions.  If your analysis 
does not include a product, TOPS Pro generates solutions based on air 
volume. 

 Cost:  Enter the cost of the product. 

Note:  This field is used only for a bag analysis. 

 Sort By:  Displays either Name or UPC to specify how the product is 
sorted. 

 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

 EAN.UCC Width – Left to Right:  Enter the width from left to right. 

 EAN.UCC Depth – Front to Back:  Enter the depth from front to 
back. 

 EAN.UCC Height – Base to Top:  Enter the height from base to top. 
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Define Shipcase 
Function:  This dialog box allows you to define a new shipcase to be used 
in a mixed-pallet solution. 

 

To access, from the MixPro Pallet module, select Define from the Menu 
Bar and click Shipcase. 

Field Descriptions and Instructions 
 Shipcase:  Enter the name of the new shipcase or select from the drop 

list an existing shipcase to review or modify. 

 Length, Width, Height, Weight:  Enter the length, width, height and 
weight of the shipcase. 

 Label:  Enter a label for the shipcase.  The label will appear across the 
shipcase when the Show Labels function is turned on by clicking the 

 button. 

 Color:  Select a display color for the shipcase. 

 Graphics Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the shipcase. 

 Contents Button:  Displays the Add Contents dialog box, which 
allows you to add contents and its arrangement to a new shipcase. You 
can also specify to use a CASY tray style and apply a CASY shape to 
the contents. 
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Define Shipping Case 
Function:  This dialog box allows you to define parameters for a new 
shipcase (one that's not already defined in the system).  This dialog box 
also allows you to change parameters for an existing shipcase. 

 

To access, from the Menu Bar, open the Define Menu and select Shipping 
Case. 

Field Descriptions and Instructions 
 Description:  For a new shipcase, type a description.  For an existing 

shipcase, select a pre-defined shipcase from the drop list or type in the 
first few letters of the shipcase. 

Note:  If you select a pre-defined shipcase, TOPS Pro will 
automatically insert values in the various dimension fields.  If you 
select User Defined, you'll need to manually enter dimensions. 

 Style:  Select a pre-defined style or type in the first few letters of the 
style. 

 Flute:  Select the flute size for the shipcase from the drop list. This 
field displays only if you select Corrugated Material. 

 Caliper:  Enter the caliper of the shipcase.  The caliper is used to 
calculate the inside vs. outside dimensions of the shipcase.  This field 
displays only if you select Other Material. 

 Length, Width, Height:  Enter the length, width and height of the 
shipcase. 
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 Tare Weight: Enter the tare weight of the shipcase. 

 Max Weight:  Enter the maximum weight of the shipcase and its 
contents. 

 Optional Turn $/1000:  Enter the turn rate per 1000 units. 

 Optional Cost:  Enter the cost per shipcase. 

 Optional Cases per Pallet:  Enter the number of shipcases per pallet. 

 Material:  Select either Corrugated or Other to specify the material 
used to make the shipcase. 

Note:  The type of material is important to determine stacking strength 
and board thickness. 

 Dimensions:  Select either Inside or Outside to specify how the 
shipcase dimensions are measured. 

 Locked:  Check the box to indicate that only a supervisor can enter or 
change parameters on this dialog box. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the shipcase. 
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Define Tub 
Function:  This dialog box allows you to define parameters for a new tub. 
(one that's not already defined in the system).  This dialog box also allows 
you to change parameters for an existing tub. 

 
Tub Options for Round Body Shape 

 
Tub Options for Rectangular Body Shape 

 Description: Select from the drop list a predefined description for the 
tub for review or modification or enter a name to define a new tub. 

 Top Length, Top Width: For rectangular tub, enter the top length and 
width of the tub. 

 Bottom Length: Displays the bottom length of the rectangular tub.  
TOPS Pro automatically calculates this value based on the proportions 
of top to bottom width. 

 Bottom Width: Enter the bottom width of the rectangular tub. 

 Top Diameter, Bottom Diameter:  For round tub, enter the top and 
bottom diameter of the tub 
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 Height: Enter the height of the tub. 

 Pitch: Enter the pitch of the tub for nesting. 
 
Note:  Pitch allows you to define the dimensions of the tubs so they 
can be stacked inside one another.  This value represents the distance 
between the rims of the nested tubs; that is, how far one tub protrudes 
from the one it's placed into.  If you leave pitch at zero, TOPS Pro 
assumes that the tubs don't nest inside one another. 

 Weight: Enter the net weight of the tub in pounds or kilograms, 
depending on the Units selected. 

 Body Shape: Select either Round or Rectangular to specify the body 
shape of the tub. 
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Define Vehicle 
Function:  This dialog box allows you to define a new vehicle and save it 
to the database. 

 

To access, use one of two options: 

 From the Vehicle Parameters dialog box, click on the New Vehicle 
button. 

 From the Menu Bar, open the Define menu and select Vehicle. 

Field Descriptions and Instructions 
 Description:  Select a pre-defined vehicle or type in the first few 

letters of the vehicle.  If you’re defining a new vehicle, type in the 
name of the new vehicle. 

 Note:  When you select a pre-defined vehicle, TOPS Pro will 
automatically insert values in the Inside Length, Inside Width, Inside 
Height and Maximum Net Weight fields.   

 Inside Length, Inside With, Inside Height:  Displays or enter the 
inside length, width and height of the vehicle. These define the actual 
loadable space of the vehicle. 

 Maximum Net Weight:  Displays the maximum net weight of the 
vehicle. 

 Locked:  Indicates that only a supervisor can enter or change the 
parameters on this dialog box. 
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Dividers 
Function:  This dialog box allows you to define parameters for the 
dividers that go into an intermediate packer or shipcase. 

 

To access, use one of two options: 

 From the Intermediate Pack Parameters dialog box, click on the 
Dividers button. 

 From the Shipcase Parameters dialog box, click on the Dividers 
button. 

Field Descriptions and Instructions 
 Material:  Select either Corrugated or Other to specify the material 

used to make the divider. 

Note:  The type of material is important to determine stacking strength 
and board thickness.  TOPS Pro uses the next three fields – Style, 
Board and Flute – to calculate stacking strength and determine board 
thickness. 

 Style:  Select the style of divider you want to use. 

Warning:  Most dividers set up in TOPS Pro are designed with a 
specific cell count and arrangement in mind.  For example, the U-Part 
w/ Tabs divider will work only for a 3x1 arrangement.  

Note:  The drop-down list contains divider types that are already set 
up in the database.  If the divider type you want is not on the list, you 
can add it to the database using the Define Dividers dialog box.  For 
more information, please refer to page B-93. 

 Board:  Select the type of board used to make the divider. 

Note:  The drop-down list contains board types that are already set up 
in the database.  If the board type you want is not on the list, you can 
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add it to the database using the Board Combinations dialog box.  For 
more information, please refer to page B-18. 

 Flute:  Select the flute size for the divider. 

Note:  This field displays only if you select Corrugated Material. 

Note:  The drop-down list contains flute types that are already set up 
in the database.  If the flute type you want is not on the list, you can 
add it to the database using the Define Flute dialog box.  For more 
information, please refer to page B-97. 

 Caliper:  Enter the caliper of the divider in inches or millimeters, 
depending on the Units selected on the Intermediate Pack or Shipcase 
Parameters dialog box. 

Note:  The caliper is used to calculate the thickness dimensions of the 
divider.  This field displays only if you select Other Material. 

 Pads Between Layers:  Check the box to place pads between layers 
within the packer or shipcase. 

 Pads on Bottom:  Check the box to place pads on the bottom of your 
primary packages in the packer or shipcase. 

 Pads on Top:  Check the box to place pads on top of the primary 
packages in the packer or shipcase. 

 Divider Height as Tray Height:  Check the box to specify that the 
selected divider will be the same height as the tray it is placed into. 
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Drum Options 
Function:  This dialog box allows you to enter bulge dimensions for a 
drum.  For example, a plastic liquid bottle, such as a water cooler, has a 
bulge factor. 

 

To access, from the Drum Parameters dialog box, click on the Options 
button. 

Field Descriptions and Instructions 
 Bulge Diameter:  Enter the amount of bulge allowed in the drum's 

diameter in inches or millimeters, depending on the Units selected on 
the Drum Parameters dialog box. 

 Bulge Height:  Enter the amount of bulge allowed in the drum's height 
in inches or millimeters, depending on the Units selected on the Drum 
Parameters dialog box. 
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Drum Parameters 
Function:  This dialog box allows you to define parameters for different 
types of drums. 

 

To access, click on the Drum Parameters icon  at the Control Panel, 

Field Descriptions and Instructions 
 C.A.S.Y. Style:  Select a CASY style to be displayed for the drum. 

 Diameter:  Enter the diameter of the drum. 

 Height:  Enter the height of the drum. 

 Volume:  Display the volume for the drum, when applicable. 

 Vert:  Check a box beside one or both of two fields – Diameter or 
Height – to specify the vertical dimension of the drum relative to the 
ground. 

 Weight:  Enter the net and gross weight of the drum. 

 Options Button:  Displays the Drum Options dialog box, which 
allows you to enter bulge dimensions for a drum. 
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Easy Import 
Function:  This dialog box allows you to access a simpler import function 
to pass data in a text file (like Excel CSV) into TOPS Pro for calculation. 
A total of 32 fields can be imported and include: 

 

Col Data     Notes 
A Analysis Name    maximum 31 characters 
B Analysis Type (starting stage of analysis)  PP: primary pack, SC: shipcase, 
                                         UL: unitload 
C Unit of measure for distance  DIST_IN: inch, DIST_FT: Feet,   
                                         DIST_MM: mm, DIST_CM: cm 
                                                                   DIST_M: meter 
                     if blank: DIST_IN is assumed 
D Unit of measure for weight  DIST_LB: pound, DIST_OZ: oz 
                                    DIST_KG: Kg, DIST_GR: Gram 
                          if blank: DIST_LB is assumed 
E Primary pack, if present   Y, N 
F Primary pack type   C: Carton, N: Can/Cylinder 
G Primary pack length    
H Primary pack width 
I Primary pack height 
J Primary pack net weight 
K Primary pack gross weight 
L Intermediate pack, if present  Y, N 
M  Intermediate pack style 
N Intermediate pack flute 
O Intermediate pack maximum count 
P Intermediate pack minimum count 
Q Shipcase, if present   Y,N 
R Shipcase type    C: Carton, N: Can/Cylinder 
S Shipcase style 
T Shipcase length 
U Shipcase width 
V Shipcase height 
W Shipcase flute 
X Shipcase maximum count 
Y Shipcase minimum count 
Z Unitload, if present   Y, N 
AA Unitload pallet 
AB Unitload maximum height 
AC Unitload maximum weight 
AD Vehicle, if present   Y, N 
AE Vehicle name 
AF Vehicle maximum weight 
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To access, from the Menu Bar, open the Import menu and select Easy 
Import. 

 

Field Descriptions and Instructions 
 Import File:  Click on the Browse button to select the file you want to 

import into TOPS Pro. 

 Import Button:  Imports a selected file into the TOPS Pro system. 
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EcoSavings Report (ESR) - Analysis 
Function:  This dialog box allows you to define the cost and usage 
information in order to create reports to compare the effects different case 
sizes and load solutions have on the environment in terms of carbon 
emission and corrugated and packaging material wastage.  

 

To access, first select two solutions for the current analysis, then go to the 
Tools menu, select ESR and then ESR for analysis. 

 No. of Containers/Year:  Enter the number of containers used per 
year for the current analysis. 

 Route:  Select from the drop list the route and its associated costs 
defined in the ESR Configuration dialog box (see next section). 

 No. of Trucks/Year:  Enter the number of trucks used per year for the 
current analysis. 

 Average Miles/Trip:  Enter the number of miles drive per trip for the 
current analysis. 

 Corrugated Cost/sq. units:  Enter the average corrugated cost per 
square unit for the materials used for this analysis. 
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 Misc. Packaging Cost/Case:  Enter the costs for any miscellaneous 
packaging materials used per shipcase. 

 Addl. Material Used/Case (sq. units):  Enter the costs for any 
additional materials used per shipcase in square units. 

 Pallet Cost:  Enter the pallet cost for the analysis. 

 Misc. Packaging Cost/Pallet:  Enter any miscellaneous packaging 
cost used per pallet. 

 Addl. Material Used/Pallet (sq. units):  Enter the cost for any 
additional material used in square unit per pallet. 

 Recycle Rate:  Enter the recycle rate for all packaging materials used 
in the analysis. 



 

Appendix B:  Dialog Boxes                                                                                   B-123 

EcoSavings Report (ESR) - 
Configuration 
Function:  This dialog box allows you to define the different cost factors 
associated with packaging and vehicle usage to be used in the Eco Savings 
Reports. 

 
 
To access, create the required analysis, go to the Tools menu, select ESR 
and then ESR for analysis. 

 Route:  Enter a name for the route and its different associated costs. 

 Cost/Container:  Enter the costs for the commonly used 40ft hi-cube, 
40ft and 20ft containers respectively. 

 CO2 emissions per container:  Enter the volume of carbon emissions 
per each of the 40ft hi-cube, 40ft and 20ft containers. 

 Cost/mile:  Enter the cost per mile for the route currently defined. 

 Average Miles/trip:  Enter the average mileage for the current route. 

 CO2 emissions/mile:  Enter the volume of carbon emissions per mile 
driven for this route. 

Corrugated Cost/sq. units:  Enter the corrugated cost used per square 
unit for the current route. 
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 Misc. Packaging Cost/Case:  Enter the miscellaneous packaging cost 
per case used for the current route. 

 Pallet Cost:  Enter the pallet cost associated with the current route. 

 Misc. Packaging Cost/Pallet:  Enter the miscellaneous packaging 
cost per pallet used for the current route. 
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Environment Factors 
Function:  This dialog box allows you to assign numeric safety factors to 
a range of environmental factors. 

Note:  For detailed information about how TOPS Pro uses environmental 
factors, please refer to Chapter 9, Stacking Strength. 

 

To access, open TOPS Configuration program.  From the Menu Bar, open 
the Define Menu and select Environment Factors or click on the 
Environment Factors quick link in the Control Panel. 

Field Descriptions and Instructions 
 Humidity Factors:  Enter a numeric safety factor for each level of 

humidity. 

 Storage Time:  Enter a numeric safety factor for each period of 
storage time.  For example, after three days stacking strength is 
reduced by another 30 percent. 

 Pallet Spacing:  Enter a numeric safety factor for each type of pallet 
spacing. 

 UL Interlock (None):  Enter a numeric safety factor when the 
unitload interlock is None; i.e., all edges are lined up. 
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 UL Interlock (Some):  Enter a numeric safety factor when the 
unitload interlock is Some; i.e., maybe the top two layers are lined up. 

 UL Interlock (All):  Enter a numeric safety factor when the unitload 
interlock is All; i.e., every other layer is lined up. 

 Locked:  Indicates if only a supervisor can enter or change parameters 
on this dialog box. 
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Export Analysis 
Function:  This dialog box allows you to export an analysis to an ASCII 
comma delimited text file.  You can use this file to transfer analyses to 
other copies of TOPS Pro (same release or higher) or to back up your 
work to a floppy disk. 

Note:  Exporting an analysis from this dialog box creates a file that can 
only be used by another copy of TOPS Pro. 

 

To access, open the Export menu and select Analysis from the Menu Bar. 

Field Descriptions and Instructions 
 Export File Name:  Display the name of the export file.  Click on the 

Browse button to specify the location and filename to hold the data for 
the exported analysis. 

 Export to Text File: The analysis will be saved as a txt file in the 
specified folder. 

 Export to XML File: The analysis will be saved as an XML file in 
the specified folder. 

 Sort By:  Select from the drop list either by Name, User or Date, the 
sort order for the list of analyses. 

 Exporting:  Displays the status of the export. 

 Folders:  Displays a tree view of existing folders and corresponding 
list of analyses available to be exported.  To select an analysis, scroll 
down the list and highlight the analysis you want to export. 
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Note:  You can select multiple analyses by using the Shift and Control 
keys. 

 Export Button:  Exports a selected file from the TOPS Pro system to 
begin the export function. 

 Show Option:  Click one of these buttons: Approval, Working or All, 
to filter the analyses to be displayed in the folder list. 

 Search Button:  Displays the Analysis Search dialog box, which 
allows you to search for a file by entering search criteria. 

For more information on the Analysis Search dialog box, please refer 
to page B-8. 

 All Button:  Exports all the files listed to another application. 

 Export to MaxLoad:  Check this option to export the analysis 
(usually pallet configuration) to MaxLoad Pro Load Planning and 
Optimization software. 
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Export Analysis (2) 
Function:  This dialog box allows you to specify the export format and 
the destination for the highlighted analyses to be exported. 

Note:  The File Type of CSV/TXT can only be used by another copy of 
TOPS Pro. 

 

To access, open the File menu and select Open.  Highlight one or more 
analyses from the list and then click the Export button. 

Field Descriptions and Instructions 
 File Type:  Click the corresponding radio button for the format to be 

used for the selected analyses.   

 Export Path:  Specify the location for the exported analyses.  Click 
on the Browse button to specify the location, the export file will carry 
the root name of the analysis. 
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Export Robotic Palletizer 
Function:  This dialog box allows you to export the arrangement of a 
pallet pattern layer to an ASCII text file, which can be used by robotic 
palletizing machines to determine how to arrange a unitload. 

 

To access, open the Export menu and select Robotic Palletizer. 

 Browse:  Click on the Browse button to specify the location and 
filename to hold the exported pallet data.  The output will be a text file 
with default name RobotArm.txt. 

 Fix Pallet origin at:  Select either to use the center or corner of the 
pallet as the pallet origin point. 

 Fix Box origin at:  Select either to use the center or corner of shipcase 
as the box origin point. 

 Delimiting Character:  Select the delimiter character for the output 
text file among comma, semicolon or tab.  Comma is the most 
common delimiting character and is recommended for use. 

 Additional Options:  Check the box(es) to output additional data to 
the text file including pallet information, shipcase information whether 
to export data for all layers. 
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Export to ASCII 
Function:  There are actually two Export to ASCII dialog boxes, as 
pictured below.  The first is used in the TOPS Pro program.  The second is 
used in the TOPS Configuration program.  There's one difference:  Export 
to ASCII in the Configuration program allows you to export the entire 
databases. 

Note:  This export function is only useful for transferring saved data to 
other copies of TOPS Pro.  The design axis export is a separate export and 
a separate menu item. 

 
Export to ASCII Dialog Box in TOPS Pro Program 

 
Export to ASCII Dialog Box in Configuration Program 

To access the Export to ASCII dialog box, use one of two options: 

 In the TOPS Pro program:  From the Menu Bar, open the Export menu 
and select Case or Carton. 

 In the TOPS Configuration program:  From the Menu Bar, open the 
File menu and select Export. 
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Field Descriptions and Instructions 
 Export File:  Click on the Browse button to select the file you want to 

export. 

 Export Style:  Enter the export style name. 

 Exporting:  Displays the status of the export. 

 Databases:  Select the databases you want to export.  To export all 
databases, click on the Select All button. 

Note:  This field is available only in the Configuration program. 

 Export Button:  Exports the current data from the TOPS Pro system 
to an ASCII comma delimited text file. 
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Fixed Pack Parameters 
Function:  When you are using a fixed size shipcase with fixed 
configuration, you can use this dialog to specify the exact product 
arrangement inside the shipcase. 

TOPS will arrange the products inside the fixed shipcase as instructed 
despite insufficient volume, indicated by the cubic efficiency of over 
100%. 

 

To access this dialog, go to the Shipcase Parameters dialog box. Make 
sure you are using ‘Fixed’ case, check the Fix Pack option, then click the 
Fix Pack button to open the dialog box. 

 Arrangement:  Enter the arrangement of products inside the shipcase 
along the length, width and height dimension. 

 Along Length:  Click to select the Along Length option. 

 Along Width:  Click to select the Along Width option. 

 

 

 



 

B-134                                                                         TOPS Pro (Version 6.50) User Guide 

Get Export File Name 
Function:  This dialog box allows you to browse for a file to be exported 
from the TOPS Pro system or select a location for a new export file to be 
created. 

 

This dialog box is available when you click the Browse button from the 
Export to ASCII dialog box. 

Field Descriptions and Instructions 
 File Name:  Enter the name of the file or click the file from the list. 

 File List:  Scroll down the list to select the name of an existing file. 

 Save File As Type:  Select the type of file. 

 Directory Path Window:  Displays the current directory path.  Click 
on the various folders to find the path to which you want to save the 
file. 

 Drives:  Displays the current drive.  Select the drive to which you 
want to save the file. 
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Get Export File Name (Open XML) 
Function:  Use this command to open analyses saved previously in XML 
format. 

 

To access, go to the File Menu and select Open XML. 

Field Descriptions and Instructions 
 Look in:  Displays the current directory path or folder.  The default 

folder is the \Data\ folder where all XML files are saved.  Use the 
Windows navigation to specify another folder if needed. 

 File Name:  Enter the name of the file or click the file from the list. 

 File List:  Scroll down the list to select the name of an existing file. 

 Files of Type:  This will be XML files only. 
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Import From ASCII 
Function:  This dialog box allows you to import an ASCII comma 
delimited text file into the TOPS Pro system.  You can use this function to 
import shipcases into TOPS Pro.  The functionality is identical to that of 
the Import option on the File menu in the Configuration program. 

 

To access, from the Menu Bar, open the Import menu and select Import 
TOPS Data. 

Field Descriptions and Instructions 
 Import File Name:  Click on the Browse button to select the file you 

want to import into TOPS Pro. 

 Importing:  Displays the status of the import. 

 Import From Text File: Import a text file from the specified location. 

 Import From xml File: Import an XML file from the specified 
location. 

 Import Button:  Imports a selected file into the TOPS Pro system. 
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Intermediate Pack Options 
Function:  This dialog box allows you to enter bulge and sizing 
parameters for a packer. 

Note:  This dialog box is used for packers, trays, cartons and shrinkwrap. 
 

 

Sizing 
The Intermediate Pack Options dialog box allows you to fine-tune the size 
dimensions of the packer.  It limits the scope of the analysis solution by 
limiting the maximum dimensions and ratios. 

For example, if you specify a maximum of four cartons along the length, 
width and depth of the packer, TOPS Pro will generate a solution with no 
more than four cartons along the length, four cartons along the width and 
four cartons along the depth of the packer – a maximum of 64 cartons.  
The maximum is 64 cartons, but TOPS Pro will also generate other 
solutions with less than 64 cartons. 

To access this dialog box, from the Intermediate Pack Parameters dialog 
box, click on the Options button. 

Field Descriptions and Instructions 
 Pattern Style:  Select pattern styles preferred for the packer by 

checking the corresponding boxes.  Note that this field is only 
available when using a fixed size intermediate pack. 

 Bulge Length, Bulge Width, Bulge Height:  Enter the amount of 
bulge allowed in the packer's length, width and height respectively. 



 

B-138                                                                         TOPS Pro (Version 6.50) User Guide 

  Max Cartons along Length/Width/Depth (Cartons):  Enter the 
maximum number of cartons allowed along the length, width and  

 Max Cartons along Length/Width/Depth (in/mm):  Enter the 
maximum dimension along the length, width and height of the packer 
respectively. 

 Length to Width Ratio:  Enter the length to width ratio of the packer.   

Note:  Length-to-width ratio limits the answer to proportions no worse 
than this value.  For example, in the dialog box on the previous page, 
the length-to-width ratio is 4.5.  This means that the length of the 
packer is less than 4.5 times its width when TOPS Pro generates a new 
size packer for you. 

 Depth to Width Ratio:  Enter the depth to width ratio of the packer. 

Note:  Depth-to-width ratio limits the answer to proportions no worse 
than this value.  For example, in the dialog box on the previous page, 
the length-to-width ratio is 3.5.  This means that the depth of the 
packer is less than 4.5 times its width. 

 



 

Appendix B:  Dialog Boxes                                                                                   B-139 

Intermediate Pack Parameters 
Function:  This dialog box allows you to define parameters for different 
types of intermediate packers. 

Note:  This dialog box is used for packers, trays, cartons and shrinkwrap.  
The Packer, Tray, Carton and Shrinkwrap Parameters icons each display 
this dialog box.  The only difference is the options contained in the Style 
drop-down list. 

 

To access the dialog box, click on one of the blue intermediate pack icons 

in the Control Panel, , , . 

Note:  Be aware that the dialog box linked to a specific icon is determined 
in the Configuration setup. 

Field Descriptions and Instructions 
 Case:  Select Fixed, New or Database to specify the type of packer 

you want to use in your analysis. 

A fixed analysis requires you to enter the dimensions of a fixed 
packer. 

A new analysis will create a new packer based on other information 
you enter on the screen. 
 



 

B-140                                                                         TOPS Pro (Version 6.50) User Guide 

A Database analysis allows you to select the packers from the 
existing shipcase database. 

 Database:  If database analysis is selected, click to specify whether to 
use all available shipcases in the database or to make selections from 
the database. 

 Material:  Select either Corrugated or Other to specify the material 
used to make the packer.  Note that the type of material is important to 
determine stacking strength and board thickness. 

 Dimensions:  Select either Inside or Outside to specify how the packer 
dimensions are measured. 

Note:  TOPS Pro uses this option to round to the nearest 16th.  If you 
select Inside, TOPS Pro will calculate the inside dimensions by 
rounding up, then calculate the outside dimensions entered from that 
value.  If you select Outside, TOPS Pro will calculate the outside 
dimensions by rounding up, then calculate the inside dimensions 
entered from that value. 

 Style:  Select the style of packer you want to use. 

Note:  TOPS Pro uses the selected style, along with the caliper of the 
material to calculate the difference between inside dimensions and 
outside dimensions. 

Note:  The drop-down list contains packer types that are already set up 
in the database.  If the packer type you want is not on the list, you can 
add it to the database using the Define Carton dialog box. 

 C.A.S.Y. Style:  Select a CASY style to display for the packer. 

 Flute:  Select the flute size you want to use if corrugated material is 
used.. 

Note:  The drop-down list contains flute types that are already set up 
in the database.  If the flute type you want is not on the list, you can 
add it to the database using the Define Flute dialog box.   

Note:  This field displays only if you select Corrugated Material.  
TOPS Pro uses the following default calipers for the various flute 
styles in inches: 

A = 0.1875 (3/16-inch) 
A/B = 0.267 (17/64-inch) 
A/C = 0.267 (17/64-inch) 
B = 0.125 (1/8-inch) 
C = 0.15625 (5/32-inch) 
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C/B = 0.267 (17/64-inch) 
E = 0.063 (1/16-inch) 
F = 0.063 (1/16-inch) 

Warning:  If you work with double-wall flutes on a regular basis, 
you'll need to adjust those flutes for the proper caliper. 

 Caliper (in/mm):  Enter the caliper of the packer if Other Material is 
used.  The caliper is used to calculate the inside vs. outside dimensions 
of the packer. 

The following three fields – Slack Length, Slack Width and Slack 
Height – refer to the extra (wasted) space you intend to include in the 
packer configuration.  For example, you might figure in two inches of 
slack space at the top (height) to more easily insert items into the packer. 

 Slack Length, Slack Width, Slack Height:  Enter the extra space 
intended for the length, width and height of the packer respectively. 

 Vert:  Check a box beside one of three fields – Length, Width or 
Height – to specify the vertical dimension of the packer relative to the 
ground. 

Note:  In packaging, height (depth) is normally the distance through 
the flaps.  Length is the greater of the two remaining dimensions. 

 Round to nearest 1/16":  Check the box to force TOPS Pro to round 
the resulting intermediate packer dimensions up to the nearest 1/16". 

 Sizing:  Select either Range or Values to specify whether you want the 
packer to hold a range of items or a set number of items. 

For example, if you want to design the packer to hold anywhere from 
two to six cans, select Range.  If you want to design the packer to hold 
exactly six cans, select Values. 

The following two fields – Min Count and Max Count – display only if 
you select Range in the Sizing Options field. 

 Min Count:  Enter the minimum number of items you want the packer 
to hold. 

 Max Count:  Enter the maximum number of items you want the 
packer to hold. 

TOPS Pro uses the minimum and maximum count values to generate a 
number of solutions.  For example, if you enter two (2) as the 
minimum count and five (5) as the maximum count, TOPS Pro will 
generate solutions for two-, three-, four- and five-count sizes. 
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 Values:  Enter the set number of items for which you want TOPS Pro 
to generate solutions. 

For example, if you want TOPS Pro to generate solutions for a set 10-
count and a set 15-count, enter 10 and 15 in the first two Set Values 
fields.  Leave zeros in the remaining fields. 

 Options Button:  Displays the Intermediate Pack Options dialog box, 
which allows you to enter additional parameters for a packer, such as 
bulge and sizing dimensions. 

 Dividers Button:  Displays the Dividers dialog box, which allows you 
to define parameters for the dividers inside the packer. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the packer. 
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Knockdown Options 
Function:  This dialog box allows you to specify additional options when 
creating knockdown analysis. 

 

To access, select KnockDown Carton in the Carton Parameters dialog box, 
then click on the Knockdown button.  

 Fluff Factor:  Enter a percentage to account for the additional 
thickness of the knockdown box caused by air in between the 
corrugated layers. 

Type:  Select the knockdown types from the drop list or specify a 
custom formula to calculate the dimension of the knockdown flats. 
Existing options include RSC with/without Glue Flap or Folded 
Carton with/without Glue Flap. 

 Rotate Nested:  Checked this option to allow rotation while nested. 

 Frequency of Nesting:  Enter a number to represent how often the 
knockdowns will be nested. For example, “5” means nesting will 
occur after every five cartons. 

 Formula:  For custom knockdown, enter the formulae for its different 
dimensions. An example is provided below. 
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Layer Parameters (Options) 
Function:  This dialog box allows you to specify the options for the 
direction of rotation, and how spread and filler will be used for each layer 
in the unitload. 

 

To access, click the Options button from either Basic or Advanced tab of 
the Layer Parameters dialog box.  

 Rotate:  Select an option to specify how the Rotate command will be 
executed. The options available are “Length Flip”, “Width Flip”, 
“Length and Width Flip” and “Rotate 90 degrees”. 

     
           No rotation            Length Flip              Width Flip           Length and        Rotate 90 
           Width Flip                    degrees 

Note:  The Rotate function is most often adjusted when you're rotating 
patterns that are symmetrical, such as some pinwheel patterns.  In that 
case, try only width or length flip – not both. 

 Filler:  Select among the options of  “None”, “Middle Filler” or “End 
Filler” on how filler will be used with column-stacked layers. 

 Spread:  Select an option to specify how the layers will be spread on 
the pallet from “Pack Tightly”, “Spread to Layer Edge” or “Spread to 
Pallet Edge”. 
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Layer Parameters 
Function:  This dialog box allows you to define advanced layer 
parameters in a unitload, shipcase or vehicle, including rotation, pads, 
slipsheets, trays, caps, secondary patterns, filler and spread. 

You can use this advanced tab to add and specify accessories to layers 
beyond 28. 

Basic Tab (Unitload) 
Function:  This dialog box allows you to define parameters for the layers 
in a unitload, shipcase or vehicle, including rotation, pads, slipsheets, 
trays, caps, secondary patterns, filler and spread. 

 

Note: The Basic tab currently accommodates only 28 layers.  If you need 
to work with more than 28 layers, use the functions under the Advanced 
tab.  

To access, from the Analysis View, highlight the pallet drawing.  Then go 
to the Menu Bar, open the Edit menu and select Layer Parameters. You 
can also access this menu quickly by clicking on the layer parameters 
button ( ) in the Unitload View pane. 

 Layer:  Displays a column of layers that correspond to a unitload 
solution.  Each layer represents a specific layer of cases in the 
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unitload.  For example, Layer 1 represents the first layer, Layer 2 
represents the second layer and so on. 

 Rotate:  Check the box to rotate a specific layer in the unitload. 

 Pad Under:  Check the box to insert a pad under a specific layer in the 
unitload. 

 Slipsheet:  Check the box to insert a slipsheet under a specific layer in 
the unitload. 

 Tray:  Check the box to insert a tray under a specific layer in the 
unitload. 

 Cap:  Check the box to insert a cap over a specific layer in the 
unitload. 

 2nd Pat:  Check the box to use a secondary pattern for a specific layer 
in the unitload. 

 Function Buttons:  Use these buttons to perform various functions on 
the unitload layers: 

 The Rotate All button rotates every other layer in the unitload.  
When you click on this button, TOPS Pro automatically checks all 
the active boxes in the Rotate column. 

 The Rotate Top 2 button rotates the top two layers in the 
unitload. 

 The Clear Rotate button clears all the Rotate commands already 
set up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Rotate column. 

 The Pad All button inserts pads between each layer in the 
unitload.  When you click on this button, TOPS Pro automatically 
checks all the active boxes in the Pad Under column. 

 The Pad Even button inserts pads under only the even-numbered 
layers in the unitload.  When you click on this button, TOPS Pro 
automatically checks all the active boxes in the Pad Under column 
for even-numbered layers. 

 The Clear Pads button clears all the Pad commands already set 
up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Pad Under 
column. 

 The Slips for All button inserts slipsheets between each layer in 
the unitload.  When you click on this button, TOPS Pro 
automatically checks all the active boxes in the Slipsheet column. 
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 The Clear Slips button clears all the Slipsheet commands already 
set up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Slipsheet 
column. 

 The Trays for All button places every layer in the unitload on a 
tray.  When you click on this button, TOPS Pro automatically 
checks all the active boxes in the Tray column. 

 The Clear Trays button clears all the Tray commands already set 
up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Tray column. 

 The Caps for All button places a cap on every layer in the 
unitload.  When you click on this button, TOPS Pro automatically 
checks all the active boxes in the Cap column. 

 The Clear Caps button clears all the Cap commands already set 
up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Cap column. 

 The 2nd Pat for All button replaces all the current layers in the 
unitload with the selected secondary pattern.  When you click on 
this button, TOPS Pro automatically checks all the active boxes in 
the 2nd Pat column. 

 The Clear 2nd Pat button clears all the Tray commands already 
set up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Tray column. 

Note: For stages other than unitload, the layer parameters will have 
rotation option available but not the other pallet accessories. 

Advanced Tab (Unitload) 
To access, from the Analysis View, highlight the pallet drawing.  Then go 
to the Menu Bar, open the Edit menu and select Layer Parameters. You 
can also access this menu quickly by clicking on the layer parameters 
button ( ) in the Unitload View pane. 



 

B-148                                                                         TOPS Pro (Version 6.50) User Guide 

 

The advanced layer parameters can be set of the following two functions: 
Rotation and Secondary pattern: 

 None: Click on this radio button to not apply the current any rotation 
or secondary pattern to the unitload. 

 Alternate: Click this radio button to apply the current layer function 
to every other layer of the unitload. 

 Basic Setup: Click this radio button to use the settings from the Basic 
tab.  

 Custom:  Click this radio button to select custom setup for the current 
layer function by enabling the Customer Layer Setup section: 

 Custom Layer Setup (Layers, comma separated): Select to 
manually specify which layers will have the pallet function.  

 Custom Layer Setup (Repeat every): Select to apply pallet 
function to specific layers. Entering a ‘3’ for example, in the 
Custom Desc field will apply the function every three layers for 
the entire unitload. 

 Custom Desc (Layers/Repeat):  Enter the layer number to apply 
the current function for the Custom Layer Setup. For example, 



 

Appendix B:  Dialog Boxes                                                                                   B-149 

enter ‘1,3,4-7,10-14,30’ to apply pallet accessory to layers 1, 3, 4 
thru 7, 10  thru 14 and 30 for the comma separated layer definition. 

The following accessories, Slipsheet, Tray, Pad and Cap, can be set with 
the following options: 

 Standard: Radio button used to select the standard item defaults from 
the Basic tab. 

 None: Click on this radio button to not apply the current accessory to 
the unitload. 

 Pre-Defined: Radio button used to select the Pre-defined item. When 
selected, users can select an existing item from the drop list or define 
an item by clicking on the New button. 

 Description: A pull down menu which allows you to select the 
Pre-defined items that are stored in the database. 

 New: Click this button to define new pallet accessories. 

 Layer (All): Click this radio button to apply the pre-defined 
accessory to all layers. 

 Layer (Alternate): Click this radio button to apply the pre-defined 
accessory to every other layer of the unitload. 

 Layer (Basic Setup): This radio button will ignore the settings on 
the Advanced tab and use the settings from the Basic tab.  

 Layer (Custom): Select this button to enable the Custom Layer 
Setup area.  

 Custom Layer Setup (Layers, comma separated): Select this 
option to manually specify which layers will have the pallet 
accessory.  

Custom Layer Setup (Repeat every): Select this option to specify 
which layers are to have the pallet accessory. Entering a ‘3’ for 
example, in the Custom Desc field will add the accessory between 
every three layers for the entire unitload. 

Custom Desc (Layers/Repeat):  Enter the layer number to apply 
the current pallet accessory for the Custom Layer Setup. For 
example, enter ‘1,3,4-7,10-14,30’ to apply pallet accessory to 
layers 1, 3, 4 thru 7, 10  thru 14 and 30 for the comma separated 
layer definition. 
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Load Plan 
Function:  This dialog box provides quick summary data on the number 
of shipcase or pallet needed to ship a given quantity of products based on 
the currently selected solution in the analysis. 

 

To access this function, click on the Interface tool button  on the 
toolbar. 

Field Descriptions and Instructions 
 Product Count in Load:  Enter the quantity of product to be shipped. 

 Show Load Details button:  Click this button to see the number of 
bundles, inter packs, shipcases or pallets (if used in the analysis) 
needed to ship the specified quantity of products. 

 

Note:  Depending on the setting in the TOPSPRO.INI file, the tool button 
 might open Send to Artios dialog box. To switch it back to the Load 

Plan function, open TOPSPRO.INI, change the line under [Integration] 
from “Type=XML” to “Type=LoadPlan”.  
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Milk Carton Options 
Function:  This dialog box allows you to enter additional dimensions for 
a milk carton, such as headspace and bulge.  When you create a new 
carton designed to contain a bulk product, such as milk, you'll need to 
allow for headspace at the top of the carton. 

 

Headspace 
Minimum and maximum headspace refers to the volume of air needed 
inside the carton prior to sealing.  This feature is used only when the 
carton is designed for a bulk product, such as milk. 

For example, when you fill a carton with milk, you'll want to add 
headspace to the carton to prevent the milk from spilling out when the 
carton is opened.  The headspace dimension will give the milk carton 
additional "wasted" space above the contents of the milk carton. 

To access the dialog box, from the Milk Carton Parameters dialog box, 
click on the Options button. 

Field Descriptions and Instructions 
 Min Headspace:  Enter a percentage of the milk carton's volume to 

specify the minimum headspace allowed in the milk carton. 

 Max Headspace:  Enter a percentage of the milk carton's volume to 
specify the maximum headspace allowed in the milk carton. 

 Bulge Length, Bulge Width, Bulge Height:  Enter the amount of 
bulge allowed in the milk carton's length, width and height. 
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Milk Carton Parameters 
Function:  This dialog box allows you to define parameters for different 
types of milk cartons, as well as containers such as dog food bag and 
cookie bags. 

 

To access, click on the Milk Carton Parameters icon  from the Control 
Panel. 

Field Definitions and Instructions 
 Carton:  Select either Fixed, New or Database to specify the type of 

carton you want to use in your analysis. 

A fixed analysis requires you to enter the dimensions of a fixed milk 
carton. 

A new analysis will create a new milk carton based on other 
information you enter on the screen. 

Note:  The database option is currently in development and not yet 
available. 

 Description:  Select from the drop list an optional description for the 
milk carton. 

 C.A.S.Y. Style:  Select a CASY style to display for the milk carton. 

For the following three fields – Length, Width and Height – if you 
selected New Carton, you'll need to enter Minimum, Maximum and 
Incremental dimensions. 
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 Length, Width, Height:  Enter the length, width and height of the 
milk carton. 

For the following Volume field, if you selected New Carton, the system 
will prompt you to enter Minimum and Maximum volume dimensions. 

 Volume:  Enter the volume of the milk carton. This field allows you to 
adjust the milk carton's volume to eliminate any undesired dimensions.  
If you selected Fixed Carton, TOPS Pro will automatically calculate 
the volume of the milk carton. 

 Vert:  Check a box beside one of three fields – Length, Width or 
Height – to specify the vertical dimension of the milk carton relative 
to the ground. 

 Net Weight, Gross Weight:  Enter the net and gross weight of the 
milk carton. 

 Caliper:  Enter the caliper of the milk carton.  The caliper is used to 
calculate the inside vs. outside dimensions of the milk carton. 

 Product Volume: Displays how much space the product takes up 
inside the shipcase. 

The following two Volume fields display only for a bulk product-into-
milk carton analysis. 

 Volume based on size:  Displays the volume of the milk carton based 
on size. TOPS Pro automatically calculates this value. 

 Volume based on weight:  Displays the volume of the milk carton 
based on weight. TOPS Pro automatically calculates this value. 

 Options Button:  Displays the Milk Carton Options dialog box, which 
allows you to enter additional parameters for a milk carton, such as 
minimum/maximum headspace and bulge dimensions. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the milk carton. 

 Add Product Button: Displays the Primary Pack Products dialog box, 
which allows you to specify the quantity and weight of the product 
going into the carton. This information is used to calculate Wal-Mart 
scores and the details will be displayed on the pallet report.   
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New User 
Function:  This dialog box allows you to add a new user to the system for 
login purposes. 

 

From the User Login dialog box, click on the Add User button. 

Field Descriptions and Instructions 
 User Name:  Enter the name of the user you want to add to the 

system. 

Note:  At this time, there is no way to limit who may add users.  Work 
performed under a specific user's name is only seen by that specific user.  
To see all analyses login as a supervisor. 
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Open Analysis 
Function:  This dialog box allows you to open or delete an existing 
analysis. 

Note:  There is no easy way to copy analyses from one user to another.  If 
necessary, you can login as a supervisor, open another user's work, then 
re-save the analysis under your current login name.  You can also use the 
user login re-name feature to move all analyses from one user to another. 

 

From the Menu Bar, open the File menu and select Open. 

Field Descriptions and Instructions 
 Find:  The Find button works with the input text box to its left. Enter a 

text string in the text box and click the Find button. If TOPS find any 
analysis with part of its name matches the text string, it will be 
displayed in the Search results.  If no match is found, the result list is 
empty; you can click on the Approved, Working or All button to show 
existing analyses. 

 Sort By:  Select from the drop list to sort the analyses by Name, User 
or Date. 
 
Note: Analyses created with earlier versions of TOPS Pro will not 
have the user and date information. 
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 Folders:  Display the tree view of folder structure within the TOPS 
analysis record database. Click the name of the folders with a (+) sign 
to their left to expand the hierarchy.  

 Analysis List window:  This window displays a list of all analyses 
that have been saved to a selected folder.  Notice that the Analysis List 
window is organized into sections:  Folders ( ), Working ( ) and 
Approved ( ). 
 
When you save an analysis, TOPS Pro includes the analysis name, the 
user creating the analysis and the creation date (as Working).  Note 
that you will only see analyses created by the login user (you) and 
those that have been approved, unless you login as a supervisor which 
enables you to view all analyses. 
 
Select the analysis by scrolling through the list or type the first few 
characters of the analysis name to quickly locate the analysis. If you 
scroll down the analysis list, you'll see a separate section of analyses 
titled "Approved."  All users can open and view these files, but only a 
supervisor can make changes to approved files.  Likewise, an analysis 
can be approved and placed in the Approved section only if a 
supervisor approves it.  This is a function of the User Approval switch 
in the Configuration program. 

Note:  With your mouse cursor placed inside this area, you can click 
the right mouse button to access a quick menu to access some file 
operations. 

 Show:  Allow you to filter the Search Results based on status of the 
analyses: Approved, Working or All. Click the corresponding button 
to select the list. 

 Delete Button:  Allow you to delete a selected analysis. You will 
receive a message to confirm removal of the analysis. 

 Move to…Button:  Allow you to move the highlighted analyses to 
another folder under the Main Folder.  To select multiple analyses, 
press down the [Ctrl] button while clicking the name of the analysis 
with the mouse button. You will be prompted to confirm the move. 
 
Note: You can also drag selected analysis and drop it to a different 
folder instead of using the Move button. 

 Advanced Search Button:  Display the Analysis Search dialog box, 
which allows you to search for a specific analysis record when the list 
of analysis names is too large; when you can't remember the exact 
name of the analysis; when you're trying to find an analysis that has 
certain products attached through its packaging profile. 
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 Reset Button:  Relocates the cursor to the top of the analysis list and 
reverts the selected folder back to the Main Folder.  

 Print Button:  Print a report of the highlighted analysis. This function 
will support multiple reports if more than one analysis has been 
selected. 

 Email Button:  Create JPEG images of the selected analysis reports 
and add them as attachments to your email client. 

 Export Button:  Export the selected analyses in the specified format 
(PDF, JPEG or CSV/TXT) in the folder of your choice.  The CSV 
output will export over 45 statistics to a comma delimited file which 
can be opened directly in MS Excel. 

Note: To select multiple reports, click the analysis name while holding 
down the [Ctrl] key.  To select a range of analysis, click the first and last 
analysis name while holding down the [Shift] key. 
 
With TOPS Pro, it is not necessary to have Acrobat writer or other third 
party PDF writer installed in your system to create the PDF file. However, 
you will still need Acrobat Reader to open an PDF file. 

 Archive: Allow you to archive infrequently used analyses and remove 
them from the active file list. 

Note: Archived analyses can be restored any time and posted back to 
the Main Folder for review.  To restore archived analyses, please refer 
to the next section. 
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Open Analysis (New via Template) 
Function:  This dialog box allows you to create a new analysis by 
opening a pre-defined template of design sequence. 

 

To access, open the File menu and select New via Template. 

Field Descriptions and Instructions 
 Find:  The Find button works with the input text box to its left. Enter a 

text string in the text box and click the Find button. If TOPS find any 
analysis with part of its name matches the text string, it will be 
displayed in the Search results.  If no match is found, the result list is 
empty. 

 Sort By:  Select from the drop list to sort the analyses by Name, User 
or Date. 

 Show:  Though available, this function is not applicable to templates. 

 Delete Button:  When logged in as Supervisor, this allows you to 
delete the selected pre-defined template. You will receive a message to 
confirm removal of the analysis. 

 Reset Button:  Redisplay the list of pre-defined templates after the 
search results.  
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Open Archived Analysis 
Function:  This dialog box allows you to restore any archived analyses 
and move them back to the Main Folder for review.  

 

From the Menu Bar, open the File menu and select Open Archive. 

Field Descriptions and Instructions 
 Find:  The Find button works with the input text box to its left. Enter a 

text string in the text box and click the Find button. If TOPS find any 
archived analysis with part of its name matches the text string, it will 
be displayed in the Search results.  If no match is found, the result list 
is empty; you can click on the Approved, Working or All button to 
show existing archived analyses. 

 Sort By:  Select from the drop list to sort the analyses by Name, User 
or Date. 

 Folders:  Display the tree view of folder structure within the TOPS 
analysis record database. Click the name of the folders with a (+) sign 
to their left to expand the hierarchy. 

 Archived Analyses:  Display the list of archived analyses in the 
selected folder. 

 Show: Allow you to filter the Search Results based on status of the 
archived analyses: Approved, Working or All. Click the corresponding 
button to select the list. 

 Delete: Allow you to delete a selected analysis. You will receive a 
message to confirm removal of the analysis. 
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 Search: Display the Analysis Search dialog box, which allows you to 
search for a specific analysis record when the list of analysis names is 
too large; when you can't remember the exact name of the analysis; 
when you're trying to find an analysis that has certain products 
attached through its packaging profile. 

 Reset: Move the cursor to the top of the analysis list, which allows 
you to continue your search from the top of the list. 

 Restore: Click to restore the selected archived analyses and place 
them back to the active file list in the Main Folder. 
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Open Request for Approval 
Function:  This dialog box displays a list of analyses that are waiting in 
the queue to be either approved or denied by a supervisor. 

 

To access: First, login as a supervisor.  Next, start from the Menu Bar, 
open the Supervisor menu and select Open Request. 

Field Descriptions and Instructions 
 Analysis List:  Displays a list of analyses that are waiting in the queue 

to be either approved or denied by a supervisor. 

 Click on OK to open the request for approval or denial. 

For detailed information on the approval/denial process, please refer to 
Chapter 15, Supervisor Functions. 
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Package Instruction 
Function:  This dialog box allows you to add notes to the report with 
regards to packaging instructions for intermediate pack, shipcase or 
unitload. 

 

 

 

To access: First, you must complete a package analysis and at the solution 
view, click on the Package Instruction icon ( ) at each stage to open the 
dialog box. You can also access the dialog box by going to the Edit Menu 
and select Package Instruction, just make sure the corresponding stage has 
been highlighted. 

Field Descriptions and Instructions 
 Cushion:  Select any cushioning or protective material for the primary 

or inter packs and make sure to specify the quantity of at least ‘1’ for 
the information to appear in the report. 

 Additional Material:  Specify any additional materials to be added to 
the carton or shipcase. 
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 Handling/Stacking:  For unitloads, add any additional notes to the 
report regarding handling. Make sure to specify the quantity of 1 for 
the instruction to appear in the analysis report. 

 ShrinkWrap/Straps:  Instead of graphically showing the straps or 
shrinkwrap on the unitload, you can use text instructions in the report 
and display them with the 3D graphics or in the Packaging section 
towards the bottom of the report. 

 Custom:  Add any custom notes as desired. 

 

Note: The Field Descriptions described above and their available options 
are customized via INI files saved in the TOPSPro folder.  If you need to 
adjust these data or have any questions, please contact TOPS technical 
support team. 
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Package Profile 
Function:  This dialog box allows you to create a package profile for a 
complete package analysis, sometimes called a cube specification.  The 
package profile is designed for situations where many products use the 
same packaging.  For example, if you package cereal, you can use the 
same box for several different brands of cereal. 

You'll use the Package Profile dialog box to add each individual product 
to the package profile.  Each product will appear on the profile 
differentiated by name, UPC, product code, declared weight and a 
calculated gross unitload weight. 

 

To access: First, you must complete a package analysis and save it to the 
database.  Then go to the Menu Bar, open the File menu and select 
Package Profile. 

Field Descriptions and Instructions 
 Pallet Spec:  Enter the specification number for the pallet style.  By 

default, TOPS Pro suggests a unique spec ID. 

 Description:  Enter a description of the package profile being created. 

 Date:  Enter the current date to specify when the package profile was 
created. 

 Product Name:  Select a product name associated with the package 
profile or type in the first few letters of the product. 

Note:  The drop-down list displays products that have been added to 
this profile.  You'll use this field to edit or delete a product. 

 Master Number:  Enter the master number associated with the 
package profile. 
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Note:  You can use this field for any numeric value.  To rename the 
field, use the Text Modification dialog box.  For more information, 
please refer to page B-178. 

 Retail Display Base:  This is a reserved key. 

 Clamp Direction:  Select the clamp direction associated with the 
package profile. 

Note:  The printout will show clampability arrows on the unitload 
according to your input here.  Unlike the clampable option on the 
UnitLoad Options dialog box, the clamp direction does not affect the 
calculations. 

 WareHouse Stack:  Enter the maximum stacking height for your 
warehouse. 

Note:  Like the Master Number field, you can use this field for any 
numeric value by renaming it via the Edit/Language function. 

 Comments:  Enter the text of any comments that are relevant to the 
package profile. 

 Add Product Button:  Displays the Specification Products dialog 
box, which allows you to define parameters for a new product to be 
added to the Product Name drop-down list. 

 Edit Product Button:  Allows you to select and delete a product from 
the product list in the package profile. 

 Remove Product Button:  Allows you to select and remove a product 
from the pallet specification in the package profile. 

  Advanced: This is a customized feature for additional profile 
information. 
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Pallet Parameters (MixPro) 
Function:  This dialog box allows you to select the pallet parameters used 
in calculating a solution in your MixPro application. The pallet 
specifications are predefined inside TOPS and can be adjusted through 
TOPS as well. 

 

To access, click on the MixPro Tool Button  and select MixPro Mixed 
Pallet Editor to access MixPro Pallet module, then click on the Pallet 
button to open the Pallet Parameters dialog box. 

 Pallet: Select the pallet to be used in your calculation from the drop 
list. 

 Length Overhang:  Enter the amount of overhang allowed along the 
length of the selected pallet. 

 Width Overhang:  Enter the amount of overhang allowed along the 
width of the selected pallet. 

 Max Height (incl. Pallet):  Enter the maximum height of the pallet 
load, including height of the selected pallet for your MixPro solution. 

 Weight: Select the maximum weight for your solution. 
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Preview Pallet report 
Function:  This dialog box allows you to select the type of pallet report to 
preview before the action to print or export. 

 
To access, open the File menu, go to Print Preview and select Pallet 
Report. 

Field Descriptions and Instructions 
 Spec ID:  Enter this optional data in the header section of the pallet 

report.  

 Customer:  This field allows you to enter your customer’s name for 
this particular pallet report. 

 Output:  Click the radio button to select to type of Pallet Report to be 
created.  

 The Smart View is a single page report providing shipcase and 
unitload data with a graphical illustration of the unitload. 

 The Extended View is a two page report providing additional data 
on efficiency data for area and cube usage as well as Wal-Mart 
specific efficiency data. 
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Print Parameters 
Function:  This dialog box allows you to design the layout of your printed 
output of an analysis, then decide what type of information will be 
included and how that information will be presented (different graphical 
views, text and numbers, etc.). 

 

To access, open the File menu and use one of three options from the Menu 
Bar: 

 Select Print, then select Analysis. 
 Select Page Setup. 
 Select Print Preview, then select Analysis. 
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Field Descriptions and Instructions 
 Page Layout:  Select one of these possible page layouts. The value in 

parenthesis is the code for the corresponding layout in print setup. 

 The Full Page layout (1) allows you to select only one area of the 
analysis to print. 

 The Horizontal Split (H) and Vertical Split (V) layouts allow 
you to select two areas of the analysis to print. 

 The 3 Way Bottom (B), 3 Way Top (T), 3 Way Left (L) and 3 
Way Right (R) layouts allow you to select three areas of the 
analysis to print. 

 The Quad Split (4) layout allows you to select four areas of the 
analysis to print. 

 The 5 Way (5) and 5 Way Down (3) layouts allow you to select 
five areas of the analysis to print. 

 The 6 Way Fixed (6), 6 Way Scaled (S) and 6 Way Down (D) 
layouts allow you to select six areas of the analysis to print. 

Note:  The Print Preview function allows you to view and annotate the 
various layouts before printing. 

 Heading:  Enter the text of the heading that you want to appear at the 
top-center of the printout. 

Note:  If you leave the Heading field blank, TOPS Pro will center the 
analysis name at the top of the printout.  If you want the heading space 
to be blank and keep the analysis name on the left, enter a space in the 
Heading field. 

 Areas 1, 2, 3, 4, 5 and 6:  Select the area(s) of the analysis from 
which you want to print information. 

Note:  Be aware that the number of areas available to select from 
depends on the page layout you selected.  For example, if you selected 
the Horizontal Split layout, which contains two sections, you'll be able 
to select from only two areas. 

Notes:  Enter the text of any notes that you want to appear at the 
bottom of the printout. 

Note:  If you enter more notes than will fit on one line of the printout, 
the notes text will wrap to the next line.  To force the notes text down 
a line, enter the left apostrophe character (`) at the end of the line. 



 

B-170                                                                         TOPS Pro (Version 6.50) User Guide 

 Printer:  Select either B+W or Color to specify whether the output 
will be printed in black and white or in color. 

Note:  Black-and-white printing is basically a line drawing.  Color 
printing on a non-color printer is a 3-D shaded halftone.  You can 
change colors by using the Color Selection dialog box.  

 Double Stack UnitLoad:  Check the box to print output as a double-
stacked unitload.  This option applies to the UL 3D View, UL Side 
View, UL Plan View and UL Front View areas. 

 Print Analysis Name:  Check the box to print the analysis name on 
the printout. 

 Show Graphics/C.A.S.Y.:  Check the box to show graphics/CASY 
design in the printout. 

Note:  This switch will reflect the Show Graphics status prior to 
entering this dialog box.  This switch will normally be checked if 
you're using the paste-on graphics feature.  If the analysis includes 
both graphics and a CASY design, the system will display the CASY 
design, not both. 

 Font:  Select from the drop list among Regular, Small and Very Small 
for the font size to be used in the reports. 

 Package Instruction: Users can add additional recurring notes 
regarding straps, corner posts or shrinkwrap, to Carton, Shipcase or 
Pallet solutions. Users can specify whether to add these notes in the 
3D graphics portion or at the bottom part of the report. 
 
To add package instructions, go to Edit and select Package Instruction 
or click on the ( ) button at each of the graphic solution view. 

 Show Additional Notes:  Check this box to enable additional notes to 
the print report as specified.  The additional notes information will 
appear right after the page layout and before the Notes section. 
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Print Setup 
Function:  This dialog box allows you to set up parameters for your 
printer. 

 

From the Menu Bar, open the File menu and select Printer Setup to access 
the dialog box. 

Field Descriptions and Instructions 
For information about the Print Setup dialog box, please refer to your 
Microsoft documentation. 
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Product Export 
Function:  This dialog box allows you to export a product report or 
analysis summary via the Export Menu.  This report exports information 
to an ASCII comma delimited text file in a form suitable for import into 
Microsoft Access or Excel.   

For Product Report, the export file includes information on every product 
attached to an approved package profile. 

For analysis summary, the export file includes all analyses within the 
TOPS Pro database, including both working and approved analyses.  Data 
being exported include analysis name, approval status, dimensions and 
weight of all primary packs, intermediate packs, shipcases, unitloads and 
pallet information. 

 

To access: From the Menu Bar, open the Export menu and select Product 
Report or Analysis Summary. 

Note:  To print a Product Report, open the File menu, select Print 
Databases, then select Product Report. 

Field Descriptions and Instructions 
 Export File Name:  Displays the name of the file to be exported. This 

should bear a .csv or .txt extension in order to be readily imported into 
MS Excel or Access. 

 Browse:  Clicks to specify the location and name of the exported file. 

 Exporting:  Displays the status of the export. 

 Export Button:  Exports a selected file to the export destination. 
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Product Parameters 
Function:  This dialog box allows you to define parameters for a bulk 
product.  You'll use Product Parameters in a New Carton analysis or to 
add products to a package profile. 

 

To access: From the Control Panel, click on the Granular icon (blue) , 

Bulk icon (yellow) , or the Powder icon (red)  

Field Definitions and Instructions 
 Product:  Select a product. 

Note:  The drop-down list contains products that are already set up in 
the database.  If a product is not on the list, you can add it to the 
database using the Define Product dialog box. 

 UPC Code:  Displays the Universal Product Code for the product. 

Note:  This field is used only by the package profile.  When you add a 
UPC code to a package profile, all UPC codes must be unique within 
the analysis. 

 Density:  Enter the density of the product in ounces per 100 inches 
cubed or in grams per liter, depending on the Units selected. 

Note:  This field is used only for a bulk product analysis.  In this case, 
TOPS Pro considers the density of the product when it generates 
solutions.  If the analysis does not include a bulk product, TOPS Pro 
generates solutions based on air volume. 

 Cost:  Displays the cost of the product. 
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Note:  This field is used only for a bag analysis that includes bulk 
product. 

 Sort By:  Displays either Name or UPC to specify how the product is 
sorted. 

 Units:  Displays either English or Metric to specify how the product 
units are measured. 

 New Product Button:  Displays the Define Product dialog box, which 
allows you to enter parameters for a new product (a product not 
already defined in the system). 
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Publisher 
Function:  This dialog box allows you to convert an analysis to HTML 
format and publish it to the Internet or to a network location. 

 
Publisher To Web Option 

 
Publisher To Network Option 
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Note:  This dialog box displays a different set of fields – as pictured on 
the previous page – depending on whether you selected To Web or To 
Network from the File menu. 

To access: From the Analysis View pane, open the File menu and select 
Publish Analysis, then select either To Web or To Network. 

Field Definitions and Instructions 
 Publish Profile:  A profile containing the settings of a specific site 

you’d like to publish the analyses to.  This section allows you to create 
a new profile or select an existing profile for a site, as well as specify 
whether the profile is based on the Web or a local network. Setting up 
a profile allows you to quickly recall the site settings when you are 
ready to publish analyses for sharing. 

 Site:  Allows you to specify the detail configuration of the location 
saved under the profile name.  If you select an existing profile, this 
section will display the previously saved settings for the profile. 
 
With the Web/Internet option selected, the Site section prompts you to 
enter information for Address, Remote Path, User Name and 
Password. 
 
With the Local Network option selected, the Site section prompts you 
to enter a destination path. 

 Album:  Allows you to create a new album or select an existing album 
to which the selected analysis will be stored. 

 Analysis:  Allows you to select and add one or more analyses to be 
published as part of the profile. 

 File Transfer Status:  Displays a list of FTP transactions (when 
publishing a profile to the Web). 

For more information on how to use the publishing function in TOPS Pro, 
please refer to Chapter 4, Publishing an Analysis. 
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Quick Print 
Function:  This dialog box allows you to select a standardized printing 
template and print output for an analysis, based on the selected template.  
This feature allows you to print output for an analysis without manually 
defining parameters on the Print Parameters dialog box. 

 

To access: From a View panel (Graphic or Text), click on the Print button 
and then select QPrint in the pop-up menu. 

Field Descriptions and Instructions 
 Analysis List:  Select the analysis you want to print. 

 Heading:  Enter the text of the heading. 

 Notes:  Enter the text of any notes that will appear on the printout. 

 PDF:  Use the Browse button to select a PDF file to print to. 

 Send To:  Select an option – PDF, Print or Both – to specify where the 
analysis will be sent. 

 Include:  Select one or more options to specify what will be included 
in the printout. 
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Save As 
Function:  This dialog box allows you to save an analysis record to the 
database and place it in a selected folder. 

Note:  Be aware that this function does not save an analysis as a file on 
your hard drive.  Rather, it saves the analysis as a record to the TOPS Pro 
database – an important difference to remember when you need to open or 
search for an analysis. 

 

To access, go to the Menu Bar, open the File menu and select Save or 
Save As. 

Field Descriptions and Instructions 
 Name:  Enter the name of the analysis. 

Note:  You can use any characters and a maximum length of 31 
characters.  If you enter a name of an unapproved analysis that has 
already been used, TOPS Pro will prompt you to overwrite the 
duplicate name. 

If the duplicate analysis is being used at the time, the system will 
reject the name and prompt you to enter another one.  There may be 
approved and unapproved (working) analyses with the same names. 

 Sort By: This function will sort the analyses by Name, User or Date. 
Users will select the sort option in the drop down list box. 
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Note:  Analyses created with earlier versions of TOPS Pro will not 
have the user and date information. 

 Folders:  Displays a tree view of all existing folders.  You can save 
the analysis into any of these folders; Main Folder is the default.  The 
window below the Folder field displays a list of folders and analyses 
that have been saved to a selected folder.  

 Analyses in Main Folder:  Displays a list analysis names that have 
been created by the user under the current folder.  The top portion of 
the list displays all sub-folders, followed by analyses that have not yet 
been approved (Working).  The bottom portion of the list displays 
analyses that have been approved (Approved), if there are any. 

Note:  If the user is logged in as a supervisor, he or she will be able to 
see all the users' analyses, along with the user associated with each 
analysis.  If the user is logged off, then only the analysis name will 
display (no user name). 

For more information, please refer to Chapter 15, Supervisor 
Functions. 

 Show: The Show option allows you to filter the analyses to be 
displayed based on their approval status, Approved, Working or All. 
Click the corresponding button to select the list. 

 New Folder: The New Folder button allows you to create a new folder 
and add it to the current database. 

 Revision History:  Enter any notes related to revisions to the analysis. 
 
Note:  When you perform a Print Preview for the analysis, TOPS Pro 
attaches the revision history notes to the bottom of the screen – if the 
Print Revision option is activated on the Configuration Screen. 
 
The Print Preview will display up to five lines of revision history text.  
After the revision history exceeds five lines, adding more text will 
delete your oldest revision history entry. 

 Save SC:  Allows you to save a new shipcase directly to the Shipcase 
database at the same time you save the analysis.  .   
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Save File As 
Function:  This dialog box allows you to save a graphic file to a 
designated directory. This can be accessed by right clicking a solution 
image or by clicking the image, then going to Export, and selecting the 
image type to be exported. 

The same dialog box also opens to allow you to save an analysis as an 
XML file via the Save As XML option under the File Menu. 

 

This dialog is available upon opening the Export menu and selecting one 
of the graphic formats from the Menu Bar. 

 BMP (Color)   BMP (B+W)   EPS   
 TIFF    PCX    JPEG 
 PNG    PDF    WMF 

 

Field Descriptions and Instructions 
 Save in:  Displays the current directory path of \BMP\ for graphics 

files and \DATA\ for XML files.  Click on the various folders to find 
the path to which you want to save the file. 

 File Name:  Enter the name of the graphic file.  Changing the file 
extension (.bmp, .jpg, etc.) does not change the file type. 

 File List:  Scroll down the list to select the name of an existing 
graphic file. 

 Save File As Type:  Use the default file type listed for the 
corresponding file. 
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Select Items 
Function:  This dialog box allows you to select multiple pallet styles to be 
used in a calculation. 

 

To access: From the UnitLoad Parameters dialog box, select the Multi 
Pallets option and click on the Select Pallets button. 

Field Descriptions and Instructions 
 Available Pallet List (left):  Display all available pallets in the TOPS 

Pro database. 

 Selected Pallet List (right):  Display the list of pallets added to be 
used for calculation in the current analysis. 

 Add Button:  Press to add the highlighted pallet in the available list to 
the selected pallet list. 

 Remove Button:  Press to remove the highlighted pallet from the 
selected list and move it back to the available list. 

 Add All:  Press to select all available pallets in the database and add 
them to the selected list. 

 Remove All:  Press to remove all selected pallets from the selected 
list. 

 Maximum Height (Incl. Pallet):  Allow the user to specify the height 
of each individual pallet in the Multi Pallet configuration. 

 Maximum Weight (Incl. Pallet):  Allow the user to specify the 
weight of each individual pallet in the Multi Pallet configuration. 
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Select Pallet Accessories 
Function:  This dialog box allows you to add different pallet accessories 
to the unitload including slipsheets, pads, trays, caps and to add a pallet on 
top of the unitload. 

 

To access, click on the Layer button in the UnitLoad Parameters dialog 
box. 

 Slipsheet, Pad, Tray and Cap:  Check the corresponding radio button 
to add selected accessory to all, alternate or custom layers of the 
unitload. 

 Custom Layer Setup:  When custom accessory is used, use the 
following option to specify custom setup: 

 Custom Layer Setup (Layers, comma separated): Select to 
manually specify which layers will have the pallet function.  

 Custom Layer Setup (Repeat every): Select to apply pallet 
function to specific layers. Entering a ‘3’ for example, in the 
Custom Desc field will apply the function every three layers for 
the entire unitload. 

 Custom Desc (Layers/Repeat):  Enter the layer number to apply 
the current function for the Custom Layer Setup. For example, 
enter ‘1,3,4-7,10-14,30’ to apply pallet accessory to layers 1, 3, 4 
thru 7, 10  thru 14 and 30 for the comma separated layer definition. 
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 Pallet on Top:  Check this option to add a pallet on top of the 
unitload. 

 Same as Load: Check this option to use the same type of pallet as 
the unitload.  

 Description:  When the Same as Load option is unchecked, select 
from the list box a new pallet type to place on top of the unitload. 

 Flip Top Pallet:  Check this option if you are flipping the pallet 
over when placed on top of the unitload. 
 

             
                  Unitload with pallet             Unitload with top          Unitload with flipped  
                            on top                         pallet flipped                Euro pallet on top 

 Truck Loads:  Specify whether to apply ‘pallet on top’ to all unitloads 
inside the vehicle or just to the bottom layers. 
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Send to Artios 
Function:  This dialog box allows you to export the current analysis to 
ArtiosCAD. 

 

To access this function, use one of the following methods: 

 Go to the Export Menu and select Send to Esko Artios. 

 Click on the Interface tool button  on the toolbar. 

Field Descriptions and Instructions 
 Export Information:  Click the corresponding radio button to specify 

the type of data to be exported from the current analysis.  

Note:  Depending on the setting in the TOPSPRO.ini file, the tool button 
 might open the Load Plan dialog box which provides quick summary 

data on the number of shipcase or pallet needed to ship a given quantity of 
products. 
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Set TOPS License 
Function:  This dialog box allows you setup your purchased TOPS Pro 
license. 

 
To access:  After logging in as Supervisor (password is “tops software”), 
go to Supervisor Menu and go to Set License.  

This dialog box will also be opened automatically after you have 
successfully installed TOPS and run the program for the first time. 

Note: Your license is not set until you enter the Verification Code 
furnished to you from TOPS.  Until then, the License Information area 
will not reflect the license configuration you actually purchased. 

 Company Name:  Enter the registered licensee name. Make sure to 
enter the name EXACTLY as provided to you. If you receive a 
checksum error when you setup the license, this means the Company 
Name you entered does not match the one provided to you. 

 Serial Number:  Enter the serial number provided to you by TOPS. 
The first 7-digit will be your short form serial number as marked on 
the face of you TOPS software CD or plastic CD case. 

 Key:  Provide this number to TOPS when you contact us to setup the 
license. 
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 Verification Code:  This will be provided to you when you contact us 
to setup the license. 

 Apply button:  After all the information has been entered, click this 
button to complete license setup. You will see a message 
“Successfully Set License” if all data are entered correctly. Check the 
License Information section at this time to verify your license 
configuration: stand-alone versus network and the number of users if 
yours is a network license. 
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Shipcase Layer Parameters 
Function:  This dialog box allows you to define layer parameters in a 
shipcase, including rotation.  You can use this dialog box to interlock and 
pinwheel products into a shipcase. 

 

To access: From the Analysis View, highlight the shipcase drawing.  Then 
go to the Menu Bar, open the Edit menu and select Layer Parameters. You 
can also click on the layer parameters button ( ) in the shipcase solution 
view pane. 

Basic Tab 
 Layer: Display a column of layers that correspond to a shipcase 

solution.  Each layer represents a specific layer of primary packs 
inside a shipcase.  For example, Layer 1 represents the first layer, 
Layer 2 represents the second layer and so on. 

 Rotate:  Check the box to rotate a specific layer inside  the shipcase 

 Rotate All Button:  Rotate every other layer in the shipcase.  When 
you click on this button, TOPS automatically checks all the active 
boxes in the Rotate column. 

 Rotate Top 2 Button:  Rotate the top two layers inside the shipcase. 

 Clear Rotate Button:  Clear all the Rotate commands already set up 
for the shipcase.  When you click on this button, TOPS automatically 
un-checks all the active boxes in the Rotate column. 

 Options Button:  Open the Layer Parameters dialog box to specify 
how the Rotate command will be executed. 
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Note:  The Rotate function is most often adjusted when you're rotating 
patterns that are symmetrical, such as some pinwheel patterns.  In that 
case, try only width or length flip – not both. 

Advanced Tab 

 

The Advanced tab provides advanced rotation function. 

 None: Click on this radio button to not apply any rotation. 

 Alternate: Click this radio button to rotate to every other layer of the 
unitload. 

 Basic Setup: Click this radio button to use the settings from the Basic 
tab.  

 Custom:  Click this radio button to select custom rotation by enabling 
the Customer Layer Setup section: 

 Custom Layer Setup (Layers, comma separated): Select to 
manually specify which layers will have the rotation inside the 
shipcase.  

 Custom Layer Setup (Repeat every): Select to apply rotation to 
specific layers. Entering a ‘3’ for example, in the Custom Desc 
field will rotate the primary packs every three layers inside the 
shipcase. 

 Custom Desc (Layers/Repeat):  Enter the layer number to apply 
layer rotation. For example, enter ‘1,3,4-7’ to rotate layers 1, 3, 4 
thru 7 only (for the comma separated layer definition). 
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Shipcase Options 
Function:  This dialog box allows you to enter bulge and sizing 
parameters for a shipcase. 

Note:  This dialog box is used for shipcases and trays. 

 

Sizing 
The Shipcase Options dialog box allows you to fine-tune the size 
dimensions of the shipcase.  It limits the scope of the analysis solution by 
limiting the maximum dimensions and ratios. 

For example, if you specify a maximum of four cartons along the length, 
width and depth of the shipcase, TOPS Pro will generate a solution with 
no more than four cartons along the length, four cartons along the width 
and four cartons along the depth of the shipcase – a maximum of 64 
cartons.  The maximum is 64 cartons, but TOPS Pro will also generate 
other solutions with less than 64 cartons. 

To access: From the Shipcase Parameters dialog box, click on the Options 
button. 
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Field Descriptions and Instructions 
The following field – Pattern Styles – displays only if you selected Fixed 
Case on the Shipcase Parameters dialog box. 

 Pattern Styles:  Select one, multiple or all pattern styles for which 
you want TOPS Pro to generate solutions. 

Note:  If you selected Fixed or Database as the Case option on the 
Shipcase Parameters dialog box, the Pattern Styles options will be 
available.  If you selected New as the Case option, the Pattern Styles 
options will be grayed out and unavailable. 

 Bulge Length, Bulge Width, Bulge Height:  Enter the amount of bulge 
allowed in the shipcase's length, width and height dimension 
respectively. 

The following Sizing fields display only if you selected New Case on the 
Shipcase Parameters dialog box. 

 Max Cartons along Length/Width/Height:  Enter the maximum 
number of cartons allowed along the length, width and height of the 
shipcase respectively. 

 Max Cartons (in dimension) along Length/Width/Height:  Enter 
the maximum dimension in inches or millimeter along the length, 
width and height of the shipcase. 

 Length to Width Ratio:  Enter the length to width ratio of the 
shipcase. 

 Depth to Width Ratio:  Enter the depth to width ratio of the shipcase. 

 Optional:  The following three fields apply to bag costing situations. 

 Turn $/1000:  Enter the turn rate per pallet. 
 Cost:  Enter the cost per pallet. 
 Cases per Pallet:  Enter the number of cases per pallet. 

 
 Box Cost:  Check the option to be used to calculate box cost and enter 

the corresponding cost of box (per box or per square unit). 
 
Note:  If you do not see Box Cost in the statistics, please go to the 
Supervisor menu, select Login/Logout.  Type in the Supervisor 
password (tops software) and click Login.  Now go to Tools menu and 
select  Configuration.  Click the Statistics button and make sure Box 
Cost is checked under Shipcase. 
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Shipcase Parameters 
Function:  This dialog box allows you to define parameters for a shipcase. 

Note:  This dialog box is used for shipcases and trays.  The Shipper and 
Tray Parameters icons both display this dialog box.  The only difference is 
the options contained in the Style drop-down list. 

 

To access: From the Control Panel, Click on the yellow Shipper 

Parameters icon  or the yellow Tray Parameters icon , 

Note:  Be aware that the dialog box linked to a specific icon is determined 
in TOPS Configuration setup. 
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Field Descriptions and Instructions 
 Case:  Select either New, Fixed or Database to specify the type of 

shipcase you want to use in your analysis. 

 A new analysis will create a new shipcase based on other 
information you enter on the screen. 

 A fixed analysis requires you to enter the dimensions of a fixed 
shipcase. 

 A database analysis goes through the shipcases defined and stored 
in the database. 
Note:  At this time, there is no way to define or specify different 
databases of shipcases. 
 

 Database:  Select an option to specify whether TOPS Pro will use all 
shipcases or a selected number of shipcases.  The Database feature has 
two options: 

 All:  Tells TOPS Pro to consider all shipcases saved to the 
database when it calculates solutions. 

 Multiple:  Opens the Select Items dialog box and allows you to 
select specific shipcases to be used in calculating solutions.  

 
 Material:  Select either Corrugated or Other to specify the material 

used to make the shipcase. 

Note:  The type of material is important to determine stacking strength 
and board thickness. 

 Dimensions:  Select either Inside or Outside to specify how the 
shipcase dimensions are measured. 

Note:  TOPS Pro uses this option to round to the nearest 16th.  If you 
select Inside, TOPS Pro will calculate the inside dimensions by 
rounding up, then calculate the outside dimensions entered from that 
value.  If you select Outside, TOPS Pro will calculate the outside 
dimensions by rounding up, then calculate the inside dimensions 
entered from that value. 

 Description:  This is an optional field, you can select a pre-defined 
shipcase or type in the first few letters of the shipcase. 

Note:  The drop-down list contains shipcase types that are already set 
up in the database.  If the shipcase type you want is not on the list, you 
can add it to the database. 

Note:  If you select a pre-defined shipcase, TOPS Pro automatically 
inserts dimensions in the Length, Width and Height fields, as well as 
any pre-defined graphics, using the parameters set up on the Define 
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Shipping Case dialog box.  If you select User Defined, you'll need to 
manually enter dimensions in the Length, Width and Height fields. 

 Style:  Select the style of the shipcase you want to use. 

Note:  TOPS Pro uses the selected style, along with the caliper of the 
material to calculate the difference between inside dimensions and 
outside dimensions.  For information about defining shipcase styles, 
please refer to the Case Styles dialog box on page B-54. 

 C.A.S.Y. Style:  Select a CASY style to display for the shipcase. 

 Flute:  Select the flute size for the shipcase. 

Note:  The drop-down list contains flute types that are already set up 
in the database.  If the flute type you want is not on the list, you can 
add it to the database using the Define Flute dialog box.   
 
Note:  This field displays only if you select Corrugated Material.  
TOPS Pro uses the following default calipers for the various flute 
styles: 

A = 0.1875 (3/16-inch) 
A/B = 0.267 (17/64-inch) 
A/C = 0.267 (17/64-inch) 
B = 0.125 (1/8-inch) 
C = 0.15625 (5/32-inch) 
C/B = 0.267 (17/64-inch) 
E = 0.063 (1/16-inch) 
F = 0.063 (1/16-inch) 

Warning:  If you work with double-wall flutes on a regular basis, 
you'll need to adjust those flutes for the proper caliper. 

 Caliper:  Enter the caliper of the shipcase. The caliper is used to 
calculate the inside vs. outside dimensions of the shipcase.  This field 
displays only if you select Other Material. 

 Length, Width, Height:  Enter the length, width and height of the 
shipcase.  These fields are active only if you are using a Fixed 
shipcase. 

 Slack Length, Slack Width, Slack Height:  Enter the extra space 
intended for the length, width and height of the shipcase.  Slacks refer 
to the extra (wasted) space you intend to include in the shipcase 
configuration.  For example, you might figure in two inches of slack 
space at the top (height) to more easily insert items into the shipcase. 
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 Vert:  Check a box beside one of three fields – Length, Width or 
Height – to specify the vertical dimension of the shipcase relative to 
the ground. 

Note:  In packaging, height (depth) is normally the distance through 
the flaps.  Length is the greater of the two remaining dimensions. 

 Fixed Pack:  If you know how many items can fit into a “fixed” size 
shipcase, you can define the arrangement, regardless of actual 
dimensions, of the items being loaded, and TOPS will adjust the size 
of the product to fit into the shipcase for the given arrangement.  The 
printout for the statistics will show the size as defined by the user. If 
there is any difference in the size, it will be represented in the Bulge 
stats. 

 Max Weight:  Enter the maximum weight of the shipcase. 

 Use Tare weight: Check the box to provide the tare weight of the 
shipcase for calculation.  If the tare weight option is not checked, 
TOPS will estimate the weight of the shipcase based on box style, box 
dimension and flute. 

 Round to nearest 1/16":  Check the box to force TOPS Pro to round 
the slack dimensions to the nearest 1/16". 

 Sizing:  Select either Range or Values to specify whether you want the 
shipcase to hold a range of items or a set number of items. 

For example, if you want to design the shipcase to hold anywhere from 
two to six cartons, select Range.  If you want to design the shipcase to 
hold exactly six cartons, select Values. 

Note:  Specify the number of units from the previous stage in the 
analysis to place within this shipcase.  For example, if your analysis 
bundles cartons into intermediate packers, then you need to specify the 
number of bundles – not the number of cartons – that will go into the 
shipcase. 

Also, when you put boxes into a fixed-size shipcase, you should 
normally leave the Range value wide open (1-1000).  If TOPS Pro puts 
too many boxes into a shipcase, use slack to reduce the amount of 
usable space in the box. 

 Min Count:  Enter the minimum number of items you want the 
shipcase to hold. 

Note:  This field displays only if you select Range. 
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 Max Count:  Enter the maximum number of items you want the 
shipcase to hold. 

Note:  This field displays only if you select Range. 

TOPS Pro uses the minimum and maximum count values to generate a 
number of solutions.  For example, if you enter two (2) as the 
minimum count and five (5) as the maximum count, TOPS Pro will 
generate solutions for two-, three-, four- and five-count sizes. 

 Values:  Enter the set number of items for which you want TOPS Pro 
to generate solutions. 

For example, if you want TOPS Pro to generate solutions for a set 10-
count and a set 15-count, enter 10 and 15 in the first two Values fields. 

 Options Button:  Displays the ShipCase Options dialog box, which 
allows you to enter additional parameters for a shipcase, such as 
minimum/maximum headspace and bulge dimensions. 

 Dividers Button:  Displays the Dividers dialog box, which allows you 
to define parameters for the dividers inside the shipcase. 

 Graphic Button:  Displays the Assign Graphics dialog box, which 
allows you to select and display a graphic image on the shipcase. 
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Specification Products 
Function:  This dialog box allows you to define parameters for a new 
product to be added to the Product Name drop-down list on the Package 
Profile dialog box. 

 

To access: From the Package Profile dialog box, click on the Add Product 
button. 

Field Descriptions and Instructions 
 Product:  Select the product you want to add to the product list on the 

Package Profile dialog box, or type in the first few letters of the 
product. 

Note:  The drop-down list contains products that are already set up in 
the database.  If the product you want is not on the list, you can add it 
to the database using the New Product button or the Define Product 
dialog box.   

 Product Code:  Enter the product code associated with the product. 

 Designed By:  Enter the name of the person who designed the product. 

Note:  This field is currently not displayed on the package profile. 

 Designed Date:  Enter the date the product was designed. 

Note:  This field is currently not displayed on the package profile. 

 Declared Weight:  Enter the weight of the product and select the unit 
of measurement (ounces, pounds, millimeters, etc.). 

Note:  This value appears on the printout only. 

 Case Weight:  Enter the case weight of the product in pounds or 
kilograms, depending on the Units selected. 
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Note:  When the case weight is multiplied by the number of cases and 
added to the pallet weight, the value will be equal to the reported 
unitload weight for that product. 

 Sort By:  Select either Name or UPC to specify how the product list 
will be sorted. 

 New Product Button:  Displays the Define Product dialog box, which 
allows you to define parameters for a new product (a product that's not 
already defined in the system). 
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Stacking Strength 
Function:  This dialog box allows you to perform a stacking strength test 
on a package analysis. 

  

You can access the Stacking Strength dialog box via one of these menus: 

 From the Menu Bar, open the Tools menu and select Stacking 
Strength. 

 From the toolbar, click on the Stacking Strength tool button  
 From the UnitLoad Analysis view window, click the Strength button 

and then select Strength. 
 

Field Descriptions and Instructions 
 Calculation Method:  Select a method of calculation, either Ring 

Crush, Edge Crush or Kellicut (for Japanese use mainly). 

 Length, Width, Height:  Enter the length, width and height of the 
case respectively.  If you already have an analysis opened which 
consists of a unitload solution, these dimensions will be populated 
with those of the current shipcase. 

 Weight:  Enter the weight of the case in pounds or kilograms, 
depending on the Units selected. 

 Flap Gap:  Enter the flap gap of the case in inches or millimeters, 
depending on the Units selected. 
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 Prod Sup:  Enter the product support of the case in pounds or 
kilograms, depending on the Units selected. 

 Flute Direction:  Select the direction the flute runs in relation to the 
case. 

 Amount of Printing:  Select the amount of printing to be performed 
on the case. 

Note:  Be aware that heavy printing does reduce the stacking strength 
of most corrugated materials. 

 Type of Printing:  Select either Quick Set or Flexo Ink to specify the 
type of printing to be performed on the case. 

 High Light:  Select either Color or None to specify whether the case 
will be colored. 

 Storage Time:  Select the amount of time the cases are stored before 
stacking. 

 Humidity:  Enter a percentage to specify the amount of humidity in 
the cases' storage environment. 

 # of Loads High:  Enter the number of loads high the cases are stored. 

 Pallet:  Select the type of pallet on which the cases will be stacked. 

Note:  The drop-down list contains pallet types that are already set up 
in the database.  If the pallet type you want is not on the list, you can 
add it to the database using the Define Pallet dialog box.  

 Cases/Layer:  Enter the number of cases to a layer. 

 Layers/Load:  Enter the number of layers to a load. 

 Overhang:  Enter the amount of overhang for the unitload in inches or 
millimeters, depending on the Units selected. 

 Rotation:  Select the how the unitload is rotated. 

 Footprint Factor:  If you have multiple unitloads and not all 
shipcases help support the unitload above, specify how many 
shipcases do help support.  Lowering this number reduces the number 
of bottom-most cases that help support the above unitload. 

 Filter Button:  Displays the Stacking Strength Filter dialog box, 
which allows you to select a number of flute sizes and define 
minimum and maximum values for compression strength, safety factor 
and unitloads high. 
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 Dividers Button:  Displays the Dividers dialog box, which allows you 
to define parameters for the dividers inside the packer. 

 Options Button:  Displays the Stacking Strength Options dialog box, 
which allows you to select which columns of information will appear 
on the Stacking Strength Results report by selecting from a listing of 
board grades. 
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Stacking Strength Filter 
Function:  This dialog box allows you to select a number of flute sizes 
and define minimum and maximum values for compression strength, 
safety factor and unitloads high. 

 

From the Stacking Strength dialog box, click on the Filter button. 

Field Descriptions and Instructions 
 Flutes:  Check against the box to select the flute sizes to be included 

in the stack analysis. 

 Min, Max Compression Str:  Enter the minimum and maximum 
compression strength range to filter the solutions. 

 Min, Max Box Performance: Enter the minimum and maximum 
values for box performance to be filtered. 

 Min, Max Safety Factor:  Enter the minimum and maximum safety 
factor range to filter stacking results. 

 Min, Max Safety Margin:  Enter the minimum and maximum safety 
margin range to filter stacking results. 

 Min, Max Unit Loads High:  Enter the minimum and maximum 
number of unitloads stacked on top of one another to be filtered. 
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Stacking Strength Options 
Function:  This dialog box allows you to select the board grades that will 
be included in the Stacking Strength Results report.  Each board grade will 
be represented by a column of data on the report. 

 

From the Stacking Strength dialog box, click on the Options button. 

Field Descriptions and Instructions 
 This dialog box displays a list of board grades.  Use the checkboxes to 

select the board grades that will be included in the Stacking Strength 
Results report. 
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Supervisor Login 
Function:  This dialog box allows you to login to the system as a 
supervisor, which is required in order to perform the following tasks: 

 Approve analyses 
 Rename and delete users 
 Change statistics settings 
 See all users' work 
 Log off other users 
 Change button templates 
 Change Quick Print templates 

 

 
 

To access: From the Menu Bar, open the Supervisor menu and select 
Login/Logout. 

Field Descriptions and Instructions 
 Password:  Enter a valid password. 

Note:  The default password is "tops software."  Note the space 
between "tops" and "software." 

 Login:  Click to login as supervisor after you’ve entered a password.  
After you’ve successfully logged in, you will see “Analysis name – 
TOPR Pro (Supervisor)” on the application title bar. 

 Logout:  Click to logout as supervisor. 

 Change Password:  Allows you to change your password.  When you 
click on this button, the Supervisor Login dialog box redisplays, as 
pictured below. 
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Notice that the redisplayed dialog box has two password fields.  To 
change passwords, follow these instructions: 

1. Enter the current password in the first field. 

2. Enter the new password in the second field. 

3. Click on the Change button. 

TOPS Pro changes your supervisor password and saves it to the database. 
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Text Modification 
Function:  This dialog box allows you to perform language editing.  You 
can replace any existing text string used within TOPS Pro with a new term 
which might provide a better description. 

 
 

 

To access: From the Menu Bar, go to the Tools menu, select Language 
and then select Edit. 

Field Descriptions and Instructions 
 ID:  Display the unique identifier for each string.  This is mainly for 

reference only and will not be used by the user. 

 English:  Select a word in the English language.  The terms are 
arranged in alphabetical order.   You can also type in the first few 
characters of the term to quickly locate it in the list. 

 American (or Current Language):  Select a word in the current 
language or display the corresponding translation for the current 
English term. 

 New String:  Enter the new text to replace the existing term in the 
current selected language. 

 Update Button:  Click to update the current change to the database. 
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Tub Options 
Function:  This dialog box allows you to enter bulge dimensions for a 
tub. 

Note:  This dialog box displays a different set of fields – as pictured 
below – depending on whether you selected Round or Rectangular in the 
Body Shape field on the Tub Parameters dialog box. 

 
Tub Options for Round Body Shape 

 
Tub Options for Rectangular Body Shape 

To Access: From the Tub Parameters dialog box, click on the Options 
button. 

Field Descriptions and Instructions 
The following field – Diameter – displays only if you selected a Round 
Body Shape on the Tub Parameters dialog box. 

 Diameter:  Enter the bulge diameter for round tubs. 

 Width, Length:  Enter the bulge width and length for rectangular 
tubs. 

 Height:  Enter the bulge height for round or rectangular tubs. 
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Tub Parameters 
Function:  This dialog box allows you to define parameters for different 
types of tubs.  The dimensions to define the tubs vary with the body shape 
selected. 

 
Tub Parameters for Round Body Shape 
 
 

 
 
Tub Parameters for Rectangular Body Shape 

To access: From the Control Panel, click on the Tub Parameters icon  
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Field Descriptions and Instructions 
 Fixed/New: This option allows users to use known dimensions as 

Fixed, or New, if they want to define ranges, for minimum and 
maximum sizes per dimension. If New is selected, the increment field 
is for the unit of incrimination, per solution tried. If for example if you 
specify 10mm, the software solutions for that dimension would always 
be some factor of 10mm. 

 Description:  This is an optional field.  If used, select from the drop 
list a predefined description for the tub. 

 C.A.S.Y. Style:  Select a CASY style to display for the tub. 

The following two fields – Top Diameter and Bottom Diameter – 
display only if you select a Round Body Shape. 

 Top Diameter, Bottom Diameter:  For round tubs, enter the top 
diameter or rim and bottom diameter of the tub. 

 Top Length, Top Width:  For rectangular tubs, enter the top length 
and width of the tub. 

 Bottom Length:  Displays the bottom length of rectangular tubs. 
TOPS Pro automatically calculates this value based on the proportions 
of top to bottom width. 

 Bottom Width:  Enter the bottom width of the rectangular tub. 

 Height:  Enter the height of the tub, round or rectangular. 

 Pitch:  Enter the value to represent the distance between stacked tubs.  

Note:  Pitch allows you to define the dimensions of the tubs so they 
can be stacked inside one another.  This value represents the distance 
between the rims of the nested tubs; that is, how far one tub protrudes 
from the one it's placed into.  If you leave pitch at zero, TOPS Pro 
assumes that the tubs don't nest inside one another. 

 Vert:  Check a box beside one of four fields – Top Length, Top 
Width, Top Diameter or Height – to specify the vertical dimension of 
the tub relative to the ground. 

 Net Weight:  Enter the net weight of the tub in pounds or kilograms, 
depending on the Units selected. 

 Gross Weight:  Enter the gross weight of the tub in pounds or 
kilograms, depending on the Units selected. 

 Volume:  This displays the product volume for the tub, when 
applicable. 



 

Appendix B:  Dialog Boxes                                                                                   B-209 

 Inverted Nest:  Check this box to load nested tubs in inverted rows.  
The picture on the right is an example of nested plastic cups.  When  
enabled, make sure to also select the nest direction. 

 Pack tightly when Nested:  This option can tightly pack flower pots, 
plumbing parts, water glasses and more by removing any space 
between the objects. 

 Nest direction (w.r.t Tub dims):  This allows you to choose the 
different variations of nesting within the shipcase – Both sides, Single 
Side or Height. 
 

                 
                  Nest single side                         Nest both sides 

 Body Shape:  Select either Round or Rectangular to specify the body 
shape of the tub. 

 Bundle:  Check the Bundle option set predefined tub arrangement in 
the intermediate pack or shipcase. 

 Options Button:  Displays the Tub Options dialog box, which allows 
you to enter bulge parameters for a tub. 
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UL Label Parameters 
Function:  This option allows you to apply graphics on the outside of the 
Unitload and adjust its size and orientation. 

  

To access, click the Options button at the UnitLoad Parameters dialog 
box.  Then click on the Label button in the Unitload Options dialog. 

 Graphic: Click the Browse button to specify a graphics to be used as 
label for the unitload.  If no graphic is specified, a plain white label 
will be used. 

 Face: Check off the side(s) on the unitload where a label will be 
placed. 

 Position: Select the position where the label will be placed. Users can 
only specify one location and this applies to all sides where a label 
will be added. 

 Label Width, Label Height:  Enter the width and height of the label 
as a percentage of the unitload width and height. 

 Cover Pallet:  Check this box if you would like to include dimension 
of the pallet into calculation of the label size. 
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UnitLoad (Pallet-Vehicle Analysis) 
If you perform a pallet-vehicle analysis, the UnitLoad Parameters dialog 
box displays as pictured below. 

 

To access: Set up a pallet-vehicle analysis and click on the Pallet 

Parameters icon  or the Slipsheet Parameters icon . 

Field Descriptions and Instructions 
 Pallet Style:  Select a pallet or slipsheet style. 

Note:  The drop-down list contains pallet types that are already set up 
in the database.  If the pallet type you want is not on the list, you can 
add it to the database using the Define Pallet function. 

 Mix Pallet:  If you have a mixed pallet created with the MixPro 
Mixed Pallet Editor you’d like to use for vehicle loading, select it from 
the drop down lost box. 

If mixed pallets are to be used for the vehicle load, all measurements 
will be picked up from the mixed pallet and the dimensions and offset 
field will be grayed out. 

  Length, Width, Height:  Enter the length, width and height of the 
pallet or slipsheet. 

 Weight (incl. Pallet):  Enter the weight of the pallet or slipsheet in 
pounds or kilograms, depending on the Units selected. 

 Load Offset:  Enter the overhang of the unitload and leave the 
underhang as is. 
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UnitLoad Options 
Function:  This dialog box allows you to define pattern styles, 
clampability and corner post parameters for a pallet. 

 

To access: Click the UnitLoad Parameters icon  on the tool bar to 
access the dialog box, then click on the Options button. 

Field Descriptions and Instructions 
 Pattern Styles:  Select one, multiple or all pattern styles for which 

you want TOPS Pro to generate solutions. 

Note:  If you selected a pallet style already defined on the UnitLoad 
Parameters dialog box, the Pattern Styles options will be available.  If 
you defined a new pallet style, the Pattern Styles options will be 
grayed out and unavailable. 

 Clampable:  Select either Length or Width to specify whether you 
want the unitload clamped along its length or width. 

 Corner Posts:  Check the box to use corner posts in the unitload 
calculation and enter the length and thickness in the corresponding 
fields.  Note that unlike layer parameters, corner posts will reduce the 
amount of usable space on the pallet. 
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 False Bottom:  Check the box to add a raised platform to the unitload 
and enter the height of the false bottom in the corresponding box. 
 

                      
       Corner posts             False bottom                   Labels 
 

 Label:  Check the box to place labels on the unitload and click the 
label button to select the image to be used as well as its size and 
placement.   If no graphic is specified, a plain white label will be used. 

 Compression %:   Some loads may be wrapped and clamp loaded, 
and such loading may cause compression for the goods loaded on the 
pallet. This compression can be accounted for by percentage, using 
this feature. Also, if for some reason you have a UL that needs to 
account for a bulge factor, you could employ negative values here and 
the negative compression would respond as a bulge value. 

  Straps:  Check the box to activate the Straps fields 
and select whether to use vertical, horizontal straps 
or both. 

 Strap Width:  Enter the width of the straps to be 
used for the unitload 

 Number of:  Enter the number of straps to be used on the unitload.  
Currently, TOPS only allows use of the same number of straps for 
both length and width dimension. 

 Strap Guards:  Check the box to use strap guards with the straps. 

 Edge Protectors:  Select whether to use edge 
protectors and its width for the unitload. 
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UnitLoad Parameters 
Function:  This dialog box allows you to define parameters for the 
unitload using a pallet or slipsheet. 

Note:  If you are working on a design sequence which starts with pallet 
stage, the UnitLoad Parameters dialog box will be much simpler as 
described in the next section “pallet-vehicle analysis”. 

 

To access: From the Control Panel, click on the Pallet Parameters icon  

or click on the Slipsheet Parameters icon   

Note:  Be aware that the dialog box linked to a specific icon is determined 
in the Configuration setup. 
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Field Descriptions and Instructions 
 Pallet:  Select either Single, Slave or Multi Pallets. 

 Single Pallet Style:  Use the Pallet Style drop-down box to select the 
pallet style to be used in the calculation. 

Note:  The drop-down list contains pallet types that are already set up 
in the database.  If the pallet type you want is not on the list, you can 
add it to the database using the Define Pallet dialog box. 

 Slave Pallet:  Use the Slave drop-down box to select the pallet style 
and quantity to be used in the calculation.  Shipcases will be stacked 
on slave pallets before being placed on the single pallet.  
 
Note:  Slave pallets are not allowed to extend outside the single pallet 
at the bottom, so make sure the dimensions of the slave pallet are well 
defined. 
 

                            
             2 slave pallets                 4 slave pallets                Slave pallets with 
                                                                                             overhung shipcases 

 Multi Pallets:  If multiple pallets are used, click on the Select Pallets 
button to display the Select Items dialog box, which allows you to 
select multiple pallet styles to be used in the calculation.   
 
Note: When using multiple pallets, users now have the option to group 
the unitload solutions based on pallet type in the UnitLoad Parameters 
dialog box shown below.   

 Optimized for all Pallets – Solutions will be displayed in one 
single list with a field “Pallet Name” identifying the pallet used for 
the selected solution.  This option offers the possibility of 
comparing solutions using different pallets. 

 Optimize for each Pallet – Solutions are grouped in tabs based on 
pallet.  Note that solutions cannot be compared across tabs. 
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 Maximum Height (incl. Pallet):  Enter the maximum height of the 
unitload and note that this value also includes the height of the pallet. 

 Maximum Weight (incl. Pallet):  Enter the maximum weight of the 
unitload, including the weight of the pallet. 

 Maximum Overhang along Length and Width:  Enter the maximum 
overhang for the length and width of the pallet or slipsheet. 

 Maximum Underhang along Length and Width:  Enter the 
maximum underhang for the length and width of the pallet or 
slipsheet. 

Note:  TOPS Pro uses underhang values to limit the solutions 
displayed when calculating legal unitloads.  Underhang instructs 
TOPS Pro to show only those unitloads that are farther than the 
entered distance from the edge of the pallet. 

If you enter zero for underhang, TOPS Pro will show only those 
answers that exactly match the size of your pallet (a situation that 
rarely happens).  In general, we recommend that you leave underhang 
alone; the best answer will rise to the top. 

Unitizing large items can cause problems with otherwise reasonable 
underhang values; for example, placing 21-inch TV's on a pallet with 
no overhang and six inches of underhang.  Quite often, you can't fit 
two TV's on a pallet side by side, but if the TV doesn't come within six 
inches of the edge, TOPS Pro will generate no answers.  Using an 
underhang of 15 inches (or 20 inches) and getting at least one solution 
is better than getting no solution at all. 

 Packaging weight:  Enter the weight of other packaging materials to 
secure a more accurate weight of the unitload.  Packaging materials 
include slip sheets, pads, caps, straps and other filler materials. 

 Limit to Max:  Enter the maximum number of layers, the maximum 
number of items per layer, or the maximum number of items on a 
unitload.  Keep the default value of zero (0) if there is no preference as 
to these parameters. 

 Max UL High: Specify the maximum number of unitloads that can be 
stacked inside a vehicle or during storage. 

 Clamp Direction: Specify if this unitload will be clamped and along 
what direction. Select from the drop down list. 
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 Options Button:  Opens the UnitLoad Options dialog box, which 
allows you to enter pattern styles, clampable and corner post 
parameters for a pallet. 

 New Pallet Button:  Displays the Define Pallet dialog box, which 
allows you to define parameters for a new pallet (one that's not already 
defined in the system). 
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User List 
Function:  This dialog box displays the users currently logged onto the 
system.  This feature is critical for network users who have a limited 
number of TOPS Pro software licenses.  For example, if you have two 
licenses and two users are logged on, then a third user will not be able to 
logon until one of the current users logs off. 

You may find it necessary to logout someone if he or she logged onto 
TOPS Pro, then did not exit the system normally (e.g., in the event of a 
crash or power failure).  If you're unable to enter TOPS Pro to logout a 
missing user, you can always login as that user, replace that user, then 
exit. 

 

From the Menu Bar, open the Tools menu and select User List. 

Field Descriptions and Instructions 
 The users list displays a list of users currently logged onto the system. 

 The user ID displays the ID number of the selected user. 

 The login date/time displays the date and time the selected user 
logged onto the system. 

 The Logout button allows you to select a user and log him or her out 
of the system.  You must be logged on as a supervisor to logout 
another user. 
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User Login 
Function:  This dialog box allows you to login to the system. 

Note:  At this time, there is no way to prevent any user from adding a user 
to the system. 

 

To access, use one of two options: 

 When you open the TOPS Pro application, the User Login dialog box 
automatically appears. 

 From the Menu Bar, open the File menu and select User Login. 

Field Descriptions and Instructions 
 The User List displays a list of users set up in the system.  To login to 

the system, select a user name and click on the Login button. 

 Add User Button:  Displays the New User dialog box, which allows 
you to add a new user to the system. 

 Delete User:  Available only when you are logged in as Supervisor, 
this allows you to select a user and delete him or her from the system. 

 Rename User:  Displays the New User dialog box, which allows you 
to rename a selected user.  In order to use this feature, you must be 
logged in as a supervisor. 
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Vehicle Layer Parameters 
Function:  This dialog box allows you to define parameters related to the 
vehicle layers in your package design. 

 

To access: First, you must create an analysis that places an item (pallet, 
shipper, etc.) into a transit vehicle.  After you've calculated the analysis, 
go to the Menu Bar, open the Edit menu and select Layer Parameters. You 
can also click on the layer parameters button ( ) in the vehicle view 

Note:  It's imperative to calculate the analysis first; otherwise, the Layer 
Parameters option will not be available on the Edit menu.  You must 
calculate the analysis and activate the vehicle panel before you can access 
this menu option. 

Basic Tab 
 Layer:  Displays a column of layers that correspond to a vehicle 

solution.  Each layer represents a specific layer of unitloads in the 
vehicle.  For example, Layer 1 represents the first layer, Layer 2 
represents the second layer and so on. 

 Rotate:  Check the box to rotate a specific layer.  This allows you to 
manipulate stacking strength. 

 Rotate All Button:  Rotates all layers in the vehicle.  When you click 
on this button, TOPS Pro automatically checks all the active boxes in 
the Rotate column. 

 Rotate Top 2 Button:  Rotates the top two layers in the vehicle. 



 

Appendix B:  Dialog Boxes                                                                                   B-221 

 Clear Rotate Button:  Clears all the Rotate commands already set up 
for the vehicle.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Rotate column. 

 Options Button:  Open the Layer Parameters dialog box to specify 
how the Rotate command will be executed. 

Advanced Tab 

 

 Rotation Layer:  Select an option to specify which layers to rotate 
inside the vehicle.  Custom allows a user to use the Custom Layer 
Setup, where layers to be rotated can be specified, using a comma as 
the separator. Alternate will rotate every other layer and Basic Setup 
will use the settings  

Options 

 

 Rotation:  Select an option to specify how the layer(s) will be rotated: 
Length flip, Width flip or Length and width flip. 

 Spread:  Select an option to specify how the unitloads will be spread 
within the vehicle layers: Pack tightly, Spread to layer edge or Spread 
to pallet edge. 
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Vehicle Options 
Function:  This dialog box allows you to enter additional parameters for a 
truck, such as pattern styles and pallet configurations inside the truck. 

 

To access: From the Define Transit Vehicle dialog box, click on the 
Options button. 

Field Descriptions and Instructions 
 Pattern Styles:  Select one, multiple or all pattern styles for which 

you want TOPS Pro to generate solutions. 

 Optimize to vehicle:  Check the box to sort solutions based on the 
best vehicle packing. 

Note:  Normally, TOPS Pro prioritizes solutions based on the best 
pallet arrangement first, then the best vehicle for that pallet.  With this 
switch turned on, TOPS Pro will sort the solutions based on the best 
vehicle packing.  This is handy where there is a possibility for 
overhang.  Sometimes, less overhang – a less efficient pallet pattern – 
will result in a better vehicle load. 

 Optimize pallet hgt for vehicle:  Check the box to optimize pallet 
height for the vehicle. 

Note:  If this switch is turned on, TOPS Pro will attempt to fit more 
shipcases onto the truck by reducing the number of layers per pallet to 
fit more unitloads per truck.  This works best in situations where the 
unitload is more than half the truck height. 
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   Before: 5 layers/UL                          After: 4 layers/UL 
  (Max UL height = 70”) 
 

 Allow different size pallet heights:  Check the box to allow different 
size pallet heights in the truck; i.e., put partial pallets on top of full 
pallets – if they fit. 
 

                    
 
   Before: 3 layers/UL                        After: 2 layers of  3-layer UL 
  (Max UL height = 52”)                        and 1 layer of 1-layer UL 

 Allow Partial Layers: This function allows TOPS to load the 
container, until it is limited by the container weight limit specified. 

 
 Justify in Vehicle Along Length:  Select either Front, Back or Center 

to specify where to place the unitloads in the vehicle. 

 Justify in Vehicle Along Width:  Select either Left, Right or Center 
to specify where to place the unitloads in the vehicle. 

 Justify in Vehicle Along Height:  Select either Top, Bottom or 
Center to specify where to place the unitloads in the vehicle. 
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Vehicle Parameters 
Function:  This dialog box allows you to define parameters for a vehicle. 

 

To access: From the Control Panel, click on one of these vehicle icons: 

Truck , Sea Van  or Rail Car . 

Field Descriptions and Instructions 
 Single:  For single vehicle, select a pre-defined vehicle or type in the 

first few letters or numbers of the vehicle. 

 Multiple:  Select multiple vehicles to use more than one vehicle type 
for calculation.  Click on the Select Vehicles to open the Select Items 
dialog box to specify the vehicles to be used. 
 
After calculation, solutions for each vehicle type will be presented in 
different tabs in the Solution List Pane as pictured below. 
 

 
 Inside Length, inside Width, Inside Height:  Enter the length, width 

and height along the inside of the vehicle.  These define the loadable 
space inside the vehicle. 
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The following three fields – Slack Length, Slack Width and Slack 
Height – refer to the extra (wasted) space you intend to include in the 
vehicle.  For example, you might figure in 12 inches of slack space at the 
top (height) to more easily insert items into the vehicle. 

 Slack Length, Slack Width, Slack Height:  Enter the extra space 
intended for the length, width and height of the vehicle. 

 Maximum Net Weight:  Enter the net weight of the vehicle in pounds 
or kilograms, depending on the Units selected. 

 Loose Load Items:  Check the locations (On Top, Side or End) inside 
the vehicles where loose shipcases will be stacked to take advantage of 
available void space. 
 

      
 
In the statistics pane, the number of Shipper per Vehicle Load will be 
displayed as, for example, 460 (T=88, S=0, E=20), meaning a total of 
460 shipcases inside the vehicle, with 88 loose items on tops, none on 
the side and 20 on the end. 
 
Note:  C.A.S.Y. display must be turned off in order to see the loose 
load items in the vehicle load in the analysis view and in reports. 

 New Vehicle Button:  Displays the Define Vehicle dialog box, which 
allows you to define a new vehicle and save it to the database. 

 Options Button:  Displays the Vehicle Options dialog box, which 
allows you to enter additional parameters for a truck, such as pattern 
styles and pallet configurations inside the truck. 
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Appendix C: Menu Options 

Introduction 
This appendix outlines the eight menus that comprise the Menu Bar in the 
TOPS Pro program, along with a brief description of the options available 
with each menu.   

For more information about the dialog boxes for each menu option, please 
refer to Appendix B, Dialog Boxes. 

The eight primary menus are as follows: 

 File menu 
 Edit menu 
 View menu 
 Define menu 
 Tools menu 
 Import menu 
 Export menu 
 Supervisor menu 
 Help menu 
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File Menu 

New 
The New option clears the Control Panel of any work and allows you to 
begin a new analysis. 

Open 
The Open option displays the Open Analysis dialog box, which allows 
you to select and open an analysis.  

New via Template 
The New via Template option displays the Open Analysis dialog box, 
which allows you to select a template and start a new analysis.  

Save 
The Save option saves the current analysis record to the database. 

Note:  Be aware that this function does not save an analysis as a file on 
your hard drive.  Rather, it saves the analysis as a record to the TOPS Pro 
database – an important difference to remember when you need to open or 
search for an analysis. 

Save As 
The Save As option displays the Analysis Save As dialog box, which 
allows you to save an analysis record to the database. 

Note:  Same as the Save function, this function saves the analysis as a 
record to the TOPS Pro database. 

Save As Template 
The Save As Template option displays the Analysis Save As dialog box, 
which allows you to save an analysis as a template and add it to the 
Template Toolbar. 
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Save As XML 
The Save As XML option saves the opened analysis as an XML file in the 
default \TOPSAPPS\TOPSPRO\Data\ folder. 

Publish Analysis 
The Publish Analysis option displays a second menu of options: 

 To Web:  Opens the web Publisher dialog box, which allows you to 
publish the results of an analysis to the web, thus allowing other 
people to view the analysis. 

 To Network: Open the network Publisher dialog box, which allows 
you to publish the results of an analysis to a local network, thus 
allowing other users within the company to view the analysis. 

Open Archive 
The Open Archive option displays the Open Archived Analysis dialog box 
which allows you to restore any previously archived analysis. 

Open XML 
The Open XML option displays the Get Export File Name dialog box 
which allows you to open and saved analysis in XML format. 

Print 
The Print option displays a second menu of options, as follows: 

 Analysis:  Displays the Print Parameters dialog box, which allows you 
to design the layout of your printed output of an analysis, then decide 
what type of information will be included and how that information 
will be presented (different graphical views, text and numbers, etc.). 

 Pallet Report: Prints the Pallet report containing unitload information 
with efficiency factors and Wal-Mart scores. 

 Package Profile:  Prints the Package Profile for an analysis. 

 Container Diagram:  Displays the Container Diagram List dialog 
box, which allows you to select container diagram for printing. 

 Combined Report:  Prints a combined report, which displays 
information from two analyses on one printout. 
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 Compare Solutions: Prints a report comparing different solutions of 
the same analysis. 

For more information about the Combined Report feature, please refer 
to Chapter 11, Printing. 

 Problem Definition:  Prints the problem definition for the current 
analysis. 

 Carton Arrangement List:  Prints the carton arrangement list for the 
current analysis. 

 Intermediate Pack List:  Prints the intermediate Pack List for the 
current analysis. 

 ShipCase List:  Prints the shipcase list for the current analysis. 

 UnitLoad List:  Prints the unitload list for the current analysis. 

 Vehicle List:  Prints the vehicle list for the current analysis. 

 Stack Strength List:  Prints the stacking strength list for the current 
analysis. 

Print Preview 
The Print Preview option displays a second menu of options, as follows: 

 Analysis:  Displays the Print Parameters dialog box, which allows you 
to design the layout of your printed output of an analysis, then decide 
what type of information will be included and how that information 
will be presented (different graphical views, text and numbers, etc.). 

 Pallet Report: Displays the Pallet report containing unitload 
information with efficiency factors and Wal-Mart scores 

 Package Profile:  Displays a print preview of the package profile for 
an analysis. 

 Container Diagram:  Displays the Container Diagram List dialog 
box, which allows you to select container diagram for printing. 

 Combined Report:  Displays a print preview of a combined report, 
which displays information from two analyses on one printout. 

 Compare Solutions: Displays a report comparing different solutions 
of the same analysis. 
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Print Databases 
The Print Databases option displays a second menu of options which 
allows you to print the following: 

 Product Report:  Packaging Component Specifications Report 
 Products:  Products Database 
 Cartons:  Cartons Database 
 Shipcases:  Shipcases Database 
 Pallets:  Pallets Database 
 Vehicles:  Vehicles Database 
 Box Styles:  Box Styles Database 
 Dividers:  Dividers Database 
 Films:  Bag Films Database 
 Cost Parameters:  Cost Factors Database 
 Stacking Strength:  Board Combinations Database 
 User List:  

 

Page Setup 
The Page Setup option displays the Print Parameters dialog box, which 
allows you to design the layout of your printed output of an analysis, then 
decide what type of information will be included and how that information 
will be presented (different graphical views, text and numbers, etc.). 

Printer Setup 
The Printer Setup option displays the Print Setup dialog box, which allows 
you to set up parameters for your printer. 

User Login 
The User Login option displays the User Login dialog box, which allows 
you to login to the system. 

Package Profile 
The Package Profile option displays the Package Profile dialog box, which 
allows you to create a package profile for a complete package analysis, 
sometimes called a cube specification.  The package profile is designed 
for situations where many products use the same packaging. 
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Analysis Details 
The Analysis Details option displays the Analysis Details dialog box 
which allows you to enter more detail information about the analysis.  
This function is reserved for specific customers only.  Please contact 
TOPS for more information. 

Container Diagram 
The Container Diagram option displays the Container Diagram Spec 
dialog box, which allows you to enter or update specifications for a 
specific container diagram. 

Request Approval 
The Request Approval option displays a dialog box that allows you to 
place an analysis in an approval queue.  This feature is used to submit an 
analysis to a supervisor for approval.  When a supervisor approves an 
analysis, that analysis can then be viewed by all users.  Before an analysis 
is approved, it can only be viewed by the user who created the analysis or 
the supervisor. 

Email Analysis 
The Email Analysis option saves the current analysis as a text attachment 
in your email program so it can be sent to another TOPS user. 

Exit 
The Exit option closes the TOPS Pro program. 
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Edit Menu  

Copy to Clipboard Color 
This option allows you to select a graphic image in the TOPS Pro 
program, then copy the image to the clipboard in color. 

Copy to Clipboard B+W 
This option allows you to select a graphic image in the TOPS Pro 
program, then copy the image to the clipboard in black and white. 

Layer Parameters 
This option displays the Layer Parameters dialog box for the current 
active window.  This dialog box allows you to define parameters related to 
the vehicle layers in your package design. 

Package Instruction 
This option displays the Package Instruction dialog box where users can 
add packaging accessories and note to the report. 

Modify Pattern 
This option opens the shipcase or pallet pattern editor which allows you 
modify the arrangement of primary packs in an intermediate packs, 
intermediate packs in a shipcase or shipcases on a pallet. 

Select as Secondary Pattern 
The Select as Secondary Pattern option allows you to select a pallet 
pattern and specify it as your secondary pattern from the list of solutions.  
This feature is useful if TOPS Pro has another pallet pattern you'd like to 
insert for a given layer of your primary (first) solution. 

Go to Secondary Pattern 
The Go to Secondary Pattern option allows you to select a pallet pattern 
and apply the secondary pattern to a layer or layers of your primary (first) 
pallet solution. 
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View Menu  
The options under the View menu allow users to change the display of 
graphics or contents of the current solution window pane. 

3-Dimension 
The 3-Dimension option displays the 3-dimensional view of 
a selected graphic, as pictured on the right. 

Plan 
The Plan option displays the plan (top) view of a selected 
graphic, as pictured on the right. 

Front 
The Front option displays the front view of a selected 
graphic, as pictured on the right. 

Side 
The Side option displays the side view of a selected graphic, 
as pictured on the right. 

Text 
The Text option displays the corresponding statistics 
in text form for a selected graphic, as pictured on the 
right. 

Divider 3D 
The Divider 3D option displays the 3-dimensional view of the 
divider in a selected graphic, as pictured on the right. 

Divider Plan 
The Divider Plan option displays the plan (top) view of the 
divider in a selected graphic, as pictured here. 
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Show/Hide Dims 
The Show/Hide Dims option acts as a toggle switch that allows you to 
show or hide (erase) the numeric dimensions on a selected graphic. 

Show Contents 
The Show Contents option displays the contents of a 
container.  For example, if a carton contains trays of 
cookies, the Show Contents option will display the 
trays of cookies in the graphic, as pictured on the 
right. 

Transparent Boxes 
The Transparent Boxes option allows you to view the 
footprint of a pallet.  To use this feature, open the View 
menu, select Plan, then select Transparent Boxes.  The 
pallet pattern redisplays with one layer of the unitload 
having transparent boxes, as pictured as the right. 

To see other views of the pallet pattern, use the Shift/Arrow keys to rotate 
the pallet. 

Show Graphics/C.A.S.Y. 
The Show Graphics/C.A.S.Y. option allows you to 
display paste-on graphics on the front, back or top of 
your shipcases, as pictured below.  This feature also 
allows you to display a CASY design you’ve created 
for a container.  For a faster display, leave this feature 
turned off. 

Note:  If an analysis includes both graphics and a 
CASY design, the system will display the CASY design, not both. 

Show Graphics 
The Show Graphics option allows you to display paste-on graphics on the 
front, back or top of your shipcases.  For a faster display, leave this feature 
turned off. 
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Show ShrinkWrapped 
The Show ShrinkWrapped option allows you to display a 
unitload with shrinkwrap applied, as pictured on the right. 

Show Strapped 
The Show Strapped option allows you to display a unitload 
with strapping applied, as pictured on the right. 

Split Screen 
The Split Screen option divides the Analysis View into three panes, as 
pictured below.  Click the Next ( ) or Previous ( ) button to move 
between stages. 

 

Tri Screen 
When available, depending on the number of stages in the Design 
Sequence, the Tri Screen layout presents the graphics in three different 
panes as pictured on the next page.   
 
You can use the Next ( ) or Previous ( ) button to move between 
stages or click on the different tabs in the Solution List pane. 
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Tri With Stat Screen 
When available, the Tri Screen with Statistics option presents the graphics 
in three different panes plus the statistics of the highlighted stage. 

You can use the Next ( ) or Previous ( ) button to move between 
stages or click on the different tabs in the Solution List pane. 
 

 

Quad Screen 
The Quad Screen option divides the Analysis View into four panes, as 
pictured next.   
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Again, click on Next ( ) or Previous ( ) button to move between 
stages or click on the different tabs in the Solution List pane. 

 

Hex Screen 
When available, the Hex Screen option presents the graphics view in six 
different panes as pictured below. 

Again, click on Next ( ) or Previous ( ) button to move between 
stages or click on the different tabs in the Solution List pane. 
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Single Stack 
The Single Stack option displays a unitload as a single-stack 
pattern, as pictured on the right. 

Pop Top 
The Pop Top option displays a unitload with the top layer 
suspended, which allows you to see the second layer in the 
pattern, as pictured below. 

Double Stack 
The Double Stack option displays a unitload as a double-stack 
pattern, as pictured on the right. 

Assembly 
The Assembly option is used for cartons with dividers and 
displays a view how the carton and dividers are assembled, 
as pictured on the right. 

Exploded 
The Exploded option is used for cartons or 
shipcases with dividers and displays a view 
how the items are loaded into a shipper, as 
pictured on the right. 
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Define Menu 

Product 
The Product option displays the Define Product dialog box, which allows 
you to define parameters for a new product.  You can also use this dialog 
box to change parameters for an existing product.  Products are used in 
Package Profiles.  Please refer to Chapter 10 for more details. 

Carton 
The Carton option displays the Define Carton dialog box which allows 
you to define parameters for a new carton or to change parameters for an 
existing carton. 

Once defined, these cartons can be found in the drop-down list of the 
Description field in the Carton Parameters dialog box. 

Can 
The Can option displays the Define Can dialog box which allows you to 
define parameters for a new can or to change parameters for an existing 
can.  Again, defined cans can be found in the drop-down list of the 
Description field in the Can Parameters dialog box. 

Tub 
The Tub option displays the Define Tub dialog box which allows you to 
define parameters for a new tub or to change parameters for an existing 
tub.  Defined tubs can be found in the drop-down list of the Description 
field in the Tub Parameters dialog box. 

Bottle 
The Bottle option displays the Define Bottle dialog box which allows you 
to define parameters for a new or to change parameters for an existing 
bottle. Defined bottles can be found in the drop-down list of the 
Description field in the Bottle Parameters dialog box. 
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Film Bag 
The Film Bag option displays the Define Film Bag dialog box which 
allows you to define parameters for a new bag or to change parameters for 
an existing file bag.  Defined film bags can be found in the drop-down list 
of the Description field in the Bag Parameters dialog box. 

Milk Carton 
The Milk Carton option displays the Define Milk Carton dialog box which 
allows you to define parameters for a new milk carton or to change 
parameters for an existing milk carton.  Defined milk cartons can be found 
in the drop-down list of the Description field in the Milk Carton 
Parameters dialog box. 

Shipping Case 
The Shipping Case option displays the Define Shipping Case dialog box 
which allows you to define parameters for a new a shipcase or to change 
parameters for an existing shipcase.  Defined shipping cases can be found 
in the drop-down list of the Description field in the Shipcase Parameters 
dialog box when using a Fixed Case. 

Pallet 
The Pallet option displays the Define Pallet dialog box which allows you 
to define parameters for a new a pallet or to change parameters for an 
existing pallet.  Defined pallets can be found in the drop-down list of the 
Pallet Style field in the UnitLoad Parameters dialog box. 

Vehicle 
The Vehicle option displays the Define Vehicle dialog box which allows 
you to define a new vehicle and save it to the database or to change 
parameters for an existing vehicle.  Defined vehicles can be found in the 
drop-down list of the Description field in the Vehicle Parameters dialog 
box. 

Box Styles 
The Box Styles option displays the Case Styles dialog box which allows 
you to define parameters for a new case style (one that's not already 
defined in the system).  This dialog box also allows you to change 
parameters for an existing style. 
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Defined box styles are available in the drop-down list of the Style field in 
the Carton, Intermediate Pack and Shipcase Parameters dialog boxes. 

Dividers 
The Dividers option displays the Define Dividers dialog box which allows 
you to define parameters for a new divider or to change parameters for 
existing dividers. 

Pallet Accessories 
The Pallet Accessories option displays the Define Pallet Accessories 
dialog box which allows you to define custom slipsheet, pad, tray or cap 
and save them to the TOPS database for later use. 

Film 
The Film option displays the Define Film dialog box which allows you to 
define parameters for a new film or to change parameters for existing film.  
Defined films can be found in the drop-down list of the Film field in the 
Bag Parameters dialog box. 

Bag Costing 
The Bag Costing option displays the Costing Data dialog box which 
allows you to enter costing data related to a number of bag-related items.  
More information can be found in Appendix B – Costing Data dialog box. 

C.A.S.Y. Primary Style 
This option displays the CASY Primary Package Screen, which allows 
you to design a primary package (bottle, can, cup, etc.) that has a custom, 
non-standard shape.  More information is available in Chapter 8, Create A 
Shape Yourself (CASY). 

C.A.S.Y. Tray Style 
This option displays the CASY Shipcase/Tray Screen, which allows you 
to design and build a shipcase or tray that has a custom, non-standard 
shape. More information is available in Chapter 8, Create A Shape 
Yourself. 
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Tools Menu 

Configuration 
The Configuration option displays the Configuration dialog box, which 
allows you to define the configuration of your TOPS Pro system by 
selecting and de-selecting a range of options. 

Language 
The Language option displays a second menu, which allows you to select 
the language to be used with the TOPS Pro system. 

You can also access the Edit menu which displays the Text Modification 
dialog box which allows you to replace existing text strings within TOPS  
Pro with a new text string. 

Stacking Strength 
The Stacking Strength option displays the Stacking Strength dialog box, 
which allows you to perform a stacking strength test on a package 
analysis. 

For more information about the Stacking Strength dialog box, please refer 
to Chapter 9, Stacking Strength, or Appendix B, Dialog Boxes. 

Search 
This option displays Analysis Search dialog box where users can specify 
the dimension of a carton or shipcase to be searched through the database 
or from the archives. 

User List 
The User List option displays the User List dialog box, which displays the 
users currently logged onto the system.  This feature is critical for network 
users who have a limited number of TOPS Pro software licenses.  For 
example, if you have two licenses and two users are logged on, then a 
third user will not be able to logon until one of the current users logs off. 
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Color Selection 
The Color Selection option displays the Color Selection dialog box, which 
allows you to select a color for a number of images in the system – blocks, 
packers, shippers, etc. 

MixPro 
The MixPro option displays the MixPro Screen, which allows you to 
design a mixed pallet with any number of different size boxes. 

For more information about the MixPallet Screen, please refer to Chapter 
6, MixPro Pallet. 

MixTray 
The MixTray option displays the MixTray Screen, which allows you to 
design a mixed tray with any number of different size primary packages. 

For more information about the MixTray Screen, please refer to Chapter 6, 
MixPro Tray. 

ESR 
The ESR, Eco Saving Report option opens a second menu which allows 
you to configure cost factors for ESR and to create ESR after multiple 
solutions have been selected for comparison. 

Recover Analyses 
The option opens the Auto Recover dialog box which allows you to select 
analyses for recovery or deletion. 
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Import Menu 

Import TOPS Data 
The Import TOPS Data option displays the Import From ASCII dialog 
box, which allows you to import an ASCII comma delimited text file or 
XML files into the TOPS Pro system.  You can use this function to import 
shipcases into TOPS Pro.  The functionality is identical to that of the 
Import option on the File menu in the Configuration program. 

Easy Import 
The Easy Import option displays the Easy Import dialog box, which 
allows you to import an ASCII comma delimited text file into the TOPS 
Pro system.   

This is a simpler import when compared to the general TOPS import and 
can include up to the following 32 fields/Columns for an analysis: 

 1) Analysis Name    2) Analysis Type (starting stage of analysis) 
 3) Unit of Measure For distance   4) Unit of Measure For weight 
 5) Primary pack (if present)   6) Primary pack type   

7) Primary pack length    8) Primary pack width   
9) Primary pack height    10) Primary pack net weight   
11) Primary pack gross weight 12) Intermediate pack (if present)   
13) Intermediate pack style  14) Intermediate pack flute 
15) Intermediate pack maximum count   16) Intermediate pack minimum count 

 17) Shipcase (if present)    18) Shipcase type   
19) Shipcase style    20) Shipcase length   
21) Shipcase width    22) Shipcase height    
23) Shipcase flute   24) Shipcase maximum count    
25) Shipcase minimum count 26) Unitload (if present)   
27) Unitload Pallet    28) Unitload maximum height   
29) Unitload maximum weight 30) Vehicle (if present)   
31) Vehicle name    32) Vehicle maximum weight 
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Export Menu 

BMP (Color) 
The BMP (Color) option displays the Save File As dialog box and allows 
you to save a selected graphic as a color bitmap file. 

BMP (B+W) 
The BMP (B+W) option displays the Save File As dialog box and allows 
you to save a selected graphic as a black-and-white bitmap file. 

EPS 
The EPS option displays the Save File As dialog box and allows you to 
save a selected graphic as an encapsulated post script (EPS) file. 

TIFF 
The TIFF option displays the Save File As dialog box and allows you to 
save a selected graphic as an TIFF file. 

PCX 
The PCX option displays the Save File As dialog box and allows you to 
save a selected graphic as an PCX file. 

JPEG 
The JPEG option displays the Save File As dialog box and allows you to 
save a selected graphic as a JPEG file. 

HTML 
The HTML option displays the Save File As dialog box and allows you to 
save a selected graphic as an HTML file. 

PNG 
The PNG option displays the Save File As dialog box and allows you to 
save a selected graphic as a PNG file. 
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Note:  TOPS recommends the PNG format because it provides the 
smallest file size and the best quality image. 

PDF 
The PDF option displays the Save File As dialog box and allows you to 
save a selected graphic as a PDF file. 

WMF 
The WMF option displays the Save File As dialog box and allows you to 
save a selected graphic as a WMF file. 

Product Report 
The Product Report option displays the Product Export dialog box, which 
allows you to export a product report.  This report exports information to 
an ASCII comma delimited text file in a form suitable for import into 
Microsoft Access or Excel.  The report includes information on every 
product attached to an approved package profile. 

Case 
The Case option displays the Export to ASCII dialog box, which allows 
you to export the shipcase in the current analysis from the TOPS Pro 
system to an ASCII comma delimited test file for use by third-party 
products, such as Design Axis' Package for DOS product. 

Carton 
The Carton option displays the Export to ASCII dialog box, which allows 
you to export the carton in the current analysis from the TOPS Pro system 
to an ASCII comma delimited test file for use by third-party products, 
such as Design Axis' Package for DOS product. 

Analysis 
The Analysis option displays the Export Analysis dialog box, which 
allows you to export an analysis to an ASCII comma delimited text or 
XML file.  You can use this file to transfer analyses to other copies of 
TOPS Pro (same release or higher) or to back up your work. 
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Analysis Summary 
The Export Analysis Summary option allows you to export all analyses, 
including both working and approved ones, in the TOPS Pro database into 
a comma delimited file.  In order to open the export in Excel or Access, 
please provide a file name with a CSV or TXT extension. 

Sarbrook – WinSPEX 
This option integrates TOPS Pro with the Sarbrook – WinSPEX system.  
For more information, please call TOPS Technical Support. 

Design Axis – PKG 
This option integrates TOPS Pro with the PKG Specification system.  For 
more information, please call TOPS Technical Support. 

Robotic Palletizer 
The Robotic Palletizer option allows you to export the arrangement of a 
pallet pattern layer to an ASCII comma delimited text file, which can be 
used by robotic palletizing machines to determine how to arrange a 
unitload. 

Interface 
The Interface option allows you to export data from TOPS Pro to other 
software applications like JD Edwards.  For an up-to-date list of 
applications that interface with TOPS Pro, please contact TOPS Technical 
Support. 

Send to MS Office 
The Send to MS Office option displays the Select template to export 
dialog box which allows you to export the current analysis to MS Word or 
Excel using predefined templates.  For more information, please see 
Chapter 18 – Send to MS Office. 

Send to Esko Artios 
The Send to Esko Artios option displays the Send to Artios dialog box 
which allows you to export shipcase or shipcase and pallet information to 
Artios CAD.  For more information, please see Chapter 3. 
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Supervisor Menu 

Login/Logout 
The Login/Logout option displays the Supervisor Login dialog box, which 
allows you to login to the system as a supervisor.  This is required in order 
to perform the following tasks: 

 Approve analyses 
 Rename and delete users 
 Change statistics settings 
 See all users' work 
 Log off other users 
 Change button templates 
 Change Quick Print templates 

 
For more information about the Supervisor Login dialog box, please refer 
to Chapter 15, Supervisor Functions, or Appendix B, Dialog Boxes. 

Open Request 
The Open Request option displays the Open Request for Approval dialog 
box, which displays a list of analyses that are queued up for approval or 
denial.  This dialog box allows a supervisor to open an analysis and look it 
over before approving or denying it. 

For more information, please refer to Chapter 15, Supervisor Functions. 

Approve 
The Approve option allows the supervisor to approve an analysis. 

Deny Approval 
The Deny Approval option allows the supervisor to deny approval of an 
analysis. 

Template Setup 
The Template Setup option displays the Control Panel in red and allows a 
supervisor to set up a template analysis and assign a button to it. 
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QPrint Template 
The QPrint Template option displays the Control Panel in red and allows a 
supervisor to set up a Quick Print analysis. 

Revert From Last Approved 
The Revert From Last Approved option is currently not active. 

Set License 
The Set License option opens the Set TOPS License box which allows you 
to setup your TOPS electronic license.  

 

Help Menu 

Contents and Index 
The Contents and Index option displays the TOPS Pro Help index, which 
allows you to select and displays Help information for a comprehensive 
range of topics. 

About 
The About option displays the About TOPS Pro screen which displays a 
variety of information about your license include software version, 
registered name, serial number, current user, license format (stand-alone 
or network) and number of simultaneous users. 

It also lists the directory path for the TOPS Pro installation, its database, 
language and location of the TOPSPRO.INI file. 

Email Problem Definition 
The Email Problem Definition option allows you to e-mail an analysis or 
problem definition report to TOPS Technical Support.  This feature 
launches your e-mail browser, automatically attaches the selected analysis 
and addresses the e-mail to TOPS Technical Support. 
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Appendix D: Pallet Patterns 

Introduction 
TOPS Pro allows you to configure unitloads with a specific pattern.  For 
example, the Shipcase Option dialog box allows you to select one or 
multiple pattern arrangements for TOPS Pro to consider when the system 
generates solutions for an analysis.  This appendix describes the pattern 
styles you can use with TOPS Pro. 

Depending on your situation, you may want to use a number of patterns in 
your analysis to get a tighter load.  Conversely, you might want to 
eliminate some options because you want simpler patterns; for example, 
your palletizing machine can handle only simple 1-block patterns. 

Note two things about the information presented in this appendix: 

 The pattern styles 1-block, 2-block, 3-block, 4-block, 5-block, 5-block 
plus and diagonal, allow you to choose a vertical dimension for the 
shipcases and use that vertical dimension throughout the arrangement.   

The figures presented with these patterns each use the depth dimension 
as the vertical dimension.  For each pattern, two unitloads are 
displayed in plan view for enhanced clarity. 

 Each pattern style has a corresponding letter in parentheses.  This 
letter is used in the various List panels and unitload statistics, and is a 
single-letter abbreviation for that particular pattern style. 
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1-Block Pattern (C) 
The 1-block, column stack pattern is a simple 
pattern with one block of shipcases.   

2-Block Pattern (B) 
The 2-block pattern or bi-block configuration, is 
pictured below. This pattern is also known as 
interlock pattern if used in conjunction with layer rotation. 

3-Block Pattern (T) 
The 3-block, or tri-block, pattern is pictured here. 

4-Block Pattern (W) 
The 4-block, pinwheel pattern is pictured below. 
In the two unitloads, this pattern is made up of 
four blocks of shipcases that form a pinwheel-like figure. 

5-Block Pattern (P) 
The 5-block, or penta-block, pattern is pictured 
here.  In these two unitloads, this pattern is 
made up of five blocks of shipcases.  Four blocks of shipcases form a 
pinwheel configuration; the fifth block of shipcase is positioned in the 
middle.   

5-Block Plus Pattern (Q) 
Notice that this 5-block pattern has another 5-
block pattern in the middle of the configuration.  
In these two unitloads, this pattern is made up of five blocks of shipcases.  
Four blocks of shipcases form a pinwheel configuration; a separate 5-
block configuration of shipcases is positioned in the middle. 

Diagonal Pattern (D) 
In these unitloads, the pattern has alternating 
blocks of shipcases that form a diagonal 
configuration. 
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Multi-Layer Pattern (Z) 
In these two unitloads, the top layer is lifted to 
show that different layers have different patterns.  
With a multi-layer pattern, TOPS Pro configures 
the unitload with the vertical dimension you 
specified, with the exception of the top layer.  
(The top layer is not affected by stacking 
strength).   

Multi-Dimension Pattern (Z) 
In the two unitloads shown here, each layer has 
a different vertical dimension.  

Multi-Surface Pattern (O) 
With this pattern, TOPS Pro turns the 
pallet on its side, loads the pallet, 
configures the pattern, then turns the 
pallet upright again.  In the figure, the 
arrows indicate the side on which TOPS 
Pro loaded the pallet. 

To use a multi-surface pattern, it's necessary to select at least two 
dimensions as vertical dimensions.  When you use a multi-surface pattern, 
TOPS Pro automatically calculates other multi-patterns.   

Repeat (Pinwheel) Pattern (R) 
With the repeater pattern, you'll fill the 
vehicle with the pinwheel pattern on the 
right, then fill the rest of the vehicle 
space with other patterns, if possible.  
This pattern is available only if you're loading pallets onto a vehicle. 

Soldiered Pattern (S) 
In the two unitloads, the cases are spaced 
apart so that other cases can be turned on 
their sides and fit into the space. 
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Staggered Pattern (N) 
The staggered pattern is used to load round containers 
onto a pallet.  As you can see, the round containers 
mean the configuration will have a staggered, rather 
than a linear, pattern.   
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Appendix E: Box Styles 
This appendix outlines the box styles defined in the TOPS Pro database.  

To see the parameters for each box style as shown in this chapter, select 
Box Styles under the Define Menu. Click on the drop down list in the 
Description field to select the style.  The Case Styles dialog box will 
appear to provide detail parameters for the selected style. 

 

 
 

Bottle Display Tray 

 

 

Bundle Strapped 

 

Carton 

CFS Cube Cube (No Thicknesses) 

Die Cut Display Case 

 

FEFCO 200 
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FEFCO 201 (RSC) 

 

FEFCO 202 FEFCO 203 (FOL) 

 
FEFCO 204 

 

FEFCO 205 FEFCO 206 

 
FEFCO 209 

 

FEFCO 210-15 (Die 
Cut) 

 

FEFCO 215 

 
FEFCO 216 FEFCO 230 FEFCO 300 

 
FEFCO 304 

 

FEFCO 308 

 

FEFCO 406 
 

FEFCO 421 

 

FEFCO 422 

 

FEFCO 453 

 
FOL 
 

Friction Lock Tuck Top Full Overlap Seal End 
Carton 
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HSC 

 

RSC 

 

RSC (Closed) 

 

RSC (FEFCP 0201) Shrink Wrap 

 

Standard Reverse Tuck 
Carton 

 
Tear Out 

 

 
Telescoping 

 
Tray and Shroud 

 

Tray (1-inch) 
 

 

Tray (2-inch) 
 

 

Tray (CFC) 

 

Tray (Half Height) 

 

Tray (Shrink Wrap) 

 

Tuck 

Wrap Around 

 

Wrap Around Economy 
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Appendix F: Divider Styles 
This appendix outlines the divider styles defined in TOPS Pro’s database: 

To see the parameters for each divider style shown in the appendix, select 
Dividers under the Define Menu. Click on the drop down list in the 
Description field to select the style.  The Define Dividers dialog box, as 
shown below, displays the parameters for the selected divider. 

 
 

2-Way Cell (A) 

 

2-Way w/ Partial (B) 

 

2-Way w/ Sleeve (C) 

 

2-Way w/ Closed E (D) 

 

2-Way w/ Closed M (E) 

 

3-Cell w/ Tabs (F) 

 

Z-Part Length (G) 

 

Z-Part Length w/ T (H) 

 

Z-Part Width (I) 
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Z-Part Width w/ T (J) 

 

H-Part  (Inside) (K) 

 

H-Part (Outside) (L) 

 

H-Part (Outside) (M) 

 

H-Part w/ tabs (Outside) (N) 

 

H-Part w/ Tabs IN (O) 

 

Split Width (P) 

 

Split Length (Q) 

 

Perimeter (R) 

 

Perimeter w/ Gap (S) 

 

Perimeter w/ Center T (T) 

 

U-Part w/ Tabs (U) 

 

Dual U w/ Box IN (V) 

 

Cradle (W) 

 

Complete Aircell 

 

Len U Simple 

 

Perimeter Aircell 

 

Wid U Simple 
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Appendix G: TOPS Bookmarks & 
Defined Names 

TOPS Bookmarks for MS Word 

Product / Primary Pack 
IMAGE_PROD_POPTOP_3D  Product Poptop 3D Image 
IMAGE_PROD_SINGLE_STACK_3D  Product Single Stack 3D Image 
IMAGE_PROD_DOUBLE_STACK_3D  Product Double Stack 3D Image 
IMAGE_PROD_ASSEMBLY_3D  Product Assembly 3D Image 
IMAGE_PROD_EXPLODED_3D  Product Exploded 3D Image 
IMAGE_PROD_POPTOP_PLAN  Product Poptop Plan Image 
IMAGE_PROD_SINGLE_STACK_PLAN  Product Single Stack Plan Image 
IMAGE_PROD_DOUBLE_STACK_PLAN  Product Double Stack Plan Image 
IMAGE_PROD_ASSEMBLY_PLAN  Product Assembly Plan Image 
IMAGE_PROD_EXPLODED_PLAN  Product Exploded Plan Image 
IMAGE_PROD_POPTOP_FRONT  Product Poptop Front Image 
IMAGE_PROD_SINGLE_STACK_FRONT  Product Single Stack Front Image 
IMAGE_PROD_DOUBLE_STACK_FRONT  Product Double Stack Front Image 
IMAGE_PROD_ASSEMBLY_FRONT  Product Assembly Front Image 
IMAGE_PROD_EXPLODED_FRONT  Product Exploded Front Image 
IMAGE_PROD_POPTOP_SIDE  Product Poptop Front Image 
IMAGE_PROD_SINGLE_STACK_SIDE  Product Single Front Image 
IMAGE_PROD_DOUBLE_STACK_SIDE  Product Double Stack Front Image 
IMAGE_PROD_ASSEMBLY_SIDE  Product Assembly Front Image 
IMAGE_PROD_EXPLODED_SIDE  Product Exploded Front Image 

Intermediate Pack 
IMAGE_IP_POPTOP_3D Intermediate Pack Poptop 3D Image 
IMAGE_IP_SINGLE_STACK_3D  Intermediate Pack Single Stack 3D 
IMAGE_IP_DOUBLE_STACK_3D  Intermediate Pack Double Stack 3D 
IMAGE_IP_ASSEMBLY_3D  Intermediate Pack Assembly 3D 
IMAGE_IP_EXPLODED_3D  Intermediate Pack Exploded 3D 
IMAGE_IP_POPTOP_PLAN  Intermediate Pack Poptop Plan 
IMAGE_IP_SINGLE_STACK_PLAN  Intermediate Pack Single Stack Plan 
IMAGE_IP_DOUBLE_STACK_PLAN  Intermediate Pack Double Stack Plan 
IMAGE_IP_ASSEMBLY_PLAN  Intermediate Pack Assembly Plan 
IMAGE_IP_EXPLODED_PLAN  Intermediate Pack Exploded Plan 
IMAGE_IP_POPTOP_FRONT  Intermediate Pack Poptop Front 
IMAGE_IP_SINGLE_STACK_FRONT  Intermediate Pack Single Stack Front 
IMAGE_IP_DOUBLE_STACK_FRONT  Intermediate Pack Double Stack Front 
IMAGE_IP_ASSEMBLY_FRONT  Intermediate Pack Assembly Front 
IMAGE_IP_EXPLODED_FRONT  Intermediate Pack Exploded Front 
IMAGE_IP_POPTOP_SIDE  Intermediate Pack Poptop Side 
IMAGE_IP_SINGLE_STACK_SIDE  Intermediate Pack Single Stack Side 
IMAGE_IP_DOUBLE_STACK_SIDE Intermediate Pack Double Stack Side 
IMAGE_IP_ASSEMBLY_SIDE  Intermediate Pack Assembly Side 
IMAGE_IP_EXPLODED_SIDE Intermediate Pack Exploded Side 
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Shipcase 
IMAGE_SC_POPTOP_3D  Shipcase Poptop 3D 
IMAGE_SC_SINGLE_STACK_3D  Shipcase Single Stack 3D 
IMAGE_SC_DOUBLE_STACK_3D  Shipcase Double Stack 3D 
IMAGE_SC_ASSEMBLY_3D  Shipcase Assembly 3D 
IMAGE_SC_EXPLODED_3D  Shipcase Exploded 3D 
IMAGE_SC_POPTOP_PLAN  Shipcase Poptop Plan 
IMAGE_SC_SINGLE_STACK_PLAN  Shipcase Single Stack Plan 
IMAGE_SC_DOUBLE_STACK_PLAN  Shipcase Double Stack Plan 
IMAGE_SC_ASSEMBLY_PLAN  Shipcase Assembly Plan 
IMAGE_SC_EXPLODED_PLAN  Shipcase Exploded Plan 
IMAGE_SC_POPTOP_FRONT  Shipcase Poptop Front 
IMAGE_SC_SINGLE_STACK_FRONT  Shipcase Single Stack Front 
IMAGE_SC_DOUBLE_STACK_FRONT  Shipcase Double Stack Front 
IMAGE_SC_ASSEMBLY_FRONT  Shipcase Assembly Front 
IMAGE_SC_EXPLODED_FRONT  Shipcase Exploded Front 
IMAGE_SC_POPTOP_SIDE  Shipcase Poptop Plan 
IMAGE_SC_SINGLE_STACK_SIDE  Shipcase Single Stack Plan 
IMAGE_SC_DOUBLE_STACK_SIDE  Shipcase Double Stack Plan 
IMAGE_SC_ASSEMBLY_SIDE  Shipcase Assembly Plan 
IMAGE_SC_EXPLODED_SIDE  Shipcase Exploded Plan 

Unitload 
IMAGE_UL_POPTOP_3D  Unitload Poptop 3D 
IMAGE_UL_SINGLE_STACK_3D  Unitload Single Stack 3D 
IMAGE_UL_DOUBLE_STACK_3D  Unitload Double Stack 3D 
IMAGE_UL_ASSEMBLY_3D  Unitload Assembly 3D 
IMAGE_UL_EXPLODED_3D  Unitload Exploded 3D 
IMAGE_UL_POPTOP_PLAN  Unitload Poptop Plan 
IMAGE_UL_SINGLE_STACK_PLAN  Unitload Single Stack Plan 
IMAGE_UL_DOUBLE_STACK_PLAN  Unitload Double Stack Plan 
IMAGE_UL_ASSEMBLY_PLAN  Unitload Assembly Plan 
IMAGE_UL_EXPLODED_PLAN  Unitload Exploded Plan 
IMAGE_UL_POPTOP_FRONT  Unitload Poptop Front 
IMAGE_UL_SINGLE_STACK_FRONT  Unitload Single Stack Front 
IMAGE_UL_DOUBLE_STACK_FRONT  Unitload Double Stack Front 
IMAGE_UL_ASSEMBLY_FRONT  Unitload Assembly Front 
IMAGE_UL_EXPLODED_FRONT  Unitload Exploded Front 
IMAGE_UL_POPTOP_SIDE  Unitload Poptop Side 
IMAGE_UL_SINGLE_STACK_SIDE  Unitload Single Stack Side 
IMAGE_UL_DOUBLE_STACK_SIDE  Unitload Double Stack Side 
IMAGE_UL_ASSEMBLY_SIDE  Unitload Assembly Side 
IMAGE_UL_EXPLODED_SIDE  Unitload Exploded Side 
 

Statistics (Primary Pack) 
STATS_PRIPACK_NAME Primary pack box style 
STATS_PRIPACK_LEN Primary Pack Length (Inside) 
STATS_PRIPACK_LEN_METRIC Primary Pack Length in metric (Inside) 
STATS_PRIPACK_LEN_METRIC_CM Primary Pack Length in cm (Inside) 
STATS_PRIPACK_LEN_OUTSIDE Primary Pack Length (Outside) 
STATS_PRIPACK_LEN_METRIC_OUTSIDE Primary Pack Length in metric (Outside) 
STATS_PRIPACK_LEN_METRIC_CM_OUTSIDE Primary Pack Length in cm (Outside) 
STATS_PRIPACK_WID Primary Pack Width (Inside) 
STATS_PRIPACK_WID_METRIC Primary Pack in metric (Inside) 
STATS_PRIPACK_WID_METRIC_CM Primary Pack in cm (Inside) 
STATS_PRIPACK_WID_OUTSIDE Primary Pack Width (Outside) 
STATS_PRIPACK_WID_METRIC_OUTSIDE Primary Pack in metric (Outside) 
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STATS_PRIPACK_WID_METRIC_CM_OUTSIDE Primary Pack in cm (Outside) 
STATS_PRIPACK_HGT Primary Pack Height (Inside) 
STATS_PRIPACK_HGT_METRIC Primary Pack Height in metric (Inside) 
STATS_PRIPACK_HGT_METRIC_CM Primary Pack Height in cm (Inside) 
STATS_PRIPACK_HGT_OUTSIDE Primary Pack Height (Outside) 
STATS_PRIPACK_HGT_METRIC_OUTSIDE Primary Pack Height in metric (Outside) 
STATS_PRIPACK_HGT_METRIC_CM_OUTSIDE Primary Pack Height in cm (Outside) 
STATS_PRIPACK_DIMVERT Vertical Dimension of Primary pack 
STATS_PRIPACK_CUBE Primary Pack Cube (Inside) 
STATS_PRIPACK_CUBE_METRIC Primary Pack Cube in metric (Inside) 
STATS_PRIPACK_CUBE_OUTSIDE Primary Pack Cube (Outside) 
STATS_PRIPACK_CUBE_METRIC_OUTSIDE Primary Pack Cube in metric (Outside) 
STATS_PRIPACK_WGT_NET Net Weight - Primary Pack 
STATS_PRIPACK_WGT_NET_METRIC Net Weight in metric - Primary Pack 
STATS_PRIPACK_WGT_GROSS Gross Weight - Primary Pack 
STATS_PRIPACK_WGT_GROSS_METRIC Gross Weight in metric - Primary Pack 
STATS_PRIPACK_PER_LAYER Primary Pack per layer 
STATS_PRIPACK_LAYER_PER_LOAD Primary pack layers per load 
STATS_PRIPACK_COUNT Primary Pack Count 

Statistics (Intermediate Pack) 
STATS_IPACK_NAME Intermediate pack box style 
STATS_IPACK_LEN Intermediate Pack Length (Inside) 
STATS_IPACK_LEN_METRIC Intermediate Pack Length in metric (Inside) 
STATS_IPACK_LEN_METRIC_CM Intermediate Pack in cm (Inside) 
STATS_IPACK_LEN_OUTSIDE Intermediate Pack Length (Outside) 
STATS_IPACK_LEN_METRIC_OUTSIDE Intermediate Pack Length metric (Outside) 
STATS_IPACK_LEN_METRIC_CM_OUTSIDE Intermediate Pack in cm (Outside) 
STATS_IPACK_WID Intermediate Pack Width (Inside) 
STATS_IPACK_WID_METRIC Intermediate Pack Width in metric (Inside) 
STATS_IPACK_WID_METRIC_CM Intermediate Pack in cm (Inside) 
STATS_IPACK_WID_OUTSIDE Intermediate Pack Width (Outside) 
STATS_IPACK_WID_METRIC_OUTSIDE Intermediate Pack Width in metric (Outside) 
STATS_IPACK_WID_METRIC_CM_OUTSIDE Intermediate Pack in cm (Outside) 
STATS_IPACK_HGT Intermediate Pack Height (Inside) 
STATS_IPACK_HGT_METRIC Intermediate Pack Height in metric (Inside) 
STATS_IPACK_HGT_METRIC_CM Intermediate Pack in cm (Inside) 
STATS_IPACK_HGT_OUTSIDE Intermediate Pack Height (Outside) 
STATS_IPACK_HGT_METRIC_OUTSIDE Intermediate Pack Height  metric (Outside) 
STATS_IPACK_HGT_METRIC_CM_OUTSIDE Intermediate Pack in cm (Outside) 
STATS_IPACK_DIMVERT Vertical Dimension of Intermediate pack 
STATS_IPACK_PATTERN Loading Pattern onto the intermediate pack 
STATS_IPACK_CUBE Intermediate Pack Cube (Inside) 
STATS_IPACK_CUBE_METRIC Intermediate Pack Cube in metric (Inside) 
STATS_IPACK_CUBE_OUTSIDE Intermediate Pack Cube (Outside) 
STATS_IPACK_CUBE_METRIC_OUTSIDE Intermediate Pack Cube in metric (Outside) 
STATS_IPACK_WGT_NET Net Weight - Intermediate Pack 
STATS_IPACK_WGT_NET_METRIC Net Weight in metric - Intermediate Pack 
STATS_IPACK_WGT_GROSS Gross Weight - Intermediate Pack 
STATS_IPACK_WGT_GROSS_METRIC Gross Weight in metric - Intermediate Pack 
STATS_IPACK_PER_LAYER Intermediate Pack per layer 
STATS_IPACK_LAYER_PER_LOAD Intermediate Pack layers per load 
STATS_IPACK_COUNT Intermediate Pack Count 

Statistics (Shipper) 
STATS_SHIPPER_LEN Shippers Length (Inside) 
STATS_SHIPPER_LEN_METRIC Shippers Length in metric (Inside) 
STATS_SHIPPER_LEN_METRIC_CM Shippers Length in cm (Inside) 
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STATS_SHIPPER_LEN_OUTSIDE Shippers Length (Outside) 
STATS_SHIPPER_LEN_METRIC_OUTSIDE Shippers Length in metric (Outside) 
STATS_SHIPPER_LEN_METRIC_CM_OUTSIDE Shippers Length in cm (Outside) 
STATS_SHIPPER_WID Shippers Width (Inside) 
STATS_SHIPPER_WID_METRIC Shippers Width in metric (Inside) 
STATS_SHIPPER_WID_METRIC_CM Shippers Width in cm (Inside) 
STATS_SHIPPER_WID_OUTSIDE Shippers Width (Outside) 
STATS_SHIPPER_WID_METRIC_OUTSIDE Shippers Width in metric (Outside) 
STATS_SHIPPER_WID_METRIC_CM_OUTSIDE Shippers Width in cm (Outside) 
STATS_SHIPPER_HGT Shippers Height (Inside) 
STATS_SHIPPER_HGT_METRIC Shippers Height in metric (Inside) 
STATS_SHIPPER_HGT_METRIC_CM Shippers Height in cm (Inside) 
STATS_SHIPPER_HGT_OUTSIDE Shippers Height (Outside) 
STATS_SHIPPER_HGT_METRIC_OUTSIDE Shippers Height in metric (Outside) 
STATS_SHIPPER_HGT_METRIC_CM_OUTSIDE Shippers Height in cm (Outside) 
STATS_SHIPPER_DIMVERT Vertical Dimension of Shipper  
STATS_SHIPPER_PATTERN Loading Pattern onto the shipper 
STATS_SHIPPER_CUBE Shippers Cube (Inside) 
STATS_SHIPPER_CUBE_METRIC Shippers Cube in metric (Inside) 
STATS_SHIPPER_CUBE_OUTSIDE Shippers Cube (Outside) 
STATS_SHIPPER_CUBE_METRIC_OUTSIDE Shippers Cube in metric (Outside) 
STATS_SHIPPER_WGT_NET Net Weight - Shipper 
STATS_SHIPPER_WGT_NET_METRIC Net Weight in metric – Shipper 
STATS_SHIPPER_WGT_GROSS Gross Weight – Shipper 
STATS_SHIPPER_WGT_GROSS_METRIC Gross Weight in metric - Shipper 
STATS_SHIPPER_RSCAREA RSC Area of Shipper 
STATS_CARTONS_PER_SHIPPERLAYER Cartons per layer in Shipper 
STATS_SHIPPER_LAYER_PER_LOAD Shipper layers per Unitload 
STATS_CARTONS_PER_SHIPPER_COUNT Cartons per Shipper – Count 

Statistics (Unitload) 
STATS_UL_LEN Unitload Length (Inside) 
STATS_UL_LEN_METRIC Unitload in metric (Inside) 
STATS_UL_LEN_METRIC_CM Unitload in cm (Inside) 
STATS_UL_LEN_OUTSIDE Unitload Length (Outside) 
STATS_UL_LEN_METRIC_OUTSIDE Unitload in metric (Outside) 
STATS_UL_LEN_METRIC_CM_OUTSIDE Unitload in cm (Outside) 
STATS_UL_WID Unitload Width (Inside) 
STATS_UL_WID_METRIC Unitload Width in metric (Inside) 
STATS_UL_WID_METRIC_CM Unitload Width in cm (Inside) 
STATS_UL_WID_OUTSIDE Unitload Width (Outside) 
STATS_UL_WID_METRIC_OUTSIDE Unitload Width in metric (Outside) 
STATS_UL_WID_METRIC_CM_OUTSIDE Unitload Width in cm (Outside) 
STATS_UL_HGT Unitload Height (Inside) 
STATS_UL_HGT_METRIC Unitload Height in metric (Inside) 
STATS_UL_HGT_METRIC_CM Unitload in cm (Inside) 
STATS_UL_HGT_OUTSIDE Unitload Height (Outside) 
STATS_UL_HGT_METRIC_OUTSIDE Unitload Height in metric (Outside) 
STATS_UL_HGT_METRIC_CM_OUTSIDE Unitload in cm (Outside) 
STATS_UL_PATTERN Loading Pattern in the Unitload 
STATS_UL_CUBE Unitload Cube (Inside) 
STATS_UL_CUBE_METRIC Unitload Cube in metric (Inside) 
STATS_UL_CUBE_OUTSIDE Unitload Cube (Outside) 
STATS_UL_CUBE_METRIC_OUTSIDE Unitload Cube in metric (Outside) 
STATS_UL_WGT_NET Net Weight - Unitload 
STATS_UL_WGT_NET_METRIC Net Weight in metric – Unitload 
STATS_UL_WGT_GROSS Gross Weight – Unitload 
STATS_UL_WGT_GROSS_METRIC Gross Weight in metric – Unitload 
STATS_UL_RSCAREA RSC Area of Unitload 
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STATS_UL_CUBICEFF Cubic Efficiency in % 
STATS_UL_AREAEFF Area Efficiency in % 
STATS_UL_PALLETNAME Pallet name 
STATS_UL_PALLETLEN Pallet Length 
STATS_UL_PALLETLEN_METRIC Pallet Length in metric  
STATS_UL_PALLETWID Pallet Width 
STATS_UL_PALLETWID_METRIC Pallet Width in metric  
STATS_UL_PALLETWGT Pallet Weight 
STATS_UL_PALLETWGT_METRIC Pallet Weight in metric  
STATS_UL_OVERHANGLEN Maximum length Overhang 
STATS_UL_OVERHANGWID Maximum width Overhang 
STATS_UL_UNDERHANGLEN Maximum length Underhang 
STATS_UL_UNDERHANGWID Maximum width Underhang 
STATS_UL_PER_LAYER Unitload per layer 
STATS_UL_LAYERS_PER_ULOAD Unitload layers per load 
STATS_UL_COUNT Unitload Count 
STATS_UL_PRIPACKCOUNT Primary pack per Unitload 
STATS_UL_INTPACKCOUNT Intermediate pack per Unitload 
 

Statistics (Transit Vehicle) 
STATS_TV_NAME Vehicle name 
STATS_TV_LEN Vehicle Length (Inside) 
STATS_TV_LEN_METRIC Vehicle Length in metric (Inside) 
STATS_TV_LEN_OUTSIDE Vehicle Length (Outside) 
STATS_TV_LEN_METRIC_OUTSIDE Vehicle Length in metric (Outside) 
STATS_TV_WID Vehicle Width (Inside) 
STATS_TV_WID_METRIC Vehicle Width in metric (Inside) 
STATS_TV_WID_OUTSIDE Vehicle Width (Outside) 
STATS_TV_WID_METRIC_OUTSIDE Vehicle Width in metric (Outside) 
STATS_TV_HGT Vehicle Height (Inside) 
STATS_TV_HGT_METRIC Vehicle Height in metric (Inside) 
STATS_TV_HGT_OUTSIDE Vehicle Height (Outside) 
STATS_TV_HGT_METRIC_OUTSIDE Vehicle Height in metric (Outside) 
STATS_TV_PATTERN Loading Pattern in the Vehicle 
STATS_TV_CUBE Vehicle Cube (Inside) 
STATS_TV_CUBE_METRIC Vehicle Cube in metric (Inside) 
STATS_TV_CUBE_OUTSIDE Vehicle Cube (Outside) 
STATS_TV_CUBE_METRIC_OUTSIDE Vehicle Cube in metric (Outside) 
STATS_TV_WGT_NET Net Weight – Vehicle 
STATS_TV_WGT_NET_METRIC Net Weight in metric – Vehicle 
STATS_TV_WGT_GROSS Gross Weight – Vehicle 
STATS_TV_WGT_GROSS_METRIC Gross Weight in metric – Vehicle 
STATS_TV_UL_COUNT Unitloads per vehicle 

Statistics (General) 
ANAL_NAME Analysis Name 
ANAL_AUTHOR Analysis Author (User)  
COMPANY_NAME Company Name  
CUST_Address Customer Address 
CUST_Name Customer Name 
CUST_Order Customer Order Number 
HDR_Desc Header Description 
HDR_Spec Header Specification 
INFO_Stats Show all statistics for the Analysis 
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Defined Names for MS Excel 

Data (Intermediate Pack) 
IP_AREAEFF Area Efficiency - Intermediate Pack  
IP_CASESPERLAYER Case per Layer - Intermediate Pack 
IP_COUNT Intermediate Pack Count 
IP_CUBICEFF Cube Efficiency - Intermediate Pack 
IP_DIMVERT Vertical Dimension of Intermediate Pack 
IP_GROSS Gross Weight - Intermediate Pack 
IP_LAYERSPERLOAD Intermediate Pack Layers per Load 
IP_NAME Name of Intermediate Pack 
IP_NET Net Weight - Intermediate Pack 
IP_PATTERN Intermediate Pack Load Pattern 
IP_RSCAREA RSC Area of Intermediate Pack 
IP_TOPULLAYERS  - Not Applicable - 
IPIN_CUBE Intermediate Pack Cube (Inside) 
IPIN_HGT Intermediate Pack Height (Inside) 
IPIN_LEN Intermediate Pack Length (Inside) 
IPIN_WID Intermediate Pack Width (Inside) 
IPOUT_CUBE Intermediate Pack Cube (Outside) 
IPOUT_HGT Intermediate Pack Height (Outside) 
IPOUT_LEN Intermediate Pack Length (Outside) 
IPOUT_WID Intermediate Pack Width (Outside) 

Data (Primary Pack) 
PP_AREAEFF Area Efficiency – Primary Pack 
PP_CASESPERLAYER Case per Layer - Primary Pack 
PP_COUNT Primary Pack Count 
PP_CUBICEFF Cube Efficiency - Primary Pack 
PP_DIMVERT Vertical Dimension - Primary Pack 
PP_GROSS Gross Weight - Primary Pack 
PP_LAYERSPERLOAD Primary Pack Layers per Load 
PP_NAME Name of Primary Pack 
PP_NET Net Weight - Primary Pack 
PP_PATTERN Primary Pack Load Pattern 
PP_RSCAREA RSC Area of Primary Pack 
PPIN_CUBE Primary Pack Cube (Inside) 
PPIN_HGT Primary Pack Height (Inside) 
PPIN_LEN Primary Pack Length (Inside) 
PPIN_WID Primary Pack Width (Inside) 
PPOUT_CUBE Primary Pack Cube (Outside) 
PPOUT_HGT Primary Pack Height (Outside) 
PPOUT_LEN Primary Pack Length (Outside) 
PPOUT_WID Primary Pack Width (Outside) 

Data (Product) 
PR_CASESPERLAYER Case per Layer - Product 
PR_COUNT Product Count 
PR_CUBICEFF Cub Efficiency - Product 
PR_DIMVERT Vertical Dimension of Product 
PR_GROSS Gross Weight - Product 
PR_LAYERSPERLOAD Layer per Load - Product 
PR_NAME Product Name 
PR_NET Net Weight of Product 
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PR_PATTERN Product Load Pattern 
PR_RSCAREA RSC Area of Product 
PRIN_CUBE Product Cube (Inside) 
PRIN_HGT Product Height (Inside) 
PRIN_LEN Product Length (Inside) 
PRIN_WID Product Width (Inside) 
PROUT_CUBE Product Cube (Outside) 
PROUT_HGT Product Height (Outside) 
PROUT_LEN Product Length (Outside) 
PROUT_WID Product Width (Outside) 

Data (Shipcase) 
SC_AREAEFF Area Efficiency – Shipcase 
SC_CASESPERLAYER Case per Layer - Shipcase 
SC_COUNT Shipcase Count 
SC_CUBICEFF Cube Efficiency - Shipcase 
SC_DIMVERT Vertical Dimension of Shipcase 
SC_GROSS Gross Weight - Shipcase  
SC_LAYERSPERLOAD Layer per Load - Shipcase 
SC_NAME Shipcase Name 
SC_NET Net Weight of Shipcase 
SC_PATTERN Shipcase Load Pattern 
SC_RSCAREA RSC Area of Shipcase 
SCIN_CUBE Shipcase Cube (Inside) 
SCIN_HGT Shipcase Height (Inside) 
SCIN_LEN Shipcase Length (Shipcase) 
SCIN_WID Shipcase Width (Inside) 
SCOUT_CUBE Shipcase Cube (Outside) 
SCOUT_HGT Shipcase Height (Outside) 
SCOUT_LEN Shipcase Length (Outside) 
SCOUT_WID Shipcase Width (Outside) 
STPR_NET - Not Applicable - 
STSCIN_LEN - Not Applicable - 

Data (Vehicle) 
TV_AREAEFF Area Efficiency - Vehicle  
TV_CASESPERLAYER Cases per Layer - Vehicle 
TV_COUNT Vehicle Count 
TV_CUBICEFF Cube Efficiency - Vehicle 
TV_DIMVERT Vertical Dimension of Vehicle 
TV_GROSS Gross Weight - Vehicle 
TV_LAYERSPERLOAD Layers per Load - Vehicle 
TV_NAME Vehicle Name 
TV_NET Net Weight - Vehicle 
TV_PATTERN Vehicle Load Pattern 
TV_RSCAREA RSC Area of Vehicle 
TVIN_CUBE Vehicle Cube (Inside) 
TVIN_HGT Vehicle Height (Inside) 
TVIN_LEN Vehicle Length (Inside) 
TVIN_WID Vehicle Width (Inside) 
TVOUT_CUBE Vehicle Cube (Outside) 
TVOUT_HGT Vehicle Height (Outside) 
TVOUT_LEN Vehicle Length (Outside) 
TVOUT_WID Vehicle Width (Outside) 
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Data (Unitload) 
UL_AREAEFF Area Efficiency – UnitLoad  
UL_CASESPERLAYER Cases per Layer - UnitLoad 
UL_COUNT UnitLoad Count 
UL_CUBICEFF Cube Efficiency - UnitLoad 
UL_DIMVERT Vertical Dimension of UnitLoad 
UL_GROSS Gross Weight of UnitLoad 
UL_LAYERSPERLOAD Layers per Load - UnitLoad 
UL_NAME UnitLoad Name 
UL_NET Net Weight - UnitLoad 
UL_PATTERN UnitLoad Load Pattern 
UL_RSCAREA RSC Area of UnitLoad 
ULIN_CUBE UnitLoad Cube (Inside) 
ULIN_HGT UnitLoad Height (Inside) 
ULIN_LEN UnitLoad Length (Inside) 
ULIN_WID UnitLoad Width (Inside) 
ULOUT_CUBE UnitLoad Cube (Outside) 
ULOUT_HGT UnitLoad Height (Outside) 
ULOUT_LEN UnitLoad Length (Outside) 
ULOUT_WID UnitLoad Width (Outside) 

Images 
IMAGE_IP_POPTOP_3D Intermediate Pack poptop 3D View 
IMAGE_PROD_SINGLE_STACK_3D Product Single Stack 3D View 
IMAGE_SC_POPTOP_3D Shipcase Poptop 3D View 
IMAGE_TV_SINGLE_STACK_3D Vehicle Single Stack 3D View 
IMAGE_UL_DOUBLE_STACK_3D Unitload Double Stack 3D View 
IMAGE_UL_SINGLE_STACK_3D Unitload Single Stack 3D View 
 
 
More images are available, please contact TOPS Technical Support. 
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Appendix H: Importing to TOPS 

Shipcase Database Import/Export 
Shipcase records are one to a line.  Any field left blank will be 
automatically assigned the default value that would be used if the shipcase 
was entered from the keyboard.  Placing strings within quotes is optional 
unless the strings contain delimiters.  Numerical units are always in 
English even if Metric is selected.  If needed, conversion of units from 
English to Metric occurs during use.   

Exporting the shipcase database is done through the TOPS Pro Config 
program by clicking on the Export Data quick link in the Control Panel.   

Importing data into TOPS Pro can be done through either: 

 The TOPS Pro program: go to the Import menu and select Import 
TOPS Data 

 The TOPS Pro Config program: click on the Import Data quick link in 
the Control Panel. 

Importing is an additive process, deletion of items must be done manually.  
If you would like to nuke the database and start over you should follow 
these steps: 

1. Delete the files SHIPCASE.DAT and SHIPCASE.IDX in the 
\TOPSAPPS\TOPSPro\DATA\ directory. 

2. Run TOPS Pro Config program. 

3. After logging in you will be prompted to recreate the SHIPCASE 
database, answer “Create”.   

At this point the Shipcase database will be empty and ready for a fresh 
import. 
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Shipcase Import Format 
[Ship Case] 
"Shipcase one",E,I,"RSC","C",C,0,,,12,10,8,,,,6,0,0,0,  
"Shipcase two”,E,O,"RSC","C",O,0.25,,,12,10,8,,,,6,0,0,0, 

  
Column Name Type Description

A Name String (21) Shipcase Name 

B Units String (1) Units for display 
"E" for English or "M" for Metric 

C Dimensions String(1) "I" for Inside Dims or "O" for Outside 
D Box Style   String (31) Name of Box Style from Box Styles Database 
E Flute String (1) Box flute if applicable (I.E. "A", "B", "C", etc.) 
F Material String (1) "C" for corrugated(fluted),  

"O" for Other (Caliper based) 
G Caliper   Distance Caliper of non-corrugated material.   

Not used with Fluted (Leave empty) 
H Blank  Placeholder; not used at this time. 
I Blank    Placeholder; not used at this time. 
J Length Distance Length of shipcase (normally greater than 

width) 
K Width Distance Width of shipcase 
L Height Distance Height of shipcase, the distance through the 

flaps 
M Blank  Placeholder; not used at this time. 
N Blank    Placeholder; not used at this time. 
O Blank    Placeholder; not used at this time. 
P Weight Weight Gross weight of shipcase, if things are placed 

within then this number is considered to be the 
maximum weight of it’s contents.  0 (zero) 
indicates no limit. 

Q Cost     Number Costing information is not used at this time and 
may be left off 

R Turn Rate  
  

Number Costing information is not used at this time and 
may be left off 

S Cases per 
pallet  

Number Costing information is not used at this time and 
may be left off 

T Graphic String (80) Graphic on Top (File Name with full path) 
U Graphic String (80) Graphic on Left Side (File Name with full path) 
V Graphic String (80) Graphic on Back (File Name with full path) 
W Supervisor 

Lock 
String (1) Lock the record for other users  

Y/N 
X Custom 

Shape 
String (80) CASY Shape for Shipcase 

Y Tare Weight Weight Tare weight of shipcase 
Z Graphic String (80) Graphic on Front (File Name with full path) 

AA Graphic String (80) Graphic on Right Side (File Name with full path) 
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Carton Import Format 
The Carton database structure is provided below; however, there should 
not normally be any reason to use it.  In most cases, cartons should be 
entered using the shipcase database as a non-corrugated case. 

 
[Carton]  
“Carton one”,E,O,”Tuck”,5,4,3,0.018, 

 
 

Column Name Type Description
A Name String (21) Carton Name 

B Units String (1) Units for display 
"E" for English or "M" for Metric 

C Dimensions String(1) "I" for Inside Dims or "O" for Outside 
D Box Style   String (31) Name of Box Style from Box Styles 

Database 
E Length Distance Length of carton (normally greater than 

width) 
F Width Distance Width of carton 
G Height Distance Height of carton 
H Caliper Distance Caliper of carton material  
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Easy Import (Analysis) Format 
To access, go to TOPS Pro’s Import menu and select Easy Import. 

Column Name Type Description
A AnalName String (31) Name of  Analysis to be imported 
B AnalType String (2) Starting stage of analysis  

PP- Primary Pack 
SC – Shipper 
UL – Unitload 

C UOM (Dist) String Unit of Measurement for Distances 
DIST_IN – Inches 
DIST_FT – Feet 
DIST_MM – Millimeters 
DIST_MTR – Meters 
DIST_CM – Centimeters 
If left blank, DIST_IN is assumed 

D UOM (Wgt) String Unit of Measurement for Weights 
DIST_LB – Pounds 
DIST_OZ – Ounces 
DIST_KG – Kilograms 
DIST_GR – Grams 
If left blank, DIST_LB is assumed 

E hasPP String (1) Has Primary Pack or not  (Y/N) 
F PPType 

  
String (1) Primary Pack Type 

C – Carton 
N – Can/Cylinder 

G PPLen Distance PP Length 
H PPWid Distance PP Width 
I PPHgt Distance PP Height 
J PPNet Weight PP Net Weight 
K PPGross Weight PP Gross Weight 
L hasIP String (1) Has Intermediate Pack or not  (Y/N) 
M IPStyle String (31) IP Box Style 
N IPFlute String (3) IP Flute 
O IPMaxCount Number Max Count 
P IPMinCount Number Min Count 
Q hasSC String (1) Has Shipcase or not  (Y/N) 
R SCType String (1) SC Type (Refer to PPType) 
S SCStyle String (31) SC Box Style 
T SCLen Distance SC Length 
U SCWid Distance SC Width 
V SCHgt Distance SC Height 
W SCFlute String (3) SC Flute 
X SCMaxCount Number Max Count 
Y SCMinCount Number Min Count 
Z hasUL String (1) Has Unitload or not  (Y/N) 

AA ULPal String (21) Pallet Name 
AB ULMaxHgt Distance Max height of Unitload (including pallet) 
AC ULMaxWgt Weight Max Wieight of Unitload (including pallet) 
AD hasTV String (1) Has Vehicle or not  (Y/N) 
AE TVName String (21) Vehicle Name 
AF TVMaxWgt Weight Max weight of Vehicle load 
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Units for Import 
For all Import files in Tops, the Units of the values entered in the text file 
are indicated by the following tags.  

 
Tag Units 
[English] All units below the tag are in English – Weights in lbs and 

distances in inches. If no tags are specified, this is the 
default assumed.

[Metric] All units below the tag are in Metric – Weights in kg and 
distances in Meters 

[DIST_MTR] All distances below tag to be in Meters 
[DIST_CM] All distances below tag to be in Centimeters 
[DIST_MM] All distances below tag to be in Millimeters 
[DIST_FT] All distances below tag to be in Feet 
[DIST_IN] All distances below tag to be in Inches 
[WGT_KG] All weights below tag to be in Kilograms 
[WGT_GR] All weights below tag to be in Grams 
[WGT_LB] All weights below tag to be in Pounds 
[WGT_OZ] All weights below tag to be in Ounces 
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Pallet Database Format 
 

Column Name Type Description
A Pallet Name String (31) Name of  Analysis to be imported 

B Units String (1) Units for display 
"E" for English or "M" for Metric 

C Pallet Style String (1) Pallet Style  
S – Stringer 
N – Notched Stringer 
B – Block 
P – Slipsheet 
E – Euro Pallet 
C – Chep Pallet 
L – Ledge 
W – Litco Presswood 
X – No Style 

D Construction 
Type 

String (1) Pallet Construction Type 
S – Single 
D – Double 
R– Reverse 

E Alignment 
Type 

String (1) Pallet alignment 
F– Flush 
S – Single Wing 
D – Double Wing 

F Length Tab String (1) For slipsheets (Y/ N) 
G Width Tab String (1) For slipsheets (Y/ N) 
H Both Tabs String (1) For slipsheets (Y/ N) 
I Length Distance Length of Pallet 
J Width Distance Width of Pallet 
K Height Distance Height of Pallet 
L Weight Distance Weight of Pallet 
M OutDeckWidth Distance Width of Outer deck board 

Length of Feet in case of Litco Pallet 
N InDeckWidth Distance Width of Inside deck board 

Width of Feet in case of Litco Pallet 
O deckHgt Distance Height of deck boards 

Width of Feet in case of Litco Pallet 
P Stringer Width Distance Stringer Width 
Q Offset Distance Offset 
R Tab Width Distance Slipsheet Tab Width 
S No. Boards Number Number of inside deck boards  

No. of Feet along Length for Litco 
Pallets 

T AutoSize String(1) Y/N 
U midDeckWidth Distance Middle Deck Width (EuroPallets) 

No. of Feet along width for Litco 
Pallets 

V supvLock String(1) Locked by supervisor  
Y/N 

W defMaxHgt Distance Default Maximum height 
X DispColor Long number Pallet Color for Display 
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Y Align Distance Distance Distance by which the offset is 
aligned - from the left side of pallet 

Z Graphic0 String(80) Pallet graphic on top 
AA Graphic1 String(80) Pallet graphic on right side 
AB Graphic2 String(80) Pallet graphic on left side 
AC Graphic 

Orientation 
Number Graphic orientation 

AD Design File String(80) Design specification File (with full 
path) 

AE Version  Not imported into db 
AF Pallet Id Long Number Pallet Id (P&G specific) 
AG DbType Number 80 – Pallet 

83 – Slip Sheet (used for defining 
Pallet Accessories) 
68 – Pad (used for defining Pallet 
Accessories) 
67 - Cap (used for defining Pallet 
Accessories) 
84 –Tray (used for defining Pallet 
Accessories) 
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Appendix I: Glossary 

Allowable Slack in the Case 
Additional space added to the inside dimensions of a shipcase to make 
loading easier.  Many designers provide a minimum of 0.125" of slack in 
the length and width of a shipcase to allow for manufacturing tolerances.  
In most cases, designers specify zero slack in the shipcase depth so the 
flaps close directly on the cartons. 

Amount of Printing 
The stacking strength of a shipcase is affected by the amount of printing 
on the shipcase.  The printing operation not only crushes the combined 
board, but also saturates the fibers of the shipcase enough to reduce the 
amount of stacking strength. 

Area Efficiency Percentage 
TOPS Pro calculates the area efficiency of a pallet pattern by multiplying 
the number of cases per layer times the area of the shipcase face bearing 
against the pallet surface.  TOPS Pro divides this value by the area of the 
pallet.  The resulting value is a percentage. 

Calculation Method 
TOPS Pro uses the widely accepted McKee formula to calculate stacking 
strength.  For the ring crush factor (RCF) method, TOPS Pro modifies the 
McKee formula slightly to transpose from RCF values to edge crush factor 
(ECF) values.  If you need the exact formula, please contact TOPS 
Technical Support.  It's relatively easy to insert other formulas in order to 
customize your specific application. 

Carton Arrangement 
The carton arrangement is displayed in the graphic output.  For example, 
"2D 3L 3W" is interpreted as follows: 

 In the length of the shipcase, there are two depths of the carton. 
 In the width of the shipcase, there are three lengths of the carton. 
 In the depth of the shipcase, there are three widths of the carton. 



 

I-2 TOPS Pro (Version 6.50) User Guide 

Cartons per Load 
Main solution reports are ranked by the cartons (primary package) per 
load (pallet load).  This value is calculated by multiplying the case count 
by the best number of cases per pallet load found in the analysis for the 
particular arrangement and carton size. 

Case Cube 
TOPS Pro calculates the shipcase cube – in cubic feet or cubic meters – 
and uses this value in output reports for warehouse/transit needs.  Case 
cube is based on outside shipcase dimensions. 

Case Depth 
The opening-to-opening dimension of the shipcase. 

Case Dimensions 
This field allows you to specify which shipcase dimension is the vertical 
dimension for loading onto a pallet.  For maximum stacking strength, the 
shipcase depth is usually the dimension used as the vertical dimension.  If 
you select more than one dimension as the vertical dimension, TOPS Pro 
will allow you to perform a multi-dimensional pallet loading analysis. 

Case Largest Allowable 
This value allows you to filter out shipcase sizes that are not reasonable in 
shape; for example, case length is four times its width.  As a rule of 
thumb, enter the largest allowable dimension.  If in doubt, use a very large 
number. 

Case Length 
The longer of the two non-depth dimensions of the shipcase.  See Case 
Depth. 

Case Smallest Allowable 
This value allows you to filter out shipcase sizes that are not reasonable in 
shape; for example, case length is four times its width.  As a rule of 
thumb, enter the smallest allowable dimension.  If in doubt, use a very 
small number. 



 

Appendix I:  Glossary I-3 

Case Stacking Strength 
The previously calculated at-lab-compression value for the shipcase is 
further adjusted for humidity, palletizing, storage and miscellaneous 
construction factors.  This value is the predicted amount of stacking 
strength for the shipcase.  Under the conditions specified, the shipcase will 
fail at or near this value. 

Case Style 
The shipcase style dictates how TOPS Pro calculates the conversion from 
inside case dimensions to outside case dimensions.  The specific case style 
selected dictates how many corrugated wall thicknesses to add to the 
shipcase length, width and depth dimensions. 

Case Weight 
The actual weight of the shipcase – either pounds or kilograms – after it's 
loaded with product. 

Case Width 
The shorter of the two non-depth dimensions of the shipcase.  (See Case 
Depth.) 

Cases per Layer 
The number of cases on a single layer of the pallet.  Layers are sometimes 
referred to as "tiers" on a pallet load. 

Clampable 
Many pallet loads are squeezed from the sides of the load for handling 
within the transit system.  TOPS Pro automatically calculates whether a 
pallet load is clampable by reviewing the pallet pattern voids.  The amount 
of void cannot exceed 0.5 inches.  Printed reports also indicate if the load 
is clampable in the unit load length or unit load width dimensions. 

Note:  All loads are subject to in-the-field verification. 
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Conditions 
You can specify the conditions to which a shipcase is exposed.  The value 
selected – average or severe – correlates directly with the safety factor 
selected – calculated or predetermined.  If TOPS Pro calculates the safety 
factor, which is usually the case, TOPS Pro will ignore any manual 
conditions entries when it calculates stacking strength. 

Cubic Efficiency Percentage 
TOPS Pro calculates cubic efficiency by multiplying the individual case 
cube by the number of shipcases per unit load, then divides this value by 
the available cube of the unit load.  The available cube of the unit load is 
the pallet length times the pallet width times the usable unit load height 
(unit load height minus the pallet height itself). 

Double Stack 
A diagram of two pallets stacked on top of one another.  TOPS Pro 
provides this view to show where the bottom boards of the second pallet 
bear against the top surface of the bottom pallet load.  This view also 
graphically shows how to correctly place a top load. 

End-to-End 
The predicted stacking strength of a shipcase with the length of the case 
vertical to pallet surface.  This value is expressed in pounds or kilograms. 

Flap Gaps 
Early laboratory analysis determined that the amount of "squareness" of a 
shipcase affects its stacking strength.  When the shipcase is closed, you 
can specify the amount of differential between the minor flaps and major 
flaps of the shipcase. 

Flute Construction 
TOPS Pro uses this value to apply the actual corrugated wall thickness to 
the case style selected in calculating inside-to-outside shipcase 
dimensions.  TOPS Pro uses the following flute construction values: 

 A flute:  0.188 inch 
 B flute:  0.125 inch 
 C flute:  0.157 inch 
 BC flute:  0.267 inch 
 CA flute:  0.267 inch 
 E flute:  0.072 inch 
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Front View 
The view of the pallet load from the side with the length of the unit load 
being left to right. 

General Case Size 
The arrangement report shows this value to indicate the approximate 
shipcase size that results if a specific carton arrangement is selected. 

Humidity Percentage RH 
Exposure to relative humidity is one of the most damaging factors to the 
stacking strength of a shipcase.  Enter the maximum amount of relative 
humidity a shipcase is expected to experience during its transit and 
storage. 

I.D. 
The inside dimensions of the shipcase or carton. 

Interior Partition Code 
Stacking strength calculations include 31 various partition styles that 
influence the overall strength of the system.  You can enter a code that 
will automatically adjust the stacking strength of the overall system 
(shipcase). 

Interlocking Layers 
Many times, TOPS Pro rotates alternating layers of a unit load 180 
degrees – the axis rotation varies – to produce a unit load that ties together 
better.  While this produces a more easily transportable load, it does 
reduce the stacking strength of the load. 

Lab Compression 
The lab compression value for stacking strength is the calculated failure 
point of a shipcase at ideal conditions.  This value is derived from ECT or 
RCF values, box perimeter and caliper of the combined board.  TOPS Pro 
then adjusts this raw number for the flute direction, print, shape and 
length-to-width factors.  The final calculation becomes the basis of further 
calculations that involve user-specified environmental factors. 
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Layers per Pallet 
In combination with the calculation of maximum number of cases per 
layer (tier), TOPS Pro calculates the most number of layers (tiers) that the 
load can dimensionally support given the maximum usable load height 
and weight of the unit load. 

Length Flip 
The rotation of the pallet pattern with the length axis of the pallet; for 
example, 48 inches.  The successive layers are mirror images of the 
previous layer's pattern across the length axis of the pallet. 

Length and Width Flip 
This double combination flip of successive layers is a length flip and 
width flip pattern executed simultaneously. 

Note:  A double flip of a symmetrical pinwheel pattern reverts to a 
columnar stack. 

Maximum Case Weight 
TOPS Pro uses this value to specify a maximum filled case weight, which 
enables the system to find the best arrangement solution without creating a 
design that is too heavy to lift. 

Maximum Dimension 
The maximum dimension that TOPS Pro will consider when it calculates 
solutions for an analysis.  TOPS Pro uses this value as the ending 
dimension in the varying of the primary carton size.  TOPS Pro 
automatically increments this value by 1/32 inch (1 millimeter) until it 
reaches the maximum dimension in the analysis.  You can control this 
increment; call TOPS Technical Support for details. 

Maximum Loads High 
The break-even point for how many pallet loads can be stacked in the 
warehouse without causing a safety problem regarding stacking strength.  
This value determines the number of pallet loads that can be safely 
stacked in the warehouse. 

Note:  The bottom pallet is counted as the first pallet. 
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Minimum Dimension 
The minimum dimension that TOPS Pro will consider when it calculates 
solutions for an analysis.  TOPS Pro uses this value as the starting 
dimension in the varying of the primary carton size.  TOPS Pro 
automatically increments this value by 1/32 inch (1 millimeter) until it 
reaches the minimum dimension in the analysis.  You can control this 
increment; call TOPS Technical Support for details. 

Mullen Burst 
A measure of tearing resistance. 

Normal Loading Analysis 
Most pallet loads fall under this description.  "Normal loading" means that 
the same shipcase dimension is vertical to the loading surface.  Therefore, 
TOPS Pro calculates solutions in which the shipcase depth (or width or 
length) is vertical to loading in all layers.  If the vertical dimension of the 
shipcase varies, there would be no mixing of different layers. 

Number of Safe Loads 
The break-even point where the fractional number of pallet loads high 
equals the resulting maximum load that can be experienced by a shipcase 
on the bottom pallet, bottom layer. 

O.D. 
The outside dimensions of the shipcase or carton. 

Pallet Overhang 
The differential between the finished unit load dimensions and the 
respective pallet dimension.  For example, after TOPS Pro calculates a 
solution, if the unit load dimensions are 49.5 inches and respective pallet 
dimension is 48 inches, then the pallet overhang is 1.5 inches (total) or 
0.75 inch on each side of the pallet (with a centered load). 

Pallets per Warehouse 
When TOPS Pro calculates stacking strength for a shipcase, the system 
uses this user-specified value as the basis to calculate how much weight is 
above the bottom case, bottom layer of the bottom pallet in the specified 
warehouse stack.  This value rarely exceeds four pallet loads high. 
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Pallet Size – Height 
The height of the pallet itself.  For example, a common pallet in the U.S. 
market is the standard Grocery Manufacturers Association (GMA) pallet 
at five to six inches in height. 

Pallet Size – Length 
The length of the pallet itself.  For example, a common pallet in the U.S. 
market is the standard Grocery Manufacturers Association (GMA) pallet 
at 48 inches in length. 

Pallet Size – Weight 
The weight of the pallet itself.  For example, a common pallet in the U.S. 
market is the standard Grocery Manufacturers Association (GMA) pallet 
at 65 pounds. 

Pallet Size – Width 
The width of the pallet itself.  For example, a common pallet in the U.S. 
market is the standard Grocery Manufacturers Association (GMA) pallet 
at 40 inches in width. 

Pallet Type 
Many styles of pallets are used around the world.  For the purpose of 
calculating stacking strength, TOPS Pro makes several pallet types 
available.  You can specify the "full surface" pallet, which is similar to 
slipsheets or plywood pallets.  For medium pallet board spacing, specify 
the GMA pallet.  For wide board spacing, specify the non-standard GMA 
pallet. 

Pattern Number 
When TOPS Pro calculates solutions to find pallet patterns, the system 
assigns an order to the answers it finds.  These answers are ranked by 
efficiency.  This number is also used to specify which pattern is to be 
displayed. 
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Pattern Type 
TOPS Pro assigns a name to pallet pattern types to assist in visualizing the 
basic pattern.  TOPS Pro assigns the following pattern names: 

 C:  1-block or column 
 B:  2-block, interblock or bi-block 
 T:  3-block or tri-block 
 W:  4-block or pinwheel 
 P:  5-block or pentablock 
 Q:  5-block plus or pentablock 
 D:  Diagonal 
 Z:  Multi-layer or multi-dimension 
 O:  Multi-surface 
 R:  Repeater 
 S:  Soldiered 
 N:  Staggered 

 

Percentage of Required Strength 
The comparison of calculated stacking strength of the shipcase, under the 
conditions specified, to the weight above the bottom case, bottom layer, 
bottom pallet load of the warehouse stack.  Look for values greater than 
100 percent to assure a strong, stable pallet load/warehouse stack. 

Primary Package 
Usually the carton or packaging material that comes into contact with the 
product itself.  Other names for a primary package are bottle, tray, packer, 
etc. 

Printing Type 
The type of printing – Flexo or Quickset/Oil – has an effect on the 
stacking strength of a shipcase.  TOPS Pro allows you to specify the type 
of printing.  This correction factor is usually minor to overall stacking 
strength. 

Product Code 
This field allows you to enter specific product code information or any 
other information that will appear on selected printouts.  This field will 
accept up to 35 characters. 
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Product Support per Case 
The added strength provided by a product packaged inside the shipcase.  
This value is entered as the total weight that the product inside the 
shipcase (on the whole case basis) can handle.  The value is added to the 
total stacking strength of the shipcase and is not reduced by factors such 
as humidity, storage, overhang, etc. 

Range of Case Counts 
This field indicates a minimum and maximum shipcase count to be 
reviewed.  For example, if a minimum of 12 case count and maximum of 
24 case count is selected as the range, TOPS Pro will review all case 
counts between 12 and 24; that is, 12, 13, 14 ... 22, 23, 24. 

Required Strength 
This value represents the comparison of the shipcase stacking strength to 
the actual load that a shipcase will experience on the bottom layer of the 
bottom pallet load.  A value greater than 100 percent means the shipcase 
stacking strength is greater than the actual load it is experiencing. 

Reversed Plan View 
The pallet pattern viewed from the perspective of being directly above the 
pallet load, but with the layer rotated to represent the next layer 
arrangement to be used for good stability. 

Safety Factor (Calculated) 
This value is calculated by dividing the at lab compression strength by the 
actual weight experienced by the bottom shipcase, bottom layer, bottom 
pallet load.  The resulting value has no dimension in nature, but is used 
throughout the corrugated industry as a good rule of thumb to predict the 
integrity of a shipcase. 

Safety Factor (Data Input) 
An early method of predicting shipcase performance was to specify a 
safety factor.  Simply stated, the safety factor is the ideal compressive 
strength of a shipcase (at ideal conditions of humidity, storage, etc.) 
divided by the actual load to which the shipcase will be exposed during its 
life.  TOPS Pro can be configured to accept a predetermined safety factor 
or actually calculate the resulting safety factor for each board grade 
combination. 
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Secondary Package 
Usually refers to the shipcase.  It generally applies that a secondary 
package is the item used to overwrap/package the primary package. 

Select Carton Style 
The carton style is used in an analysis so that the carton blank size can be 
calculated and related to total material costs for the particular solution. 

Select Measure Unit 
The unit measure (English or metric) to be used for input and output 
values in the TOPS Pro software. 

Side View 
The view of the pallet load from the perspective of the viewer who sees 
the load from the side, with the width of the unit load being left to right. 

Side-to-Side 
The predicted stacking strength of a shipcase with the width of the case 
vertical to pallet surface.  This value is expressed in pounds or kilograms. 

Single Stack 
A diagram of only one pallet load standing by itself. 

Single/Double Wall 
When you select "S" or "D," TOPS Pro converts inside-to-outside case 
dimensions based on single- or double-wall board construction. 

Soldiering Analysis 
A highly specialized type of pallet loading.  A soldiered load occurs only 
when the shipcase length and width are exactly equal; that is, a square 
footprint.  The loading procedure attempts to find the most cubic-efficient 
pallet load where the shipcase can be slipped down between the pallet 
seams on its edge to provide a better pattern.  Not all cases with a square 
footprint can be soldiered. 
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Specific Case Counts 
This question allows you to select specific case counts desired.  You can 
enter up to three specific case counts to be reviewed.  If three values are 
already entered, simply type over the existing case counts requested or 
type in zero (0) to void a case count to be reviewed. 

Storage Time 
An estimate of the total time the shipcase will be stored in the distribution 
network.  A storage time of 60 days is usually a good value. 

Tiers per Flat Stack 
The number of upright layers in the pallet pattern.  This value appears 
only in the soldiering calculations.  These cases are loaded on the pallet 
with the case depth dimension vertical. 

Tiers per Soldiers 
The number of soldiered layers in the pallet pattern.  This value appears 
only in the soldiering calculations.  These cases are loaded on the pallet 
with the case width/length dimension vertical. 

Top Plan View 
The pallet pattern viewed from the perspective of being directly above the 
pallet load with the length of the unit load left to right. 

Top-to-Bottom 
The predicted stacking strength of a shipcase with the depth of the 
shipcase vertical to the pallet surface.  This value is expressed in pounds 
or kilograms. 

Truck Width (in/m) 
The inside clearance dimensions of the transit vehicle's width.  This value 
is expressed in inches or meters. 

Unit Load Cube 
A complex calculation of finished load dimensions.  Basically, the unit 
load cube (cubic feet or cubic meters) is the pallet load dimension (length 
by width) times the finished load height.  If the pallet load does not exceed 
the pallet dimensions, then the pallet dimensions are used in the 
calculation instead of the unit load dimensions. 
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Unit Load Height 
The overall height that a unit load can reach.  For example, most transit 
vehicles allow for approximately 108-110 inches of vertical clearance 
height.  Therefore, a good unit load height would not exceed 54 inches 
(for a double stack in the trailer). 

Unit Load Length 
The length of the pallet plus any allowable overhang.  For example, if the 
pallet length is 48 inches and there is one inch of overhang allowed on 
each side of the pallet, the unit load length would be 50 inches. 

Unit Load Loading 
A type of trailer loading allowed in the TOPS Pro software.  The 
algorithm will find the best patterns available for loading a pallet/unit load 
into a rectangular space (the transit vehicle, sea container, etc.). 

Unit Load Statistics 
After calculating the pallet patterns, TOPS Pro shows the finished unit 
load dimensions.  These values are the maximum values of the unit load 
length, width, height (including the pallet itself) and weight. 

Unit Load Weight 
The maximum allowed weight (pounds or kilograms) of a completely 
loaded pallet.  TOPS Pro will filter out all solutions that exceed the 
maximum allowed weight. 

Unit Load Width 
The width of the pallet plus any allowable overhang.  For example, if the 
pallet width is 40 inches and there is one inch of overhang allowed on 
each side of the pallet, the unit load width would be 42 inches. 

Width Flip 
The rotation of the pallet pattern with the width axis of the pallet; for 
example, 40 inches.  The successive layers are mirror images of the 
previous layer's pattern across the width axis of the pallet. 
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